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Audience 

How This Book Is 
Organized 

Preface 

This book describes the DeskSet™ Environment for OpenWindowsTM. The 
DeskSet Environment is a group of productivity applications. 

This book is written for users who are familiar with Sun windowing environments 
and mouse and menu-driven applications. Refer to the OpenWindows User's 
Guide for infonnation on how to use the mouse, icons, windows, menus, and the 
on-line Help facility. If you have used SunView™ applications, see Appendix A 
for a list of differences between the Sun View and the Open Windows DeskSet 
Environments. 

Chapter 1, Getting Started, contains a brief sunUnary of the DeskSet 
applications. 

Chapter 2, File Manager, describes the DeskSet application that provides a 
graphical display of the UNIX~ file system. 

Chapter 3, Mail Tool, describes the Desk.Set application that provides a 
convenient and intuitive way to use UNIX mail handling facilities. 

Chapter 4, Calendar Manager, describes the DeskSet resource and schedule 
management tool. 

Chapter S, Text Editor ,describes the DeskSet ASCII text editing application. 

Chapter 6, Print Tool and Tape Tool, describes the DeskSet tools that provide 
an easy-to-use interface to the UNIX printing and tape archiving commands. 

Chapter 7, Snapshot, describes the DeskSet application that you can use to take 
black and white or color snapshots of regions, windows, or the entire screen. 

Chapter 8, Shell Tool, Command Tool, and Console, describes the three 
standard shell applications. 

Chapter 9, Clock and Performance Meter, describes the clock and perfonnance 
meter applications. 

Chapter 10, Calculator, describes the DeskSet calculator. 

Chapter 11, Icon Editor, describes the DeskSet application that you can use to 
edit and create your own icon images. 
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xiv DeskSet Environment Refel'ence Guide 

Conventions 

Other Books 

Support 

Chapter 12, Binder, describes the DeskSet application that you can use to connect 
or bind different types of files with printing methods, application opening and 
viewing methods, and File Manager icons and colors. 

Appendix A, Differences between Sun View and the Open Windows DeskSet 
Environment, provides a list of functional differences between the two 
environments. 

Appendix B, Keyboard Accelerators, provides a list of keyboard accelerators 
that are common to the DeskSet applications. 

Appendix C, DeskSet Environment Application Man Pages, provides the 
system man page summaries for the DeskSet applications. 

The following conventions are used in this book: 

o Terms introduced for the first time, variables, and book titles are in italic type. 

o Names of buttons, menu items, and settings have Initial Capitals. 

o Text that you type and system listing information is in Typewriter font. 

o Names of keys on the keyboard have initial capitals (for example, "Press the 
Return key"). 

o Names of mouse buttons are referred to by function, not by location, and are 
capitalized. For example "Press SELECf" is used, not '~Press left." The de­
fault mouse button function assignments are: "SELEIT' = left mouse button, 
"ADJUST" = middle mouse button, and "MENU" = right mouse button. 

For additional information, refer to the following books that are available with the 
SunOS and Open Windows documentation packages: 

o Getting Started 

o SunOS User's Guide: Doing More with SunOS 

o OpenWindows User's Guide 

o OpenWindows Release Notes 

o OpenWindows Installation and Start-up Guide 

o On-Line Help: Press Fl or the Help key 

For additional help, refer to the following resources: 

CJ The Read This First information provided with this product contains a list of 
known problems and suggests solutions or workarounds. It also contains a 
support telephone number that you can use while your software is under war­
ranty or under a service contract. 
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Chapter - Preface xv 

CJ The Software Technical Bulletin maintains an ongoing reference service. 
Check the cumulative index for relevant articles. If you have a Sun support 
contract, see the technical contact person named in that contract for a master 
copy of the Software Technical Bulletin. 

You can order a support contract through your local Sun sales office. 
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1 
Getting Started 

'This chapter introduces the DeskSet Environment for Open Windows. 

TIle DeskSet Environment contains the following applications: 

(] The File Manager application is a graphical file management program. A file 
is a collection of infonnation - a document, an application, or a directory. 
With File Manager you can find, copy, move, open, close, create, delete, and 
print files. 

(] The Mail Tool application is a powerful tool for composing, sending, sorting, 
and storing electronic mail. 

(] The Calendar Manager application is an appointment and resource scheduling 
tool. 

(] The Text Editor application is a convenient, easy-to-use interactive text editor. 

(] The Print Tool application provides a convenient and intuitive way for you to 
print files. 

(] The Tape Tool application provides a convenient and intuitive way for you to 
archive and retrieve files using a streaming tape cartridge. 

(] The Snapshot appUcation provides a convenient and intuitive way for you to 
take snapshots of regions, windows, or the entire workspace. 

(] The Shell Tool provides a tty command-Une interpreter. When you type a 
command at the command line, the shell accepts and interprets the command 
and runs it as a separate process. 

(] The Command Tool and Console provide a text-editorbased tty command-line 
intetpreter. 

o The Performance Meter provides a graphic display of system and ne~ork 
perfolDlance. 

o The Clock provides an on-line time and date display. 

o The Calculator application is a scientific calculator designed to perform a 
variety of mathematical functions in much the same way as many hand-held 
calculators. 

a The Icon Editor provides a way to create and store your own icon images. 

1 Revision A of 11 JlDle 1990 



2 DeskSet Environment Reference Guide 

1.1 Starting DeskSet 
Applications 

Figure 1-1 

o The Binder provides a way to check the default system bindings, to customize 
the visual display of icons in the Ftle Manager, and to specify default print 
scripts for use with the Print Tool. 

One of the features of the DeskSet Environment is the way the applications are 
integrated with one another. TIle integration configuration enables you to "drag" 
files from one application and "drop" them on another application in order to 
perform functions such as copying, moving, printing, and backing up fues. This 
drag-and-drop method of direct and intuitive maniJX1lation is introduced in this 
chapter and explained in more detail in the chapter for each application. 

You typically access DeskSet applications from the Programs Submenu of the 
Workspace menu, described in the OpenWindows User's Guide. When the 
DeskSet applications are installed on your system, they are automatically provided 
as items in the Programs submenu, as shown in Figure 1-1. 

The Programs Submenu with DeskSet appUcations 

.-G:Q Programs 
~ommand Toot. ) 

Utilities text Editor ... 

Properties ... File Manager ... 

Exit .. Mall Tool ... 

Calendar Manager ... 

Clock. .. 

Calculator ... 

Print Tool. .. 

Tape Tool... 

Binder ... 

Snapshot .. 

Icon Editor ... 

Performance Meter ... 

Shell Tool ... 

Dbx Tool ... 

Demos ... 

You can also start any of the DeskSet applications from a system prompt in a 
Command Tool or Shell Tool window by typing filename & and pressing the 
Return key. Table 1-1 shows what you type to start each DeskSet application. 
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Chapter 1 - Getting Started 3 

Table 1-1 What you type from a prompt to start up DeskSet applications 

Application Name What You Type 

Binder binder & 

Calculator calctool & 

Calendar Manager cm & 

Cock clock & 

Command Tool cmdtool & 

Console cmdtool -c & 

File Manager filemqr & 

Icon Editor iconedit & 

Mail Tool mail tool & 

Petfonnance Meters perfmeter & 

Print Tool printtool & 

Shell Tool shelltool & 

Snapshot snapshot & 

Tape Tool tapetool & 

Text Editor . textedit & 

1.2 Drag and Drop Many DeskSet applications allow you to drag icons or glyphs representing files and 
drop them onto other windows, icons, or glyphs. For example. you can print files 
by selecting one or several data file icons, dragging them onto the Print Tool icon, 
and dropping them. The term "drop" is a shortcut for the completion of a move or 
duplicate operation. Follow the steps below for any drag-and-drop operations: 

1. Select an object by pointing at it and clicking SELECf. Select group of objects 
by pointing to an additional object and clicking ADJUST to add the object to 
the group or remove it from the group if it is already selected. 

2. Initiate a move by pointing to one of the selected objects, pressing SELECf, 
and dragging the pointer. You initiate a duplicate, where an object is copied 
instead of moved, by pressing the Control key on the keyboard and then 
pressing SELECf. 

3. When the hot spot of the pointer (the tip of the pointer arrow) is at an 
appropriate place, drop the selection by releasing SELECT. The selection is 
"dropped" to the new location. 

When you drop the selection, the location of the hot spot of the pointer detennines 
how the dropped selection is treated by the receiving application. The DeskSet 
applications follow these rules: 
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(] When the selection is dropped on an icon or on the window, the object is 
loaded into the application, replacing any information that already exists. If 
the data being dropped will overwrite existing data, a Notice is displayed 
allowing you to choose whether to continue or cancel the operation. 

(] When the selection is dropped onto the pane of the Mail Tool Compose 
window, a Notice is displayed asldng if you want the file encoded. When you 
choose Text, the data is inserted at the caret location. When you encode the 
message, the encoded file is appended to the text in the Compose window. See 
Chapters 2 and 3 for more information about encoding files with Mail Tool. 

The following paragraphs list which of the DeskSet applications support drag-and­
drop operations. This book describes drag-and-drop operations by discussing 
source applications (from which you can drag data) and destination applications 
(on which you can drop data). See Chapter 2 for information about the Flle 
Manager as a source application. See the appropriate chapter for each applications 
for information about how they support drag-and-drop operations. 

Flle Manager glyphs can be dropped onto the following DeskSet applications: 

(j Text Editor 

CJ Print Tool 

(j Tape Tool 

CJ Mail Tool 

(j Wastebasket 

CJ Icon Editor 

Headers for mail messages from the Mail Tool application can be dropped onto the 
following DeskSet applications: 

Cl Text Editor 

Cl Print Tool 

Cl Flle Manager 

Cl Wastebasket 

Cl Calendar (with specific fonnat restrictions) 

Text selections from Text Editor files can be dropped onto these applications: 

Cl Mail Tool 

Cl Text Editor 

The following DeskSet applications cannot be dragged and do not accept dropped 
data because they do not provide and cannot accept editable text: 

Cl Calculator Tool 

Cl Command Tool 

Cl Shell Tool 
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2.1 The File "Manager 
Icons 

Figure 2-1 

2 
File Manager 

The File Manager provides a graphical display of the UNIX file system. You can 
use it to find, copy, move, open, close, delete, undelete, and print files. A file can 
be a directory, a collection of data, or an executable program. 

The File Manager displays folder icons that represent directories, and data file and 
application icons. You can select and operate on these icons within the FJ.le 
Manager either directly by dragging and dropping, or indirectly by using 
cut/copy/paste functionality. You can start applications from the File Manager, 
reorganize your file system by moving or copying files between folders, create new 
files, and print existing files. You can use the File Manager to link. files (an 
alternative to the In command) and to transfer files to other machines (an 
alternative to the rep command). 

In addition, the icons representing individual parts of the file system can be 
dragged out of the File Manager window onto the worlcspace or onto other DeskSet 
application icons or windows. 

The icons for the File Manager and the Wastebasket base windows show you useful 
infonnation about the File Manager. application. The primary icon for the File 
Manager looks like a file folder. The name of the current directory is displayed 
inside the rtIe folder, as shown in the example in Figure 2-1. 

The File Manager icon 

G;J 
The Wastebasket icon looks like a wastebasket When the Wastebasket contains 
files that you have not yet deleted, the icon shows papers sticking up out of the 
wastebasket Figure 2-2 shows both views of the Wastebasket icon. 

Figure 2-2 The Wastebasket icon, empty andfull 
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2.2 The File Manager 
Base Windows 

The Flle Manager is organized in a slightly different way from most of the other 
DeskSet applications: It has two base windows instead of one. The primary base 
window displays your file system and allows you to manipulate it The secondary 
base window is a Wastebasket that you can use to remove files from your file 
system. When you Stan the File Manager, the Wastebasket window is 
automatically started and displayed as an icon. 

The FJ.le Manager base window, shown in Figure 2-3, provides a set of controls that 
you can use to manipulate your file system. TIle window has a path pane that you 
use to display the operating system hierarchy and a scrollable folder pane that 
always displays the contents of the open folder in the path. 

Figure 2-3 The File Manager base window 

Ii) File ....... er./ ... Me/It •• It •• 
, 

<E!!:!) (View V )(Edit V) (props v) (Home v) (Coto: V). 

~ ~ Path pane 

0 0 ~ 0 0 
l~ 
H 
1;1 

TeehPubs.mex convert dead.letter deskset draw2troff 

0 EI 0 ~ 0 
drawps.sed emall.lds fmtralnlng frame. convert fra""thlngs 

0 ~ 0 ~ ~ 
funthlngs hlrlng.elephants Install junk junk2 

~ ~ ~ 0 EI ~ Folder pane 
Junk3 k.ystrokes1 Iocklt mailbox mbox 

0 EI 0 EI 0 
mlf.flle.memo nloek personal sces.cp sk.letons 

0 0 0 0 0 
slldeshow software sunroof tetra trofsum 

0 
wrlte.prep 

File Manager Icons The files in your file system are represented by three kinds of glyphs, which are 
similar to icons on the workspace. Directories are displayed as folders. Data fues 
such as documents, graphic files, and spreadsheet files are displayed as dog-eared 
sheets of paper. Executable files (applications) display either the application icon 
or a small window. Figure 2-4 shows the three generic file type icons. 

Figure 2-4 The three generic types 0/ file icons 

o D E1 
Folder Data file Application 
The File Manager logically connects or binds each data file to a specific application 
so that when you open the data file, the application is automatically started for you. 
The bindings are stored and displayed as part of the Binder application. You can 

Revision A of 11 JWle 1990 



Chapter 2 - File Manager 7 

change the default bindings and add new ones using the Binder. See Chapter 12 
for more information about the Binder. 

As part of the binding, a small picture representing the type of application can be 
displayed inside the data file icon so that you can tell at a glance which data files 
represent different application data files. When a data file is not bound to a specific 
application, the generic icon is displayed. In the example shown in Figure 2-5, the 
first data file is generic. TIle other files are botmd to three different application 
types. 

Figure 2-5 Data file icons that also show the application type 

Selecting and Operating on 
File Manager Icons 

(i) File MaNter. IMMe/ .... s.r 

(File V)(Vlew V)(EcIlt V) (Props V)(Home v){eoto: V). 
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0 ~ ~ 
tblrthdays.cal buslnesscard .ps openlook2.ps 

~ i! it 
yearprlnt1.ps A-Wletter .doc artresume.doc 

iii fill] il 
flyer.doc ftlwelCampletrs purp!ecow.rs .1, 

------ - -
You can create your own images for data files using the Icon Editor application, 
and bind them to the File Manager data file icons using the Binder. See Chapters 
11 and 12 for more infonnation. 

This section provides a brief introduction to how to select and operate on Flle 
Manager icons. You can perfOml the following kinds of operations on selected 
icons: 

(] Open files, folders, and applications 

c:J Create new files and folders 

(] Move or copy files, folders, and applications 

(] Delete and undelete rdes and folders 

(] Link files so you can access them from more than one folder 

(] Transfer files to other systems 

(] Change file properties, such as the file name, pemissions, and ownership 

Detailed examples are provided later in this chapter. 

You select a Flle Manager folder in the path pane by moving the pointer onto it and 
clicking SELEcr. You can select single icons or groups of icons in the folder pane 
by cliCking SELEcr on the first icon and clicking ADJUST on each additional 
icon that you want to include in the group (or exclude by clicking ADJUST on an 
icon that is already selected). Selected icons are highlighted. 

Revision A of 11 June 1990 



8 Revision A of 11 June 1990 

Double-Click Accelerators 

The Control Area 

The File Menu 

You operate on selected File "Manager icons in any of the following ways: 

CJ Dragging and dropping Flle Manager icons on other icons within the File 
Manager, on other windows or icons on the workspace, or on the worlcspace 
itself 

CJ COOosing commands from the File Manager menus 

CJ Using accelerator keys on the keyboard 

You can dQuble-click SELECT on any individual icon to open it Double-clicking 
SELECT on any folder in the path pane or the folder pane opens it and displays its 
contents in the folder pane. Double-clicking SELECT on a data rue starts the 
application for that data file and usually displays its data. Double-clicking 
SELECT on an application icon starts the application. 

The control area has six menu buttons: File, View, Edit, Props, Home, Go1O, and 
a text field. This section shows each of these controls and provides a brief 
introduction to each of the items. 

File has a menu, shown in Figure 2-6, with choices that you can use to perfonn 
filing functions. 

Figure 2-6 The File menu 

CJ Use Open to open selected folders and files. Open is inactive unless you have 
made a selection in the folder pane. 

o Use Print FIle to print selected files. Print File is inactive unless you have made 
a selection in the folder pane. 

o Use Create Folder to create a new folder. 

o Use Create Document to create a new document 

o Use Remote Copy to open a pop-up window to allow you to perform remote 
transfers. See "Copying Files to Other Systems" later in this chapter for more 
information. 

o Use Your Commands to create your own customized commands. See 
"Customizing Your File Manager" later in this chapter for more information. 
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View has a menu, shown in Figure 2-7, with choices for different ways to view the 
file system. 

Figure 2-7 The View menu 

E:89in TI'81£- I-ti-r .. 
Add Tr€-s"! P«r9llt 
folder Display C> 
Sort By C> 

a Use TreelPath to choose the way your file system is displayed in the Path pane. 

a When you view your file system as a tree; you use Hide Subfolders, Show All 
Subfolders, Begin Tree Here, and Add Tree's Parent to customize the way the 
file system tree is displayed in the path pane. See "Customizing Your Flle 
Manager" later in this chapter for more infonnation about these choices. 

a Use Folder Display to choose how the contents of the folder pane are 
displayed: 

• As icons, to help you identify each file by type. 

• As a listing, to display more files in the pane and to show you more 
infonnation about each individual file when you choose listing options 
from the File Manager Tool Properties window. See "Flle Manager Tool 
Properties" later in this chapter for more infonnation. 

a Use Sort By to choose how the contents of the folder pane are sorted: 

• Alphabetically by name. 

• In reverse chronological order by date. 

• In order of file size, largest to smallest. 

• In alphabetical groups by file type, with folders first, followed by data 
files, then by applications. 
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The Edit Menu 

The Props Menu 

Edit has a menu, shown in Figure 2-8, with options that you use to perfonn editing 
functions. 

Figure 2-8 The Edit menu 

[] Use Select All to select all the files in the folder pane. 

[] Use Link to create links between files. Link is inactive unless you have made 
a selection in the Folder pane. See "Linking Files" later in this chapter for 
more information. 

[] Use Copy to put a copy of selected file names on the clipboard. Copy is 
inactive unless you have made a selection in the Folder pane. 

[] Use Paste to paste the contents of the clipboard at the pointer location in the 
FJle Manager. 

D Use Cut to remove selected file names from a folder and place them on the 
clipboard, in the Wastebasket, or really delete them, depending on which 
option you choose from the Cut submenu. Cut is inactive unless you have 
made a selection in the Folder pane. 

D Use Show Oipboard to display the current contents of the clipboard used by 
the Cut/Copy/Paste commands. 

Props has a menu, shown in Figure 2-9, with a File Properties item that you can use 
to change file properties and a Tool Properties item that you can use to customize 
the File Manager. See "File and Folder Properties" and "Customizing Your File 
Manager" later in this chapter for more infonnation. 

Figure 2-9 The Props menu 
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Home has a menu, shown in Figure 2-10, with choices that you can use to quickly 
go back to your home directory or to other directories that you have accessed 
recent! y. See "Shortcuts" later in this chapter for more infonnation. 

Figure 2-10 The Home menu 

The Goto Menu and Text Field Ooto has a menu and a text field shown in Figure 2-11. Oloosing Fmd from the 
Ooto menu displays a pop-up window that you can use to find files. See "Finding 
Files and Folders" later in this chapter for more infonnation. 

Figure 2-11 The Goto menu and textfield 

The Path Pane 

Parts of the Path and Tree 

The path pane shows your file system. You can display it either as a path of 
connected folders or as a hierarchical tree that shows all or part of your file system 
structure. 

The first time you start the File Manager, the file system will be displayed as a path. 
When you start the Flle Manager any time after that, the fue system will be 
displayed in the same way it was displayed when you last quit the File Manager. 

The path shows only the folders for the directory and subdirectories that lead to the 
current folder, which is the folder that is open. Any folders below it in the tree are 
sub/olders. An example of a path is Figure 2-12, which shows the path for 
thome/winsor. 

TIle hierarchical "family tree" structure is another way of showing the UNIX file 
system, using an analogy between the parts of a tree and the parts of the file system. 
The tree can show all parts of the file system. Alternatively, it can start at any 
directory or folder in the file system. 

Root is the top directory in the file system. Under the root are various branches.-­
For example, Figure 2-13 shows root and the branches that start with the directories 
bin, home, lib, and usrl. 

Along with the tree analogy, there is a parent/child analogy. The root directoIy is 
the parent directory. A subdirectory is also a parent directory when there are one 
or more subdirectories below it Each subdirectory is a child of the parent directory 
that is above it 
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Which Path is Displayed When you start the FIle Manager, it displays the path from which you started it If 
you choose File Manager from the Programs submenu, it displays the path for your 
home directory. The last folder in the chain is open, and its contents are displayed 
in the folder pane, as shown in Figure 2-12. 

Figure 2-12 An example of a home directory path in the path pane/or a user named "winsor" 

12l 
(File v) (View v) (Edit v) 

D 

Use the items on the View menu to change the display of your file system in the 
path pane. Choosing Tree from the View menu changes the display to show the 
file system hierarchy, as shown in the example in Figure 2-13. 

Figure 2-13 An example of a tree structure in the path pane 
File Manager: /home/wlnsor 

(File V) (View V) (Edit V) 

When you display a tree, the contents of the open folder are displayed in the folder 
pane (the contents of folder "winsor" in the example shown in Figure 2-13). As 
you move around from folder to folder by double-clicking SELEer to open each 
one, the tree display expands to show subfolders and rearranges the other branches 
of the tree. 

You can expand or reduce the number of folders in the tree display using the Hide 
Subfolders, Show All Subfolders, Begin Tree Here, and Add Tree's Parent items 
from the View menu. Once you have chosen one of these items from the menu, the 
FIle Manager remembers it When you change the display back to a path and then 
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The Folder Pane 
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choose Tree again, the tree is displayed using the last fonnat that you chose for the 
tree display. See "Customizing Your File Manager" for examples of these other 
kinds of path displays. 

The path pane has a Path Commands pop-up menu that contains some of the 
commands from the control area. Choosing a command from the pop-up menu 
perfonns the same operation as choosing a command from the control area. See 
"Shortcuts" for more infonnation about the Path Commands pop-up menu. 

The folder pane displays the contents of the open folder in the path pane, regardless 
of how you choose to display the path. When you first start the File Manager, the 
folder pane displays icons with names beneath them, as shown in Figure 2-14. 

Figure 2-14 Icons in the/older pane 
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Folder Commands Pop-up Menu The folder pane has a Folder Commands pop-up menu that contains some of the 
commands from the control area. Choosing a command from the pop-up menu 
perfonns the same operation as choosing a command from the control area. See 
"Shortcuts" for more infonnation about the Folder Commands pop-up menu. 

Alternative Display Options You can change the way icons are displayed in the folder pane by choosing 
different options from the View Folder Display submenu shown in Figure 2-15. 
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Figure 2-15 The Folder Display submenu 

Icon Folder Display. Choosing the Icon option displays a list of standard-size 
icons with the name of the icon centered below it When application images are 
specified by the Binder, those images are displayed. 

List Folder Display. If you have a large number of files in a folder, displaying a 
list shows more file names in the same area, minimizing scrolling to view the entire 
folder. Choosing List shows a list of mini-icons and file names, as shown in 
Figure 2-16. 

Figure 2-16 An example of a list display 

Sorting the Contents of the Folder 
Pane 

~ file M ....... : I.sr/F ...... 

(Fie V )("'ew V HEcit V) (Props V ) (Home V HCoto: V 1. 

~ 
O£lCamples OTOC Cl dlp2fIleI\'l9'.1c1c r: 
D flIemgr.doeJck Cl fhmgr.lmages Cl flIemgr.text.mlf 

t-

O fmfolderpane1.rsJoclc o f'emgr.doc Cl flIemtr.cIoc.backup 
. 

D filemgr.telCt o fhmgr.t8ICt.b.dcup o filemgr.copyfle.rs 
o flIe""r.copyfller15ultrs CI fhmgr .cop~rs Cl flIemtr .copytlaste""g.n 
o filemgr.cr .. tefoldermenurs CI flemgr.a .. tefoldarresuttrs Clflemtr.displayYiew.rs 
D filemgr .dlsplayYlewresult.rs [) fhmgr .docwnentrs [) fIIIm9r .tclitmenucutmenu.rs 
D flIemgr.entet'cmdmanu.rs o fhmgr .... cut.bI..,s CI flIemtr .fhopanfllers -.- -"' -...r 

Mini-icons do not display the application images for data files. You can select and 
operate on mini-icons in the same way as for standard-sized icons. 

When using the List option, you can choose to display additional information about 
each file such as the Pennissions, Links, Owner, Group, Size, and Date. You 
choose the infonnation to display by changing the default settings from the File 
Manager Tool Properties window. See "Customizing Your Flle Manager" later in 
this chapter for more infol1llation about setting tool properties. 

You can arrange the fues in the folder pane in order by name, date, or size, or you 
. can group them alphabetically by type by choosing the appropriate option from the 
View Sort By submenu shown in Figure 2-17. 
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Opening Files 

Figure 2-17 The Sort By submenu 

Hid.;. Subf(·ld.;.r£ 
5h('1:-:" 1\11 5\,bf(oldoi-r:; 
E:siin Tree!' He!'r(­
A4.~ Tre!'so£ JI<!o,os.tt 

Folder Display 
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You can easily change the display in the folder pane by opening a different folder 
either in the path pane or in the folder pane. 

To open a folder, move the pointer onto any folder icon and double-click SELECf. 
The folder opens and its contents are displayed in the folder pane. 

Alternatively, you can open a folder following the steps below: 

1. Move the pointer onto a folder and click SELECT to select it. 

2. Move the pointer onto the File menu button and press MENU. 

3. Drag the pointer to highlight Open. 

4. Release MENU. 

The Open command is also provided on the Path Pane and Folder Pane pop-up 
menus. See "Shortcuts" for more infonnation about pop-up menus. 

When you select and open a data file, the appropriate application is started and the 
data of the opened file is displayed in the application's window. When you select 
and open an application or executable file, the application is started. Executable 
files that are not bound to a specific application display a Notice asking you if you 
want to start the application in a Shell Tool. 

From the folder pane, you can select and operate on folders, data files, and 
applications in the following ways: 

o Dragging and dropping selected folders, data ftIes, and applications onto the 
workspace. 

o Double-clicking SELECf on a data file or application icon. 

o Selecting single or multiple data files and applications and choosing Open 
from the File menu or the Folder Pane pop-up menu. 
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NOTE 

Creating New FUes and 
Folders 

The Open item on these menus has a submenu with the items Flle, 
With 'Ooto' Arguments, and In Document Editor. Use this submenu in the 
following ways: 

• Use the Flle item to open a file by starting up the appropriate application, 
as described above. This is the default 

• Use the With 'Ooto' Arguments item to start up the application with 
command line arguments specified in the Ooto text field on the Flle 
Manager header. 

• Use the In Document Editor item to open the file in the Text Editor, 
regardless of the application that is bound to the file type. 

When you open a datafile or an appUcationjrom the File Manager, you cannot 
close or quit it by dragging it back onto the File Manager. You quit any window 
or icon on the workspace by choosing the Quit item from the Window menu .. 

You can create new folders and files in the folder pane, which puts them into the 
open folder in the path pane. 

To create a new file or folder, follow the steps below: 

1. Check to be sure you are in the folder where you want to create the new 
file or folder. If necessary, change to a different folder in the path pane. 

2. Move the pointer onto the File button and press MENU. 

3. Drag the pointer to highlight either Create Folder or Create Document. 

Figure 2-18 shows the File menu with Create Folder highlighted. 

Figure 2-18 File menu with Create Folder highlighted 

4. Release MENU. 

An empty file called either NewDocument or NewFolder is created in the 
folder pane. Subsequent new documents or folders are numbered in sequence. 
For example, if a file called NewDocument already exists when you create a 
document, the new file will be called NewDocument2. 1be name of the new 
document or folder is underlined when it is first displayed, which means it is 
ready to be renamed. Figure 2-19 shows a new folder in the folder pane. 
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Figure 2-19 A new/older in the/older pane 

Naming a Document or Folder 

2.3 Copying and Moving 
Files 

Drag and Drop 
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When the name of a file or folder is underlined, the name is an editable text field. 
You can change the name of any folder or file by double-clicking SELECT on its 
name to select it and display an editable text field. You can edit the contents of this 
text field in the same way you edit any other text field. When you have changed 
the ftIe name, press Return or click SELECf on the background of the folder pane. 
You can change properties of the file, including its name, using the File Properties 
window. See "File and Folder Propertiesu later in this chapter for more 
infonnation 

You can copy and move icons that are displayed in the folder pane in two ways: 

t:J Using drag and drop 

t:J Using the clipboard 

Using drag and drop, you can copy and move files to the following destinations: 

t:J Into folders in the folder or path pane of the Flie Manager 

t:J Onto the background of the folder pane of the FtIe Manager 

t:J Onto the Wastebasket icon or window 

t:J Onto the Text Editor icon or window 

o Onto the Mail Tool Compose icon or window 

o Onto Print Tool orTape Tool icons or windows 

o Onto the Icon Editor icon or window 

o Onto the workspace 

To copy or move files using drag and drop, fonow these steps: 

1. Select the file or files you want to copy or move. 

2. Move the pointer onto one of the selected tiles. To copy, press the Control 
key and SELECT. To move, press SELECT. 
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The Clipboard 

NOTE 

3. Drag the rde or group of files so tbe hot spot of the pointer (the tip of the 
arrow) is on the destination object. 

4. Release SELECT. 

You can copy or move files within the File Manager using the clipboard and the 
cut/copy/paste commands. Cut/copy!paste commands are provided on the Edit 
menu, the Folder Commands pop-up menu, and as function keys on the keyboard. 
When you cut material, it is not deleted. It is put on a clipboard, where it is stored 
temporarily. Only one item or group of items is stored on the clipboard at a time, 
so if you do another cut without using what is on the clipboard, the previous 
information is lost. 

To copy or move files within the Flle Manager using the clipboard, follow the steps 
below: 

1. Select the file or files you want to copy or move. 

2. To copy the selected files, choose Copy from the Edit menu or press the 
Copy key on the keyboard to put the reference file name(s) on the 
clipboard. 

3. To move the selected files, choose Cut from the Edit menu or press the Cut 
key on the keyboard to put the reference file name(s) on the clipboard. 

4. Change to the folder where you want to copy or move the files. 

S. Choose Paste from the Edit menu or press the Paste key.on the keyboard 
to put the reference file name(s) from the clipboard into the folder. 

The File Manager puts a reference file name on the clipboard, not ,he entire 
contents ofthe/ile. When you paste the reference/ile name into the File Manager, 
the entirefile is inserted. When you choose paste elsewhere on the workspace, only 
the name of the file is inserted from the clipboard. 

If you are not sure what is on the clipboard, you can view the contentS at any time 
by using the Show Oipboard item on either the Edit or the Folder Commands pop­
up menu. TIle submenu displays the first 30 characters of the contents of the 
clipboard, as shown in the example in Figure 2-20. 

Figure 2-20 An example of the submenu for Contents of the Clipboard 
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Cut 
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Moving Files and Folders 
Using Drag and Drop 

Moving Files and Folders Within 
File Manager 
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Thefollowing sections show some specific examples of moving files. You perform 
copying operations in the same way except that you use the Control key together 
with SELECT for drag and drop, and use Copy instead of CUI for clipboard oper­
ations. 

This section shows examples of moving files and folders into another folder, onto 
an icon, and onto the workspace. 

To move a file or folder into another folder within the File Manager when both the 
source and destination icons are visible. follow these steps: 

1. Click SELECT on a rale or folder icon that you want to move. 

The icon is selected. If you want to move a group of files or folders, click 
ADJUST on individual icons to add them to the group. If the icon is already 
selected, clicking ADJUST deselects it, removing it from the group. 

2. With the pointer on the icon, Press SELECT and drag the pointer onto the 
destination folder. 

The Move pointer is displayed. The tip of the mow is the hot spot that defines 
the destination of the move operation. When the folder accepts input. it 
highlights and opens,_ as shown in the example in Figure 2-21. If the folder 
cannot accept the file, it displays a lock. 

Figure 2-21 Moving afile to folder 

Moving a File onto an Application 
Outside of the File Manager 

o D • sayhey Toe u..--__ 

3. Release SELECT. 

The file or folder is moved to the new folder. 

You can move a file onto another application outside of the File Manager . 
regardless of whether the application is displayed as an icon or as an open window. 
When you drop a file onto an icon, the file is loaded into the application, but is not 
displayed until you open the icon. If you drop a file with an inappropriate fonnat 
on an icon, the move is not perfonned. When you drop a file onto the window of 
an application, the file·is loaded into the application. 
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As a guideline, the following list describes the data fonnats that can be accepted 
for DeskSet applications: 

(] The Wastebasket accepts any data type. 

(] The Text Editor accepts ASCll file fonnats. 

(] Mail Tool Compose accepts ASCn file fonnats, and can encode any other file 
fonnats (such as raster or PostScriptTM) so that you can send them as part of an 
electronic mail message. When you drop any file onto the Mail Tool Compose 
window, a Notice is displayed asking you how you want the fue to be handled. 
When you choose to encode a file, an "(E)" is automatically inserted at the 
beginning of the Subject field to show both the sender and the recipient that the 
message contains encoded files.· 

(] Print Tool (duplicate copy only) accepts any fue fonnat that has an appropriate 
print script bound to it You can specify a file fonnat, a script, or a filter from 
the Print Tool window. See Chapter 6 for more infonnation about the Print 
Tool. 

(] Tape Tool (duplicate copy only) accepts any file fonnat 

(] Icon Editor accepts any file in icon fonnat. 

Follow these steps to move a fue onto an icon: 

1. Click SELECT on the data file icon in the File Manager that you want to 
move. 

2. Drag the file onto the icon on the workspace, as shown in Figure 2·22. 

3. Release SELECT. The file is loaded into the application. 

Figure 2-22 Moving afile onto an icon on the workspace 
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If the application cannot accept the file format, the fue is not moved. When you 
drop an icon of an incompatible file type onto an open window, an error message 
is displayed in the footer of the destination window. In the exam.ple shown in 
Figure 2-23, a file that is not an icon was dropped onto the Icon Editor. 

Figure 2-23 An error message that an inappropriate file has been dropped on an icon 

L~ ______ ko_n_E_d_ltor __ ~ 

Incorrect file format: opening brace missing. 
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Moving a Folder onto the 
Workspace 
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You can move individual data file icons from the File Manager onto the workspace. 
When you drop the icon onto the woIkspace, it starts the appropriate application, 
displays it as an icon, and loads the file. 

You can move individual folders from the Flle Manager onto the WoIkspace. 
When you drop the folder onto the woIkspace, it is opened, and the contents of the 
folder are displayed in a pop-up window. If you switch frequently between 
directories, you can use this feature to display the contents of more than one folder 
at a time. 

To move a folder onto the workspace, follow these steps: 

1. Click SELECT on a folder to select it. 

2. Press SELECT and drag the folder onto the workspace background, as 
shown in Figure 2-24. 

Figure 2-24 Dragging a/older onto the workspace 

.. 

3. Release SELECT. The window is opened, and the contents displayed, as 
shown in the example in Figure 2-25 • 
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Figure 2-25 A/older pop-up window 
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The folder pop-up window has a Folder Commands pop-up menu, shown in 
Figure 2-26, that you can use to operate on the contents of this folder. 

Figure 2-26 The Folder Commands pop-up menu 

~ 

o 
Examples 

D 
fUemgr .doc.kk 

Folder Commands 

(Open 1» 
Print FOe 
Select AI . 
Link 
Copy 

Paste 
Cut I> 
Show Clipboard I> 
File Properties ... 

Up 

D 
TOC 

D 
fiJemgr.images 
~ 

The items on the Folder Commands menu are a subset of the commands you can 
access from the File Manager control area, and worle in the same way as those 
commands. 
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To move folders and data files using the clipboard, follow the steps below: 

1. Click SELECT on the file or folder to be moved to select it. 

2. Move the pointer to the Edit button and press MENU. 

3. Highlight Cut and drag the pointer to the right to display the Cut 
submenu. 

4. Highlight Move to Clipboard, as shown in Figure 2-27. 

NOTE If you choose Cut to Wastebasket thefiles are moved to the Wastebasket window. 
If you choose Really Delete thefiles arepernuuaently removedfromyour system. 

Figure 2-27 Starting a Move with Cutfrom the File Menu 

,,""na'.·.'· '---..... -111( Really Delete 

o D 
sayhey blnderlcon.rs.lock 

D • 
tIHCtsw.info 

5. Release MENU. 

An instruction message is displayed in the footer, as shown in Figure 2-28. 

Figure 2-28 Information message when/iles are on the clipboard 

Moye these file(s) by opening the target folder and selecting 'Paste' 

6. Open the folder you want to receive the files. 

7. Choose Paste from the Edit menu, the Folder Commands pop-up menu, 
or press the Paste key on the keyboard. 

While the operation is in progress, an infonnation message is displayed in the­
footer. Figure 2-29 shows an example of this message. 

Figure 2-29 In/ormation message while paste is in progress 
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Moving and Copying 
Multiple Files 

You can move or copy more than one file at a time to a common location using 
either drag and drop or the clipboant. To move or copy files using drag and drop, 
follow these steps: 

1. Click SELECT to highlight the first file and then click ADJUST on each 
additional file that you want to include in the group. (Click ADJUST on 
a highlighted (de to deselect it, removing it from the group). 

Figure 2-30 shows an example of a group of selected files. 

Figure 2-30 Files highlighted/or moving 

ld il II • • [dJ 
ArtlsL Mode Is BlgRlpper Classk ClownAlley Deslgnllvlng Easter_2 

~ II [d [d ~ [d 
FlveHeadFourth Manusalpt M erryX mas PrlntFlre ThanksClvlng Valentine 

2. To move, press SELECT on one of the highlighted files. To copy, press the 
Control key and then press SELECT on a highlighted file. Drag the (de 
on top of the receiving folder, as shown in the example in Fi.gure 2-31. 

Figure 2-31 Move o/multiple/iles in progress 

[d [d) • • • ArtisLModels BIgRlpper Classk CIOWnAII.y D.s Ignllv 1 rig 

il • il il il 
Ma.nusalpt M.rryXmas PrlntFlrt ThanksClvlng 

The hot spot of the pointer specifies the destination folder for moving all of the 
selected files. All of the highlighted files move together. 
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3. Release SELECT and aU the files will be placed in the folder. 

You can also move or copy multiple rues by using cut/copy/paste commands in the 
same way you use them to move or copy one file. To do this, follow these steps: 

1. Select the files to move or copy by clicking SELECT to highlight the first 
file and then clicking ADJUST on each additional rde you want to include. 

2. Choose Cut or Copy from the Edit menu as described in "Moving Files 
and Folders Using Cut and Paste", or use the Cut or Copy keys on the 
keyboard. 

3. Open the folder where you want to put the files. 

4. Choose Paste from the Edit menu, or move the pointer into the folder pane 
and press the Paste key on the keyboard. 

The selected files are copied or moved into the new folder. 

As mentioned previously, you can encode ftIes by dragging and dropping them 
onto the Mail Tool Compose window. When you receive a mail message that 
contains encoded files, as shown by the "(By' at the begirming of the subject line, 
you can decode them by dragging and dropping them onto the File Manager, as 
described in the following steps: 

1. Open both the File Manager and Mail Tool windows. 

2. Open the folder in the File Manager where you want to put the encoded 
mail message(s). 

3. In the Mail Tool application, click SELECT on the header" of the mail 
message that contains the encoded files. 

4. Press SELECT to move or press the Control key and SELECT to copy, 
and drag the pointer. 

A small envelope is displayed, as shown in Figure 2-32. You can release the 
Control key any time after the envelope is displayed. 
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Figure 2-32 Dragging a mail message with encodedfiles 
rim fie ....... r: ' ...... 'wills.r/Ex ... "es 

(Fit V )(Ylew V)(Ecit V) (Props V)(Homt V)(COto: V 1. 

~ - .r-<:::= 

s. Drag the pointer onto the folder pane of the File Manager and release 
SELECT. 

The mail message is decoded, and icons representing the encoded files are 
displayed and selected in the folder pane of the File Manager. In the example 
shown in Figure 2-33, two encoded files were included in the mail message, 
artresume. doc and birdsofafeather. rs. 

Figure 2-33 Decodedfiles dropped onto the File Manager 
rID File Mana.er: thome/winsor/Examples 

@ill (View V) (Edit V) (props V)(Home v)(coto: V). 

I~ I 
II II D D D : --

artresume.doc blrdsofa fea ther .rs bugs bugtraq dlsses 
.. 

D D D D D 
colorpalnt company _announ company_email company _fi1anclal company_fiscal 

'-- - -. 
~ - "-

H you drop another message containing the same files, the files are oot decoded 
because this would overwrite the existing files. Instead, the files are displayed with 
a compress icon and a • Z suffix is added to the file name. 1be compress icon 
shows two anows compressing the data in a file. 

In the example shown in Figure 2-34, three encoded files were iDcluded in a 
dropped mail message. The file bird. r s is decoded, displayed as an icon, and 
selected. TIle other two files artresume. doc and birdsofafeather . rs 
were already present in the Examples folder and did not overwrite the existing 
files. They therefore appear in the Flie Manager as encoded files. 
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Figure 2-34 Encodedfiles in the File Manager 
12) Fie Ma" •• er: IhelM/wlnse,/E •• Mples 

, 
(File V)(Vlew V)~ (props V) (Home V) (COto: V). 

~ 

~ I:} • [d] 
~ .. 
f0-
r-

artr.sume.doc .rtresume.doc.2 blrd.rs blrdsofaf.atherzs • 

= D D D 
blr dso fa fea ther .rs.2 bugs bugtraq classes 

.,,--..- - --.. 
""'" -- --" -

Opening Encoded Files To use an encoded • Z file that has the same prefix as an existing file, you must first 
rename one of the files. If you rename the encoded file, make sure to keep the • Z 
suffix. The first time you open the • Z file, File Manager uncompresses it Then 
when you open the uncompressed file, File Manager starts up the appropriate 
application to display and edit the file. 

2.4 Printing Files 

If you try to open a • Z file that still has the same prefix as another file (for example, 
artresume. doc. Z in Figure 2-34), you get the following error message in the 
Console window: 
<filename> already exists; not overwritten. 

You can print flIes from the Ftle Manager in two ways: 

(') Select files in the folder pane and drag and drop them onto the Print Tool 
application. Ftles are printed using the default print instructions bound to the 
icon. See Chapter 6 for more information about using the Print Tool and 
Chapter 12 for infonnation about print bindings. 

(') Select files in the folder pane and choose Print File from the File menu, as 
shown in Figure 2-35. The Print item is inactive unless files are selected. Files 
are printed using the default print script that you specify from the File Manager 
Tool Properties window. See "Customizing Your File Manager" later in this 
chapter for infonnation about tool properties. 

Figure 2-35 Highlighting Print File in the File menu 

(Open ~) 

Pnnt file 

Create Folder 
Create Document 
R.mote Transfer ... 
Your Commands Do 

When you print files from the File Manager, an information message is displayed 
in the footer. as shown in the example in Figure 2-36. 

Figure 2-36 Example of message after file sent to Printer 
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2.5 Finding Files and 
Folders 

Using the Goto Text Field 
and Button 

The File Manager provides two ways to locate folders and files in your file system: 

[] TIle Goto text field and button 

[] The Fmd pop-up window 

This section describes how to use these methods to find folders and files. 

When you know the path of the folder you want to open or the path and file name 
of a specific data file that you want to select, you can type the path or the path and 
filename in the Ooto text field, and either press Return or click SELECf on the 
Ooto button. 

When you type a path, the folder you specify is opened and its contents are 
displayed in the folder pane. When you type a path and file name, the folder you 
specify is opened, its contents are displayed in the folder pane, and the file name is 
located, scrolled into view, and selected, as shown in the example in Figure 2-37. 

Figure 2-37 Using the Goto teX/field to/ind afile 
(2J fUe Mana.er: lusr Ifile",sr 

~(View V)(Edit v) (Props V)(Home v)(coto: v)/usr/FHemgr/fm.tmp. 

I~ 
filemgr .yrcmdmenuadd.rs filemgr .yrcmdm.nunadd.rs filemgr .yrcmds.lrs • ~ ~. 

fmcod.drag.rs:.--__ -..J 

When you use the Goto text field to locate a file or directory, the infonnation in the 
text field is displayed on the Ooto menu. If you change your location in the file 
system, you can quicldy return to that folder or file by clicking SELECfon the 
Ooto button. When the text field is empty, clicking on the 0010 button does not 
change your location in the file system. Figure 2-38 shows an example of an item 
on the Ooto menu. 

Figure 2-38 Goto menu with the most recently used destination 

f'!emgr .yrcmclmenuadd.rs 

[liB) 
fm.tmp fmcod.dragrs 

You can use wildcard characters to select groups of related files in the currently­
displayed folder pane by typing a pattern-matching sequence. For example, the 
symbol • can be used to match any string, so typing *. r s in the Oototext field 
and either pressing Return or clicking SELECf on the 0010 button will select all 
files ending in .rs. Figure 2-39 shows an example of a folder pane with all *. r s 
files selected. 
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Figure 2-39 Using pattern matching with Goto to select related files 

Using the Find Pop-up 
Window 

(i) File Man.ler: /usr /Fllernlr 
-.., 

(File V) (View V) [Edit V) (PrOPS V) (HOlM v)(coto: V) ·.rs. 

~ -- ~ ........ 

~ Examples TOC chp2fll.mgr .backup 

D • • chp2fllemgr Jck fll.mgr .eopyflle.rs fM.mgr.copyflieresult.rs • • I} 
fllemgr.eopymsg.rs fl''"9r'.copypastemsg.rs flI.mgt' .crea tefoldermenu.rs • • • filemgr .crea tefolderresult.rs fUemgr .dIspia yvllw.rs fI!emgr .dfsp/ayvlewnsultrs 

i) i) D 
fH.mgr.doc fllemgr .doc.b. ckup fDemgr.doc.lek • • • fl!emgr .docum.nt.rs fllerngr .. dltrnenucutmenu.rs flllmgr .. ntercmdmenu.rs • • Il 

fllemgr .ex.cuta ble.rs fl!emgr .fHeopenfHers fllemgr. fllepropmenu.rs - .. - .J 

When you do not know or C;::.'/;\ot remember the specific location of a folder or file, 
or when you want to locate a group of files according to specific criteria, use the 
Find pop-up window. To display the Find window, follow these steps: 

1. Move the pointer to the Goto button and press MENU. 

2. Highlight Find, as shown in Figure 2-40. 

Figure 2-40 Goto menu with Find highlighted 

3. Release MENU. The Find pop-up window is displayed, as shown in 
Figure 2-41. 
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Figure 2-41 Find window 

~inding Files 

.~ File Mau .. r: Fintl 
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Flle.a ... : Ilnduded I Excluded I 
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':: 
~ 
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The Find window contains controls that allow you to perfonn the following kinds 
of searches: 

o Search by specific fue name. 

o Search for file names by pattern matching, using wildcard characters. 

o Include or exclude. a specific file name or pattern from the search. 

o Include or exclude a specific owner from the search. 

o Fmd files that were modified either before or after a date that you specify. 

o Search by specific fue type. 

o Search for files containing a specific text string (a word or phrase) that is either 
case sensitive or case insensitive. TIlis feature uses the UNIX grep command. 

To find a specific file or group of fues, you can fill in some or all of the text fields, 
according to the type of search you want to perform. 

o Use the Fmd files in and below folder text field to specify where in your file 
system you want to start the search. The search begins in the folder you specify 
in this text field, and includes all subfoldeD in that path. 

o Use the Filename text field to specify the file name or pattern you want to 
match. Use Included or Excluded to either include or exclude the pattern from 
the search. 

o Use the Owner text field when you want to search for files by owner, or 
exclude a particular owner from the search. 

o Use the Modified After and/or Modified Before text fields to specify a time 
frame for the search. You must specify, as a minimum, the month and day for 
each of these text fields. 
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o Use the File Type settings to specify whether you want to search all file types, 
only folders, only data files, or only executable files. 

o Use the Search Flies Containing String field when you want to find files with 
specific contents. For example, to find all files in which the DeskSet product 
is specifically named, you would type DeskSet in the text field. If you click 
SELEer to tum on the Ignore Case setting, all files with the word "DeskSet"' 
will be listed in the scrolling list, regardless of how the word is capitalized. 

When you have filled in the text fields, click SELEer on the Find button to start 
the search. Once you start a search, the Stop button is activated. You can stop the 
search at any time by clicking SELEcr on the Stop button. 

When the search is completed, all files that match the pattern are displayed in the 
scrolling list at the bottom of the Fmd window. Figure 2-42 shows' an example of 
a file content pattern matching search. File Manager found 10 flIes containing the 
specified string. 

Figure 2-42 An example of a find 

.-c:o file Maaa,er: find 
, 

find flies In and below folder: /home/winsor /Deskset 

fUename: I Included I Excluded I 
Owner: I Included I Excluded I 

Modified After: (nun/dd/VV) 

Modified lefore: (Mm/dd/vv) 

File Tvpe: ELL]t:llD IEIl 
Search files Contain In, Str .... : DeskSe\, Il9nore Case. I 

@) (St<·fl ) (')Il':-" ) 

D /home/winsor /Oeskset/ch8.doc.backup 
D thome/winsor /Oeskset/ch9.doc 
D Ihome/wlnsor IDesksetldesksetdocplan.doc 
D lhome/wlnsor IDeskset/desksetdocplan.docbackup 

~ 
10 fll.(s) found 

.J 

You can select and open one file at a time from the Fmd window scrolling list. To 
select a file, move the pointer onto the line and click SELEer. The line is 
highlighted, and the Open button is activated, as shown in the example in 
Figure 2-43. To open the highlighted file, click SELECf on the Open button. 
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2.6 Using the 
Wastebasket 

Figure 2-43 Opening afile/rom the Find window 
rQ FII. Ma_.-: F.d 

F ..... ,lies , .. a.ul belew fel4er: !home/winsor 

File ... ",.: -.rs. I Included I EKcluded I 
Ow ... r: I Included I EKcluded I 

Mdtfle" After: (Mln/.wlvv) 

Modified lef.r.: (illmbld/vv) 

File Tvpe: ELLICJI D IEII 
Search Flies C ... talAln. StrIA,: I Ignore Case I 

(Find )(St<.r- HOpen ) 

.. 
: Cl/home/wlnsor IDeskset/blnderwindow.rs ~ 
D /home/wlnsor /Oeskset/cakalphakeypad.rs I" 

D Ihome/wlnsor /Deskset/cakanglesettlng.rs 
D /home/wlnsor 100skset/cakblnaryfuns.rs 
D /home/wlnsor /Oeskset/ calckon.rs 
"r'I .L ". .., 
163 flle(s) found 

The Wastebasket is a temporary storage area for files that you want to discard and 
that you probably will delete from your file system. When you start the File 
Manger, the Wastebasket is automatically opened and displayed as an icon, as 
shown in Figure 2-44. The default position for the Wastebasket icon is the lower 
right comer of the worlcspace. You can move this icon anywhere you want on the 
worlcspace, or quit it if you do not intend to use it 

Figure 2-44 The empty Wastebasket icon 

You can move folders and files to the Wastebasket by selecting them and dragging 
and dropping them onto the Wastebasket icon or window, or by cutting them to the 
Wastebasket from the Edit menu. 

Files that you put in the Wastebasket are stored in a • wastebasket folder in 
your home directory. After you have put a file in the Wastebasket, the Wastebasket 
icon's appearance is changed to remind you that at least one file is there. 
Figure 245 shows the Wastebasket icon when there are files in ~e Wastebasket. 
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Figure 2-45 The Wastebasket icon when it contains files 

The Wastebasket can hold up to 100 files before you must empty it If the 
Wastebasket becomes full, a message warns you that you must empty it before you 
can add any more files. 

You can view the contents of the Wastebasket by opening the Wastebasket icon. 
A base window is displayed with a scrolling pane that shows you the files you have 
moved to the Wastebasket Figure 2-46 shows an example of some files in a 
Wastebasket window. 

Figure 2-46 The Wastebasket window 
~ File M .... 'e' W.stebasket: lhome/be.bee/.w.stebasket 

II ~ ~ ~ 
convert frame_convert hlrlng_elephants.1 Junk 

I~ 
I" 

~ ~ D 0 
Junk2 Junk3 mlf.flle.memo wrlte.prep --

The Wastebasket window has the standard Folder Commands pop-up menu, shown 
in Figure 2-47, that you can use to operate on the flIes in the Wastebasket 

Figure 2-47 The Wastebasket pop-up menu 

Creating a New Wastebasket 

(2) File Manager Wastebasket: /home/winsor/.wastebasket 

Beta snaDshot.rs 
F alder Commands 

~~ (Open E» 
Print File 
Stlect All 
link 
Copy 

Paste 
Cut E> 
Show Clipboard £> 
File Properties ... 
Up 

If you quit the Wastebasket window, you can create a new one by following these 
steps: 

1. In the File Manager, select a folder or file that you want to put into the 
Wastebasket. 
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2. From the Edit menu, highlight Cut. 

3. Drag the pointer to the right to display the Cut submenu, highlight Cut to 
Wastebasket, as shown in Figure 2-48, and release MENU. 

A new Wastebasket is created to contain the files you selected. 

Figure 2-48 Highlighting Cut to Wastebasket 

Undeleting Files and Folders 

Emptying the Wastebasket 

Copy 
Paste 

Show Clipb 
File Proper 
U~ ,. .... ~~ ..... 

You can move or copy files from the Wastebasket window in the same way that 
you move or copy files in the File Manager. As long as you have not chosen Really 
Delete from the Folder Commands Cut submenu, your files are accessible to you. 
You can move or copy them back into the Ftle Manager using drag and drop or the 
clipboard. 

To empty the Wastebasket, follow these steps: 

1. Open the Wastebasket window. 

2. Move the pointer into the pane and press MENU to display the Folder 
Commands menu. 

3. Highlight Select All, as shown in Figure 2-49, and release MENU. 

All of the folders and files in the Wastebasket are selected. 
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4. Press MENU again to display the Folder Commands menu. 

5. Highlight Cut and drag the pointer to the right to display the Cut 
submenu. 

6. Highlight Really Delete, as shown in Figure 2-50. 

Figure 2-50 Wastebasket menu with Really Delete highlighted 

Falder Commands 

(Open t» 
Print File 
Select All 
link 
Copy 
Paste 

(Cut to Wastebasket) 
Show Clipbo Move to Clipboard 
file Propertl 
Up 

7. Release MENU. 

As a safeguard to be sure you intended to delete these files, the Flie Manager 
displays a confinnation Notice, as shown in Figure 2-51. 

Revision A of 11 JWle 1990 



36 Revision A of 11 June 1990 

Figure 2-51 Wastebasket confirmation Notice/or deleting files 

Caution: 

2.7 Linking Files 

Creating a Link 

121 File Manager Wastebasket: /home/wlnsor/.wastebasket 

II II 
Beta snapshot.rs 

Are you sure you want to remove these file(s)? 

If you click SELECf on Yes, all the selected items in the window are deleted, 
and the Wastebasket is emptied. 

You cannot recover any files that you delete with Really Delete. 

A link is a symbolic connection or pointer to a single file that allows you to access 
it from more than one directory. You can set up a link to a file in a restricted 
directory, allowing access to the file without providing access to the directory. 

The Link command on the Edit menu executes the standard In operating system 
command. A symbolic link is created when you link files between directories. 
When you link files in the same directory, a hard link is created. Refer to the man 
page for In for a complete description. 

For example, if you have a file named Thin_man in a folder called Hammet t, 
you can link it to another folder called Myrna_loy. Once the link is established, 
you can access Thin_man from either folder. Thin_man has not been copied 
into Myrna_loy; it is linked with a pointer from one folder to another. 

Any editing changes you make to a file with links arc reflected in all of the folders, 
since there is really only one file, not multiple copies of it. 

To use a linked file, you can drag and drop its icon from any folder it is linked to. 

To link files to folders, follow these steps: 

1. Select the tile (or tiles) you want to link. 

2. Choose the Link command from the Edit menu, as shown in Figure 2-52. 
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Figure 2-52 Folder Commands menu with Link highlighted 

• D D D 
archive .rchiYing benefits books 

An instructional message is displayed in the footer, as shown in Figure 2-53, 
telling you how to proceed. 

Figure 2-53 Instruction message after a link is initiated 

Link these flle(s) by opening the target folder and selecting 'paste' 

3. Open the folder you want to link the file to. 

4. Choose Paste from the Edit menu or the Folder Commands pop-up menu, 
or press the Paste key on the keyboard. 

The file icon is displayed in the folder pane and a message confinning the link 
is displayed in the footer, as shown in the example in Figure 2-54. 

Figure 2-54 An example of a link completion message 

- ----- --- -
0 D D ~ 

NtwFolder .Iiases .rchiye .rtrtsume.doc 

~ fd) fd) ~ 
.rtr.sume.doc.Z bird.rs birdsof.ftather.rs birdsofaf.ather .rs2 

linkIng' IuS( IFllemgr IExampies/archlve' from dpboard_ 

Link infonnation is displayed as part of the properties of the fue, as shown in the 
example in Figure 2-55. See ''File and Folder Properties" later in this chapter for 
more infonnation about file properties. 
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Figure 2-55 links are displayed as part of the file type properties. 

Removing a Link 

, .~ File Manaler: File Properties 

D Name: archly,. 

Owner: _w_ln_sOf ______ _ 

Croup: staff 
~-----------

Size: 0 bytes 

last Modified: Mon Jan 22 16:52:481990 

last Accessed: Mon Jan 29 09:47:491990 

Tvpe: link to /usr /Fllemgr /Examples/archlve - --

, 

You can remove a link by selecting the file and choosing Really Delete fro.m the 
Cut submenu. Removing a link does not remove the original file. 

If you remove the original file without also deleting the link, the icon for the link 
changes to display a broken chain. In the example shown in Figure 2-56, the 
original file named aliases has been deleted, but the linked file remains. 

Figure 2-56 A broken link 

2.8 Copying Files to 
Other Systems 

I2l File Manager: /llome/winsor/Exampies 

[File V)(View V}(Edit V) (props V) (Horne V) (coto: V ). rs. 

~ 

0 B D ~ 
~ 
~ 
I-... 

Hewfolder aliases arch/vI artr.sume.doc T --
If you are running the automounter, you can transfer files between systems in the 
same way that you move and copy files on your system. The / net folder contains 
all the machines on your local netwoIK. 

To fmd out if auotmounter is rwming, in a Shell Tool or Command Tool type: 

ps ax I grep automount 

If the automounter is rwming, the system displays a message listing the process 
number and other information about automounter. 

If you are not running the automounter, you can use the Remote Copy item on the 
Flle menu, shown in Figure 2-57, to execute the standard remote copy (rep) 
operating system command, which allows you to transfer copies of files between 
systems. You can copy files from your system to another system, or from another 
system to YOUI'S, providing that the pennissions and ownership of directories and 
files allow you to do so. See the man page for rep for more infonnation. 
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To transfer files from your system to another system, follow these steps: 

1. Select the tile or tiles you want to transfer. 

2. Display the Remote Copy pop-up window by choosing Remote Copy from 
the File menu. 

The file names are displayed in the Source Path field of the Remote Copy 
window, as shown in the example in Figure 2-58. The default for the Source 
Machine is your machine. It is not necessary for you to fill in the field if your 
machine is the correct Source Machine. 

Figure 2-58 The Remote Copy pop-up window 

~ File Manager:llemote Cop V 

Source Machine: .... _______ _ 

Source Pa th: (Dye artresume.doc classes 

Destination Machine: -----------------
Destination Path: -----------------

3. Type in the name of the destination machine hi the Destination Machine 
text field. 

4. Type the destination path in the Destination Path text field. 

In the example shown in Figure 2-59, two files, artresume. doc and 
classes, will be copied to the /tmp directory on the machine named 
shargola. 
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Figure 2-59 An example of the Remote Copy window with entries in the fields 

2.9 File and Folder 
Properties 

~ File Mallager: Remote CoPV 

Source Machine: --------
Source Pa th: GIve artnsum"do( classes 

Destination Machl.e: shargola 
-~------

Destination path: ;..It_m..;.,..p+II--_____ _ 

(COpy) 

s. Click SELECT on the Copy button to initiate the transfer. 

While the transfer is in process, the Copy button displays the standard busy 
pattern. When the copy is complete, the Remote Copy window is dismissed 
unless you have pinned it. 

To transfer files from another system to your system, you must know the path and 
file name of the files you want to transfer. To transfer a file from a remote machine 
to your machine, follow these steps: 

1. Type the name of the remote machine in the Source Machine text field. 

2. Type the path and file name of the file you want to transfer in the Source 
Path text field. 

3. You can leave the Destination Machine field blank or'type your machine 
name. 

4. Type the path and file name for the file in the Destination Path text field. 

If you want to change the name of the file as part of the transfer, type the new 
file name at the end of the path. 

S. Click SELECT on the Copy button to start the transfer. 

Each folder and file in ,your file system has the following set of properties 
associated with it: 

[] Name 

[] Ownership 

[] Group 

[] Pennissions (read, write, execute) 

You can display these properties for an individual selected file using the FIle 
Properties pop-up window. You can change these properties if you own the file 
and have the correct pennissions set. 
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The File Properties window also displays the following infonnation about each 
file: 

[J Date the fue was last modified 

(] Date the file was last accessed 

[J File type 

[J Mount point 

(] Mounted from 

[J Free space 

Figure 2-60 shows an example of a File Properties window. 

Figure 2-60 An example of a File Properties window 
.-I)::Q File Nanager: File Properties 

Name: artresum •• dof;., 

Owner: winsor ------------------
Croup: daemon ------------------

Size: 12.896 bytes 

last Modified: Fri Jan 19 09:49:00 1990 

last Accessed: Mon Jan 29 13:13:331990 

Tvpe: Frame Maker document 

Permissions Read Write Execute 

Owner: ~ if 0 

Croup: ~ if 0 
World: ~ if 0 

Mount Point: Ihome 

Mounted From: /d9Y/sd2c 

Free Space: 26.511 kbytes (46%) 

To display the File Properties window, select a file or a group of files and choose 
File Properties from the Properties menu, as shown in Figure 2-61, or from the 
Folder Commands menu. If you have not selected a file, the File Properties item 
is inactive. 
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Changing Properties 

Figure 2-61 The Properties menu 

Tool PropertIes., 

H you select more than one file, the FJle Properties window shows those properties 
that the selected files can share in common. Figure 2-62 shows an example of a 
FJle Properties window when multiple files are selected. The document names and 
specific document infonnation are not displayed. You can change the pennissions 
for the group of selected fIles to be the same by clicking SELECf on the check 
boxes to change the pennissions and then clicking SELECf on the Apply button. 

Figure 2-62 File Properties window 
.-t:G Fie .. ana .. r: File PropertlH 

OWller~ w_in_so ..... r.o....-___ _ 

Croup: da_.m_on ____ _ 

Size: 

Last No.lfl,4: 

last Accessed: 

Ttl": 

PerMissions lea. Write Execute 

OWfter: liJ' liJ' 0 

ernp: liJ' liJ' 0 
Werl4: !if &tJ 0 

Mount Pelat: /horne 

No_t •• from: /dIav/sd2c 

Free S,aee: 2G.511 kbytes (-4s.) 

Every file and directory has a security system organized around permissions. 
Pennissions determine which users can read a file, write to (or change) it, or 
execute it (applications are executed). You must own the file to change its 
permissions. Users are categorized as owner, group, and world. 

(] Owner designates the owner of the file. 

(] Group designates the name of a specified group that can access the file. 

(] World allows access to anyone on your network. 

You can change file properties for any file that you own. If you do not own the file, 
the write pennissions determine whether you can access a file to change it 
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To change file properties, type new infonnation in the text fields. Click SELECf 
on a check box to either add or remove a check. The check boxes toggle between 
checked and unchecked. 

When you have changed the properties, click SELECT on the Apply button to 
apply them. 1be changes take effect immediately. 

You can change common properties on more than one file in the same way. 

. You can customize your File Manager in the following ways: 

o You can customize the tree display of folders in the path pane. 

o You can set application-specific properties for the File Manager. 

o You can create your own custom commands and add them to the Your 
Commands submenu that you access from the File menu. 

These methods are described in the sections that follow. 

The View menu contains commands that you can use to "prune" the tree view in 
the path pane so that it contains branches. of the tree that are useful to you and 
suppresses other folders that you may not need to access. 

If you frequently move or copy files between folders, you may find that using the 
tree display allows you to perfonn more operations using drag and drop, since more 
folders can be displayed in the File Manager window with the Tree option than 
with the Path option. 

When you display your path as a tree, you can choose the following options from 
the View menu: 

o Hide Subfolders 

(] Show All Subfolders 

o Begin Tree Here 

o Add Tree's Parent 

Subfolders are folders that are farther down the tree than the CUtTent folder. Figure 
2-63 shows a tree that contains all folders from the root directory downward. 
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Figure 2-63 An example of a complete tree path 

The following examples show a series of progressions, using each of the view 
modification commands from the View menu. 

Clicking SELECf on the winsor folder and choosing Hide Subfolders results in 
the display shown in Figure 2-64. Compare that display with the one shown in 
Figure 2-63. 

Figure 2-64 An example of hiding subfolders 
12) 

Choosing Show Subfolders without making any other changes to the display in the 
path pane produces the display shown in Figure 2-65 .. 
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Figure 2-65 An example of showing sub/olders 

With the winsor folder selected, choosing Begin Tree Here changes the display 
as shown in Figure 2-66. 

Figure 2-66 An example of changing the beginning point of the tree 

Choosing Show Parent adds one folder farther up in the path, and its subfolders:, as 
shown in Figure 2-67. 
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File Manager Tool 
Properties 

List Options 

Figure 2-67 An example of adding a parent/older 

You can change the way File Manger behaves and the way it presents certain 
infolDlation by changing controls in the Tool Properties window. To display the 
Tool Properties window, choose Tool Properties from the Properties menu or move 
the pointer onto the window background of the File Manager and press the 
Properties key on the keyboard. 

The Tool Properties window is shown in Figure 2-68. 

Figure 2-68 The Tool Properties window 

.~ File Manager: Tool Properties 

list Options: I Permissions I ~ I Owner II Croup II Size II Date I 
Hidden flies: I Invisible I Visible I 

Deletions: I Confirm I D<>n:'t Confirm I 
Default Document Editor: I textedltor I Other. I 

Default Print Script .;.t;'PAlr.. _________ _ 

See Filter Pattern: __________ _ 

longest Fllename: 255 

When you have changed the desired file manager properties, click SELECT on the 
Apply button to record the changes. The tool property changes take effect 
immediately and are displayed in the FIle Manager window. 

The List Options allow you to choose how much infolUlation is displayed when 
you display the contents of the folder pane as a list with mini-icons. To display the 
list with mini-icons, choose List from Folder Display on the View menu. 

The List Options are nonexclusive settings. You can choose none, some, or all of 
the options. To set an option, click SELECT to toggle it from off to on, or from on 
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to off. Chosen options have a thickened border. Figure 2-69 shows an example of 
a list when all of the list options are chosen. 

Figure 2-69 A/older pane with all of the Ust Options set 
,1"(2) File a.a .... r: 1 ....... /wl"s.r 

(File V) (View V HEdit V) (props V ){Home V ) (Coto: V) .. 

~ 
c:J drw-rw-rw-

I-
2 winsor staff 12288 Jan 1910:11 220pen ~ 

D-rw-rw-rw- 1 winsor daemon 40571 Jan 1909:49 A-Wletter .doc f-

D -rw-rw-rw-
... 

1 winsor staff 41939 Jan2913:07 8OFletters.doc 
D -rw-rw-rw- 1 winsor daemon 8825 Jan 19 09:49 8OFIetters.doc.backup 
c:J drw-rw-rw- 2 winsor staff 2560 Jan 1910:18 calendar 
c:J drw-rw-rw- 2 winsor staff 5632 Jan2610:48 Oeskset 
c:J drw-rw-rw- 3 winsor staff S12 Jan 29 09:47 Examples 
c:J drw-rw-rw- 2 winsor staff 102 .. Jan 24 14:29 cettlngstarted 
c:J drw-rw-rw- 2 winsor staff 358 .. Jan 2212:41 MaHtool 
c:Jdrw-rw-rw- 2 winsor staff 512 Jan2212:42 Prlnttool 
r:::l drw-rw-rw- 2 winsor staff 1024 Jan 2512:12 Snapshot 
D -rw-rw-rw- 1 winsor daemon 12896 Jan 1909:-49 artresurne.doc 
D-rw-rw-rw- 1 winsor staff 12896 Jan 19 14:37 artresume.doc.1 ~ 
~ - --
The Hidden Flles settings allow you to choose whether or not to display those files 
ordinarily not displayed. Most hidden files begin with at least one dot (.), and are 
often referred to as Dot Files. Oick SELBeI' on the setting you want to use. 
Figure 2-70 shows an example of a listing with hidden files displayed. 

Figure 2-70 A/older pane with Hidden Files visible 

(2) Fae N.nager: Ihome/wlnsor 

~ (View v) (Edit V) (props V )CHome V l(coto: v) .. 

~ 

~ D ~ 
~ .... .... .. 

.. 136 .. fYlype • tmJcon 

~ D D 
.trash.icon .bind .cak:toolrc 

D D D 
.cal09 .cIockrc .em.re 

LJ D D 
~_.cshrc .defaults .fflemgrrc - -

The Deletions settings allow you to choose whether Flle Manager displays 
confinnation notices for delete operations. It is generally a good idea to leave this 
option set to Confirm. If you choose Don't Confinn, you may inadvertently delete-­
some information from your file system that you did not want to. 

Default Document Editor The Default Document Editor setting specifies what default editor the Flle 
Manager uses to display data file icons that are not specifically bound to another 
application. If you click SELECT on Other, a text field is displayed in which you 
can type the name of a different text editor application. If you specify a different 
text editor that does not display its own window, you must specify that a shelltool 
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Default Print Script 

See Filter Pattern 

is started before the text editor. You should also invoke the sleep command after 
the shelltool and before the text editor. The sleep command gives the shelltool 
enough time to start up before the text editor tries to detennine the dimensions of 
the shelltool. Use the format shown in Figure 2-71, and replace the editor vi with 
the editor you want to use. 

Figure 2-71 The Default Document Editor textfleld 
fP File Ma ... er: Tool PnJpertles 

List options: Permissions I ~ I Owner II Croup I ~ I Date I 
Hidden Files: Invisible I Visible I 

Deletions: Confirm I Oon#t Confirm I 
Default Document Editor: textltdltor I Other: I shelltool sh -c ·sleep 3; yl SFILE· 

Default Print Script: Ipre. -
The Default Print Script text field allows you to specify a different default print 
script for files that are printed from the File Manager. The default is the standard 
Ipr operating system print command. If you want to print ASCII files using a 
PostScript filter and without a header page, type the following into the Default 
Print Script text field: cat $FILE I mp I Ipr -h. 

The See Filter Pattern text field allows you to specify that only files of a certain 
type are displayed in the folder pane of the File Manager. In the example shown 
in Figure 2-72, the filter pattern * . r s shows only the raster fues in a directory, 
even though other flies are there. Note that the header of the window shows you 
what filter pattern is set. 

Figure 2-72 A/older pane with a *.rsfllter pattern set 
"'(2) file M ...... r: tUter: • .rs /home/wlnsor 

@!:!) (View V HEdit V) (props v)( Home V) (Goto: V) .. 

~ 

~ ldl ~ 
jooo .. 
l-
I-

birdrs birdsof.feather ,rs brokenladyrs • 

[d. ldl Id 
chapter,agers CW-5Orrs darkJow8r rs 

[d ldl il 
dtsktopleyel,rs dogrs doggle,rs -- --- -

Longest File Name The Longest Ftle Name numeric field allows you to choose how many characters 
of each file name are displayed in the folder pane of the File Manager. You can 
type any number from 0 to 999. If you typically have very long file names, you can 
change the default number of 25S to a shorter length, say 8 or 10, to display more 
icons in the same area of the folder pane. 

NOTE The number of characters is calculated/or variable-width/onts to determine the 
length of the text that is displayed. The num!Jer 0/ characters displayed/or each 
file name may vary. 
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Names that do not fit within the specified length are followed by a > to show that 
the complete name is not displayed. Figure 2-73 shows an example of the' folder 
pane with shorter file names set. 

Figure 2-73 A/older pane with shorter file names specified 
r(2) File Manager: /home/wlnsor , 
~(Vlew V) (Edit V) (Props V) (Home V l(Coto: V). 

~ 

0 ~ 0 ~ [J 0 [J 0 0 0 
':: 
H 

220pen A-Wlette'llOFlette~OFlette>Calendar Oeskset Exarnple>Cettlngs> Mantool Prlnttoof 
~ 

0 ~ iB ~ [J 0 ~ ~ ~ ~ 
Snapsho>ertresum~rtresum~rtr.sum> bin blnderk> bird.rs birdsofa>bltmapr>brokenla> 

~ ~ ~ D ~ ~ ~ it ~ 0 
chapter> cursor.rsdarkpow>dead.let> desktop> dog.rs doggie.rs flyer.doc foUowm> mall 

.-. 

If you want to see the complete file name, you can double-click SELECf on the 
name. In this example, the file beginning "birdsofafeather" is selected, and the full 
name is displayed in an editable text field, as shown in the example in Figure 2-74. 

Figure 2-74 Displaying a completeJile name when shon names are specified 

The Your Commands Menu 

file Manager: Ihome/wlnsor 
, 

(File V)(View V)(Edit V) ~~C§O:V).-------

I~ I 
28n •. !!eJd.eJ~Lgar 0e9. ... 8J2" M9.~ pI~1 ~ 
oiiliiliiJoD~Il~Ia 

o 
Snapsho)Qrtresum~rtresum~rtresum> bin bind eric> bircllirdsofafeather.rs 

~~~D~~~~ra 
okenla' 

chapter> ~or.rsdarkpow>dead.let> desktop> dog.rs dO~ie.rs flyer.doc foHowm> mall 

The Your Commands menu that you access from the File menu, shown in 
Figure 2-75, allows you to create and store commonly used operating system 
commands. Once you have added the commands to the menu, you can use them at 
any time by choosing them from the Your Commands submenu. Figure 2-75 
shows the default items on the Your Commands submenu. 

A.Lsun 
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Figure 2-75 The Your Commands submenu 

p;r int file 
Create Folder 
Create Document 
Remote Copy ... 

Use the Shell item as a convenient way to open a Shell Tool window. 

Use the Enter Command item to display the Enter Command pop-up window, 
shown in Figure 2-76, that you use to create items to be included on the menu. 

Figure 2-76 The Enter Commandpop-up window 

.~ Enter Command 

Command: .. + _______ _ 

Creating Your Commands You can type any SunOS operating system command on this menu. If the 
command requires a window in which to display its infonnation, be sure to include 
the command for a window-based tool such as shell tool at the beginning of the 
command. 

Suppose you want to print a file using a print script that is different from the default 
print script specified from the File Manager Tool Properties window. You can add 
that command to the Your Commands menu by following the steps below: 

1. Display the Enter Commands pop-up window. 

Type the command in the text field. In this example you would type the 
following: cat $FILE I Ipr -h. . 

This command prints files you select in the File Manager without printing a 
header. 

2. Move the pointer to the Enter button and click SELECT. 

The command is stored in a • fvcmd file in your home directo~, and is added 
to the Your Commands submenu. Figure 2-77 shows the menu with the new 
command. 

Revision A of 11 June 1990 



2.11 Shortcuts 

Pop-up Menus 

Chapter 2 - File Manager 51 

Figure 2-77 The Your Commands submenu with a new command 

J;rirlt fli.:-
Create Folder 

Crea te Document 
Remote Copy ... 

o 

To use the item, select a fIle or files to print, and choose the command from the 
Your Commands submenu. If you want to edit or remove commands from the 
submenu, you must edit the • fvcmd fIle in your home directory. 

The File Manager provides you with pop-up menus for both the path and folder 
panes, and a Home menu to help you navigate through your file system. These 
shortcut features are described in the following sections. 

Pop-up menus in the DeskSet applications contain a subset of frequently-used 
commands from the control area You can display and choose from a pop-up menu 
anywhere in the pane by pressing the MENU mouse button, choosing an item from 
the menu, and releasing MENU. 

The commands on the path pane pop-up menu, shown in Figure 2-78, work the 
same way as they do when you choose them from the menus in the control area. 
As with other menu items in the FIle Manager and the other DeskSet tools, items 
that require a selection are inactive unless you have made a selection on which the 
command can operate. 

Figure 2-78 The Path Pane pop-up menu 
~ FII. Mana,.r: /home/wlnsor 

@:!)(VieWV)(EditV)(PropsV)(HorneV)(Coto:v) .... ___ --.,. __ 

Path Comlnands 

ttlriE'Subf·)lder£ 
Sh(-WAII SIJbfC-ldt!'.--; 
(:aljir. Traio ~oi-re 

Add Tr .. ·s Parent 
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The Folder Commands pop-up menu, shown in Figure 2-79, contains a different set 
of commands that are more useful to the functionality of the folder pane. 

Figure 2-79 The Folder Commands pop-up menu 

Using the Home Menu 

-- -141 I. n 

F .. derC ....... lNIs u 

I~ 0 , (C:l.e'l 1:01 ij 0 p.·ir.t Flit!' 
220pen A-OW 

Select All ~Oflettlrs.doc.ba> Calendar 

0 U!lk 0 0 C·)&))' 
Olskslt £1 

'astl 
MaUtool Print tool 

0 (ut 1:' ~ 0 
Snapshot artr 

Show ClIpboard c> 
artrlsumt.doc.2· bin 

D 
Flit!' p...,Pt!'.·t*~ ... 

~ [d) IJ~. 

blnderlcon.rs.lock b r .rs olroso a eatner.r itmaorevlewmem:> brokenladv.rs 

... 
The only command that is unique to the Folder Commands pop-up menu is the Up 
command. The Up command is always inactive for the FIle Manager base window. 
It is active in Folder pop-up windows and in the Wastebasket, where it is possible 
to move down a path (by double-clicking SELECT on selected folders), but where 
there is no other way to move back up the path. When you are at the top level of 
the hierarchy in a Folder pop-up window (the folder you initially dragged onto the 
worlcspace) or in the Wastebasket (the topmost folder you dl:agged or cut to the 
Wastebasket), Up is inactive. 

One of the menu buttons in the control area is Home. By clicking SELECT on the 
Home button, you can quickly return to your home folder from anywhere in the fue 
system. 

The Home button also has a menu that stores a recent history of the folders that you 
have accessed since you started the File Manager. Your home folder is the default 
item on this menu and is always the item at the top of the menu. The rest of the 
items on the menu show you up to nine of your most recently-accessed folders. 
You can change back to any of these folders by choosing the appropriate path from 
the Home menu. Figure 2-80 shows an example of items on a Home menu. 
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Figure 2-80 An example o/the Home menu 

2.12 Troubleshooting 

Ihome/wlnsor /Oeskset 
!home/winsor /22open 
lusr IFllemgr 

If files you expect to see in the folder pane are not being displayed, check to be sure 
that you have not specified a filter pattern from the File Manager Tool Properties 
window that suppresses the display of those files. When a filter is specified, it is 
al ways displayed in the header of the File Manager base window. 

If you have trouble transferring files between remote systems, you may not have 
the correct pennissions to access the fue, directory t or system, or the remote system 
may not be accessible through the networic. Contact the person who owns the fues 
(or the person who asked you to transfer the files) to change pennissions so the 
transfer will work.. To find out if the remote system is available on your networlc., 
contact your system administrator. 
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3.1 How Mail Tool Is 
Organized 

3.2 TheMaii Tool Icons 

Figure 3-1 

3 
Mail Tool 

The Mail Tool application provides a convenient and intuitive way to use the 
UNIX mail handling facilities. 

Using Mail Tool by itself, you can write, send, and receive electronic mail and 
organize your mail messages into logical groupings. 

Using drag and drop, Mail Tool works in combination with File Manager, Print 
Tool, Text Editor, and Calendar Manager to provide an integrated workspace 
environment You can organize information effectively and communicate not only 
with other users on the electronic mail network but with other applications on your 
workspace. 

This chapter describes how to use the Mail Tool application and how you can use 
the intuitive drag and drop method to copy or move ft.Ies into and out of Mail Tool 
and the other DeskSet applications. 

The Mail Tool application has two base windows. The primary base window 
shows you a list of electronic mail messages that you have received. You read your 
mail messages in a View Message pop-up window. To respond to messages or to 
compose new messages you open a Compose base window that closes to its own 
icon. Once you have opened a Compose base window, you can use it to write and 
send electronic mail messages without opening the primary Mail Tool base 
window. Each of these windows is described in detail later in this chapter. 

The icons for each Mail Tool base window show you useful infonnation about the 
Mail Tool application. The primary icon for Mail Tool, for the window that shows 
you incoming mail messages, looks like a rural American mail box with the door 
closed and the flag down. When new mail arrives, the flag goes up and the qoor of 
the mail box opens to show you that you have new mail messages. Figure 3-1 
shows these views of the mailbox icon. 

The primary Mail Tool icon 

mailtool mailtool 
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The Compose Mail Tool icon shows an envelope, a pencil, and a label indicating 
the recipient of the message. When you close the Compose window before you 
have indicated the recipient(s), the '70:" label has no name. Figure 3-2 shows these 
views of the Compose icon. 

Figure 3-2 The Compose Mail Tool icon 

3.3 The Primary Mail 
Tool Base Window 

-----_ ... 

0: o:maynat 

The primary Mail Tool base window, shown in Figure 3-3, provides a set of 
controls with which you access other parts of the Mail Tool application, displays a 
list of your electronic mail messages, and shows you the status of your mail 
messages. 

The primary Mail Tool base window, by default, shows you a list of the mail 
messages in your In Tray. See "Organizing Your Mail Messages" for infonnation 
about moving or copying mail messages from your In Tray into mail files. 

Figure 3-3 The primary Mail Tool base window 

~ Mall Tool - lusrlspool/mail/wlnsor 
, 

~(View v)@[!) (Compose v) Mall file: 12). 

1 Br1dge@sun.com Fri Oec 1 17:98 19/792 next bridge Vednesday, Oe 

~ 2 ger1@shargola Mon Dec 4 13:19 35/895 Richard's whereabouts 
3 gerieshargola Fri Dec 8 14:98 37/1938 PS(Janice winsor) 
4 geritshargola Fri Dec e 14:99 639/25777 SIGCHI 
5 tut@cairo Fri Dec 8 19:51 9/159 Re: Frame 2.9 license 
6 ~er1 @shargo 1 a Mon Dec 11 98:47 25/798 OL lunch 

1-tI 7 winsor Mon Uec 11 14:blj ~b/ljblj Menu items in mult1-colum 
N 8 winsor Mon Dec 11 15:17 14/395 ~riting about Mail Tool 

8 messa ges. 1 new. 0 de lete d 

Controls The control area has four menu buttons: File, View, Edit, and Compose. The 
following sections provide a brief introductory deSCription of each of these 
controls. 

The Flle Menu File has a menu, shown in Figure 3-4, with choices that you can use to organize 
your mail messages, print them, or commit changes (such as deleting messages). 
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I'?IJII ... ----~ 

Co)"]' Irit<o M-ioll Filo:­

Pi"illt 

SaYe changes 

Done 
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[j Use Open to view messages from either your In Tray or your mail flIes. See 
"Organizing Your Mail Messages" later in this chapter for more information 
about mail flIes. 

o Use Move Into Mail File and Copy Into Mail Flle to move or copy messages 
from your In Tray into mail files that you specify. See uOrganizing Your Mail 
Messages" later in this chapter for more information about mail files. 

[j Use Print to print the selected messages. See "Printing Messages" later in this 
chapter for more information about printing. 

[j Use Save Changes and Done to incorporate changes to Mail Tool. See "Saving 
Changes for Mail Tool" later in this chapter for more information. 

The View Menu The View menu, shown in Figure 3-5, has choices for different ways to view 
messages and move between them. 

Figure 3-5 The View menu 

Messages t> 
Previous 

(Next 

[j Use Messages to view selected messages with either an abbreviated or full 
heade~ . 

[j Use Previous to view the message before the current message. 

[j Use Next to view the message following the current message. 

[j Use Sort By to sort messages in your mail files. Since you canrtot sort the 
messages in your In Tray, the Sort By item is inactive unless you are displaying 
mail headers in yourmail files. See "Organizing Your Mail Messages" later 
in this chapter for more information about mail files. 

See "Viewing Messages" later in this chapter for more information about using the 
first three items on the View menu. 

Revision A of 11 June 1990 



58 DeskSet Environment Reference Guide 

The Edit Menu 

Undelete t> 
Find ... 

Properties ... 

C1 Use Cut and Copy to put selected messages onto the clipboard. You can then 
paste these messages from the clipboard into other windows. 

C1 Use Delete to delete selected messages. 

C1 Use Undelete to restore deleted messages. 

C1 Use Find to fmd messages in your In Tray by sender and/or by subject. See 
"Finding Messages" later in this chapter for more infonnation about using the 
Find pop-up window. 

C1 Use Properties to customize your Mail Tool application. See "Customizing 
Your Mail Tool" later in this chapter for more infonnation about Mail Tool 
properties. 

The Compose Menu Compose has a menu, shown in Figure 3-7, with choices for opening Compose base 
windows from which you can write and send mail messages. 

Figure 3-7 The Compose menu 

C1 Use New to open a new Compose window. 

C1 Use Reply to open a Compose window to respond to a selected message. See 
"Replying to Messages" later in this chapter for more infonnation about Reply 
options. 
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(] Use Forward to open a Compose window that includes selected message for 
forwaming. 

(] Use Vacation to initiate or stop an automatic response to incoming messages 
when you are away from your mail. See uUsing the Vacation Notifier" later in 
this chapter for more information about Vacation options. 

You use the Mail Flle text field and abbreviated menu button to create and view 
mail file messages. See UOrganizing Your Mail Messages" later in this chapter for 
infonnation on creating and viewing mail files. 

Each line in the scrolling list of the primary Mail Tool base window represents a 
single electronic mail message, and is called the header for the mail message. Each 
header has nine columns of infonnation as follows: 

a The first column shows you the status of the mail message: 

• An arrow points to the cu"ent message. 

• An N shows you that the message is new. 

• A U shows that a message is unread. 

• A blank is displayed when you have viewed the message. 

a The second column contains a message number that is automatically assigned 
to messages by the Mail Tool in the order in which they arrive. 

a The third column contains the electronic mail address of the sender of the 
message. 

(] The fourth column contains the day of the week the message was received. 

a The fifth and sixth columns contain the month and date that the message was 
received. 

(] The seventh column contains the time the message was received. 

D The eighth column tells you how big the message is. The first number tells you 
how many lines are in the message, the second number tells you the number of 
characters in the message. These numbers include the number of lines and 
characters of the full message header, as well as the text of the message. 

D The ninth column contains the subject of the message when the person who 
sent the message provides a subject line. An (E) at the start of the subject text 
shows that the message is encoded. 

Status messages are displayed at the right side of the footer telling you how many --­
messages are in your in tray, how many new messages you have and how many you 
have deleted. 

You can select each message header by moving the pointer into the line and 
clicking SELECf. A selected header has a box around it, as shown in Figure 3-8. 
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Figure 3-8 The primary Mail Tool base window 

~ Mall Tool - lusrispool/ftlall/wlflsor 
., 

~ (View V) (Edit V) (compose V) Mall rile: 121. 
1 8r1dgeesun.cCIIII Fr1 Dec 1 17:88 191782 next bridge ¥ednesday I De I': 
2 gerieshargol. Non Dec 4 13:18 35/895 Richard'. whereabouts II-
3 ged.shargo 18' Fri Dec 8 141:88 37/1838 PS(Jan1ce winsor) It; 

I 41 oer H!sharoo 18 J"r1 Dec B 141:89 O.,t:J/~O((( ~miCHI 

5 tuteca1ro fr1 Dec 8 19:51 9/159 Re: frame 2.8 license 
6 gerieshargola Non Dec 11 88:417 25178a Ol lunch 
7 winsor Man Dec 11 141:58 26/858 Menu items in IlUlti-colun 

N B winsor Man Dec 11 15:17 141/395 Yriting about Mail Tool .. 9 agteshur1ken Mon Dec 11 15: 39 281766 New Style 

c:::l 

9 messages. , new. 0 deleted 

You can select more than one message at a time for most of the Mail Tool 
operations. To select additional messages, move the pointer into the line and click 
ADJUST. If a message is already selected, clicking ADJUST deselects it. 

When a message or group of messages is selected, you can choose commands from 
a Mail Tool menu, or you can drag and drop the messages from Mail Tool onto 
other applications such as File Manager, Calendar Manager, Print Tool or Tape 
Tool. 

Finding Messages To help you find messages, you can search your In Tray or mail files for messages 
that have been sent to you by a specific person, or by subject To fmd a message, 
first display the Find pop-up window by choosing Find from the Edit menu, as 
shown in Figure 3-9. 

Figure 3-9 The Find item on the Edit menu 

Properties ... 

The Find pop-up window is displayed, as shown in Figure 3-10. 

Figure 3-10 The Findpop-up window 

Q Mall Tool: Find ~essa.es 

Sender: • 

Subject: 

(Find Forward ) (Find Backward) (select All ) 

You can search for messages by sender, by subject, or by subject and sender. The 
Search text fields are case-insensitive and match partial words and phrases. You 
do not need to type a complete sender name, and you can use keywords to match 
subjects. For example, typing the name "winsor" in the Sender text field will find 
files sent by "winsor@castle" as well as '~winsor." 
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To search for messages by sender, type the sender name in the Sender text field. 
Clicking SELECf on the Find Forward button selects the next message header 
with the sender name you specify. Qiclong SELECf on the Find Backward button 
selects the previous message header. Oicking SELECf on the Select All button 
selects all message headers with the sender name. An information message is 
displayed in the footer of the Find Messages window telling you how many 
messages are selected, as shown in the example in Figure 3-11. 

Figure 3-11 An in/ormation message in the Find Messages window 

3.4 Viewing Messages 

~ Mall Tool: Find Messages 

Sender: winsor. 

Subject: 

(Find Forward) (Find Backward) (select All ) 

'0 Items found and selected 

To search for messages by subject, type a word or phrase in the Subject text field. 
To search for messages by sender and by subject, type the appropriate infonnation 
in each text field and click SELECf on one of the buttons. 

To view a message, follow these steps: 

1. Move the pointer onto the line of a header and click SELECT. 

A rectangular box is displayed around the selected header. 

2. Move the pointer onto the View menu button and press MENU .. 

The View menu is displayed. 

3. Drag the pointer to highlight Messages. 

4. Release SELECT. 

A View Message pop-up window is displayed showing you the text of the 
selected message, with an abbreviated header, as shown in Figure 3-12. 
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Figure 3-12 The View Message pop-up window 

Using the Pushpin in the 
View Message Window 

Viewing the Next or Previous 
Message 

..... Mall Tool: View Messa.e ~ 

~rom gerieshargola Fr1 Oec 8 14:89:91 1989 
110: winsor.castle 
Subject: SIGCHI 

----- Begin Included Message -----

)From jcbefr1sbee Yed Nov 29 15:28:82 1989 
From: jcbefrisbee (Jim Secker) 
To: SayCHlejf 
Subject: CHI '98 Conference on Human Factors and Computing Systems 
Cc: sriram@cremona, 1slam@mish1ma, lemke.ncd 

I hadn't aeen this come across the wire yet, so thought that I would 
fo~ard it via the SayCHI alias. 

-Jim 

-- included text --

CHI '99 (the seventh annual Conference on Human Factors and 
Computing Systems) will be held in Seattle, ~ashington, from April 
1st to 5th, 199B. 

The theme of CHI '9B is Empowering People: facilitating their 

, 

Alternatively, you can double-click SELECf on the header of a mail message to 
display the View Message window without using a menu. 

The number of the message that is displayed is always shown in the window header 
of the View Message pop-up window (Message 4 in this example). 

The View Message pop-up window uses the standard text editing pane and -pop-up 
menu. You can edit the text in the View Message pane. If you have made -editing 
changes to the message, and if you have set the Mail Tool properties so that you 
are asked for a confinnation, a Notice is displayed when you change messages or 
close the window, asking if you want to save the changes. See "Customizing Your 
Mail Tool" for more infonnation about Mail Tool properties. 

The View Message pop-up window can be split into two or more panes in order to 
view and edit different pans of the mail message at the same time. See Chapter 5 
for infonnation about editing text and splitting the text pane. 

The View Message pop-up window has a pushpin that you can use to pin the 
window to the workspace if you want to keep a message (or several messages) 
visible. 

If you do not click SELECf on the pushpin to pin the window, the View Message 
pop-up window is reused for subsequent mail messages that you view. If you do 
pin the View Message pop-up, a new View Message pop-up will be displayed for 
the next message you view. 

When the View Message pop-up window is displayed but not pinned, you can view 
the next message in the same window by moving the pointer to the View menu 
button and clicking SELECf. The next message is displayed using the existing 
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View Message window. If no unpinned View Message window is displayed, 
choosing an item from the View menu automatically displays one. 

Clicking SELECT activates the default item for the menu. If you have changed the 
default, you must display the View menu and choose Next. 

Alternatively, you can double-click SELECf on the header of the next message to 
display it in the View Message window. 

When the last message in your In Tray is already displayed in the View Message 
window, choosing Next displays the previous message. 

To display the previous message, move the pointer to the View menu button, press 
MENU, choose Previous, as shown in Figure 3-13, and release MENU. 

Figure 3-13 Choosing Messagefrom the Previous submenu 

Viewing Messages With a 
Full Header 

Mail Tool messages are nonnally displayed with an abbreviated header. The 
contents of this header are detennined by the "ignore" variable in your .mailrc 
file. All mail headers are displayed except those listed after "ignore". For 
example, if you do not want to see the header fields Message-Id, Received, Retum­
Path, or Status, use any text editor to add the following line to -the . mailrc file 
in your home directory: 

ignore message-id received return-path status 

If you do not have the "ignore" variable in your. mailrc file, you will always see 
a full message header. If you have the "ignore" variable set, you will nonnally see 
an abbreviated header. To display a message with the full message header. 
regardless of the setting of the "ignore" variable, follow these steps: 

1. Select a message. 

2. Move the pointer to the View menu button and press MENU. 

3. When the View menu is displayed, highlight Messages. 

4. Drag the pointer to the right to display the Messages submenu. 

s. Drag the pointer to highlight Full Header. 

6. Release MENU. 
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Figure 3-14 shows an example of a full message header. 

Figure 3-14 A/ull message header 

Viewing Multiple Mail 
Messages 

.~ Mall Tool: View Message 4 
From ger1eshargola Fri Dec 8 14:89:81 1989 
eturn-Path: <ger1@shargola) 

Received: from shargola.aun.com by castle.sun.com (4.8/SMI-4.8) 
1d AA9SS54j Fri, e Dec 89 14:98:59 PST 

Received: by shargola.sun.com (4.9/SMI-4.9) 
1d AA93273; Fri, e Dec 89 99:46:54 PST 

Date: Fri, e Oec 89 89:46:54 PST 
From: geri@shargola (Geri Vounggren) 
Message-Id: <89128S1746.AAB3273eshargola.sun.com) 
To: winsor@castle 
Subject: SIGCHI 
status: RO 

If you select multiple mail messages and display them, a View Message window is 
opened for each message, layered on top of one another in numerical order, as 
shown in the example in Figure 3-15. 

Figure 3-15 Viewing multiple mail messages 

NOTE 

.~ Mall Tool: View Message 2 ~ 
~ .~ Mall Tool: View Mess.ge 3 ~ 
I~ ~ r.~ Mall Tool: View Messale 4 

I ~ I ( ~~om gerieshargola Fri Dec 8 14:89:81 1989 

~ I CI I' 
0: wfnsorecastle 

Subject: SIGCHI 

I ~ ----- Begin Included Message -----
- l 

~ >From jcbefrisbee ¥ed Nov 29 15:28:82 1989 
) From: jcbefr1sbee (Jim Becker) 

f ~ To: BayCHIejf 
Subject: CHI '98 Conference on Human Factors and Computing Systems 

~ ~ Cc: sr1ramecremona, islamtmishima, lemkeencd 
~ 

( [ I hadn't seen this come across the wire yet, so thought that I would 
forward it via the BaytHI alias. 

-Jim 

I- -- included teKt --

If CHI '98 (the seventh annual Conference on Human Factors and 
i- Computing Systems) will be held in Seattle, ¥ash1ngton, from April 

~ 
1st to 5th, 1998. 

~ 
The theme of CHI ' 98 1 s &\pawed ng Peop le: facilitating their 

The View Message windows are displayed in numerical order, not in the order that 
you selected them. 

You can move the windows so they do not overlap one another, click SELECf on 
the header to bring an individual message window to the front of the screen, or 
dismiss each window individually after you have read the message. 
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Once you have displayed a message in a View Message window, it is marlced as 
"read" whether or not you actually have read the message. 

You can print your electronic mail messages by using either Mail Tool or Print 
Tool. 

To print your messages from Mail Tool, follow these steps: 

1. In the primary Mail Tool base window, select the headers for the messages 
you want to print. 

It is best to never select more than five headers to be printed at one time. 
Selecting and printing many messages at one time uses a lot of swap space, 
which can potentially cause your server to crash. 

2. Choose Print from the File menu. 

Figure 3-16 shows these steps. 

Figure 3-16 Printing multiple mail messages 

NOTE 

.~ 

Open ~ 

Move Into Mall File 
Copy Into Mail File 
ga;, 
Save changes 
Done 

un. com 
o 
rgola 

Mall Tool - /.,srlspool/maillwlnsor 

( Compose V) Mall file: lID 
Fri Dec 1 17:99 19/792 next bridge ~ednesdaYI De • 
Fr1 Dec 8 19:51 9/159 Re: Fr.me 2.9 license 
Mon Dec 11 98:47 25/798 Ol lunch 
Men Dec 11 14:58 26/858 Menu items i~ multi-colum 

22 messages, 0 new, o deleted 

Alternatively, you can use Print Tool to print your mail messages, by following 
these steps: . 

1. With both Mail Tool and Print Tool running, select the headers for the 
messages you want to print. 

2. Press the Control key and SELECT and drag the headers until the hot 
spot of the pointer is on either the Print Tool icon or the open Print Tool 
window. 

The selected mailfiles will be deleted if you do not press the Control key before you 
press SELEcr to drag them. Dragging with SELECT moves the files, removing 
them/rom the Mail Tool application. They are stored in the Undelete window, and ~ 
you can recover them as long as you have not saved changes to Mail Tool. 

The pointer changes to the duplicate pointer. A small envelope is displayed if 
you are dragging one mail header, or three small envelopes are displayed if you 
are dragging several mail headers. In the example shown in Figure 3-17, three 
overlapping envelopes move with the pointer~ 
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Figure 3-17 Printing using drag and drop 

I2J Mall Tool - lusrlspoo ~ Print Tool 

~ (View V) (Edit V) (compose V) Mall file: 
file: • 

Printer: Ii) spitfire 18 .ar~d@steamer Mon Dec 11 18:82 -~ 
I 11 11m H!bardO 1 DtI Mon Oec 11 1S: 86 ~ Copies:. _, _ El3 

12 rpn@fordtruck Mon Dec 11 28: 94 18 
U 13 hohensee@eliot Man Dec 11 23: 32 5 fUter: I Hone I Raster I TeX J 

14 poseur!earle Tue Dec 12 88:43 9· I Plot I Cit Plot I trotf I 
L Ib scnaDD eel::as~ lueOec l~ It!:bt! 3 

~ Ipr I control I other: I 
I 16 w1nsor lue Oec 1~ 11::i4 ;:s 

17 batten@sunmicro Tue Dec 12 11:39 4 
18 owl@danse Tue Dec 12 11:58 1 (Print HStatus )(Stop Printing V) 19 julies@sherpa Tue Dec 12 12:86 5 

-Jl;l -
3. Release SELECT to drop the headers. 

If the Print Tool window is open, infonnation messages are displayed in the 
footer of the Print Tool window showing you the printing status. Figure 3-18 
shows an open Print Tool window that has accepted Mail Tool messages for 
printing. See Chapter 6 for more infonnation about the Print Tool application. 

Figure 3-18 Print Tool printing mail messages 

3.6 Deleting Messages 

(2) Print Tool 

file: Itmp/mall,wlnsor.629503345. 

Printer: 121 spitfire 

1 Print Jobes) Submitted 

It is a good idea to periodically save or delete obsolete messages from your In Tray. 
See "Organizing Your Mail Messages" for infonnation on how to move or copy 
messages from your In Tray into mail files. nus section describes how to delete 

. messages. 

1. Select the message headers for messages you want to delete. 

Click SELECf to select the first message, then click ADJUST on each 
subsequent message to either add it to the group or remove it from the group if 
it is already selected. 

2. Choose Delete from the Edit menu. 

Figure 3-19 shows some selected message headers and the Delete item 
highlighted on the Edit menu. 
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Figure 3-19 Deleting messages 

(£) Mall Tool - lusrispoollmall/winsor 
(E!ill (Vi8WV) _ l Compose V J Mall file: (2) 

28 8cha .-t:e Ie Dec 12 12:21 33/1383 New look Critique 
21 jul1 Cut Ie Dec 12 12:28 75/2416 deskset feedback from IR 
22 5aJe Copy ~ Dec 12 12:28 19/589 Re: Beta2 Docs for DeskS 

I 23 earl Ie Dec 12 1.q:t!~ bZ/l~£'b I'<e: New lOOI( Cr1t1aue 
'lit! 25 5cha e Dee 12 14:26 2711111 Re: New _LooK Cr it i Que 

I 26 tut@ Undelete e> e Dec 12 1.q:~ 17/~~2 I'<e: New Look Cr1t1oue 
Find", 

~ Properties," 

27 messages, 0 new, 0 deleted ~ 

3. Release MENU. 

The mail messages are deleted from the In Tray display t and the status message 
in the footer updates to reflect the current state of your In Tray, as shown in the 
example in Figure 3-20. 

Figure 3-20 Status message after deleting messages 

3.7 Un deleting Messages 

riJ Mail Tool - lusrlspool/mail/winsor 

~(View V)@!:!) (compose V) Mall file: @ +OesI9n/blit2I1s~ 

29 ;chapple@East Tue Dec 12 12:23. 33/13B3 New look Critique 
21 julies@sherpa Tue Dec 12 12:28 75/2416 deskset feedback from IR 

1-+1 22 sai@viDeia Tue Dec 12 12:26 19/589 Re: Beta2 Docs for DeskSl 

~ ... 
)Po( 

~ 
27 messa ges, 0 new, 3 deleted ~ 

As long as you do not incorporate changes to Mail Tool by switching to another 
Mail File or by choosing either Save Changes or Done from the File menu, the 
deleted messages remain available and you can "Undelete" them. See "Saving 
Changes for Mail Tool" for more infonnation about incorporating changes. 

When there are no deleted messages available, the Undelete item on the File menu 
is inactive. 

To undelete a message, follow these steps: 

1. Move the pointer to the Edit menu button and press MENU. 

The Edit menu is displayed. 

2. Drag the pointer to highlight Undelete. 

3. Drag the pointer to the right to display the Undelete menu •. 

4. Choose Last to undelete the last message you deleted. 
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Alternatively, choose From List to display the Undelete pop-up window, 
which contains a scrolling list of messages that you have deleted since you last 
saved changes in Mail Tool. 

Figure 3-21 shows an example of tile Undelete pop-up window. 

Figure 3-21 Message headers in the Undelete pop-up window 

3.8 The Compose Base 
Window 

r.~ Mail Tool: Undelete 
, 

.... 

79 dary18ihuxy.att.com Fr1 Feb 9 

~ 
t::I 

(undelete ) 

Select the headers you want to undelete and click SELECf on the Undelete 
button. 

REMINDER: You can use the resize comers to adjust the size of the Undelete 
pop-up window. 

Any time you choose an item from the Compose menu (except for Vacation), a 
Compose base window is opened. See "Using the Vacation Notifier" at the end of 
this section for more infonnation about Vacation. 

A Compose window operates independently from the primary Mail Tool ~ase 
window. You can close an opened Compose window to an icon for later use or 
keep a Compose window open while the primary Mail Tool window is closed to an 
icon. You can open as many Compose windows as you like at one time, working 
on replying to or composing several messages concurrently. The Compose 
window is shown in Figure 3-22. 
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Figure 3-22 The Compose base window 
~ Mail Tool: COMpose Messa.e 

, 
[Include V)(Oeliver V)(Header V)(NameFlnder_ )(Clear ) 

To: 
S .... ject: 

Cc: .. 

• ': 
t-
t; 

The Compose window has its own set of controls that you use to create and send 
mail messages: 

D The Include menu button provides choices so that you can include selected 
messages as part of the message you are composing and also provides you with 
a set of templates for creating different types of messages. See "Using 
Templates" and "Template Properties" for more information about templates. 

D The Deliver menu button provides choices for how the Compose window 
behaves once the message is delivered. 

o The Header menu button provides choices for the number and type of text 
fields with which to create the message header. . 

D The Name Finder window button displays a pop-up window that you can use 
to search the Network Infonnation Service (NIS) database in your NIS domain 
for names and email addresses. 

D TheOear button clears the contents of the window. 

D The To, Subject, and Cc text fields are used to type the email addresses, subject 
of the message, and email addresses for those to receive copies of the message. 

D Bcc is also available for sending blind carbon copies. See "Composition 
Header Properties" for details. 

D The pane of the Compose window is where you type the contents of the 
message you want to send. The Compose pane uses the standard text editing 
conventions available from the Text Editor application. See Chapter 5 for 
more infonnation about editing. 
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Composing Messages 

Encoding Files 

To compose a message, follow these steps: 

1. Choose an option from the Compose menu or click SELECT on a 
Compose icon to open the window. 

2. Move the pointer into the To text field and click SELECT to set the insert 
point. Type an email address or a series of addresses. 

If you type more than one email address, separate each one with a comma 
and/or a space. For example, type this: 
here@machine, there@elsewhere, outside@nowhere 

3. Press Tab or Return to move the insert point to the Subject field and type 
the subject of your message. 

Alternatively, you can move the pointer and click SELECf to reposition the 
insert point. 

4. Press Tab or Return to move the insert point to the Cc field. Type the 
addresses of recipients. 

Separate the addresses with a comma and/or a space. Many users routinely 
include their own email address as part of the Cc field and maintain a personal 
record of messages they have sent. 

S. Press Tab or Return (or move the pointer into the pane and click 
SELECT) to set the insert point in the pane. Compose your message. 

You can cut and paste infonnation from other windows using the Copy and 
Paste keys on the keyboard. 

You can include complete mail messages from your In Tray or from your Mail 
folders by selecting the header and choosing an option f~m the Include button 
at the top of the Compose window. 

6. When you have finished composing the message, click SELECT on 
Deliver. 

The message is delivered and the Compose window is quit. 

If you want to keep a compose window available as an icon, consider changing the 
default for the Deliver menu from Quit Window to Oose Window. See the 
OpenWindows User's Guide for infonnation on how to change a menu default. 

You can include files other than ASCII text, such as raster or PostScript files, by 
selecting rde icons from the File Manager and ~ragging and dropping them onto 
the Compose window. 

When you drop a rde onto the Compose window t a Notice is posted, as shown in 
Figure 3-23, asking you how you want Mail Tool to process the contents of the file. 
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Figure 3-23 The Compose window drag and drop Notice 
@) Mall Tool: campose Mess .. e 

(Include v) (Deliyer v) ( Header v) ( Name Finder _) (Clear) 
To: ... __________________ _ 

Subject: 

• Would you IlIce /home/jungle/brendalcllpartlCraphIcs/PrlntFlre 
loaded as text or .ncoded Into an .ndosure? 

o Choose Text to insert the file as ASCII text at the caret location. 

o Choose Encode to append the file to the end of the message and insert (E) at 
the beginning of the subject line to show that the mail message contains 
encoded data. 

o Choose Cancel to stop the operation. 

To decode an encoded message, select the header and drag and drop it onto the File 
Manager folder pane. See "Using Drag and Drop with Mail Tool" later in this 
chapter for more infonnation about drag and drop and Chapter 2 for infOImation 
about the File Manager. 

You can create and store your own templates for composing messages. You might, 
for example, want to create a standard table fonnat for status report infonnation or 
a standard signature and closing message. See "Customizing Your Mail Tool" for 
infonnation about how to create and store templates. When you have created a 
template file and added it to Mail Tool, it is displayed as an item on the Include 
Templates submenu. Figure 3-24 shows a Templates submenu with two 
templates. 

Figure 3-24 The Templates submenu 

The Calendar template in this example creates messages in a fonn that Calendar 
Manager inteIprets when the message header is dragged and dropped onto the 
Calendar Manager application. See Chapter 4 for more infonnation about 
Calendar Manager. TIle user-defined Signature template adds a standard signature. 

Any template available from the Templates submenu can be added to a message at 
any time while you are composing it. When you choose the item from the 
Include menu, the template is inserted at the caret location. 

Figure 3-25 shows an example of a signature template. 

Revision A of 11 June 1990 



72 DeskSet Environment Reference Guide 

Figure 3-25 An example of a signature template 

Using the Name Finder 

v Mall Tool: 

To: 
Subject: --------------------~ 

~:--------------~--~ 

Janice ~insor 
Technical ~r;ter 
Sun Microsystems, 

When you do not know the email address of a person, or when a message is 
returned as undeliverable because the email address is incorrect, you can use the 
Name Finder pop-up window, shown in Figure 3-26, to help you locate names and 
addresses available in your NIS database. 

Figure 3-26 The Name Finder pop-up window 
{P Mail Tool: Name Finder 

Name: • 

0 Sounds Like Q§D 

I ; 
.... J 

You can type in the first name, last name, or a fragment of a name. The Name 
Finder is case insensitive, so you do not need to use exact capitalization. In the 
example shown in Figure 3-27, the Name Finder matched seven people with the 
first name of "Janice." The finder displays the full name, login name, mail alias, 
and address for each of the seven names. . . 

Figure 3-27 Using the Name Finder 
{P Mall Tool: Name Finder 

Name: ja nice 

o Sounds Like ~ 
Full name: janice w~nsor 

~ It~gi n name: winsor 
Mail alias: jwinsor 
Address: w1nsor8castle 

1 
'l? name(s) matched .J 

If you are uncertain of the spelling of a name, and want the Name Finder to broaden 
the scope of the search to ·'sound alike" names, you can click SELECf to tum on 
the Sounds Like functionality. In the example shown in Figure 3-28, the Name 
Fmder matched six names with the word "anathema. tt 

Revision A of 11 June 1990 



Replying to Messages 

Chapter 3 -Mail Tool 73 

Figure 3-28 Using the Sounds Ukefeature o/the Name Finder 

r~ Mail Tool: Name Finder 

Name: ana the ma. 

Iii' Sounds Like (!§) 

Full name: anthony j. hillman 

~ login narne: tjh 
Mail a lias: ahi llman 
Address: tjh@sarun 

~ nameCs) matched 
.,.J 

You can configure your own grOUps of frequently-used email addresses by creating 
an "aliases" file and then simply typing the name you assign to the group of names 
instead of typing individual email addresses. See "Creating and Using Mail Tool 
Distribution Lists" later in this chapter for more information. 

When you choose one of the following options from the Reply submenu, shown in 
Figure 3-29, a Compose window is opened. 

Figure 3-29 Clwices on the Reply submenu 

The Reply submenu options provide these functions: 

o To Sender fills in the To field with the originator of the selected" message and 
the Subject text field using the information from the selected message's 
Subject field. 

o To All fills in the To and Cc fields with all the names in the header fields of the 
selected message, including the originator of the message, and fills in the Sub­
ject field with the Subject field from the selected message. 

o To Sender, Include fills in the To and Subject text fields, and puts a copy of the 
text of the message into the Compose window pane. 

o To All, Include fills in the To, Subject, and Cc text fields using all the names 
from the selected message, and puts a copy of the text of the message into the 
Compose window pane. 

To reply to an individual message or to a group of messages, follow these steps: 

1. Select the message header (or headers) that you want to answer. 

2. Choose one of the four options from the Reply submenu. 
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A Compose window is opened. Figure 3-30 shows an example of a Compose 
window when To Sender is chosen. 

Figure 3-30 The Compose base window 

Using the Vacation Notifier 

~ Mall Tool: Compose Mess •• e 
, 

(Include V l(Oeliver V l(Header V l(Name Finder." )( Clear) 

To: gerl<Dshargola • 
Subject: Re: " small design proposal 

Cc: 

• ~ 

When you are away from your office for business or on vacation, you can 'use the 
Vacationnotifierthat you access from the Compose menu to automatically respond 
to each email message you receive. Mail Tool provides you with a generic message 
fonn that you can edit and customize to suit your individual needs. Figure 3-31 
shows the Vacation Setup pop-up window with the generic message. 

Figure 3-31 The Vacation Setup pop-up window 
,...~ Mail Tool: Vacation Setup 

., 

~Subject: I am on vacation ':' -
Your mail regarding "SSUBJECT" will be read when I -• return. 

If you have something urgent, please contact ••• 

c:::l 

I (Start) I 
'1. J 

You can edit this message in the same way you edit messages in the Compose 
window. The $SUBJECf part of the message automatically extracts the subject 
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from the message being responded to, and includes it as part of the reply message. 
Figure 3-32 shows an example of a message that has been modified. 

Figure 3-32 A modified vacation message 
r .-();Q Mall Tool: Vacation Setup 

, 
Subject: I am on vacation 

~ Ilm.on vacation from December 18 through 
December 25. 

Your lIIail regarding "$SUBJECT" will be read when I 
return. 

Hope you have a happy holiday season. 

Janice 

i,..., 

I (Start) I 
.~ 

To start the vacation message, click SELECf on the Start button. The word 
"Vacation" is displayed in the header of the Mail Tool window to remind you that 
the vacation notifier is turned on. 

While the vacation notifier is turned on, incoming mail messages are stored in your 
In Tray and are readily available when you return to the office. The vacation 
notifier replies to a sender when that sender is explicitly listed in the To text field. 
It does not respond to individual names that are grouped together under an alias that 
is available for public use. The vacation notifier will respond to names that are 
included as part of a private .mailrc file alias. See "Creating and Using Mail Tool 
Distribution Lists" later in this chapter for more infonnation about aliases. The 
sender is notified only for the first message it receives from an individual for each 
seven-day period. 

Once you have activated the vacation notifier, the Stop item on the Vacation 
submenu is also activated. To stop the vacation notifler and remove the word 
"Vacation" from the header, choose Stop from the Vacation submenu, as shown in 
Figure 3-33. 
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Figure 3-33 

3.9 Saving Changes for 
Mail Tool 

Forward 

To improve system perfonnance, the Mail Tool application does not automatically 
save changes that you make when you close it to an icon. Any messages that you 
have deleted remain available to you when you open the primary Mail Tool base 
window. 

To free up file space and keep your mail box a manageable size, it is a good idea 
to periodically delete obsolete messages and save changes to. renumber your mail 
messages. 

You save changes from the File menu using either Save Changes or Done, as 
shown in Figure 3-34: 

Figure 3-34 . Items on the File menu you use to save changes 

LJ Use Save Changes to commit changes and incorporate new mail without 
closing the primary Mail Tool base window. 

LJ Use Done to close the primary Mail Tool base window to an icon, commit 
changes, and automatically incorporate new mail the next time you open the 
icon. Using Done leaves Mail Tool in a condition that permits you to read mail 
using another mail program without creating conflicts in the mail spooling 
files. 

Mail Tool automatically checks and incorporates new mail messages using a time 
period specified from the Mail Tool Properties window. If you have a long time 
period set and want to see if you have new mail, you can use either the Save 
Changes or the Done items. Choosing Open In Tray from the File menu also 
checks for new mail messages. See "Customizing Your Mail Tool" for more 
infonnation about Mail Tool properties. 
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When you quit the Mail Tool application, a Notice is displayed, as shown in 
Figure 3-35, asking you whether you want to save changes, quit without saving 
changes, or cancel the quit 

Figure 3-35 The quit Notice 

3.10 Customizing Your 
Mail Tool 

The current mail b<»e has been changed 
Do you wish to save the changes? 

(saye{fanges) (Discard Changes) (Ca!iC!T) 

Choosing Save Changes commits the changes and quits Mail Tool. Choosing 
Discard Changes discards changes you have made, reincorporating any deleted 
messages as part of the In Tray, and quits Mail Tool. Choosing Cancel cancels the 
quit 

You can customize some of the properties of the Mail Tool application from the 
Mail Tool Properties pop-up window. You display that window by choosing 
Properties from the Edit menu, as shown in Figure 3-36. 

Figure 3-36 The Properties item on the Edit menu 

The Properties window has four categories of properties, as shown in Figure 3-37. 

Figure 3-37 The four Properties categories 
~ Mall Tool: Properties I 
Display: II Mail ArriYai Pro1)_erties / 

Mall Arrival Properties 

Composition Header Properties 

~ 
Template Properties 

S beep(s) 
Ce neral Properties 

__ \000. 

Each of these menu items has a set of properties associated with it To display the 
properties for each item, choose the item from the Display menu. When you 
release·MENU, the contents of the property window shows the properties you can 
set for that category. The new properties take effect immediately in most cases. In 
a few cases (such as Default Height and Width), you must quit and restart Mail 
Tool before the changes take effect. 
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Mail Arrival Properties 

You must apply changed properties for each category by clicking SELECf on the 
Apply button. 

The Mail Arrival Properties, shown in Figure 3-38, allow you to set how often Mail 
Tool checks for new mail, how you are notified of incoming mail, and whether 
headers are automatically displayed. 

Figure 3-38 Mail arrival properties 

Composition Header 
Properties 

~ Mall Tool: Properties 

Display. @) Mall Arrival Properties 

Check for Mail Every. ~ 1.1.. seconds 

Signal New Mail With: _, _F13 beep(s) 

_0 _ EEl flash(es) 

Automatically Display Headers: I VIS I No I 

You can type a number in the numeric fields or click SELECT on the 
increment/decrement buttons to the right of the field to either increase or decrease 
the value of the number. You can set the numeric values for each numeric field 
from 0 to 9999. 

If you want Mail Tool to automatically display the headers for incoming mail 
messages, choose Yes for Automatically Display Headers. If you choose No, Mail 
Tool does not display headers for incoming messages unless you specifically 
request them by choosing Open In Tray or Save Changes from the File menu. 

When you change Mail Arrival properties, click SELECf on the Apply button to 
apply them to the Mail Tool Application. Mail Arrival properties become effective 
immediately.· . 

You can customize the text fields at the top of the Compose window using the 
Composition Header Properties category shown in Figure 3-39. 
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& Mall Tool: Properties 

Display: @) Composition Header Properties 

eompose with Subject Line: 

Cc Line: 

Bce line: 

I Ves I No I 
I Ves I No I 
I Ves I No I 

(custom fields v) I I.'~ 
Field:. ' ,. 

I i 
I i , I 
I i '"--_____ ....... !t::J 
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To automatically include a Subject, Cc, or Bee line, click SELECf on Yes. To 
exclude a Subject, Cc, or Bcc line, click SELECf on No. 

To create a custom field, follow these steps: 

1. Type the label for the field in the Field line. 

You do not need to type a colon following the label. The colon is automatically 
provided by Mail Tool. 

2. Move the pointer to the Custom Fields menu button and press MENU. 

3. Choose either Add Before or Add After from the Custom Fields menu, as 
shown in Figure 3-40, to put the new field at the top or bottom of the 
existing scrolling list. 

Figure 3-40 Custom Fields menu 
Mail Tool: Properties 

Display: @) Composition Header Properties 

~-----------------------------

neld: N.'-----
Delete 

4. Release MENU. The item is added to the scrolling list. 
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Template Properties 

s. To apply the change to Mail Tool, click SELECT on the Apply button. 

The custom field is added to the header menu in the Compose window, as 
shown in Figure 3-41. 

Figure 3-41 An example of a Custom field on the Add Custom submenu 

Subject: 
----I 

Bee: 

Delete Bee 
Delete Subject 

Name Finder ... 

6. To include the custom label, choose the item from the Add Custom 
submenu. 

Figure 3-42 shows an example of a custom field added to the Compose 
window. 

Figure 3-42 An example of a Custom field added to the Compose window 
Mall Tool: Compose Message 

(Indude V HOeliver V )(Header V )(Hame Finder _ )( Clear) 

To: -----------------------------------------Subject: _______________________________________ _ 
cc:.~ ______________________________ _ 

Icc: 
leminder: ------------------------------

To delete a custom field, click SELECf on the item in the scrolling list, choose 
Delete from the Custom Fields menu, and click SELECf on Apply. 

The Composition Header Properties become effective immediately when you click 
SELECf on Apply. 

You can create your own templates to use when you compose messages. Each 
template is an individual rue that you create outside of Mail Tool using any editor 
such as Text Editor or vi. When you have created the file, you can add it to Mail 
Tool using the Template Properties category, shown in Figure 3-43. 
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tP Mail Tool: Properties 

Display. @) Template Properties 

( Templates v) I Calendar 

Name: Signature 

File: + _____ _ 
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To add a template to the Template menu, follow these steps: 

1. In the name field type the name of the template that you want to be 
displayed on the Compose Include Templates submenu. In this example, 
type Signature. 

2. Press Tab or Return to move the insert point to the File field. 

3. Type the path and name of the file containing the template. 

4. Move the pointer to the Templates menu button and press MENU. 

S. Choose Add Before or Add After from the Templates menu. The item is 
added to the beginning or end of the scrolling list. 

6. Click SELECT on the Apply button. The items in the scrolling list are 
added to the Compose Include Templates submenu. 

A Calendar template is provided as part of the DeskSet installation. If you want to 
use the Calendar template, you must add it to the Template menu yourself 
following the steps above. The location of the Calendar template is: 
$OPENWINHOME/share/xnews/client/templates/calendar.tpl 

Figure 3-44 shows an example of the Templates submenu with two template items. 
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General Properties 

Figure 3-44 The Templates submenu in the Compose window 

To use a template, choose the item from this menu and the text from the template 
file is displayed in the Compose text pane. 

To delete a template name, click SELECf on the name in the scrolling list, choose 
Delete from the Templates menu, and click SELECf on the Apply button. 

The General Properties category, shown in Figure 3-45, allows you to specify 
general properties such as the size of panes, print scripts, the directory for mail 
files, and whether confinnation Notices are displayed when you make changes to 
a mail file. 

Figure 3-45 General properties 

~ Mail Tool: Properties 

Display. @) General Properties 

Default Header Pane Height l2.-'.I •• lines 

Default Header Pane Width: ~ '.1 •• columns 

Default Message Panel Height ~ '.1.. lines 

PrlntScript .;.r;lp..;..r-....Jp~ ____ _ 

Mall File Directory. .;.;..m..;..al..;..;,ld.;.;..lr ____ _ 

Ask For COnfirmations: I Ves I No I 

You can specify the number of lines that are displayed in the Mail Tool message 
header pane, the number of columns in panes for all windows, and the number of 
lines in the pane of the View Message pop-up window. You can also specify a 
different print script and a file for mail rtIe messages. 

Use the Mail File Directory text field to specify the directory where mail files are 
stored when you move or copy them from your In Tray to mail files. Unless a full 
path name is specified, the directory is considered a subdirectory of your home 
directory. If the directory name you specify does not exist, when you click 
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SELECT on the Apply button, a Notice is displayed asking you if you want to 
create the directory. See "Organizing Your Mail Messages" for more infonnation 
about using the Mail File directory. 

If you choose Yes for the Ask for Confinnations setting, a Notice is displayed when 
you have made editing changes to a message in the View window and you display 
a new message or receive new incoming mail. If you choose No, any editing 
changes are automatically incorporated when you display a new message or 
receive new incoming mail without notification. 

When you have changed properties, click SELECf on the Apply button. The 
changes to Mail Tool window sizes from the General Properties category do not 
become effective immediately. They take effect the next time you quit Mail Tool 
and start it again. The Print Script and Mail File Directory properties become 
effective immediately. 

In addition to scrolling through message headers in your In Tray and using the Find 
pop-up window to locate specific messages, you can organize your mail by 
grouping related messages together in a "Mail File." A Mail File is a file that 
contains single or multiple mail messages. If you view a Mail File outside of Mail 
Tool, it looks like a single file with multiple mail messages appended to one 
another. When you view a Mail File using Mail Tool, however, each separate 
message header is displayed in the Mail Tool header pane, and you can view, edit, 
delete, and respond to each message individually. 

Where do these Mail Files reside in your file structure? You specify the.directory 
using the General Properties category in the Mail Tool Properties window. See 
"Customizing Your Mail Tool" for more infonnation about setting properties. Any 
Mail Files that you create in this directory are displayed as items on the Mail File 
menu. If you have not specified a Mail File directory, the Mail File menu will not 
work. 

You can put Mail Files anywhere you like in your rue structure. Typically, many 
users create a subdirectory named ''mail'' in their home directory. Be aware, 
however, that Mail Files you put outside of the Mail File directory specified from 
the Mail Tool Properties window will not be displayed as items on the Mail File 
menu. 

Suppose you want to keep a Mail Flle history of status reports you receive for a 
particular project To create a status report mail file, follow these steps: 

1. Type +statusreports in the Mail File text field, as shown in 
Figure 3-46. 
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Figure 3-46 Creating a new mailfile 
Mall Tool - lusrispool/malllwinsor 

(Compose V) Mall file: (i) +statusr~ports 
~ed Dec 29 15:33 171/7297 Design action items plus 
Thu Dec 21 19:12 2B/627 Re: Design meeting neHt 
Thu Dec 21 19:12 21/561 I am on vacation 

~"""""1(lj,Io( 22 11:95 27/1B64 Meet ¥ed 12127 
22 12:99 98/2519 SQA Status Report 
26 89:53 36/918 Re: Drag and drop Mail T • 

The + sign tells Mail Tool to put the mail file in the Mail File directory that you 
specify from the Mail Tool Properties window. If you type a file name without 
a + the mail file is created in the directory where you started Mail Tool, 
typically your home directory. 

You can also type a complete path name (such as 
/home/username/mail/windows) or a relative pathname (such as 
mail / windows) to put the mail fue somewhere else in your file structure. If 
you type a full or relative path name, do not use the + symbol. Relative path 
names are relative to your current directory, that is the directory from which 
you started Mail Tool. Typically the current directory is your home directory. 

2. Select the items from your In Tray that you want to move or copy to the 
new mail tile by clicking SELECT on the tirst item and then ADJUST on 
subsequent items. 

Figure 3-46 shows one selected item. 

Figure 3-47 A selected message header 
(v] Mail Tool - lusr/spoollmail/winsor 

~ (View V HEdit v) (Compose v) Mall FUe: (2) +statusreports. 

7B schapple@East Yed Dec 28 15:33 171/72B7 Design action .items plus 
71 winsor Thu Dec 21 1B:12 2B/627 Re: D8sign meeting ne~t 
72 winsor Thu Dec 21 1B:12 21/561 I am on vacation 
73 schapple@East Fri Dec 22 11:95 27/1964 Meet Yed 12/27 

I 74 sa1@Dlavland ... fr1 Dec ZZ 12:89 SBIZ519 SOA Status ReDort 
75 winsor Re: " lue Dec 26 99:53 36/918 Drag and dro.J2...!ta il T .. ] 
~ - . - -...;. -
3. Choose Move into Mail File from the File menu, as shown in Figure 3-48. 

Figure 3-48 The Move into Mail File item on the File menu 

.-t:o 
Open 

(print 
Save changes 
Done 

The message is moved to the new fue, and an information message is displayed 
in the footer of the Mail Tool window, as shown in Figure 3-49. 
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Figure 3-49 An information message after a mailfile has been created 

(2J Mall Tool - lusrispool/mall/winsor 

C!I!ill(View V)~ 
79 8chapple@East 
71 winsor 
72 winsor 
73 schapple@East 
75 winsor 
76 winsor 
77 gift@theal1ey 
7B knutson@scylla 
79 winsor 
Be winsor 

·+statusreport~ [New file] 

( Compose v) Mall file: (2) +statusrepo 

~ed Dec 29 15:33 171/7297 
Thu Dec 21 19:12 28/627 
Thu Dec 21 18:12 21/561 
Fri Dec 22 11:85 27/lr. 
Tue Dec 26 89:53 
~ed Dec 27 19:31 
~ed Dec 27 14:eo 
~ed Dec 27 15· 
~ed Dec 27 
~ed Dec 

The Mail Fue menu contains a list of files in your mail file directory and also 
contains a history of most recently accessed mail files. This menu is called the 
Mail File history menu. The history is maintained until you quit the Mail Tool 
application. 

The item +statusreports shown in Figure 3-50 is the history item. It is also included 
as part of the Mail Files submenu. 

Figure 3-50 TheMail File history menu 

Adding Messages to an 
Existing Mail File 

Mail Tool - lusrlspool/mail/winsor 

If you create a new mail fue outside of your mail directory, the file is displayed on 
the Mail File history menu, but is not included as part of the listing in the Mail Files 
submenu. 

If you have a set of mail files that you want to always appear on the Mail File 
history menu, you can specify these fIles in your. rnailrc file in your home 
directory. For example, if you want +statusreports and +openwindows to always 
appear on the Mail File history menu, without having to initially access these mail 
files, you can add the following line to your • mai lr c fue: 

set filernenu='+statusreports +openwindows' 

You can add subsequent mail messages to the statusreports fue in one of three 
ways: 

(] Type +statusreports in the text fIeld, or 

(] Choose +statusreports from the Mail Fue history menu, or 

(] Choose +statusreports from the Mail Flles submenu. 
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Viewing a Mail File 

Sorting the Contents of a 
Mail File 

3.12 Shortcuts 

Pop-up Menus 

Then select the additional mail messages and choose Copy into Mail File or Move 
into Mail Flie from the File menu to append those messages to those already filed 
in the status reports file. 

To view the messages that you have stored in a mail file, follow these steps: 

1. Enter the name of the mail file in the Mail File text field. 

2. Choose Open Mail File from the File menu. 

The messages in the mail file are displayed as separate message headers in the 
header pane of the Mail Tool window. You select and operate on mail fIle 
messages in the same way you select and operate on In Tray messages. 

To return to the In Tray, choose Open In Tray from the File menu. 

You can sort items in your mail files by time and date of receipt, by name of sender, 
or by subject. To sort files, follow these steps: 

1. Enter the name of the mail file in the Mail File text field. 

2. Choose Open Mail File from the File menu. 

3. Move the pointer onto the View menu button and press MENU. 

4. Highlight the Sort By item and drag the pointer to the right to display the 
Sort By submenu. 

S. Highlight Time and Date, Sender, or Subject, and release MENU .. 

The message headers are redisplayed, sorted according to the item you chose. 

To return to the In Tray, choose Open In Tray from the File menu. 

Each application in the DeskSet Environment provides you with the following 
shortcuts: 

o Pop-up menus for each pane contain frequently-used items from the menus in 
the control area. 

o Keyboard accelerators let you perfonn standard core and editing functions 
without moving your hands from the keyboard to the mouse. See Appendix B 
for a list of keyboard accelerators. 

In addition to these shortcuts, the Mail Tool application provides' a standard 
template for Calendar Manager appointments and allows you to create 
personalized distribution lists, called aliases. This section describes pop-up menus 
and tells you how to create templates and aliases. 

In addition to the commands on the Flie, View, Edit, and Compose menus, the Mail 
Tool application provides a pop-up menu in the header pane that contains a subset 
of controls from the File, View, and Edit menus, as shown in Figure 3-51. 
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Figure 3-51 The message header pane pop-up menu 

79 winsor 
ae empcomm@polaris 

1 schappleeEast 
~ Larry.KlugereUK 

@moe 
'~d1restra1ts 

Mall Tool - lusrispool/mall/winsor 

(Vie ..... Messages t» 
Delete 
Moye Into Mall File 
Copy into Mail File 
print 
Find ... 
s(·!·~ E:y I:· 

OeskSet 
EMPLOY 
Meet It. 
QNX 
Re: 
Re: 
Re: 

The View Messages, Delete, Move Into Mail File, Copy Into Mail File, Print, Find. 
and Sort By items work in the same way as already described whether you choose 
the item from a menu button or from this pop-up menu. 

The message header pane pop-up menu has a pushpin that you can use to tum the 
menu into a pop-up window. It then becomes like a moveable control area that you 
can position at your convenience, keeping the choices on this menu visible and 
available to you. 

Alternatively, you can choose any item from this menu without needing to move 
the pointer out of the pane by pressing the MENU mouse button anywhere in the 
pane, highlighting the item you want, and releasing MENU. 

The text editing panes in the View Messages and Compose Messages windows 
contain the standard editing commands from the Text Editor application. 
Figure 3-52 shows the editing pop-up menu. 

Figure 3-52 The Text Pane pop-up menu 

Text Pane 

'File D» 

View D> 

Edit D> 

Find D> 

E)(tras D> 

For a description of the text editing commands, see Chapter 5. 

The Mail Tool application allows you to create your own template files containing 
text that you frequently use for composing messages. DeskSet installation 
provides one standard template for reminders of appointments and meetings that is __ 
compatible with the Calendar Manager application. 

When you create a template document, you can add it to the Templates submenu 
from the Mail Tool Properties window. See '-'Template Properties" earlier in this 
chapter for information about creating your own templates and "Using Templates" . 
earlier in this chapter for information about using them. 
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Creating and Using Mail 
Tool Distribution Lists 

Creating and Using Aliases in 
.mailrc 

You can create your own distribution lists containing groups of user names. 
Instead of typing a distribution list of ten names, you can type the single name that 
you specify as the name of the alias in the To text field. 

There are two kinds of distribution lists, or aliases, you can create on your own 
system: 

o Aliases in your • mai lr c file that only you can use. 

D Aliases in your /etc/aliases file that anyone can use. 

This section describes how to create each of these aliases. 

To create an alias in your. mailrc file, you must edit your. mailrc file in your 
home directory using any text editor. On a separate line in the file, type alias 
aliasnarne username usernarne. Separate each item with a space and end 
the group with a Return. 

Figure 3-53 shows an example of an alias line in a .mailrc file. 

Figure 3-53 An example of an alias group in mailrc 

Creating and Using Local Aliases 
in fetc/aliases 

textedit - (.mailre), dir: /home/wlnsor 

ali as friends a lbert@monkey gene@bigbird fred@skyhi9'l 

When the alias is complete, save the changes. 

To use the alias, simply type the name of the alias (for example, friends) in the 
To, Cc, or Bcc line of the Compose Messages window. The names you typed in 
the rue are expanded and included as part of the outgoing message. 

The Vacation notifier responds to individuals you have liste4 as part of aliases in 
your. mailrc file. See "Using the Vacation Notifier" earlier in this chapter for 

. more infonnation. 

To create an alias in your / et c / alias es fue, you must have root access to your 
system. Edit your / etc/ aliases file using any text editor. Under the Local 
Aliases category, on a separate line, type aliasnarne : username, usernarne. 
Separate each item with a comma and end the group with a Return. You can 
include a space after each comma, if desired. 

Figure 3-54 shows an example of an alias group in fetcfaliases. 

Figure 3-54 An example of an alias group in Jete/aliases 

textedit - (aliases), dir: 'etc 

fr1ends:albertemonkey.geneeb1gb1rd.fredeskyhi9'l 

When the alias is complete, save the changes, type newaliases and press Return 
to record the new alias grouping with the sendmail program. 
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To use the alias, type the name of the alias in the To, Cc, or Bcc line of the Compose 
Messages window. The names you typed in the file are not expanded as part of the 
outgoing message. The alias group itself is displayed as the user name when the 
message is receiVed. To use an alias on someone else's system, type the alias 
name, @, and their machine name in the To line of the Compose Messages 
window. For example, someone else could send mail to the "friends" alias in the 
example by typing friends@castle. 

You can select single or multiple headers in the Mail Tool base window and copy 
or move them to other DeskSet applications. 

You-can drop message headers onto the following destinations: 

CJ File Manager 

[J Text Editor 

[J Print Tool 

[J Tape Tool 

0 Calendar Manager 

0 Mail Tool Compose window 

To drag and drop a copy of a message header, follow these steps: 

1. Click. SELECT on the message header. 

2. Press the Control key and then SELECT. 

3. Release the Control key. 

4. Drag the pointer to the destination. 

A small envelope moves with the pointer to show you that you are dragging a 
mail message, as shown in the example in Figure 3-55. When you select 
multiple message headers, a group of envelopes is dragged with the pointer. 

Figure 3-55 Dragging a copy 0/ a message header 

Man Tool-/usrispool/mail/wiftser 

(File V HYiew V )( Edit V) ( Compos. V) ..... Fie: Iil. 
256 sehappleeEast Fri Jan 26 17:24 154/6281 Mateo drops in on us 
257 lauevision Fri Jan 26 18:16 28/691 Re: suggestion for displ. 
258..,l1Hamaea1thea Fri Jan 26 19:28 72/2278 o.skSet Online Help: Sta 
259 sehappleeEast Sat Jan 27 17:56 1SS/~529 Draft of Typographic ConY 
268 Mailer-Daemon s..m Jan 28 89:26 19115373 Returned un: User unkno 
261 winsOf" Sun Jan 28 89:31 2-t8/15821 (E) Encoded Mail Me.sages 
262 Mailer-Daemoneeafro Sun Jan 28 89:32 197/5693 Returned .afl: Remote 

un an : 
Sun Jan 28 e9:~6 228/6385 

264 messages, 0 new, 0 deleted 

s. Release SELECT. 
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Warning: 

3.14 Troubleshooting 

To move message headers, follow these steps: 

1. Click SELECT on the message header. 

The header is selected. 

2. Press SELECT. 

3. Drag the pointer to the destination. 

4. Release SELECT. 

Ifl0U move message headers anywhere outside of the Moil Tool In Tray, the 
messages are deleted from the Mail Tool In Tray. You can, however, recover 
these messages from the Undelete pop-up window as long as you have not 
saved changes to Mail TooL 

You can schedule appointments in Calendar Manager by dropping a copy of a 
message header onto the Calendar Manager icon or window. See Chapter 4 for 
more infonnation about the Calendar Manager application. 

The Mail Tool Compose window accepts dropped files from the File Manager and 
Text Editor. 

It is not a good idea to run multiple versions of Mail Tool at the same time. 
Running multiple Mail Tool applications can cause the system to become confused 
about the state of the mail spool file that keeps track of messages in your In Tray. 
If you make changes and choose either Save Changes or Done from the File menu, 
that infonnation is used to modify messages in your In Tray. When you have made 
changes using different versions of the Mail Tool application, or the Mail program, 
it is possible that you could lose messages that you intended to save. 

You can avoid confusing Mail Tool about the state of your IIi Tray by getting into 
the habit of choosing Done from the File menu at the end of each day, or when it 
is likely that you will be logging into your machine and reading mail from a remote 
location. 

If you forget to choose Done, and log into your machine to read mail, you can tell 
Mail Tool to choose Done by following the steps below: 

1. From a shell prompt type ps -ax I grep mailtool and press Return. 

The listing should look like the one shown in Figure 3-56. 

Figure 3-56 An example of a ps listing/or mailtool 

[65]castle{w1nsor}S ps -ax I grep ma11tool " 
413 co I 2:18/home/sundesk/b1n/ •• /b1n.sun4/b1n-20/mailtool 

11935 p1 S B:BB grep ma11tool 
[66]castle{w1nsor}S 
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2. Look in the left-hand column of the listing for mailtool (not the listing for 
grep mail tool) to find the process number (PID). 

The process number is the first number on each line. 

3. Type kill -30 PID and press Return. 

In the example above, the process number is 413, so you would type: 
kill -30 413 

4. Read your mail as you normally do from the remote location. 

The next time you open your Mail Tool, the changes you make to your In Tray 
from the remote location are incorporated and recorded as part of the Mail Tool 
application. 

The steps above only work with the DeskSet Mail Tool application. Using these 
steps/or other versions of Mail Tool wiU kill Mail TooL 

The Mail utility uses a lock file to prevent two or more processes from altering your 
mail spool file at the same time. HMail Tool quits unexpectedly and takes the Mail 
utility with it, the lock file may be left behind. 

If Mail Tool takes a long time to open the In Tray, either when you specifically 
request it or when you open Mail Tool after you have chosen Done from the File 
menu, check /var / spool/mail for a file named username .lock, where 
username is your login name. To remove the file, from a system prompt, type 
rm /var / spool/mail/ username .lock and press the Return key. For 
example, if your username is "fred", you would tyt>e 
rm /var/spool/mail/fred.lock. 

Mail Tool lets you select and print several mail messages at one time. This uses a 
lot of swap space, which can potentially cause your server to crash. Therefore you 
should not select more than five messages to be printed simultaneously. 
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4.1 Calendar Manager 
Views 

Icon 

Figure 4-1 

4 
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Calendar Manager 

The Calendar Manager application is an appointment and resource scheduling tool 
with the following features: 

o Displays a day, wee~ month, or year at a glance 

o Schedules a single or repeating event 

o Provides the following reminders of events that can be used individually or 
combined with one another: 

• Beeping, flashing, and/or opening a Reminder pop-up window 

• Sending a reminder mail message about an appointment 

o Specifies security for your appointments 

o Accesses, browses, and edits the calendar appointments of other users 

o Prints high-quality output 

This chapter describes these features of the Calendar Manager. 

The Calendar Manager provides different ways to view your calendar 
appointments. This section describes all the ways you can view the calendar. 

When the Calendar Manager application is displayed as an icon, it shows the 
current month with the current date highlighted, as shown in Figure 4-1. The 
current month and date are displayed in the icon regardless of the view you choose 
to display when the Calendar Manager window is open. 

An example of the Calendar Manager icon 

May 1990 
S M T W T F S 

12345 
6 7 8 9 10 11 fj]] 

13 14 15 16 17 18 19 
20 21 22 23 24 25 26 
27 28 29 30 31 
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Window The Calendar Manager base window has a control area and an area for displaying 
the calendar in the view you choose. The default display is the current month at a 
glance, which shows appointment scheduling for a one-month period. You can, 
however, change the default from the Properties window. See "Customizing Your 
Calendar Manager" later in this chapter for more information on changing defaults. 
Figure 4-2 shows an example of the default Calendar Manager window. 

Figure 4-2 An example of the default Calendar Manager window 
(!) calendar Manager: "renda.Jungle 

( View v) Q!lI!) ( Browse v) ~ ( Prey) ( Today) ( Next) 

MavlS90 

:tun !llton Tue wea ThU ft'l :tat 
1 2 3 4 5 
2~0 SUfl'III 12:15 LullC" wi 

6 
10100 DukStt • 9 10 11 12 

2100S~III 11:30 IIIurvit 
2100 NUtllttt 12100 ,,"ifs I 
no User tt 

13 14 15 16 17 18 1$ 
10100 DeskSet 2:Dt Stlfl'III First Drift De Dav Off J:OOOlle~II-

430 ,ellllV. 1030 Monttrev 

20 21 22 23 24 25 26 
':00 STC/ITC ':00 STC/ITC '100 STC/ITC 

10100 DeskSet 2~O St.n III 

27 28 29 30 31 
Melllorial DaV 2lO0 SUfl'III 11:30 IUllch- 1UI0 It'" lilt 

Copyright (c) 1987-1990 Sun Mlcrosystems, Inc. 

Note that one appointment is displayed for each line and the text for the 
appoinunents is clipped to accommodate the size of the date box. 

The current day is automatically selected when you open the Calendar Manager 
window. A day that is selected has a double border. In Figure 4-2, above, May 7 
is the selected day. You can select any other day by pointing to a different day and 
clicking SELBCf. 

TIle base window has resize comers that you can use to change its size. If you want 
to display more information on each line, use one of the resize comers to stretch 
the window horizontally, as shown in Figure 4-3. 
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Figure 4-3 A Calendar Manager window that has been resized 
(!) CaIeMar Manqer: a.,.IId .. julttle 

( Vie .... 9) ~ ( Browse v) ( Print 9) ( PrlIY) (Today) ( Next) 

MaVllM 

sua 
_ n 

T _ 

wea TlUI 11'1 sat 
1 2 l .. 5 a .. fIUIf __ 

12:'15 LeIlClo"Ie 

S .~ .. ~IkStt Mettl • I 11 11 12 
a .. SItIII'r_ftiII '1:l11-'.w~, 

Z"N4rIIIet!t 12 .. AIIII','ullct. 
J"uHrteftillt 

13 14 15 tS 17 ,. tI 
, ... ~1kS« Mttd Z .. Sltlll'rMt_ FlmOriltl>efkSet oey Off '''OII_" __ 'tIf _P'H"' •• , ":lI~'f"""" 

2e 21 22 23 24 25 25 
, .. STC/lTCCeM , .. STC/lTCC C .. t .. STC/lTCC eM ta" ~ .... « Mud Z .. sulf_ttift 

27 2. 21 30 31 
IIIe_Wo." z ... .,,_ftiII ,131-.cft-Uft! " ... ." .. ettiflg 

Copyright (d 1917-1190 Sun Mi0"8systems, Inc. 

If you want to increase the number of lines for appointments, use one of the resize 
comers to stretch the window vertically. 

The Navigation Controls The control area of the Calendar Manager application has three buttons at the right, 
shown in Figure 4-4, that you can use to browse quickly through the view of the 
calendar currently displayed. 

Day View 

Figure 4-4 The navigation control buttons 

\\---=-----....=---.,.,=--
l~(§D~ 
\.. ---" 

Clicking SELECf on Prev moves the view (whether it is day, week, month, or 
year) backward one unit. Oicking SELECf on Next moves the view forward one 
unit Oicking SELECT on Today returns you to "today." 

The day-at-a-glance view is useful when you have many appointments scheduled 
for a single day. To change the view in the Calendar Manager window so that it 
displays appointments for one day, follow these steps: 

1. Move the pointer into the rectangle for the day you want to view and click 
SELECT. 

2. Move the pointer to the View menu button. 

3. Press MENU. 

4. Drag the pointer to highlight the Day item on the menu, as shown in 
Figure 4-5. 
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Week View 

Figure 4-5 Highlighting the Day item 

s. Release MENU. 

The view in the Calendar Manager window changes to display the selected day. 
Figure 4-6 shows an example of a day display. 

Figure 4-6 A day view 
Ii) caleltd_ "' ..... er. 1M'e ...... j .... I. 

( View v) ~ (Broows. v) ( Print v) (§ (Today) ( Next) 

Me .. 1Iav "'av 7,1'. 

• "'orlll", • After_II 

7 12 
.111 11111 

• 1 
~ .. ,nil 

a=oo - 2:10_. 
t 2 o« ... vitw 

fa .. 11111 

,e:oD-u:oo ••• u .. _ ... a:oo- ......... t ......... t ... 
1. '_k Cetot.renct ~ :I j4IIIin'lofI'ict 

fa .. PIlI ,,., ,..,11 .,mlo .. 

11 4 
fa III II'" 

S 
p. 

, 
11111 

Cepyrltht Cd 1117-1'. h .. MIcrosYSteMS,I.c. 

You can set the range of hours that are displayed for the day view from the 
Properties window. See "Customizing Your Calendar Manager" later in this 
chapter for more infonnation. The day view displays all the information you enter 
about the appointment in the Appointment Editor pop-up window, not just the first 
line. See "Scheduling and Editing Appointments" later in this chapter for more 
information about the Appointment Editor. 

To change the view in the Calendar Manager window so that it displays 
appointments for one week, choose Week from the View menu. 

The view in the Calendar Manager window changes to display the week containing 
the current date, as shown in Figure 4-7. The week view in the lower left corner of 
the window shows you the blocks of time allocated for appointments during the 
week. 
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Figure 4-7 A week view 
(!J Calendar Mana.er: .. ,. .. daeJungle 

( View v) @§ ( Browse v) ~ ( Prey) (Today) (Next) 

Week Starting May 7,1990 

Monday 7 Tuesday' WednesdayS Thursday 10 fto'idayll 

1~;;.!!ti~ ~.-a:oo,. 
IIIUti ... 

11:3DUt-1z:..,. 
IllUrvlew apps 1110 

z:oo,.-z:..,. 1 z:oo,.-1:IOo,. 
N&IInettt Anlrs lunch 
",.-4:00,. 
User ttstlnl IIIUt 

• C!!:1 
T W T F S S Saturday 12 Sunday 13 

10 I I I 8:309.-.:00,. 

1,- I I 
Silllpsons 

12 • 1 
2 

a 4-
5 

• 
"I 

• 
• ...... 

Copyright (c) 1987-1990 Sun Microsvstems,lnc. 

Alternatively, you can point to the number for an individual day in the Month view 
and click SELECf to change the view to the week containing that day_ 

To change the view in the Calendar Manager window so that it displays the 
calendar for the current year, choose Year from the View menu. 

The view in the Calendar Manager window changes to display the current year. 
Figure 4-8 shows the Calendar Manager window with 1990 displayed. 
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Figure 4-8 A year view 

4.2 Scheduling and 
Editing 
Appointments 
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The Calendar Manager provides year-at-a-glance views for the years 1970 through 
1999. 

You schedule appointments from the Appointment Editor pop-up window. You 
display the Appointment Editor window by selecting a day and choosing 
Appointment from the Edit menu, as shown in Figure 4-9. 

Figure 4-9 Choosing Appointment from the Edit menu 

C Print v) 

13 14 
130 simpsons 10:00 DeskSet 

Alternatively, you can double-click SELECT on an hour (for Day view) or a day 
(for Week or Month view) to display the Appointment Editor. 

Note that clicking SELECf when the pointer is on any date number in the Month 
view changes the view to a Week view and does not display the Appointment 
Editor. This is a quick method to display the Week view, as described in the "Week 
View" section earlier in this chapter. 

The Appointment Editor pop-up window automatically displays the selected day 
and lists scheduled appointments in the scrolling list, as shown in Figure 4-10. 
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Figure 4-10 The Appointment Editor pop-up window 
eM Appointment Editor 

10:00 OeskSet Meeting ~. 
2:00 Nannette 
3:00 User testing meetl 

Date: Mon May 7.1990 

What: • ________ _ 

Start 

End: 

(!) ~I AM I PM I 
(!) ~ I AM I PM I 

Repeat: None Dally 

Weekly Biweekly 

Monthly Vearly 

lemlnder:@Advance:_s_mlnSRepeat:(!) __ 

I Flash I L- mlns 

I Open I ~ lItitlS 

~ , hours Mall To; t"·"rl'~3.~IIJrt91" 

onsert) ( Delete ) ( Change ) ( Defaults ) 

-

The Appointment Editor pop-up window has the following controls: 

CJ A Date field that automatically displays the selected date. You can type in 
another date to schedule additional appointments using any fonnat described 
in the next section, "Entering a New Appointment". Note that there are several 
acceptable fonnats, and that you do not have to type in the day of the week 
even though the day of the week is displayed. 

o A What field in which you type infonnation about the appointment. The first 
line of this field is displayed in the Month view, so the first line should describe 
the appointment You can also include details about the appointment in this 
field, such as the appointment place, a brief meeting agenda, or a reminder to 
bring something to the appointment 

o A scrolling list that displays existing appointments for the selected date. 

CJ A Start and End set of controls that you use to set the time of the appointment 
You can either use the time menu or type in a number in the text fields. The 
time menu is available via the Start and End abbreviated menu buttons. The 
choice of times on this menu is detennined by the Day Bounds settings from 
the Properties window. See "Customizing Your Calendar Manager" later in 
this chapter for more infonnation. When you set a start time, the end time is 
automatically set to one hour later. IT the appointment is longer than an hour, .-. 
you can set a different end time by choosing a time from the time menu or by 
typing a time in the text field. The last choice on the time menu is "None", 
which you can use if you don't want a time associated with an appointment 
This is useful for "to do" list items or reminders, such as "Report Due", or 
appointments that refer to the entire day, such as "Memorial Day." 
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Entering a New 
Appointment 

o Repeat controls that you use to indicate whether the appointment is individual, 
daily, weekly, biweekly, monthly, or yearly. When an appointment repeats at 
a regular interval, you can set the number of times the appointment is repeated. 

a Reminder controls that determine how you are reminded of an appointment 
You can use as many of the reminder controls as you like for each appoinnnent. 
In the example shown in Figure 4-11, Beep, flash and Open are set. Mail is 
not set. Note that the Mail To text field is inactive and therefore dimmed. 
When you click SELECf on Mail, the text field is automatically activated. 

Figure 4-11 The Reminder settings in the Appointment Editor window 

Iteminder: I Beep I Adyance: 5 mlns 

I Flash 5 mins 

I Open 5 mins 

I Mail 2 hours Man To: wlnsorClcastle 

D Advance text fields that determine how far in advance of an appointment a 
reminder action takes place. 

D Insert, Delete, Change, and Defaults buttons that you use to enter, remove, or 
modify appoinnnents. 

You can change the default settings for the Appointment Editor pop-up window 
from the Calendar Manager Properties window. See "Customizing Your Calendar 
Manager" later in this chapter for more information about properties. 

To enter a new appointment on the day displayed, follow these steps: 

1. If the caret is not already positioned in the What text field, move the 
pointer into the text field and click SELECT. Type information about the 
appointment. 

You can type up to 255 characters on each line. 

2. To set the time, move the pointer to the Start text field, click SELECT to 
set the insert point, and type in a time. If necessary, click SELECT on the 
PM setting. 

Alternatively, you can move the pointer onto the abbreviated menu button and 
press MENU to display a menu from which you can choose hours that are 
detenninedby the setting of day boundaries from the Properti~ window. See 
"Customizing Your Calendar Manager" later in this chapter for more 
information 

Each hour item has a submenu with 00, 15, 30, and 45 minute items. 
Figure 4-12 shows the Time menu and a submenu. 
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Figure 4-12 The Time menu and a submenu 

Highlight the time you want and release MENU to enter the time in the text 
field. When you choose a time from the menu, the correct AM or PM setting 
is automatically chosen for you.. If you choose "None", no time is associated 
with the appointment. 

3. The time in the End text field is automatically set to one hour later than 
the time in the Start text field. To change the duration for the appointment 
from the default of one hour, move the pointer to the End text field, click 
SELECT to set the insert point, and type in a. time. If necessary, click 
SELECT on the PM setting. 

Alternatively, you can move the pointer ontO the abbreviated menu button and 
press MENU to display the time menu as described in Step 2. 

4. If the appointment is one that is repeated on a regular basis, choose the 
appropriate Repeat setting by moving the pointer onto it and clicking 
SELECT. 

You can choose repeat intervals of None , Daily, Weekly, Biweekly (every two 
weeks), Monthly, or Yearly. 

5. When Repeat is set to None, the Repeat text field is inactive and is dimmed 
to show you that it will not accept input. 

When you choose a repeating appointment, the Repeat text field and 
abbreviated menu button are active and the units are displayed following the 
text field, as shown in Figure 4-13. 

Figure 4-13 The Repeat lextfield 

repeat-.................................... 
None Daily 

Weekly Biweekly 

Monthly Vearly 

~~~~~~!: ...... ®. ... ~~ ............. !!!~~!~~; 
You can choose the number of times you want the appoinunent to repeat. For 
example, you may know that a weekly meeting will be scheduled for the next 
two month period. Move the pointer onto the abbreviated menu button and 
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press MENU to display a menu containing repeat items from 2 through 14 and 
"forever". Highlight the item you want and release MENU to enter the repeat 
rate in the text field. 

Alternatively, you can move the pointer to the Repeat text field and type in a 
number. The default number usually sets the appointment to repeat for a year. 
For example, the default number is 365 when the repeat interval is Daily, or 52 
when the repeat interval is Weekly. The default number for the Yearly setting 
is two years. If you want the appointment to repeat indefinitely, you can type 
the word "forever" in the text field. 

6. Choose the way you want to be reminded of this appointment. 

You can set none, some, or all of the Reminder options. Beep and Flash cause 
the Calendar Manager icon to beep and flash if it is closed. The Calendar 
Manager window itself will beep and flash if it is open. If you choose Open, 
at the time specified for Open the appointment Reminder pop-up window is 
displayed showing the appointment infonnation. Figure 4-14 shows an 
example of the Reminder pop-up window. 

Figure 4-14 An example of the Reminder pop-up window 

.~ Calendar: Reminder 

sn/90 

from 3:45 to 4:45 

Staff meeting 

Bldg 5, Bradbury Conf Rm 

Take Design Committee 

material for status 

presentation 

Choosing the Mail setting automatically mails a reminder to the email 
addresses you type into the To text field. 

7. You can change the Advance times by typing a new whole number into the 
appropriate text field (decimals and fractions are not accepted formats). 

You can also change the default Advance times from the Properties window. 
See "Customiz~g Your Calendar Manager" for more infonnation. 

8. When you have entered all the information for the appointment, click 
SELECT on the Insert button. 

The appointment is added to the scrolling ~st in the Appointment Editor 
window and to the Calendar Manager window. 

If you want to enter appointments for another day t double-click SELECf on the 
new day in the Calendar Manager base window or type a new date in the Date field 
using any of the fonnats listed below t and then follow the preceding steps. 
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You can type a new date using the following date fonnats: 

Cl MM/DD/YY or MID/YY (for example, 10{l6!90 or 7/5/90) 

(] Mon Day, Yr or Month Day, Year (for example, Aug 26, 90 or August 26, 
1990) 

Cl Day Mon Day, Yr (for example, Sat May 12, 1990) 

(] Today 

(] Tomorrow 

Cl Yesterday 

(] Next Weekday (for example,Next Wednesday) 

(] Last Weekday (for example, Last Wednesday) 

When you are finished with the Appointment Editor window, dismiss it by cliCking 
SELECf on the pushpin or choosing Dismiss from the pop-up Window menu. 

To delete an existing appointment, follow these steps: 

1. Select a date and display the Appointment Editor pop-up window. 

2. Move the pointer over the appointment in the scrolling list that you want 
to delete and click SELECT. 

The appointment is highlighted, as shown in Figure 4-15, the appointment 
infonnation is displayed in the What field, and the author of the appointment 
is displayed in the footer. 

Figure 4-15 An Appointment Editor window with a highlighted appointment 
~ CM Appointment Editor 

Date: Mon May 7,1990 
~ 0:00 OeskSet Meeting I ~ What: OeskSet MeetinS1e 2:00 Nannette 

Bartok Conference Room 
3:00 User testing meeti 

~ -
C'iM!rt) ( Delete) ( Change) ( Oefaults ) 

Author: 'renda_Jungle 

If you want to delete several appointments at one time, click SELECf on each 
additional appointment you want to delete. 

3. Move the pointer onto the Delete button and click SELECT. 

The appointment is deleted from both the scrolling list and the Calendar 
Manager base window. 
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Editing an Existing 
Appointment 

If you select a repeating appointment and click SELECT on the Delete button, a 
Notice is displayed, as shown in Figure 4-16, allowing you to delete the 
appointment for the selected date only, for all dates, or to cancel the operation 

Figure 4-16 The Notice/or repeating events 

The appointment 
10:00 OeskSet Meeting 

Is part of a repeating series. 
00 you want to delete? 

To edit an existing appointment, follow these steps: 

1. Select an hour (from a Day view) or a day from a Week or Month view and 
display the Appointment Editor pop-up window. 

Unless you have made a selection, the Appointment Editor displays 
appointments for the current date. 

2. Point to the appointment in the scrolling list that you want to edit and click 
SELECT. 

The appointment is highlighted, the appointment infonnation is displayed in 
the What text field, and the author of the appointment is displayed in the footer. 

3. Change the information in the Appointment Editor window to reflect the 
new information for the appointment. 

4. Move the pointer onto the Change button and click SELECT. 

The changes you made to the appointment are made to both the scrolling list 
and the Calendar Manager base window. 

If you select a repeating appointment and click SELECT on the Change button, a 
Notice is displayed allowing you to change the appointment for the selected 
appointment only, for all appointments in the repeating series, or to cancel the 
operation. 

Note that the Date entry cannot be changed for all appointments in a repeating 
series. If, for example, you want to change a repeating meeting from every 
Tuesday to every Wednesday, you need to first delete the repeating appointment, 
then reinsert it on the new day_ 
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You can customize the following parts of the Calendar Manager application from 
the Properties window: 

o Editor Defaults, for the Appointment Editor pop-up window. 

o Day Boundaries and View, to specify boundaries for the Day view, time 
ranges on the Start and End menus in the Appointment Editor window, and the 
default View setting for the Calendar Manager base window. 

o Browser Calendars, the set of user names automatically displayed on the 
Browse menu of the Calendar Manager base window and in the Browse pop­
upwiodow. 

o Access List and Pennissions, to specify security access defaults. 

The Properties window has four separate displays that you use to modify the four 
different sets of properties listed previously. Figure 4-17 shows the Properties 
window with the default display of Editor Defaults. 

Figure 4-17 The Editor Defaults Properties window 

~ eM Properties 

Display: iii Editor Defaults 

lemlnders: ~ Advance: _5 _ mlns 

~ _5_ mins 

_5_ mins 

, hours 

( APply) C§D ( Defaults ) 

You display the Properties window by moving the pointer into the control area or 
pane of the Calendar Manager window and pressing the Properties key (L3) on the 
keyboard. You can also display the Properties window by choosing Properties 
from the Edit menu. 

You use the Display menu to choose a set or category of properties to display, as 
shown in Figure 4-18. 
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Figure 4-18 The/our Calendar MfJIUlger Properties categories 

Editor Defaults Properties 

S51 eM Properties 

Display. &. Editor Defaults 

Remind Editor Defaults ",Ins 

Day 90undarJes and View ",Ins 
Browser Calendars 

",Ins 
Access List and Permissions 

""-- -- hOU~ 

--To display a particular category of properties, choose the appropriate item from the 
Display menu shown in Figure 4-18. When you release MENU, the contents of the 
property window shows the properties you can set for that category. 

When you have changed properties, you must apply them by clicking SELECf on 
the Apply button. This only applies the properties currently displayed. To change 
properties of a different category, display the new category, change the desired 
settings, and click SELECf on the Apply button again. . 

The Editor Defaults properties, shown in Figures 4-17 and 4-19, specify the 
defaults for the Appointment Editor pop-up window. When you set the editor 
defaults from the Properties window, they are automatically set each time you 
display the Appointment window. 

Figure 4-19 The Editor Defaults Properties 
~ eM Properties 

Displav: @) Editor Defaults 

Reminders: ~ Advance: _5 _ mlns 

~ _5_ mins 

lopen I _5 _ mins 

~ _1_ hours 

( Apply ) Ci§'8D ( Defaults ) 

To change the defaults, click SELECf on the settings you want Click SELECf in 
the text field and type a new number. Figure 4-19 shows an example of the 
Reminders with Beep, Flash, and Open set . 

When you click SELECf on the Apply button, the new defaults become effective 
immediately. Changing the Reminders or Advance settings does not affect any 
appointments that have already been scheduled using the old default choices. 
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The Day Boundaries and View controls, shown in Figure 4-20, specify the 
boundary times for your day, and the default View setting for the Calendar 
Manager base window. 

Figure 4-20 The Day Boundaries and View Properties 

Changing the Day Boundaries 

NOTE 

~ eM Properties 

Display. @) Day Boundaries and View 

Dav Boundaries 

Begin: --0====::::::1 7:D0 a.m. 

End: ~ 7:D0 p.m. 

Default View 

Show: I Year I Month I Week I Day I 

( APply) ("'R!S!D ( Defaults) 

You can specify the range of hours for both the Day view in the Calendar Manager 
base window and the Start and End time menus in the Appointment Editor window 
using the Day Boundaries sliders shown in Figure 4-20. 

The current value is displayed to the right of each slider. To change the setting, 
follow these steps: 

1. Move the pointer to the slider drag box (the open rectangle) and press 
SELECT. 

2. Drag the pointer to the left or to the light. 

Note that the time changes as you drag the slider. The pointer is "locked" onto 
the drag box as long as you keep SELECf pressed. 

3. When the time you want is displayed, release SELECT. 

Alternatively, you can move the pointer onto the slider bar to the left or right of the 
drag box and click SELECf to change the time hour by hour. 

You cannot set a day boundary that ends before it begins. When the values overlap, 
the drag boxes are synchronized and move together so that the end time is always 
at least one hour after the start time. 

When you have set the day boundaries, click SELECI' on the Apply button to 
record them. The changes are applied and take effect immediately. 

Figure 4-21 shows the sliders with the day boundaries set for 8 AM and 5 PM, and 
the Day view and Appointment Editor menus that are affected. 
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Figure 4-21 How the Day Boundaries sliders affect Calendar Manager 
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You can set the default view of the Calendar Manager base window to Year, 
Month, Week, or Day using the Default View settings show~ in Figure 4-22. 

Figure 4-22 The Properties window Default View settings 

Browser Calendars 
Properties 

Default View 

Show: I Year I Month I Week I Day I 

To change the default view, click SELECf on the setting you want and then click 
SELECf on the Apply button. The change is applied and takes effect immediately. 

You can use the Calendar Manager to display and edit appointments for other 
users. The user names (login and system name) you enter in the Properties window 
are recorded and displayed on the Browse menu of the Calendar Manager base 
window. If you quit the Calendar Manager application and start it up again, the 
login names on this scrolling list remain available on the Browse menu. 

See "Browsing Remote Calendars" later in this chapter for infoIDlation on how to 
browse. Use the Browser Calendars scrolling list and the Name button and text 
field, shown in Figure 4-23, to enter and edit the login names of those users whose 
calendar appointments you access most frequently. 
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Figure 4-23 The Browser Calendars Properties 

Adding Users to the Browser 

tP eM Pro pertles 

Display. ~ Browser Calendars 

~ 
c:::J 

Name ~ 

( APply) C Reset) ( Defaults ) 

New user names are displayed on the Browse menu in the order you enter them in 
the Browser Calendars scrolling list If you plan to add a number of user names to 
the Browse menu at the same time, you might want to enter them in an order that 
makes sense to you. Consider entering the most frequently accessed names first, 
putting the names in alphabetical order, or grouping them by departments. 

You add other users following the steps below: 

1. In the Name field, type the email address of the user you want to add to 
the Browse menu (for example, 8ug@cobra). 

2. Press Return to add the name. 

Alternatively, you can choose Add from the Name menu, as shown in 
Figure 4-24, or from the scrolling list pane pop-up menu. 

Figure 4-24 Choosing Add/rom the Name menu 

(iI eM Pro perties 

Display. ~ Browser Calendars 

I ~ 
I II n::::::J 

Name II sU9~cobra.. 

--I Delete 

( APply) ( Reset) ( Defaults ) 

The name is added to the scrolling list, as shown in Figure 4-25. 

Revision A of 11 Iune 1990 



110 DeskSet Environment Reference Guide 

Figure 4-25 The Browse scrolling list with a user name added 
~ eM Properties 

Display: ffi Browser Calendars 

SU9~(obra I~ 
I 
I 

~------------------~!~ 
Name ffi ~SU~9~~~(o~b~r, __________ _ 

( Apply) ('Re"S'et) ( Defaults ) 

You can enter any user name in this scrolling list. To improve system and network 
perfonnance, the Calendar Manager does not confinn that the user name is valid or 
that the appointments for that user name are available when you enter that user 
name in the Browse scrolling list Calendar Manager does this checking when you 
choose the Browse option from the Browse menu or the Browser pop-up menu. 

When you have completed adding names to the Browser scrolling list, click 
SELECT on the Apply button to record the changes. These changes are not 
automatically displayed, since the Calendar Manager only looks at the list of 
browser calendars when you start it To display these changes as part of the 
Calendar Manager, quit and restart the application. The changes are reflected in 
both the Browse menu and the Browser pop-up window, as shown in Figure 4-26. 

Figure 4-26 How the Browser Calendar properties affect the Calendar Manager 
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( View v) ( Edit v J I ( Print v 

(Browse ... 
) ,. Name: SU2~(ob!3. 

wlnsorCicastle 
sugClcobra wlnsorClcastie 

~ June 1990 ~U9ClCobra I 
SUD MOD Tue Wed 

I 4 I • ... 
,.: •• 0'1 1 ... 1 '1:1. , •• 

;;;: :::#"" 4=-. It& 

c::BD ( Delete ) C§S!) 

a. II aa u 
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.... - -- ------' 
Deleting Users from the Browser You delete a user name from the Browse menu by following these steps: 

1. Display the Properties window. 

2. Choose Browser Calendars on the Display menu. 
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3. Point to a name in the scrolling list and click SELECT to select it. 

4. The line is highlighted. 

5. Choose Delete from the Name menu, as shown in Figure 4-27, or from the 
scrolling list pane pop-up menu. 

Figure 4-27 Choosing Delete from the Name menu 

Access List and Permissions 
Properties 

NOTE 

~ eM Properties 

Display: @) Browser Calendars 

I !=; 
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I I~ ,. , i , I 
I I , 
I I 

I 
I i.., 

Name ~br. Add 
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6. To record the changes to the Browser Calendars scrolling list, click 
SELECT on the Apply button. 

The names are not deleted from the Browse menu until you quit Calendar Manager 
and start it up again. 

The Calendar Manager browser allows you to browse the appointments for others .. 
as well as allowing other users to browse your appointments. See 4cBrowsing 
Remote Calendars" later in this chapter for more infonnation about browsing. 

The Access List and Pennissions properties let you specify who may browse or 
change your appointments. 

The permissions you give to a user apply to all of your appointments. If you give 
someone permission to change your appointments, that user will be able to change 
all your appointments, not just specific ones. Make sure the user is trusted before 
providing Insert or Delete permissions. 

The default access list,-shown in Figure 4-28, gives all users permission to browse 
your calendar, but not to insert or delete appointments. 
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Figure 4-28 Access List and Permissions Properties 

Adding Users to the Access List 

~ eM Properties 

Display. @) Access List and Permissions 
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Name@) .... _______ _ 

Permissions: I Browse I I Insert I I Delete I 

( APply) Q!!!D ( Defaults ) 

The scrolling list displays a list of everyone who has access to your calendar. The 
entry "world" means everyone who is using the DeskSet Environment. If you 
delete the world entry, only the users you specifically add will be able to read your 
appoinunents. 

To the right of each name in the scrolling list are letters indicating the pennissions 
that user has. The available pennissions are "B" for Browse, meaning the user can 
read your appoinunents, "1" for Insert, meaning the user can insert new 
appoinunents in your calendar, and "D" for Delete, meaning the user can delete 
existing appointments from your calendar. 

If you give more pennissions to the world than you give to an individual, that 
individual will still have the world pennissions. For example, if you give a user 
named Jim pennission to browse your calendar, but the world has pennission to. 
browse and insert, Jim will inherit the world pennissions and will be able to insert 
appoinunents as well as browse your calendar. 

If you give someone both Insert and Delete pennission, that person can also edit or 
change existing appoinbnents. The name of the person who most recently edited 
an appoinunent is displayed in the footer of the Appointment Editor window when 
that appointment is selected. 

You add to and delete users. from the Access List in the same way as you do for the 
Browser Calendars scrolling list You can also change the existing pennissions for 
a user already on the Access List The methods of editing the Access List are 
described below: 

To add a user, follow these steps: 

1. In the Name field, type the email address of the user you want to add. 

2. Select the permissions you want to give the user. In Figure 4-29, Browse, 
Insert, and Delete are all selected. 
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3. To add the name, choose Add from the Name menu, as shown in 
Figure 4-29, or from the scrolling list pane pop-up menu. 

Figure 4-29 Adding a name to the Access Ust 

Deleting Users from the Access 
List 

Changing the Access List 

~ eM Pro pertles 
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4. Repeat the first three steps to add other users. 

5.. When· you have completed the list, click SELECT on the Apply button to 
record the changes. 

To delete a user, follow these steps: 

1. Click SELECT on the user name in the scrolling list. If you want to delete 
several users at one time, click SELECT on each additional user name you 
want to delete. 

2. Choose Delete from the Name menu or the scrolling list pane pop-up 
menu. 

3. Click SELECT on the Apply button to record the changes. 

To change the existing pennissions for a user already onthe Access List, follow 
these steps: 

1. Click SELECT on the user name in the scrolling list. 

You can only change the pennissions for one user at a time. If you click 
SELECT on more than one user, the Change item on the Name menu is 
dimmed. 

2. Select the new permissions you want to give the user. 

In Figure 4-30, Browse and Insert are selected to replace the existing 
permission of Insert for winsor@castle. 

3. Choose Change from the Name menu, as shown in Figure 4-30, or from 
the scrolling list pane pop-up menu. 
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Figure 4-30 Changing an entry in the Access Ust 
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4. Click· SELECT on the Apply button to record the changes. 

The Calendar Manager application allows you to access the appointment schedules 
of other users if you are included on their Access List. This convenient feature 
allows administrative personnel and their staff to coordinate Scheduling of 
appointments. It can, for example, allow individual users access to the 
appointments that coordinate scheduling of conference rooms. 

The default is for the Calendar Manager application to allow you access to your 
own calendar appointments. You can add and delete other user names on the 
Browse menu from the Properties window, as described in the previous section. If 
you have not added names to the Browse menu from the Properties window, the 
Browse menu button initially contains two items: A Browse window item and an 
item for your login and machine name. Figure 4-31 shows an example of the 
default Browse menu. 

Figure 4-31 An example of a defaUlt Browse menu 

Adding Another User's 
Appointments to the 
Browser 

Print 

Browse ... 

brenda~jungle 

You can temporarily add another user's appointment schedule to the Browse menu 
from the Browse pop-up window. User names ~at you add from the Browse pop­
up window remain on the Browse menu until you quit the Calendar Manager 
application or delete them using the Delete button in the Browse pop-up window. 

To display the Browse pop-up window choose the Browse item from the Browse 
menu. An example of the Browse pop-up window is shown in Figure 4-32. 
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Figure 4-32 The Browse pop-up window 
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The Browser scrolling list shows all the user names from the Browse menu, 
whether you added them from the Properties window or the Browse window. 

You temporarily add other users to the Browse menu following the steps below: 

1. In the Name field, type the email address of the user you want to add to 
your browser. 

2. Move the pointer onto the Add button and click SELECT. 

Alternatively, you can press the Return key. The user name is added to the 
scrolling list and to the Browse menu. 

You can enter any user name in this scrolling list. The Calendar Manager does not 
confinn that the user name is valid or that the appointments for that user name are 
available until you click SELECf on Browse in the Browser pop-up window or 
choose the user name from the Browse menu. This checking can be a time 
consuming operation, so it is not done at the time you add a name to the scrolling 
list. 

Once a user name has been added to the Browse menu, you can display and/or edit 
the appointments for that user, (depending on the access permissions that user has 
given you), by choosing the user name from the Browse menu. Alternatively, you 
can change the Calendar Manager base window to display appointments for 
another user from the Browser window. Qick SELECT on the user name in the 
scrolling list to choose it and then click SELECT on the Browse button. 

If the Calendar Manager cannot find the user name or access the appointments for-­
that user, the error message "Unable to access user@machine ••• " is 
displayed in the footer of the Browser window. The appropriate user and machine 
names are displayed in the error message. 

If the Calendar Manager can access the appointments for that user, they are 
displayed in the Calendar Manager base window, and the name of the user is 
displayed in the header following the words "Calendar Manager". If you do not 
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have browse access for that user you cannot see or edit any of their appointments, 
but you can see blocks of scheduled time. as shown in Figure 4-33. 

Figure 4-33 Browsing a Calendar with Week view when you don't have Browse Access 
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To change back to your own calendar, choose your user name from the Browse 
menu. 

To delete another user's name from your Browse menu, follow these steps: 

1. Choose the Browse window item from the Browse menu. 

The Browser pop-up window is displayed. 

2. Move the pointer onto the user name you want to delete and click 
SELECT. 

The user name is highlighted. 

3. Move the pointer onto the Delete button and click SELECT. 

The user name is removed from the scrolling list, but remains displayed in the 
Name field. If you inadvertently deleted a name, you can add the name again 
by clicking on the Add button without retyping the name. 

You can temporarily delete user names that you have added from the Properties 
window, as well as any user names you have added from the Browser pop-up 
window. When you delete names that you entered from the Properties window, the 
names are redisplayed the next time you quit the application and start it up again. 
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The Calendar Manager application provides high-quality printed output for day, 
week, month, and year vjews~ You set the printer name and options from the 
Printer Options window that you access from the Print menu. You print Calendar 
Manager output by choosing the view you want to print from the Print menu. 

You can set printing options from the Printer Options pop-up window. 
Figure 4-34 shows the default settings for the Printer Options window. 

Figure 4-34 The Printer Options pop-up window 
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From this window, you can specify the following print options: 

(j The destination of the printed output (Printer or File) 

(j The printer name or file destination and file name 

(j The width and height of the printed image 

(j The left and bottom margin 

[] The number of units that print 

In Figure 4-34 above, the unit is Months. When a day view is displayed, the 
unit is Days, and so on. You can tell what view will print from the label on this 
field. The selected unit (day, week, month, year) always begins the sequence. 
Subsequent units print according to the number you enter in this field. 

To change the unit, choose a new option from the View menu. 

[] The number of copies to print 

Clicking SELECf on the Print button in the Printer Options window prints the 
view that is displayed in the Calendar Manager base window. For example, if you 
are displaying appointments for a day at a glance, choosing Print prints a day view. 

When you change the settings from the Printer Options window, they become the 
new default printer settings until you quit the Calendar Manager application and 
start it up again. 
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Day View To print appointments for the current day, choose Day from the Print menu. To 
print appointments for a day other than the current one, move the pointer onto the 
day you want to print and click SELECT. Then choose Day from the Print menu. 
Appointments for the day are printed in the format shown in Figure 4-35. 

Figure 4-35 A printed day view 

Monday December 4, 1989 

1.:00 ..... 11,00 .... 
OW Business Team 
Bldg 1. Banok Conf Rm 

3:3O ....... 5:OOpm a= ~Ita Con'-nce Room 
Bring Information for 
Design Committee 
status report. 

Revision A of 11 June 1990 



Week View 

Chapter 4 - Calendar Manager 119 

To print appointments for the current week, choose Week from the Print menu. To 
print appointments for a week other than the current one, move the pointer onto the 
day you want to print and click SELEer. Then choose Week from the Print menu. 
Appointments for the week are printed in the fOImat shown in Figure 4-36. 

Figure 4-36 A printed week view 

............ 
JCtrrdt 

ltu..1I:u.. 
.IrunIy" SCSIta SCSA 
ltu-u:u.. 
OPEHlOOK 
ltu..ltu.. 
Open Wincbn 0id:IIII SCII os ani SYr4 

ltU-ltu.. 9:0lIl ..... 
SP~ PhiotaPIY SPAR; ~ 

ltl5em-ll!u.lI f:GQa.~1I 

NIIISAM Net !SAM 

t:&.It:&a 
flEX: Ptigs ExItnsirIc 10 X 
t:45I.~. 

GX TICInIi:Igy 
t-.&.It:&11 

SCII os , SVr. 
t-.&.IO:&II 
SPARC~ 

au...lI:u.. ....14tCIOt1l 11:lla.l2:GOpm 
p.., DweIapHrt 1JqH! ~ Orientd~ iI SInIaIds II SCII 

ltu...ltu.. M:u..II:&1I 11:11a.l2:GOpm 
SM3 AuIhian CllIIyS .bmey .. SCSI 10 SCSA ()pin Fcm 

1O:15I .. 11:15a1l 

s s 

Revision A of 11 J\Ule 1990 



120 DeskSet Environment Reference Guide 

Month View To print appointments for the current month, choose Month from the Print menu. 
To print appointments for a week other than the current one, move the pointer onto 
the day you want to print and click SELECT. Then choose Month from the Print 
menu. Appointments for the month are printed in the format shown in Figure 4-37. 

Figure 4-37 A printed month view 
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To print the current year, choose Year from the Print menu. To print a year other 
than the current one, change the year view to the year you want to print. Then 
choose Year from the Print menu. You can print a standard view of the year, as 
shown in Figure 4-38, or a schedule view of the year, as shown in Figure 4-39. 

Figure 4-38 A printed standard year view 
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Figure 4-39 A printed schedule year view 
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You can enter appointments into the Calendar Manager from Mail Tool by 
dragging and dropping a mail message header when the mail message provides the 
appoinunent information in a fonnat that the Calendar Manager can interpret 

Mail Tool provides a template that you can use to create mail messages in the 
fonnat that Calendar Manager can accept, as shown in Figure 4-40. See Chapter 3 
for more information about Mail Tool templates. 
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Figure 4-40 TheMail Tool template/or Calendar Manager messages 

Dragging an Appointment 
Message from Mail Tool 

Mall Tool: Cempose Message 

(Include v) (Dellyer v) (Header v) (Name Finder ... ) (Clear) 

To: 
Subject: -------------------{ 

Cc: 

• 

----------------------~ 

•• Calendar Appoint.ent •• 

Date: 1> •• /dd/yy<1 
Start: I>hh: •• p.<1 
End: I>hh: •• pI<1 
What: I >l1n8 1 <I 

I >11ne 2<1 

Alternatively, you can type a message following the rules listed below. 

o You can type either uppercase letters, lowercase letters, or a combination of the 
two. For example, "Date", "date", "DATE", and "DaTe" are all-acceptable. 

o Type a tab or white space(s) before the Date, Start, End, and What fields. 

o After the words Date, Start, End, and What, type a colon and white space(s) or 
tabes). 

o Type Return after each line. 

o Use any fonnat for _the Date field that is accepted by the Appointtnent Editor, 
as described previously. -

o Type hours and minutes, separated by a colon, in the Start and End fields. You 
can follow the time with AM or PM, or you can use military time. If the date 
is not military time or is not followed by PM, Calendar Manager will assume 
the time is AM. 

o You can type up to Slines of text in the What field, with a maximum of 255 
characters per line. Follow each line with a Return, and type white space(s) or 
tab(s) before each of the second through fifth lines. 

A mail message can contain several appointments and have explanatory text either 
before or after each appointment. The Calendar Manager application accepts only 
the infonnation in the Date, Start, End, and What fields and ignores everything else 
in the mail message. TIle Calendar Manager application will accept multiple 
appointments in the same mail message as long as each message is in the . 
acceptable fonnat. 

When you receive a mail message that has appointment infonnation in the correct 
fonnat, or a mail reminder generated by another Calendar Manager application, 
you can drag and drop it onto the Calendar Manager to schedule your appointment 
by following these steps: 

1. Open the Mail Tool window that displays your mail message headers. 
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2. Point to the header and click SELECT to select it. 

3. Press the Control key on the keyboard and the SELECT mouse button. 

If you don't press the Control key first, the mail message is moved and deleted 
from the Mail Tool instead of copied. 

Once you have pressed SELECT, you can release the Control key. 

4. Drag the pointer a short distance. 

The poInter changes to the duplicate pointer and a small envelope representing 
the mail message is displayed, as shown in Figure 4-41. 

Figure 4-41 Dragging a mail message 

64 winsor 
67 winsor 

s. Drag the envelope onto the Calendar Manager. 

You can drop it onto the Calendar Manager icon or anywhere on the open 
Calendar Manager window. 

6. Release SELECT. 

When the appointment has been successfully scheduled, an information message is 
displayed in the footer of the Calendar Manager base window. Figure 4-42 shows 
an example of such an information message. 

Figure 4-42 An example of an information message for a scheduled appointment 

If the appointment is in a format that Calendar Manager cannot understand, a 
Notice is displayed informing you that the appointment cannot be scheduled, as 
shown in Figure 4-43. 

Figure 4-43 Invalid format Notice 
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The Calendar Manager application consists of two parts: 

o A database manager, called rpc . cmsd (Calendar Manager service), that 
maintains the information for the Calendar Manager application 

o The Calendar Manager application itself, called cm 

The Calendar Manager application cannot function without the Calendar Manager 
service. In order for the Calendar Manager sexvice to run, you must have run the 
install_cmgr script. See the OpenWindows Installation and Start-up 
Guide forinfonnation about install_cmgr. 

If your Calendar Manager consistently does not display appoinonents, or if you get 
"RPC timeout" messages in the console window, rpc. cmsd is probably not 
running. To check your configuration, use these steps: 

1. Open a Shell Tool or Command Tool. 

2. At the system prompt, type ps -axw I grep rpc. cmsd and press 
Return. 

3. Look at the listing displayed in the window. 

Figure 4-44 shows a listing that contains the Calendar Manager service 
process. 

Figure 4-44 A ps listing showing the rpc.cmsd process 

% ps -axw I grep rpc.cIsd 
196 co!W 0:07 rpc.cmsd 

3759 pO 5 0:00 grep rpc.cIsd 
% 

Note that you can ignore the entry grep rpc. cmsd in your ps listing. 

If you do not have an rpc . cmsd process running, follow these steps: 

1. If you have a Calendar Manager application running, quit the Calendar 
Manager by choosing Quit from the Window menu. 

2. Become root. 

3. At the system prompt, type cd $OPENWINHOME/xview/bin andpress 
Return. 

4. Type install_ cmgr and press Return. 

S. Start up another Calendar Manager application. 

6. To make sure that the Calendar Manager Service is now running, type 
ps -axw I grep rpc. cmsd and press Return. 
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5 
Text Editor 

The Text Editor is an interactive ASCn text editor. The editing functionality 
provided in this DeskSet application is also available to you in the text editing 
panes of the Console and the Command Tool, and in the View and Compose 
windows of the Mail Tool. 

The Text Editor application is integrated with the DeskSet drag and drop 
functionality. You can drag Text Editor files from the Flle Manager, or from the 
window background of the Text Editor window itself. You-can drop Text Editor 
files onto the Print Tool, Tape Tool, and Mail Tool Compose windows. 

You can cut and paste directly between Text Editor windows and any other text 
window in the DeskSet 

This chapter describes how to use the Text Editor. 

5.1 The Text Editor Icon The Text Editor icon shows you as much as it can of the beginning of the file name. 
When the file has been edited and you have not saved the changes, the file name is 
preceded by a ">" symbol. When there is no file, or when you have .created a new 
file but have not saved it, the icon displays the words "No File" in the icon. 
Figure 5-1 shows an example of three Text Editor icons. The one on the left 
contains a file named "example." The one in the middle contains a file named 
"example" that has been edited but not saved. The one on the 'right contains either 
no file at all, or a file that has never been saved. 

Figure 5-1 Text Editor icons 

S.2 The Text Editor Base·' 
Window 

.-----..., 

JaJ251l1 
example >example NO FILE 

The Text Editor base window, shown in Figure 5-2, has a control area and a text -­
pane that you use to compose and edit your text message. The header of the Text 
Editor window always displays the name of the file you are editing (or the word 
"None" when you have not assigned a name to the file), and shows you the 
directory where the file is located. When you have made editing changes, or have 
not yet saved a file, the word "edited" is displayed in parentheses following the file 
name. 
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The Control Area 

Figure 5-2 The Text Editor base window 

Text Editor - (NONE), dlr: /home/wlnsor 

• 

The control area of the Text Editor has File, View, Edit, and Find buttons. The 
Text Editor pane has a pop-up menu, shown in Figure 5-3, containing these same 
commands. The Text Pane pop-up menu is also provided in the text editing panes 
of the Console, Command Tool, and Mail Tool applications. 

The commands for each of the items in Text Pane pop-up menu operate in the same 
way as the controls in the Text Editor base window, described in the following 
sections. There is an additional item on the TextPane pop-up menu called Extras, 
which is described later in this chapter. 
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The File Menu The File menu, shown in Figure 5-4, contains items that you can use to load and 
save your text files, and for other file-related functions. 

Figure 5-4 The File menu 

Saye Current File 

(Store as New File ... ) 

Include File ... 

Empty Document 

Use the Load File item to display the Text: Load pop-up window shown in 
Figure 5-5. Type the directory and name of the file you want to load. Qielting 
SELECf on the Load File button loads the file in the window, replacing any 
existing text 

Figure 5-5 The Text: Load pop-up window 

Text:load 

Directory. /home/jungle/brenda 

rile: .... _________________ _ 

(Load File) 

Use the Save Current File item to save the contents of the Text Editor pane in the 
current directory, using the file name displayed in the header of the Text Editor 
window. If "NONE" is shown as the file name, use the Store as New File aption. 

Use Store as New File to display a Text: Store pop-up window, shown in 
Figure 5-6. Type a directory and file name, and click SELECf on the Store as New-­
File button to save the contents of the Text Editor pane. The Text: Store pop-up 
window automatically displays the current directory in the Directory text field. 
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Figure 5-6 The Text: Store pop-up window 

.-i:O Text:Store 

Directory. /home/Jungle/brend, 

nle: __ --______________________________ ___ 

( Store as New ftie) 

Use the Include File item to display the Text: Include pop-up window shown in 
Figure 5-7 .. Type the directory and name of the file you want to include, and click 
SELECT on the Include File button to include the file you specify at the insert point 
in the text pane. 

Figure 5-7 The Text: Include pop-up window 

Text:lnclude 

Directory. Ihome/Jungle/brenda 

Rle: .. * ______________________________ _ 

(include File) 

Use the Empty Document item to clear the contents of the text pane. If you have 
made editing changes and have not saved them, a Notice is displayed asking you 
to confinn or cancel the operation. 

The View Menu The View menu, shown in Figure 5-8, provides choices you can use to control the 
position of the cursor and the way the line wrap is used. 

Figure 5-8 The View menu 

Use the Select Line at Number item to display the Text: Line Number pop-up 
window shown in Figure 5.:9. Type the number of the line that you want selected, 
and click SELECT on the Select Line at Number button. The text on the specified 
line is selected, and the insert point is moved to the end of the selected text 

Figure 5-9 The Text: line Number pop-up window 

Q Text:lIne Number 
line Number: .. + _______ _ 

(select line at Number) 
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Use the What Line Number? item to locate the line number where the selected text 
begins. The line number is displayed in a Notice. When there is no current 
selection in the Text Editor window t the Notice displays an error message instead 
of a line number. 

Use the Show Caret at Top item to move the line with the caret to the third line 
from the top of the text pane. 

The Change Line Wrap submenu provides three choices for line wrapping: word, 
character, and clip lines. The text shown in Figure 5-10 is wrapped at a character, 
so words are broken at the end of lines. 

Figure 5-10 Lines wrapped at a character 

Change 1Ilie Wr 
to work. Based on .Y 

wrinkles and a this was about 10 y 
ears or so into usual exit. and e 
nded up in East through the electri 
c fence gates. 1,·, ~;;;;;;;;;;;;;;;;;;;;;;;;;;;:.J had just recently IOV 
ed. Eyeryone WB! ded ared that she had 
done sOle figuring. and s was her 32nd office since bei 

ng at the cOlpany. 

Not all of us were still here. Henry had just opened his 0 
wn phone repair business called Dead Ringers. and John was 
considering retirelent fro. the co~puter business to organi 
ze 9 of his friends. his brother. wife. and seyen kids into 

The most commonly used wrapping method is to wrap at the end of words. The 
text shown in Figure 5-11 is wrapped at the end of words. 

Figure 5-11 Lines wrapped at a word 

,... _______ ~ to work. Based onlY 
this was about 10 
the usual exit. and 

ked through the 
that we had just 

recently loved • ..... ---...... n9. and Mary declared 
that she had done sale figuring. and this was her 32nd 
offic8 since being at the cOlpany. 

Not all of us were still here. Henry had just opened his 
own phone repair business called Dead Ringers. and John was 
conSidering retire.ent frol the co.puter business to 
organize of his friends. his brother. wife. and seven kids 
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The Edit Menu 

TheFmdMenu 

If you choose Qip Lines, the beginning of each line that ends with a Return is 
displayed. The text shown in Figure 5-12 has Returns only at the end of each 
paragraph. 

Figure 5-12 Clipped lines 

What Line Number? 

Show Caret at Top 
'. h;:jngE' line Wrap 

I unpacked and he 

Next Alison told us 

•• driving to work. 

just opened hi s 

n9. We had lot 

rse she was busy 

The Edit menu, shown in Figure 5-13, provides standard editing functions. 

Figure 5-13 The Edit menu 

o Use Again to repeat the last editing action. 

o Use Undo to undo the last editing action or all editing ac~ons and restore what 
was there before, depending on which item you choose from the Undo 
submenu. 

o Use Copy to store a copy of the selected text on the clipboard. Only one 
selection can be stored on the clipboard at a time. If something is already on 
the clipboard and you do a copy or cut, the contents of the clipboard are 
overwritten with the new infonnation. 

o Use Paste to insert the contents of the clipboard at the insertion point 

o Use Cut to remove the selected text and store it on the clipboard. Only one 
selection can be stored on the clipboard at a time. 

The Find menu, shown in Figure 5-14, includes items that help you to search for 
specific text strings, special characters, and delimiters to fmd a text string and 
replace it with another. 
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The Text: Find and Replace Item. Use the Find and Replace item to display the 
Text: Find and Replace pop-up window . If you have a current selection, it is 
automatically displayed in the Find text field, as shown in the example in 
Figure 5-15. 

Figure 5-15 The Text: Find and Replace pop-up window 

.~ Text:Find and Replace 
~ : ~dr~e=a~~ ________________________________________________ ____ 

(Replace): ____________________ _ 

C Find then Replace) (Replace then Find) C Replace All) @) All Text 

To fmd a text string and select it, type the text in the Find field and click SELECI' 
on the Find button. Oick SELECf on the Find button again to find and select the 
next occurrence of the text string. 

To replace the current selection with a text string, type the text in the Replace field 
and click SELECf on the Replace button. You can use the Replace button together 
with the Find button to find a string and then replace it with another, or separately 
to replace highlighted text. You can replace a string with nothing by leaving the 
Replace text field blank. . 

The buttons at the bottom of the Find and Replace window combine fmd and 
replace operations, allowing you to Find then Replace, Replace then Find, or 
Replace All. 

You can specify whether you want the find and replace operations to apply to all 
of the text, or restrict the operation to the text between the insert point and the end 
of the document by using the abbreviated menu button to select either All Text or 
To End. The current setting is listed to the right of the abbreviated menu button. 

The Find Selection Item. Use the Find Selection item of the Find menu to search 
the fue for another occurrence of the text string that is highlighted as the current 
selection. You can search fOlward or backward from the insert point by choosing 
Forward or Backward from the Find Selection sub-menu. 

The Find Marked Text Item. Use the Find Marked Text item of the Find menu 
to highlight text between a matched set of delimiters provided as options in the 
Text:Find Marked Text pop-up window, shown in Figure 5-16. 
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The Extras Menu 

Figure 5-16 The Text:FindMarked Text pop-up window 
.-0:0 Text:Flnd Marked Text 

I () I" I 1# I" II> <I I [] I () I,· ., 
(Find Pair) : I Forward I Backward I Expand I 

( Insert Pair) (R8 m<>Ye Pair) 

You can search and highlight text for any of the matched delimiters provided as 
choices in the Text:Find Marked Text pop-up window by clicking SELECf on one 
of the sets of delimiters, and then clicking SELECf on the Find Pair button. Use 
the Backward or Forward choice to direct the search either backward or forward 
from the current insertion point If you have nested delimiterS, such as matched 
parentheses in code, you can use the Expand choice to select text outward from the 
current insertion point to the next outer pair of specified delimiters. 

To surround the selected text with the selected delimiters, click SELECf on . the 
Insert Pair button. To delete a matched pair of delimiters from the selected text, 
click SELECf on the Remove Pair button. 

The Replace Field Item. The Text Editor pane recognizes any text between the 
characters I> and <I as a text field. You can search forward through the text from 
the insert point to find and select each field using the Replace l>field<1 item of the 
Find menu. The Replace l>field<1 submenu provides three options: Expand, Next, 
and Previous: 

o When the caret in the Text Editor pane is between field delimiters, choose 
Expand to search in both directions and select the entire field and its delimiters. 

o Use Next to search forward from the insert point and select the next field. 

o Use Previous to search backward from the insert point and select the previous 
field. 

There is an additional item on the Text Pane pop-up menu, called Extras, that is not 
also a button in the Control area. This menu contains some useful commands to 
fonnat the selected text. See the section "Customizing Your Text Editor" later in 
this chapter for infonnation about how to customize the Extras menu to contain 
your own commands. This section describes the default Extras menu, shown in 
Figure 5-17. 
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The Format Item. Choose Fonnat to reformat selected long lines of text into 
physical lines of no more than 72 characters. This is useful, for example, when 
reading mail with lines longer than the width of the window. It is also useful to 
fonnat text with long lines before printing it, to make sure that lines will not be 
truncated by the printer. 

Format uses the UNIX fmt command. It does not split words between lines, and 
it preserves blank lines and the spacing between words. 

The Capitalize Item. You can use the Capitalize jtem to capitalize selected text. 
You use the first item on the Capitalize submenu, abcd->ABCD, to capitalize every 
letter of the selected text. Use the second item on the Capitalize submenu, 
ABCD->abcd, to tum all the letters of the selected text into lowercase. You can 
use the last item of the Capitalize submenu, abcd->Abcd, to capitalize the first 
letter of every selected word. Uppercase letters within a word are not changed. 

The Shift Lines Item. Choose the Shift Lines item to insert or remove a Tab 
character at the beginning of each line in the selected text Use the submenu of this 
item to specify whether to shift right or left. Choose shift right to insert a Tab 
character, and shift left to remove a Tab character. 

The Pretty-print C Item. This item uses the UNIX indent command to format 
C program listings. It formats the selection according to standard specifications. 
or to the specifications of a • indent. pro file if you have one. For more 
infonnation, refer to the SunOS Reference Manual. 

The Insert Brackets Item. You can use the Insert Brackets item to quickly insert 
any of the following type of brackets around the selected text, depending on what 
item you choose from the Insert Brackets sub-menu: ( ), [ ], { } or" ". 

The Remove Brackets Item. Choose the Remove Brackets item to remove any 
of the following brackets around the selected text, depending on what item you 
choose from the Remove Brackets sub-menu: (), [], { } or" ft. 
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5.3 Selecting Text 

S.4 Operating on Text 

You select text in the Text Editor pane in the same ways that you select and operate 
on text in the other DeskSet applications. See the Open Windows User's Guide for 
more information about selecting and operating on text 

Selected text is highlighted (shown in reverse video), and is pending delete: when 
you type a new character, highlighted text is replaced with the new infonnation that 
you type. 

You can select "text in the following ways: 

a Move the pointer and click SELECf to set the insert point, as shown by a 
triangular caret. 

Cl To select a word, move the pointer onto the word and double-click SELECf. 

a To select a paragraph, move the pointer onto the paragraph and triple-click 
SELECf. 

Cl To select the entire document, quadruple-click SELECf. 

a To select any continuous body of text, move the pointer to the place where you 
want to begin the select, press SELECf, drag the pointer over the text you want 
to select, and release SELECf. 

Cl You can also select a continuous body of text by clicking SELECf to set the 
insert point, moving the pointer to the end of the selection and clicking 
ADJUST. 

Cl You can expand text that is currently selected, adding to the beginning or the 
end of the text by moving the pointer and clicking ADJUST. 

Cl You can adjust the selection, making it smaller by moving the pointer into the 
highlighted text and clicking ADJUST. The text is adjusted. Highlighting is 
removed from the selection. Reducing a selection in this way is usually fairly 
intuitive. However, it may not work exactly as you expect, since the 
adjustment depends on how you made the original selection and the starting 
position of the insert point. 

You operate on text in the Text Editor pane in the same ways that you operate on 
text in the other DeskSet applications, using the clipboard and cut/copy/paste 
functions from the Edit menu or from the keyboard. 

To copy text, follow these steps: 

1. Select the text to be copied. 

2. Choose Copy from the Edit menu or press the Copy key on the keyboard. 

A copy of the selected text is put on the clipboard. 

3. Move the pointer to the place where you want to insert the text and click 
SELECT to set the insert point. 

4. Choose Paste from the Edit menu or press the Paste key on the keyboard. 
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To move text, the steps are similar, except that you choose Cut instead of Copy, 
and the selected text is removed from its original location. 

The Text Editor pane can be split into two or more panes so that you can view and 
edit different parts of the document at the same time. The document itself is not 
split, so any ~iting changes you make in one view are reflected in other views as 
well. See the OpenWindows User's Guide for detailed information on how to split 
panes and how to remove split panes. The following steps describe one method of 
splitting the Text Editor pane: 

1. Move the pointer to the top cable anchor of the vertical scroll bar and press 
SELECT. 

2. Drag the pointer downward into the pane. 

A horizontal line is displayed from the left edge of the pane to the center of the 
cable anchor to show where the split will occur. 

3. Release SELECT. 

The pane is now split into two panes, such as the example in Figure 5-18. 

Figure 5-18 A Text Editor Split Pane 

5.6 Drag and Drop 

@) Text Editor - story, dlr; /home/jungle/brenda 

~ I have to tell you guys about a dreal I had last night. You 
were all there. let.e prefa<e this with a relinder that 
sOletiles dreals are very strange. 

gates .. 1t was obv .. 1ous that we had ,just recently loyed. 
Everyone was unplcking. and Mary declared that she had done 
sOle figuring. and this was her 32nd, office since being at the .. cOlpany. 

Not all of us were still here. Henry had just opened his own • 
phone repair business called Dead Ringers, and Iohn was 
considering retirelentfrol the computer business to organize 
9 of his friends, his brother, wife, and seven kids into a 

One way to remove a split pane is to move the pointer to the top cable anchor in the 
pane you want to remove and press SELECT. Then drag the pointer downward 
until the top and bottom cable anchors overlap, and release SELECT. 

You can drag and drop files onto the Text Editor window background or pane to 
load them. 

You can drag and drop copies of selected text from a Text Editor window onto 
other Text Editor windows or onto the Mail Tool Compose window. 

To drag a copy of text from the Text Editor, follow these steps: 

1. Select the text to be copied. If you want to copy the entire file, 
quadruple-click SELECT. 

2. Press the Control key on the keyboard and the SELECT mouse button. 
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Once you have pressed SELECf you can release the Control key. 

3. Drag the pointer a short distance. 

A text duplicate pointer is displayed, as shown in Figure 5-19, with the first 
several characters of the selected text displayed inside the rectangle. 

Figure 5-19 Dragging a copy o/Text Editor text 

S.7 Customizing Your 
Text Editor 

The.text extras menu - -
File 

4. Drag the pointer to its destination and release SELECT. 

There are two files used by the Text Editor that you can modify to customize your 
Extras submenu and to specify function key mappings. This section describes 
these two files. 

You can customize the Extras pull-right menu of the text pane pop-up menu to 
include your own favorite commands by modifying the file . 
. text_extras_menu. By default, the Text Editor uses the infonnation found 
inthefue /usr/lib/ .text_extras_menu. Youcancreateyourowncopy 
of this file and tell the Text Editor to use it instead of the default in either of the 
following two ways: 

D Change the value of the . Xdefaults parameter: 
text .extrasMenuFilename or Text . ExtrasMenuFilename to 
the path and fue name of your customized file. See the XView man page, 
included in Appendix C, for information about the . Xdefaul ts file. 

D Set the environment variable "EXTRASMENU" to the desired file name. 

If you specify both options, the .Xdefaults parameter will be used. 

The standard Extras.menu fue is /usr/lib/ . text_extras_menu and is 
shown in Figure 5-20. It will give you some ideas on how to implement your own 
extras menu fue. Once you've created a custom file and told the Text Editor where 
to fmd it using one of the methods above, you can make changes to the file and see 
them immediately implemented in the Extras pull-right menu. 
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Figure 5-20 The Extras menu file in /usr /lib/. text_ extras_menu 
(!) Text Editor - .teKLextras_menu, dlr;/usr/lib 

, 
Cl!0 (View v) ~ (Find v) 

.: t<M)text-extras_.enu 1.6 88/02/08 SHl 

~ M Copyright (c) 1987 by Sun Microsyste.s. Inc. 
It 
It Text -ExtrasM .enu 
M 
MFouat" ht 

MCap1 tal 1 zeM MENU 
Mabcd -) ABeDM capitalize -u 
-ABeD -) abcd" capi tali ze -1 
-abcd -) Abed" capitalize -c 

·Capi tali ze" END 

MShift L 1 nes· MENU 
-R1~ht· shift-lines -t 1 
·Le t M shift-lines -t -1 

Mshift lines" END 

MPretty-print C- indent -st 

"Insert Brackets· MENU · ( ). insert_brackets C ) 
• [ ] M insert_brackets \[ '] 
• { } M insert_brackets { } 
"" ,'M insert_brackets \" ,. 

·Insert Brackets· END 

"Relove Brackets· MENU · ( )" remove_brackets ( ) 
M [ ]" remove_brackets \[ '] M { }M remove_brackets { } 
.,' ". remove_brackets \" ," 

MRelove BracketsM END 
'1 

The name of each Extras menu item is surrounded by double quotation marks. 
Each pull-right menu begins with a MENU statement and ends with an END 
statement. 

To include a backslash (\) character in the • text_extras_rnenu file -- as in the 
troff inline font specifications \ fB and \ fP -- you must use four backslash 
characters; for example: 

insert brackets \\\\fB \\\\fP 

You can associate filters (programs or routines) with unused function keys by 
modifying your own copy of the file • text s wr c. When a text selection has been 
made and a function key pressed, the selected text is piped through the filter 
assigned to that key. The output is then piped back into the text at the caret, 
replacing the text that was selected. 

If you want to specify your own set of bindings of filter keys to function keys, you 
must copy the file /usr/lib/ . textswrc to a file called • textswrc in your 
home directory. The Text Editor application reads the file • text swrc from your 
home directory, if the file exists. 
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Format of the • textswrc 
File 

List the sample file, /usr/lib/ . textswrc, to see an example of filters used 
with a right-handed keyboard. You can copy this file into your home directory, 
then modify it by adding filter bindings to unused function keys. 

Here is the basic fonnat of each. textswrc file entry: 

key-name FILTER 
command-line 

A function is assigned to one of the function keys by including a statement like the 
following in your. textswrc file: 

/* 
* Note that: 

* 
* 
*/ 

insert brackets /* */ does NOT work 
double quotes are needed 

KEY_TOP (10) FILTER 
insert_brackets "/* " " */" 

This example shows how to include C language comment marlcers around a piece 
of text. You could enter this example into your . text s wr c file, and save the file. 
Then, to use this added function, start up a new Text Editor application. Changes 
to your . text swrc file are only effective when you bring up a new Text Editor. 
Then select the text and press the key. The text will be replaced with a copy of 
itself surrounded with "1*" and "*,'. Note the C-like syntax of comments in the 
. textswrc file. 

When defining a filter in the • text swrc file, remember that the filter must 
appear in a directory accessible by your search path. If the command is not found, 
or if there is some other failure in the invocation of the filter, no change occurs in 
the document. 
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Print Tool and Tape Tool 

Print Tool and Tape Tool are two DeskSet applications that provide a convenient 
and intuitive way to print and make backup copies of your files. You can use both 
Print Tool and Tape Tool in conjunction with File Manager and other DeskSet 
applications that support drag and drop operations. 

This chapter describes how to use the Print Tool and the Tape Tool. 

6.1 Print Tool The Print Tool application provides a user interface to the UNIX Ipr, Ipr~ and 
Ipq printing functions. 

The Print Tool Icon You can print fIles by dragging and dropping files from the File Manager, a header 
from the Mail Tool application, or the contents of a Text Editor window onto the 
Print Tool icon, shown in Figure 6-1. 

Figure 6-1 The Print Tool icon 

Iw 

~~=-~~ 
printtool 

The name of the current printer is displayed in the upper left comer of the Print 
Tool icon. When a file is dragged and dropped onto the Print Tool. application, the 
icon label "printtool" changes to the name of the file being printed, and may also 
change to display error messages. 
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The Print Tool Base Window You can perfonn the following operations from the Print Tool base window, which 
is shown in Figure 6-2: 

[] Print files by typing the fIle name in the File text field and clicking SELECf 
on the Print button. 

[] Print files by dragging and dropping files from the File Manager, a header from 
the Mail Tool application, or the contents of a Text Editor window. 

[] Choose which of your available printers you want to use. 

[] Specify the number of copies you want to print 

[] Specify a special file fonnat for the file you want to print 

[] Display print queue status. 

[] Stop printing a specific job or all jobs in your print queue. 

Figure 6-2 The Print Tool base window 

""(2) Print Tool 
., 

File: • 

Printer: (2) spitfire 

Copies: _1 _ EI~I 

fUter: None Raster TeX 
Plot elf Plot troff 
pr control other: 

(Print) (Status) (Stop Printing v) 

~ 

0 
\. J 

Printing a File You can print a file u~ing the default settings in the Print Tool window by following 
these steps: 

1. Type the complete path name of an ASCn file in the File text field. 

2. Point to the Print button and click SELECT. 

Alternatively, you can drag and drop a file (or multiple files) to be printed onto the 
Print Tool window by following these steps: 

1. Select a file from the File Manager application or a mail header from the 
Mail Tool application. To print more than one tile, press ADJUST on 
additional files to be printed. 
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2. While holding down the SELECT mouse button, drag the tile onto the 
Print Tool window, as shown in Figure 6-3, and release SELECT to drop 
it. 

Figure 6-3 Dropping a mail message on the Print Tool window 

(i) Print Tool 

File:. 

Printer: (2) spitfire 

Copies: _1 _ '.1'" 
Filter: None Raster TeX 

Plot ClfPlot troff 
pr control other: 

(print) (status) (Stop Printing v) 

~ 
H 
H .. 

Q 

c:::J 

'L. ,.J 

The file name is automatically entered in the File text field, and an infonnation 
message is displayed in the footer of the window, as shown in Figure 6-4. 

Figure 6-4 An information message from Print Tool 

NOTE 

Print Tool 

Regardless of which method you use to print a fIle, status information messages are 
displayed in the footer of the Print Tool window, such as the following: 

1. Printing <filename> 

2. Printing <filename> e' •• 

3. No entries. 

When the printing job is complete, the Print Tool window flashes and beeps. 

Status messages are not provided for files that are printed without using the Print 
Tool. 
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Choosing Another Printer The Print Tool automatically displays the name of the first printer entry in your 
/etc/printcap file. All printers that are available to you are listed on the 
Printer menu. The names on the Printer menu are retrieved from the entries in your 
/etc/printcap file. The name used for each printer is the first or second name 
of the /etc/printcap entry, whichever is longest Make sure there are no 
spaces before any of these printer names in your /etc/printcap file, or the 
Print Tool will not be able to print to that printer. 

To choose another printer follow these steps: 

1. Point to the abbreviated menu button next to the Printer label. 

2. Press MENU. 

The Printer menu is displayed, as shown in the example in Figure 6-5. 

Figure 6-5 An example of the Printer menu 

Using the Print Tool Filters 

I£) Print Tool 

file: 

Printer: B. crunchy 

crunchy grumpy 
hannah kraljev 
Ims mania er TeX 

lot troff polde printery 
rol other: sandstone scupper 

smooth sweden 
sosumi spitfire p Printing V J 

v--- - ---...,.. 

3. Drag the pointer to the name of the printer you want to choose. 

4. Release MENU. 

The name of the new printer you chose is displayed to tlie right of the 
abbreviated menu button. 

To add other printers to your system configuration (and the Printer menu), contact 
your system administrator for infonnation about configuring your 
/ etc/printcap file. 

When the rue you are printing has a print filter script bound to it in either 
/etc/filetype or • filetype in your home directory, that script is 
automatically used by Print Tool. You can change the default print filter scripts for 
each application using the Binder. See Chapter 12 for more infonnation about the 
Binder application. 

The filter format is automatically chosen and displayed when you drop a file on 
Print Tool or type its file name in the Print Tool window and click SELECf on the 
Print button. 
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Here is a brief description of the seven standard filter fonnats: 

a None provides no filter. 

a Plot is a filter for files produced by the UNIX command plot, which produces 
plotting instructions, in particular for graphics tenninals and printer/plotters. 

a Pr prints text into pages headed by date, file name, and page number. 

a Raster is a ruter for raster images. 

a CifPlot is a filter for files produced by the UNIX command cifplot. 

a Control interprets the first character of each line as a standard FORTRAN 
carriage control character. 

a TeX is a filter for tex documents. 

a Troff is a filter for files containing troff commands. 

None and troff are provided as part of the standard SunOS installation. The other 
filters may be provided as part of other printer installations. 

If you occasionally need to print a file with another print method, you can choose 
Other. A text field is displayed into which you can type any command line print 
method, including UNIX pipes. This text field accepts three variables: 

a $FILE substitutes the name of the specified file in the print script. 

a $PRINTER substitutes the name of the printer currently selected in Print Tool. 

a $eop IES substitutes the number of copies currently specified in the Copies 
text field. 

For example, if you want to pretty-print a C file using the vgr ind command and 
pipe the output to lpr, you would follow these steps: . 

1. Click SELECT on Other. 

2. In the text field, type vgrind -t $FILE I Ipr -P $PRINTER -t 

3. Type the name of the file in the File text field, or drag and drop the file you 
want to print onto Print Tool. 

You can view jobs in the print queue by clicking SELECT on the Status button. 
When there are no entries, the message No Entries is displayed in the footer. 
When there are entries in the print queue, the list of all the jobs for that printer (not 
just yours) is displayed in the scrolling list in the lower part of the Print Tool 
window, as shown in Figure 6-6. 
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Stopping Printing 

Troubleshooting 

Figure 6-6 An example of jobs in the Print queue 

NOTE 

NOTE 

~ --- .,--
(print) (status) (Stop Printing v) 

active 186 lail.winsor.627 winsor 

~ 

6 
~rlnting Itmp/mall.winsor.627611322 ... 

J 

You can stop printing all your jobs in the job queue by choosing All Print Jobs from 
the Stop Printing menu. To stop selected jobs, follow these steps: 

1. Click SELECT on the Status button to display jobs in the print queue. 

2. Point to a job in the scrolling list that you want to stop and click SELECT. 
To stop more than one job at a time, point to additional jobs and click 
SELECT. 

3. When you have selected the jobs you want to stop, point to the Stop 
Printing button and press SELECT. 

Alternatively, you can point to the Stop Printing button, press MENU, drag the 
pointer to highlight the Selected Print Job item, and release MENU. 

When you stop printing one or more print jobs, the Print Tool remains busy and 
does not accept further input until the printer acknowledges the request. Depend­
ing on the number of jobs selected and the status of the printer queue, it may take 
a long time (several minutes)for the printer to respond to your request. 

If a file has an inappropriate print script in /etc/filetype or • filetype in 
your home directory, the Prin~ Tool may hang when you use it to print that file. The 
print script may be missing the $FILE, $PRINTER, or $eOp IES variable. See 
Chapter 12 for infonnation about how to change print scripts using the Binder. 

The Print Tool and the File Manager read the filetypejiles when you start the 
appUcation. Jfyou make changes to the Binder, you must quit the tool and restart 
it/or the changes to take effect. 

When you print multiple mail headers by dragging and dropping them onto the 
Print Tool icon or window, they are batched together as one print job. Print Tool 
starts printing each new mail message at the top of a new page. 
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If you print a file and the appropriate filter is not available on the printer, you will 
receive an error mail message. 

The Tape Tool application provides a user interface to the UNIX tar tape 
archiving and retrieval functions. Refer to the man page for tar for more detailed 
infolDlation. The Tape Tool is designed to allow you to archive selected files and 
directories onto a streaming tape cartridge, and to list and retrieve files from a 
streaming tape cartridge that have been archived using the tar command. 
Alternatively, you can use Tape Tool to archive individual files to and from one 
large archive file instead of to and from a streaming tape cartridge. The Tape Tool 
is not intended to be an all-purpose system backup tool, and cannot read tapes that 
have been written using the epio command. 

The Tape Tool icon has an image of a streaming tape cartridge, as shown in 
Figure 6-7. 

Figure 6-7 The Tape Tool icon 

tapetool 
You can select flies and folders from the File Manager and the Mail Tool to be 
archived on tape. You can drag and drop them as a group or individually onto the 
Tape Tool icon or onto the open Tape Tool window to accumulate a list of files to 
be written to a streaming tape cartridge. When you drop a file or group of files onto 
the Tape Tool icon, the tape in the Tape Tool icon moves, as shown in Figure 6-8, 
to show you that you have selected files for archiving but have not yet completed 
the process. 

Figure 6-8 The Tape Tool icon when files are listed/or archiving 

[I] 
tapetool 

The Tape Tool Base Window You can perfOIDl the following operations from the Tape Tool base window. shown 
in Figure 6-9: 

o List the files from a streaming tape cartridge or archive rue that have been 
archived using the tar command. 

o Read some or all of the files from the tape or archive file into the directory that 
you specify. 

o Write specific files or directories that you specify onto a streaming tape 
cartridge or into an archive file. 
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o Display a window from which you set the properties for the tar command 
from the Tape Tool Properties window. 

Figure 6-9 The Tape Tool base window 

Caution: 

The Tape Tool Properties 
Window 

@) Tapetool 

( list .. ) ( Read v) ( ':'-!rite) ( Props ... ) 

(File To Write:) • 

Destination: /home/Jungle/brenda 

~ 
" 

..... 

't 

The control area provides controls for listing, reading to tape, writing from tape, 
and setting Tape Tool properties. 

The File To Write button and text field allow you to type in the names of files that 
you want to write to tape. After typing in the name of a file to write, press the 
Return key or click SELECf on the File To Write button. The scrolling list displays 
a list of the files you specify by typing file names or by dragging and dropping 
icons from the File Manager. 

The Destination field allows you to specify where files that are read from the tape 
are put in your file system when they were archived without a path name or with a 
relative path name. The default destination is your current working directory. You 
can change the destination to anywhere you want in the file system by typing the 
path name in the Destination text field. 

If the files on a tape have a complete path (absolute path), the files are always 
put in the directory specified on the tape, regardless of what you type in the 
Destination field. To strip files of their absolute path name when you archive 
them, set the Delete Dir option in the Tape Tool Properties window to All and 
click SELECT on the Apply button .. 

Each of these functions is described in more detail in the following sections. 

Before you read to or write from a tape or archive file, it is a good idea to display 
the Tape Tool Properties window t shown in Figure 6-10, to confino that the 
properties you want to use are set correctly. 
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Figure 6-10 The Tape Tool Properties window 

.~ Tapetool: Pro pertles 
Device: /dey/rst§.. 

Tar Options 

Write: No sees I I No sees+ I I B lock I/O 

Sym links I I Show Errs I I Suppress 

Read: No eheck I I Mod Time I I Orig Mode I 
Delete Dlr: None I All I Pattern I 

Other: Err Exit I I Exclude I 

o Use the Device text field to identify the tape drive to your system. TIle most 
common device numbers for a tape drive are / dev / r st 8 and / dev / r st O. 
Alternatively, you can specify a file name in this field if you wish to read or 
write files to and from one big archive file instead of to and from a streaming 
tape cartridge. 

o Use the Write nonexclusive settings to choose none, some, or all of the write 
options listed here: 

• Use No sees to exclude all sees directories. 

• Use No sees+ to exclude all sees directories, files with a suffix .0, and 
files named errs, core, and a. out. . 

• Use Block I/O to specify a blocking factor fot better throughput. When 
you click SELECf on this setting, a text field is displayed in which you 
can type the blocking factor you want Tape Tool to use. 

• Use Sym Links to follow symbolic links as if they were normal files. 

• Use Show Errs to display error messages if all links to archived files cannot 
be resolved. 

• Use Suppress to suppress infolDlation showing owner and iue modes for 
portability. 

(] Use the Read nonexclusive settings to choose none, some, or all of the read 
options listed here: 

• Use No eheck to ignore directory checksum errors. 

• Use Mod Time to keep Tape Tool from resetting the modification time of 
files that it reads from the tape. 
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Listing Files from a Tape 

• Use Qrig Mode to restore the named files to their original mode, ignoring 
the default umask setting of 2. 

a Use the Delete Dir settings to choose whether you want selected files to be 
stripped completely of their path names, use complete path names, or use a spe­
cific path name. When you click SELECf on Pattern, a text field is displayed 
in which you can type the name of a path to use for all the files. 

a Use the Other exclusive setting to choose none, one, or both of the following 
options for both read and write operations: 

• Use Err Exit to exit the operation as soon as an error is encountered. 

• Use Exclude to specify a file name that contains a list of files and/or direc­
tories that you want to exclude from reading from the tape. This item can 
be useful when the tape contains many files and you want to retrieve all but 
a few of them. 

When you have set the options you want, click SELECf on the Apply button to 
apply the changes. These options will remain in effect until you quit the Tape Tool 
application. 

To view a list of files from a tape, follow these steps: 

1. Insert the tape in the tape drive. 

2. Click SELECT on the List button. 

A Tape Contents pop-up window displays a list of files from the tape in the 
scrolling list, and information messages are displayed in the footer of the Tape 
Tool base window, as shown in the example in Figure 6-11. 
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Figure 6-11 The Tape Contents pop-up window 

NOTE 

Editing the List of Files in the 
Tape Contents Window 

Tapetool 
., 

g) [Read V) (write J (Props ... ) 

(File To Write:) .... _____________ • 

Destin. tlon: 

".--- -
..---... - -- --- c! 
643 Item(s) Found 

,J ~ 

,.. .-0:0 Tapetool: Tape Contents/files to Read 
, 

( File To Read:) • 

I/hole/w1nsorl21open/21artl1st.dOC 

~ Ihole/w1nsorl21open/21openlookl.doc 
Iholle/w1nsor/21open/21openlook19.doc 
Ihole/w1nsorl21open/21openlookl1.doc 
Ihole/w1nsor/21open/21openlook12.doc 
Ihole/w1nsorl21open/21openlook13.doc 
Ihole/w1nsorl21open/21openlook14.doc 
Ihole/winsorl21open/21openlooklS.doc 
Ihole!w1nsorI21open/21openlook16.doc 
Ihole/w1nsorl21open/21openlook17.doc 
Ihole/winsor/21open/21openlook19.doc 
Ihole/w1nsor/21open/21openlook2.doc 

It may takefrom afew seconds to several minutes to list the files on the tape, 
depending on how many files are on the tape. While the files are listing, the Tape 
Contents window is busy and cannot accept any user input. You can, however,. 
press the Stop key on the keyboard to stop the operation. 

Once the files are listed, you can retrieve all of the files in the list, retrieve specific 
selected files, or edit the list to remove files you do not want to retrieve. This 
section describes several ways that you can edit and select from the Tape Contents 
scrolling list. 

The Tape Contents window has a pop-up menu, shown in Figure 6-12. 

Figure 6-12 Selectedfiles in the Tape Contents window 

r.~ Tapetool: Tape Contents/Files to Read 
, 

(File To Read:). 
21open/21artlist.doc Read Functions 
210pen/21openlookl.doc 
21open/21openlooklB.doc 

" 
(select All ) 

21open/21openlookll.doc OeselectAII 
21open/21openlook12.doc Oelete Selected 21open/21openlook13.doc 
21open/21openlook14.doc 
21open/21openlook15.doc 
21open/21openlook16.doc 
21open/21openlook17.doc 
21open/21openlook18.doc 
21open/21openlook2.doc 

To select all the files on the tape, choose Select All from the Read Functions pop­
up menu. 
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To edit the list, select a group of files by clicking SELECT on the name of each file 
that you want to delete. Clicking SELECf on a selected file deselects it Selected 
files are highlighted, as shown in Figure 6-13. 

Figure 6-13 Selectedfiles in the Tape Contents window 

Reading Files from a Tape 

~cP Tapetool: Tape Contents/Files to Read 

(File To Read:) • 

catconvertge nerk 

I~ ~Iodcanalog.rs 
d«kdlgltal.rs 
clockicon.rs 
tlOCkPOP up me n u.rs II lockprops.rs 

I I 
cmaccess.rs 
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1t:::J 
I ... ...I 

To remove these files from the list, choose Delete Selected from the Read 
Functions pop-up menu. If you want to delete all the flIes from the list, choose 
Select All and then Delete Selected from the pop-up menu. 

If you inadvertently delete a file that you want to restore, you can add it back to the 
list by typing the file name in the File To Read text field, then pressing the Return 
key or clicking SELECf on the File To Read button. 

When you have edited the scrolling list to your satisfaction, you can choose an 
operation from the Read menu described in the next section. 

The Read menu, shown in Figure 6-14, has three options that you can use to read 
files from the tape or archive file to the destination directory specified in the Tape 
Tool base window. 

Figure 6-14 The Read menu 

Caution: 

==-r-- (Props ... ) 

When you read tiles that have a path name in front of them (an absolute 
path), as shown in the Tape Contents list, that path name is always used as 
the destination. 

If the files are not preceded by a file name, the directory you specify in the 
Destination text field is used as the destination. 
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When you have listed the contents of a tape and selected all or some of the files, 
choosing Selected from the Read menu copies the specified files to the destination 
directory shown in the control area. 

When you have not listed the contents of a tape, choosing Selected displays the 
Tape Contents window without a listing. If you know the names of specific files 
that you want to retrieve, you can type a name in the File To Read text field, then 
press the Return key or click SELECI' on the File To Read button to add them to 
the list. 

When you have listed the fues from a tape, choosing Entire List from the Read 
menu reads the entire list of files from the Tape Contents window. 

When you have not listed the contents of a tape, choosing Entire List displays the 
Tape Contents window without a listing. 

While the files are being read, infonnation messages are displayed in the footer of 
the Tape Tool window showing you the percentage of files that have been read. As 
the flIes are read, they are removed from the Tape Contents window~ When the 
process is complete, an infonnation message is displayed in the footer of the Tape 
Tool window telling you how many files were read. 

If there are a large number of flIes, it may take several minutes for the files to be 
copied to your system. 

Using the Read Entire Tape Item Choosing Entire Tape from the Read menu copies all of the fues on the tape to the 
destination directory without displaying the Tape Contents window. -

Writing Files to a Tape To write files to a tape, first accumulate the list of files you want to archive. You 
can specify files in the following ways: 

(] Select files from the File Manager, and drag and drop a copy of those files onto 
the Tape Tool. 

The files are accumulated in the scrolling list in the Tape Tool base window, 
as shown in Figure 6-15. 
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Figure 6-15 A list offiles to be written to tape 
,..~ Tapetool 

, 
(List ... ) (Read v) (Write ) (props ... ) 

( File To Write:) • 

Destination: Ihome/wlnsor 

[)/hole/w1nsor/artresule.doc 

~ [)/ha.e/winsor/bird.rs 
~/hole/winsor/b1rdsofafeather.rs 
~/hoI8/w1nsor/brokenlady.rs 
[)/hole/w1nsor/darkpower.rs 
[)/hole/w1nsor/dog.rs 
~/hole/winsor/doggie.rs 

7 Items(s) grabbed 

a Alternatively, you can type the name of a directory or of an individual fue in 
the File To Write text field and then press the Return key or click SELECf on -
the File To Write button. 

The infonnation is added to the scrolling list. 

The Tape Tool scrolling list has a pop-up menu, shown in Figure 6-16, that you 
can use to edit the list by deleting all of the files or selected files. 

Figure 6-16 The Write Functions pop-up menu 

fl2J Tapetool 
., 

(List. .. ) (Read v) (~rl~e ) (Props ... ) 

(File To Write:) • 

Destlna tlon: 
... 

Write Functions .. 
~ 

(Delete selectea) '-• 
Delete All _-___ I ... - ~ 

To write the list of files to the tape, follow these steps: 

1. Click SELECT on the Props button to display the Tape Tool Properties 
window and confirm that you have the correct options set. 

It is a good idea to check the Tape Tool Properties window each time you write 
files to a tape, since the settings are not saved if you quit Tape Tool and start it 
up again. 

2. Check the tape to be sure that it is not write-protected. 

3. Insert the tape in the tape drive. 

4. Click SELECT on the Write button. 
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H you receive a checksum error when reading fues from a tar tape, there may be 
a mismatch between the block size on the tape and the block size you specify. 

To correct the block size, choose Block 110 from the Tape Tool Properties 
window. In the text field that appears, type the correct block size (the one from the 
tape). 

If you reUieve files from a tape and they are not copied to the destination directory 
you specify, list the contents of the tape to see if the file names are preceded by an 
absolute path name. When you retrieve files that have an absolute path name~ that 
path is used as the destination directory. 
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Snapshot 

The DeskSet Environment provides an application called Snapshot that you can 
use to take black and white or grayscale and color snapshots of regions, windows, 
or the entire screen. The snapshots are created and stored as raster files. 

This chapter describes how to use the Snapshot application. 

When you use Snapshot on a black and white monitor, the snapshots created are 
always black and white. When you take snapshots on a color monitor, the 
snapshots are usually in color. If you have a color monitor but you are running 
Open Windows in black and white (in the overlay plane only), the snapshots created 
are black and white. Some applications can handle black and white snapshots but 
cannot handle grayscale or color snapshots. See "Troubleshooting" later in this 
chapter for infonnation about how to determine whether a snapshot is black and 
white or color. See the OpenWindows Installation and Stan-Up Guide for 
infonnation about how to run Open Windows in black and white on a color monitor. 

7.1 The Snapshot Icon The Snapshot icon is an image of a camera, as shown in Figure 7-L 
and Base Window 

Figure 7-1 The Snapshot icon 

trW 
The Snapshot base window, shown in Figure 7-2, contains all the controls you need 
to take snapshots.· 
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Figure 7-2 The Snapshot base window 

7.2 Locating and 
Naming Snapshot 
Files 

7.3 Setting the Timer 

7.4 Hiding Snapshot 
During Capture 

@) Snapshot - directory:/home/junglelbrenda ' 

Directory: Ihome/Jungle/brend, 

File: snapshotrs 

Timer: UD 2 14 Ie I '6 I seconds 

I Tim.;-!" E:ell I I Hide Snapshot During capture I 
( Snap Window) (Snap Region) ( Snap Saeen) 

(View Snap) (Print Snap v) 

'L. .J 

When you start it, the Snapshot application uses your current woddng directory 
(typically the home directory) and a file named snapshot. rs as the default for 
the Directory and File text fields. 

You can put your Snapshot flIes anywhere you want in your file system. Type the 
path of the directory in the Directory field and the file name in the File text field. 

It is a good idea to use . r s or some other common suffix for raster file names to 
make it easier for you to manage them as a group. 

Snapshot has a timer that you can use to set the time period between when you 
initiate the snapshot and when it is taken. The timer is especially useful if you are 
taking snapshots of menus that you must display after you start the snapshot, or if 
you want to be sure the pointer is at a specific location when the snapshot is taken. 

When the timer is set to 0 seconds, the snapshot i~ taken immediately ~ Wh~n the 
timer is set from 2 to 16 seconds, the Timer Bell setting is activated. When the 
Timer Bell setting is on, a bell beeps once each second between when you initiate 
the snapshot and when it is taken, followed by four quick successive bells when the 
snapshot is taken. 

Click SELECT on the Timer setting that you want, and click SELECT on the Timer 
Bell setting to toggle it from off to on, or vice versa. 

Sometimes you may want to take a snapshot of a large portion of the screen or of 
the entire workspace without showing the Snapshot window. In such cases, click 
SELECT on the Hide Snapshot During Capture setting to remove the Snapshot 
window from the screen while the snapshot is in progress. 

When the Hide Snapshot During Capture setting is toggled on, Snapshot 
automatically adjusts the Timer setting to eight seconds. This is to guarantee that 
there will be enough time to remove the Snapshot window before the snapshot is 
taken. Remember to reset the Timer setting after you toggle the Hide Snapshot 
During Capture setting back off. 
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Snapshot provides you with three buttons for creating snapshots: 

(] Snap Window 

(] Snap Region 

(] Snap Screen 

This section describes how to use each of these buttons. 

You can take snapshots of windows and icons following these steps: 

1. Make sure the window or icon you want to snap is completely visible and 
is not partially obscured by overlapping windows unless you want to 
include them in the snapshot. 

2. Type the name of the directory and the file name you want to use for the 
snapshot in the text fields at the top of the Snapshot base window. 

3. Set the timer and timer bell if you want to use them. 

4. If you want to hide Snapshot during the capture operation, click SELECT 
on that setting. 

S. Click SELECT on the Snap Window button. 

If the file name you have specified already exists in that directory, a Notice is 
displayed asking for confinnation that you want to overwrite the file. 

The Snap Window button displays the standard busy pattern and an 
infonnation message is displayed in the footer. 

6. Move the pointer into the header of the window you want to snap and click 
SELECT to start the snapshot. To cancel the operation, click either the 
ADJUST or MENU mouse buttons. 

When the pointer is in the header of the window, the entire window is snapped~ 
including the header. When the pointer is in a pane of a window, only that pane 
is snapped. 

When the snapshot is complete, an infonnation message is displayed in the 
footer of the Snaps~ot window telling you that the Snap succeeded. Figure 
7-3 shows an example of an infonnation message in the footer. 
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Snapping a Region 

Figure 7-3 The Snapshot information message 

NOTE 

(!) Snapshot - dlrectorv:/home/Jungle/brenda 

Directory: /home/Jungle/brenda 

File: sampfesnap.,.. 

Timer: 10) 2 14 1 a 116 I seconds 

I Timor'· E:eil I I Hide Snapshot During Capture I 
(Snap Window) (Snap Region) (Snap Saeen) 

(View Snap) (Print Snap v) 

Snap succeeded. 

When you have the timer set, and are taking snapshots of windows or icons, 
Snapshot records the window position when the snap is initiated. If you move the 
window before the snapshot is completed, you may not get all of the information 
you wanted in the snapshot. 

You can view the snapshot in a pop-up window by clicking SELECT on the View 
Snap button. See "Viewing a Snapshot" later in this chapter for more infonnation. 

You can take snapshots of any rectangular area that you specify using the 
Snap Region button. The following example shows how to take a snapshot of the 
pop-up menu for the Command Tool pane. 

1. Open a Command Tool window. 

2. Type the path of the directory and the file name you want to use for the 
snapshot in the text fields at the top of the Snapshot base window. 

3. Set the timer to four seconds (or longer), and turn the timer bell on. 

4. Decide where in the Command Tool window you want to put the menu. 
Display the menu to determine how large a region you need to define. 

S. Click SELECT on the Snap Region button. 

The Snap Region button displays the standard busy pattern and an infonnation 
message is displayed in the footer. 

6. Move the pointer into the Command Tool window and·click SELECT to 
define one corner of the region. Move the pointer and c1~ck SELECT 
again to define a rectangular region. 

A bounding box is displayed. You can adjust the size of the bounding box by 
moving the pointer and clicking SELECf at a different place. 

7. When the region is defined, click ADJUST to start the timer. 

8. Move the pointer into the region and press MENU to display the 
Command Tool pane pop-up menu. 
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9. When the timer stops, and the information message is displayed, the 
snapshot is complete. 

You can take snapshots of the entire screen following these steps: 

1. Make sure the screen is set up in the configuration you want. 

2. Type the path of the directory and the file name you want to use for the 
snapshot in the text fields at the top of the Snapshot base window. 

3. Click SELECT on Hide Snapshot During Capture unless you want the 
Snapshot window as part of the screen shot. 

4. Set the timer and timer bell if you want to use them. 

S. Click SELECT on the Snap Screen button. 

If you set the Hide Snapshot During Capture setting, the Snapshot window is 
removed from the display and is redisplayed when the snapshot is complete. 

You can view any snapshot file at any time by typing the directory and the name 
of the file in the text fields and clicking SELECT on the View Snap button. 

A pop-up window is displayed, as shown in the ex~ple in Figure 7-4, showing the 
contents of the snapshot file. 

Figure 7-4 The View pop-up window 

In addition, you can view a raster file by dragging the rue from the FlleManager 
application and dropping it onto the View window or the Snapshot base window. 
The raster file will then be displayed in the View pop-up window. 
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You can view grayscale or color snapshots on a black and white monitor. Snapshot 
automatically converts a copy of the grayscale or color image to black and white 
so that it can display the file in the View Snap pop-up window. The file itself is 
not changed. 

You can only view one snapshot at a time. When the View window is displayed, 
and you type a new snapshot file name in the text field and click SELECf on the 
View Snap button, the View window is reused and automatically resizes to match 
the size of the second snapshot file. 

7.7 Printing a Snapshot You can print your snapshot files by clicking SELECf on the Print Snap button. If 
the default settings in the Print Options window are incorrect for your system, you 
can change them by choosing Print Options from the Print Snap menu to display a 
pop-up window, shown in Figure 7-5, that allows you to change your printer 
settings for Snapshot 

Figure 7-5 The Print Options pop-up window 

cP Snapshot: Print Options 

Destination: I Printer I File I 
Printer: IWe 

Orientation: I Upright I Sideways I 
Position: 0.25 Inches from left. --

0.25 Inches from bottom --
Width: !.- Inches I Scale I Size I 

Double Size: I No I Ves I 
(Print) 

You can designate whether a snapshot is sent to a printer or to a file. When the 
Destination option is set to Printer, use the Printer text field to specify which printer 
you want to use. 

When the Destination option is set to File, the text fields change to Directory and 
File, as shown in Figure 7-6. 

Figure 7-6 The print to file text fields 

CP Snapshot: Print Options 

Destination: I Printer I File I 
Directory: ______ _ 

File: ... _____ _ 

-- .'-~--------------
Choose the orientation of the printed image on the page by clicking SELECT on 
Upright to print a portrait image, or Sideways to print a landscape image. 
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You can change the margins for the printed image from 1/4 inch at the left and 
bottom by typing new values in the Positions text fields. 

You can specify the width of the printed image on the page by choosing Scale and 
typing a value, either whole number or decimal, in the Width text field. The image 
is automatically scaled proportionate to the width you select 

When you click SELECT on Size, a Height text field is displayed, as shown in 
Figure 7-7, allowing you to specify an absolute width and height for the image to 
fit into. 

Figure 7-7 The Size textfields 

~:prl.tOPtl5d 

7.8 Troubleshooting 

Width: ~ Inches I Scale I Size I 
Height: ~ Inches 

Double Size: ( No I Yes I 
(Print) 

You can specify whether the file is printed in the size you specify, or whether it is 
doubled in size by clicking SELECT on the Double Size option. 

CliCking SELECf on the Print button prints the file that is specified in the File field 
of the Snapshot base window. 

Once you change the settings in the Print Options window, they are automatically 
recorded and used each time you click SELECf on the Print Snap button of the 
Snapshot window. 

If the screen pointer does not show up in your snapshots, yoti are probably using 
the Snapshot application on a color workstation with a cgsix framebuffer. The only 
way to get the pointer to appear in your snapshots is to run Snapshot on a 
workstation with a different kind of framebuffer. To find out if a workstation is 
using a cgsix framebuffer, follow these steps: 

1. Start up a Command Tool or Shell Tool. 

2. At the system prompt, type / etc/ dmesg I grep cgsix 

3. Press Return. 

If the system replies with any messages containing the string "cgsix", you are 
using a cgsix frame buffer, so the screen pointer will not appear in your snapshots. 
If the system just returns another prompt, you are not using a cgsix frame buffer, 
so the screen pointer will appear in your snapshots. 

If you experience difficulty in using Snapshot files with other applications, it may 
be because you are trying to incorporate a snapshot from a grayscale or color 
monitor into an application that can only handle black and white images. 
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Raster files have three dimensions: height, width, and depth. Black and white 
raster files are 1 bit deep. Grayscale and color raster flIes are 8 bits deep. 

You can see if a raster file is I bit or 8 bits by typing file rasterfilename 
and pressing Return from a Shell Tool or Command Tool prompt, or by selecting 
the file from the File Manager and displaying the File Properties window. In the 
example shown in Figure 7-8, the listing shows the file properties for all files 
ending in • r s. As you can see from the listing, there is one 8-bit raster file 
(snapshotrs) and the rest are I-bit files. 

Figure 7-8 An example of a file command listing 

42]castle{winsor S file -.rs 
cmdtoolmenu.rs: rasterfile, 8K8Kl standard format image 
samplesnap.rs: rasterfile, 114K285Kl standard format iMage 
snapshot.rs: rasterfile, 258K287K8 standard fOrMat 1.age 
s.pr1ntmenu.rs: rasterfile, 463K126Kl standard format iMage 
ssprinbaJindow.rs: rasterfile, 293K322K1 standard forMat image 
••• napmsg.rs: rasterfile, 461K236Kl standard format image 
sswindow.rs: rasterfile, 461K236Kl standard format image 
[43]castle{w1nsor}S + 

You can convert 8-bit images to I-bit images using the rasfilter8tol 
command. To convert a flle, type the following, then press Return: 

rasfilter8tol inputfilename outputfilename 

For example, to convert snapshot. rs from a color image to a black and white 
image called convertedsnapshot . rs, type the following, then press Return: 

rasfilter8tol snapshot.rs convertedsnapshot.rs 
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Shell Tool, Command Tool, and 
Console 

This chapter provides infonnation about the Shell Tool, Command Tool, and 
Console. Shell Tool and Command Tool are standard Open Windows shells, or 
command intetpreters. The Console is a special Command Tool designated for 
displaying error and system messages sent by the SunOS operating system, 
Open Windows, and some applications. The Shell Tool and Command Tool are 
essentially the same application, but with different default pane pop-up menus. 

8.1 Shell Tool Shell Tool is a command intetpreter that accepts SunOS commands and can be 
used for shells or other programs that employ a standard teletype (tty) interface. 
Figure 8-1 shows the Shell Tool icon and an open Shell Tool window. 

Figure 8-1 A Shell Tool icon and base window 

IW"I n.n 
(u~=c==cuc:c:c== ") 

Ibin/csh 

~ '. shelltool -./bin/csh 

J 

A Shell Tool window has a header with a Window menu button, a Window menu, 
resize comers, and a teJDlinal emulator pane. A Shell Tool window does not have 
a scrollbar at start-up, but you can enable scrolling if desired. The insert point is 
shown by a block cursor. When the insert point is not in the Shell Tool, the block 
cursor is displayed as an outline of the block cursor. Editing is limited to the 
current line. For example, you can only delete characters on the current line. Once 
you press the Return key, the characters on the line are interpreted as a command. 
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The Shell Tool Pop-up Menu The Shell Tool tenninal emulator pane has a pop-up menu, shown in Figure 8-2. 

Figure 8-2 The Shell Tool Term Pane pop-up menu 

Term Pane 

(Enable Page Mode) 

Copy 

Paste 

Enable Saolling 

Use the Enable Page Mode item to show you only one page or pane of text at a 
time, just as the Unix mo re command does. 

When you choose Enable Page Mode the pointer changes to a stop sign when the 
window fills up, as shown in Figure 8-3. 

Figure 8-3 The Shell Tool pop-up menu 

2 winsor 
2 winsor 
2 winsor 
3 winsor 
2 winsor 
2 winsor 
2 winsor 
2 winsor 
2 winsor 

shelltool-/bin/c:sh 

512 Feb 11 15:19 8inder 
2569 Feb 11 15:18 Calendar 

15369 Feb 28 11:46 Oeskset 
512 Jan 29 89:47 EKamples 

6656 Feb 11 15:17 Filemgr 
1924 Feb 11 15:18 Gett1ngstarted 

! 512 Feb 6 89:54 Installation 
3564 Feb 11 15:18 Ma11tool 
1924 Feb 11 15:18 Printtool 

Instead of continuing to flow the lines through the window, the display stops so that 
you can look at it as long as you like. In addition, the Enable Page Mode item on 
the Term Pane pop-up menu changes to Continue when there is more infonnation 
that you can display. 

When you want to see the next pane, press any key to display it You can also 
choose Continue from the pop-up menu to display the next pane of infonnation. 

When there is no more data to display, the first item of the Tenn Pane pop-up menu 
changes to Disable Page Mode. You can choose Disable Page Mode from the pop­
up menu to switch out of page mode. 

Use the Copy item to copy highlighted text from the Shell Tool window to the 
clipboard. 

When there is text on the clipboard, you can use the Paste item to insert the 
contents of the clipboard" at the insert point 

The Enable Scrolling item can be used to tum the Shell Tool into a Command Tool. 
When you choose Enable Scrolling, the name stripe at the top of the Shell Tool still 
says "she11tool", but the application acts like a Command Tool. See the next 
section for details about the Command Tool. 
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Command Tool is an enhanced Shell Tool. It provides a scrolling pane that acts as 
an editable command interpreter and can also provide a standard text editing pane. 
The Command Tool icon looks the same as the Shell Tool icon shown in 
Figure 8-1. Figure 8-4 shows an open Command Tool window. 

Figure 8-4 A Command Tool base window 

The Command Tool 
Pop~upMenu 

The History Submenu 

Figure 8-5 

r 121 emdtool - Ibin/csh 
., 

[26]castle{winsor}l. 

A Command Tool window has a header with a Window menu button, a Window 
menu, resize comers, a scrollbar, and. a text/te~inal emulator pane. 

The Command Tool Term Pane pop-up menu has the Edit, Fmd, and Extras items 
of the standard text editing pop-up menu (described in Chapter 5), plus three 
additional items: the History, File Editor, and Scrolling submenus. Figure 8-5 
shows the Tenn Pane pop-up menu. 

The Command Tool Term Pane pop-up menu 
cmdtool-/bin/csh 

Term Pane 

(History ~) 

Edit ~ 
Find ~ 

Extras ~ 

File Editor ~ 

Scrolling ~ 

The History of a Command Tool is a log of all the commands typed in that 
Command Tool. You can access this log by scrolling the Term Pane with the 
scrollbars or by saving the log to a file. This may be useful, for example, if you 
have performed a complicated sequence of operations that you want to save or send 
as part of a mail message for troubleshooting or debugging. The History submenu, 
displayed in Figure 8-6, provides options to modify the history log. 
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Figure 8-6 The Term Pane History submenu 
cmdtool -/bln/csh 

Term Pane ~ I Editable 

Edit 

find 

Extras 

Store log as new fIl8,"=;::=::1 ~ 
1 Read Only ~ 

Clear log I 

File Editor ~ 

Scrolling c> 

I 

-
The Mode setting determines whether the history log is Editable within the 
'Command Tool, or Read Only. If you set the mode to Read Only, in order to 
protect against accidental changes, you can still save the log to ~ file and edit that 
file using the File Editor option described below. If the mode is editable, you can 
edit text anywhere in the Term Pane and use the editing items on the Term Pane 
pop-up menu. See Chapter 5, &'Text Editor", for information on the editing 
functions. 

Use the Store log as new file option to save the current history log to a file. When 
you choose this option, the Text: Store pop-up window, shown in Figure 8-7, is 
displayed. 

Figure 8-7 The Text: Store pop-up window 

The Flle Editor Submenu 

.~ Text:Store 

Directory. Ihome/jungle/brend,. 

File: __ -----------------

(store as Hew Fuel 

Type the directory and name of the file you want to save the history in, and click 
SELECf on the Store as New File button. You can treat this new file as you would 
any other text rue. You can edit it and save it again or drag and drop it from the 
File Manager onto a, Mail Tool Compose or Text Editor window. 

Use the Clear log option to clear the current history log. This resets the Command 
Tool history log as if you just started the Command Tool application. (Ibis does 
not change the output of the UNIX history command). 

The choice from the File Editor submenu determines whether a Text Editor Pane 
is displayed. When you enable the File Editor, the Command Tool is split into two 
panes: a Command Tool pane and a Text Editor pane, described in Chapter 5. 
Figure 8-8 shows a Command Tool with the File Editor enabled. 
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Figure 8-8 The Command Tool with the File Editor 

The Scrolling Submenu 

8.3 Console 

Figure 8-9 

8.4 Troubleshooting 

r(!) cmdtool -/blnlcsh 
, 

-. = • --.. 

., 
~ (view v) (Edit v) (Find v) 

• ~ 

..." 

The choice from the Scrolling submenu of the Command Tool Tenn Pane pop-up 
menu detennines whether a scrollbar is displayed. When you disable scrolling, the 
Command Tool acts like a Shell Tool. 

The Console is a special Command Tool that is used to display error and system 
messages for the SunOS operating system, Open Windows, and some applications. 
Figure 8-9 shows the Console icon and base window. 

The Console icon and base window 

-( Uctccu::c:necc:> 

CONSOLE 

r &l cmdtool (CONSOLE) - Ibln/csh 

Jan 2 11:59:44 castle su: winsor on 
/dev/ttypl 
NFS server hammer not responding still 
trying 
NFS server hammer ok 

, 

,~ 
Always have one (and only one) Console window running. If you do not have a 
Console window t messages are displayed in large type at the bottom of the screen. 
To clear such messages, choose the Redisplay All utility from the WoJkspace 
menu. If you have more than one Console window running, messages are 
displayed in the most recently opened Console window. You may miss important 
system messages if you have more than one Console window running and do not 
look for messages in the newest one or if you have opened a new Console window 
and then quit the most recently opened one. 
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Clock and Performance Meter 

TIlis chapter provides information about the Clock and Perfonnance Meter. 

9.1 Clock Clock is a tool that displays an analog clock face icon showing the current time of 
day. The icon displays a clock, as shown in the example in Figure 9-1. 

Figure 9-1 The Clock icon 

Figure 9-2 

Customizing the Clock 

• + • 

• • 
+. ~. · t "' ... 

When you open the Clock icon, the clock is displayed in the pane of a base window, 
as shown in Figure 9-2. 

The Clock base window 

@) May13 .. 
• • 

• • 
• ~ . • 

• • 
The Clock base window has a header and resize comers. You can use the resize 
comers to change the area of the window, making the clock larger or sma1l~r. 

You can customize the Clock using the settings in the Clock Properties window. 
To display the Properties window, move the pointer onto the clock pane and press 
the Properties key on the keyboard. Alternatively, you can press MENU to display 
the Clock pop-up menu, as shown in Figure 9-3. 
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Figure 9-3 The Clock pop-up menu 

l!J Mav13 I 

Clock I • . I " PropertIes) 

• • 

·.A • 
• 

• • • 
Choosing Properties from the pop-up menu displays the Oock Properties window, 
as shown in Figure 9-4. 

Figure 9-4 The Clock Properties window 

.~ Clock Properties 

Clock face: I digital I analog I 
Oispla y Options: I Seconds I I Date I 

(APply) (Reset) (Defaults) 

Choosing digital and clicking SELECf on the Apply button changes the display in 
the base window to a digital clock, as shown in Figure 9-5. 

Figure 9-5 A digital clock display 
@) May 13 

The icon always displays an analog clock, regardless of the Clock Face property 
setting. 

Choosing Seconds displays seconds on the icon and on the analog and digital clock 
faces. 

Choosing Date displays the date in the header of the Clock base window but does 
not affect the icon display. 
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The Performance Meter allows you to monitor many aspects of system 
perfoimance, such as processor performance, network performance, and I/O 
perfonnance . 

. You can run one or a combination of several Performance Meters at the same time. 
Each Performance Meter has its own icon that displays a speedometer-like gauge. 
The needles move as systems conditions change. The short needle, or "hour hand," 
tracks average perfonnance over a 20-second interval, and the long one, or 
"second hand:' tracks current performance over a 2-second interval. The display 
is updated every two seconds. You can change these default times from the 
Perfonnance Meter Properties window described later in this chapter. 

The performance option being measured is displayed in the lower left comer of the 
icon and its maximum value is shown in the lower right comer. Figure 9-6 shows 
an example of the Percent CPU Used Performance Meter icon. 

Figure 9-6 The Percent CPU Used Performance Meter icon 

cpu lee 

When you open a Perfonnance Meter icon, a window that is the same size as the 
icon is displayed. Perfonnance data is displayed as a strip chart. Figure 9-7 shows 
an example of the Percent CPU Used Perfonnance Meter base window. 

Figure 9-7 The Percent CPU Used Performance Meter base window 

~ 
cpu lee 

The window has resize comers that you can use to change the area of the window. 
A resized Perfonnance Meter window is shown in Figure 9-8. 

Figure 9-8 A resized Performance Meter base window 

The Performance Meter 
Pop-up Menu 

CIIU 

You can change the performance value to be monitored from any Perfonnance 
Meter base window by choosing a different item from the pop-up menu shown in 
Figure 9-9. 
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Figure 9-9 The Performance Meter pop-up menu 
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Properties ... 

Here are the perfonnance values you can display and a description of their 
functions: 

o Choose Show cpu to monitor the percent of CPU being used. 

o Choose Show packets to monitor the number of Ethernet packets per second. 

o Choose Show page to monitor the paging activity in pages per second. 

o Choose Show swap to monitor the nwnber of jobs swapped per second. 

o Choose Show interrupts to monitor the number of job interrupts per second. 

o Choose Show disk to monitor disk traffic in transfers per second. 

o Choose Show context to monitor the number of context switches per second. 

o Choose Show load to monitor the average number of runnable processes over 
the last minute. 

o Choose Show colls to monitor the number of collisions per second detected on 
the Ethernet. 

o Choose Show errs to monitor the number of errors per second on receiving 
packets. 

You can customize some aspects of the Perfonnance Meter from the Properties 
window shown in Figure 9-10. 
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Figure 9-10 The Performance Meter Properties window 

9.3 Troubleshooting 

.~ Perfmeter: Properties 

Monitor: I cpu I packets I page I swap I Interrupts J 
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Machine: I local I remote I MathlftP .. amp: ____ _ 

Sample time: ~ '.1 •• seconds 

Hour hand: ~ '.1 •• seconds 

Second hand: _2 _1.1 •• seconds 

Choosing one of the Monitor settings and clicking SELECf on the Apply button 
does the same thing as choosing one of the items from the Perfomlance Meter pop­
up menu described in the previous section. 

You can monitor perfonnance for your own system or for another system on the 
network. To monitor a remote system, follow these steps: 

1. Click SELECT on Remote. 

The Machine name text field is activated. 

2. Click SELECT in the text field to set the insert point and type the name of 
the machine you want to monitor. 

3. Click SELECT on the Apply button. 

The Perfonnance Meter displays the name of the remote system at the bottom 
of the pane under the name of the value you are monitoring. 

To change back to your local system, click SELECf on Local,· then click SELECf 
on the Apply button. 

You can change the Sample Time, the frequency that the meters are updated, and 
the units measured by the Hour Hand and Second Hand on the icon scale. The 
default is for the hour hand to show a sample over a 20-second interval and the 
minute hand the average over a 2-second interval. If you change the values in these 
fields, remember to click SELEcr on the Apply button to record the changes. 

Displaying seconds for the clock may affect system perfomlance. 
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10.1 The Calculator Icon 
and Base Window 

10 
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Calculator 

The DeskSet Calculator is a scientific and financial calculator designed to perfonn 
a variety of mathematical functions. It operates in much the same way as many 
hand-held calculators. There are financial, logical, and scientific modes. You can 
store numbers in ten different memory registers and retrieve and replace them 
easily. In addition, you can store up to 10 of your own functions and constants in 
menus. 

The DeskSet Calculator initially displays numbers in fixed point notation and in 
decimal base. You can also display numbers in engineering or scientific notation. 
You can change the base of operation from decimal to binary, octal, or . 
hexadecimal. 

This chapter describes how to use the Calculator. 

The Calculator icon and base window are shown in Figure 10-1. The Calculator 
base window does not have resize comers or a control area, since the buttons of the 
calculator are the controls that activate its functions. The base window has six 
rows of eight buttons. Qick SELECT on a button to activate it. Buttons that have 
a menu mark have pulldown menus associated with them. }>ress MENU to display 
the menu, highlight the item you want, and release MENU. 

Figure 10-1 The Calculator icon and base window 
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10.2 Performing Simple 
Calculations 

10.3 Modes of Operation 

Numeric Bases 

To perfonn a numerical operation, such as adding two numbers together, follow 
these steps: 

1. Click SELECT on the first digit, for example, 7. 

The number is entered in the display at the upper right comer of the Calculator. 
In Figure 10-1 the number 0.00 is displayed in the numeric display area. 

2. Click SELECT on the operation you want to perform, for example, +, to 
add a ~umber. 

3. Click SELECT on the number you want to add to the first number, for 
example, 6. 

The number 6 is displayed in the numeric display area. 

4. Click SELECT on the = sign. 

The reSUlt, 13 in this example, is displayed in the numeric display area. 

Alternatively, you can use the keyboard to enter numbers and simple arithmetic 
functions. You can also use the Copy function key to store the numeric display to 
the clipboard, and the Paste function key to retrieve the contents of the clipboard. 

If an operation needing more than one input is partially complete, the pending 
operation is displayed on the line beneath the current number as a reminder. 

An important thing to remember about the Calculator is that calculations are 
perfonned from left to right, with no arithmetic precedence. If you need arithmetic 
precedence, then you should use parentheses. For example, the calculatio~: 

2+3*4= 

as perfonned by the DeskSet Calculator gives a result of 20. The same equation 
perfonned with correct arithmetic precedence would give a result of 14. This can 
be achieved with the Calculator by using parentheses: 

2+(3*4)= 

The Calculator has various modes of operation. The area below the header displays 
the current number, followed by a mode line that shows what the current mode 
settings are. 

You can set the following numeric bases using the Base key pop-.up menu, as 
shown in Figure 10-2: 

a Binary 

a Octal 

(] Decimal 

a Hexadecimal 
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Figure 10-2 The Numeric base pop-up menu 
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The current base 'setting is indicated as the first item in the mode line. In 
Figure 10-2, "DEC" indicates Decimal base. 

Up to 40 digits can be entered for eadl number, regardless of the base, but internal 
accuracy may be lost for large numbers. 

The numeric keypad changes to display only those numbers appropriate to the base 
mode that you choose. Inappropriate numbers are dimmed out. For example, in 
Figure 10-2 above the hexadecimal letter keys (A-F) are dimmed. TIle numeric 
base in that figure is decimal, so the hexadecimal letters are not valid or accessible. 
Choosing Binary displays the digits 0 and 1 on the numeric keypad. Choosing 
Octal displays the digits 0 through 7. Choosing Decimal displays the digits 0 
through 9. Choosing Hexadecimal displays the digits 0 through 9 and also 
activates the alphabetic keys at the top of the n~eric keypad. 

Figure 10-3 shows the keypads for both Binary and Hexadecimal numeric bases. 

Figure 10-3 The Binary keypad and the Hexadecimal keypad 
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You can choose to display Calculator results in one of the following notations by 
using the Disp key pop-up menu, as shown in Figure 10-4: 

o Fixed point notation 

o Engineering notation 

o Scientific notation 
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Figure 10-4 The Display type pop-up menu/or display notation mode 
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The current display notation is displayed as the third item in the mode line. In 
Figure 10-4 above. the mode line shows "FIX", indicating Fixed Point notation. 
When the current display notation is Engineering, &CENG" appears on the mode 
line. When the current notation is Scientific, "san is displayed. 

When the current notation is Fixed Point, the Calculator will revert to Scientific 
notation if a number is larger than the display will allow. 

There are four major Calculator modes that detennine the available functions: 

LJ Basic 

LJ Financial 

LJ Logical 

LJ Scientific 

You can choose these four modes using the Mode key pop-up menu shown in 
Figure 10-5. The default mode is Basic mode, which uses the standard keys on 
the Calculator base window. The other three modes have extra buttons that appear 
on a pop-up window. For infonnation on these modes, see "Financial Functions", 
"Logical Functions", and "Scientific Functions" later in this chapter. 

Figure 10-5 The Mode pop-up menu 

l!.I Calculator 

O.OOe+O 
HEX DEC SCI B"SIC 

0 E F C1 r Int Frae Base V Dlsp ~ Mode 

A B C Dsp Abs Chs Keys Mode 

"hi mandai 
7 8 9 X 1/x xA2 Ace v Mel. 

logical 

4 5 6 / , Sqrt Con V Fun Scientific 

t , ., (-

'" Rd V ..stgV -
The current major mode is displayed on the mode line underneath and slightly to 
the left of the number display. In Figure 10-5 above, "BASIC" is listed as the 
current mode. 
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The Calculator has twelve number manipulation functions, as shown in 
Figure 10-6. 

Figure 10-6 Number Manipulation /unctions 
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(] Use Int to return the integer portion of the currently displayed value. 

(] Use Frac to return the fractional portion of the currently displayed value. 

CJ Use Abs to return the absolute value of the currently displayed value. 

CJ Use Chs to change the arithmetic sign of the currently displayed value, or of an 
exponent being entered with the Exp key. 

CJ Use 1Ix to return the value of I divided by the currently displayed value. 

CJ Use x"2 to return the square of the currently displayed value. 

(] Use % to calculate the percentage of the currently displayed value specified by 
the next value entered. For example, to find out what 75% of 40 is, enter 40, 

. click SELECf on %, enter 75, then click SELECf on =. The Calculator 
returns the result 30. 

CJ Use Sqrt to return the square root of the currently displayed value. 

CJ Use ( and ) to give a calculation arithmetic precedence. All calculations 
within parentheses are calculated first Parentheses can be nested. The result 
of an operation containing parentheses is not perfonned until the last 
parenthesis is matched. 

CJ Use Exp to start exponential input Any number entered after you choose Exp 
is taken to be the exponent portion of this number. The numbers entered before 
the Exp key are taken to be the mantissa If no numerical input has occurred 
when the Exp key is entered, a mantissa of 1.0 is assumed. You can use the 
Cbs key after entering the exponent to change its arithmetic sign. 

CJ Use Asc to display the ASCn value of a character in the appropriate numeric 
base. The Asc key displays its own small pop-up window. 
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10.4 Miscellaneous 
Functions 

The Calculator has five miscellaneous functions, shown in 
Figure 10-7. 

Figure 10-7 Miscellaneous/unctions 

0.00 

CJ Use Clear (Clr) to clear the current value from the display. 

CJ Use Backspace (Bsp) to remove the rightmost character from the current 
display and recalculate its value. Note that internal accuracy is lost with this 
operation. 

CJ Use Keys to change the display of the Calculator keys to show the keyboard 
equivalents of each Calculator key for mouseless operation of the Calculator. 

Everything that can be done by clicking SELECf can also be done using the 
equivalent keyboard commands. Keys that have pop-up menus associated with 
them require two keyboard commands: the first to select the command, and 
the second to select the appropriate entry. When the pop-up menu contains 
numerical values, the numbers 0 through 9 can be used. For the logical shift 
pop-up menu, use the letters a through f for the numberS 10 through IS: Use 
the first letter in lower case of all other menu items. 

See the Calculator man pages included in Appendix C for more infoImation 
about the keyboard mapping. 

a Use Accuracy (Acc) to choose the number of digits of precision used in the 
calculator display. This key has a pop-up menu associated with it, which lets 
you specify 0 through 9 radix places. The default value is 2 radix places. 

a Use Quit to quit the Calculator .. 
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The Calculator has 10 memory registers that you can access using the keys shown 
in Figure 10-8. 

Figure 10-8 Memory Register functions 

\ 

\ 0.00 

BASIC 

file •••• 

~ 

\ Rd v Stov 

\ E)(chv 

o Use Memory (Mem ... ) to display a pop-up window showing the values of the 
ten memory registers in the current base to the current accuracy. 

o Use Store (S1o) to store the current value in the memory register number that 
you choose from the Store pop-up menu. 

o Use Recall (Rcl) to retrieve a value from the memory register number that you 
choose from the Recall pop-up menu. 

o Use Register Exchange (Exch) to exchange the contents of the current display 
with the current value in the memory register nUmber that you choose from the 
Exch key pop-up menu. 

The Exch, Sto, and Rcl keys have pop-up menus that you use to access the 
registers. Figure 10-9 shows the Exchange pop-up menu. 

Figure 10-9 The Exchange menu 
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10.6 User Defined 
Functions 

The Calculator allows you to enter your own set of constants and to define your 
own functions using the Con and Fun keys shown in Figure 10-10. 

Figure 10-1 0 User-defined /unctions 
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Each of these keys has a pop-up menu associated with it. Choosing the first item 
on the menu displays a pop-up window that lets you enter the value of a constant 
or a function, and associate a name with that value. The numbers you enter are 
stored in a . calctoolrc file in your home directory. 

Once you have entered the new value, by clicking SELECT on the button at the 
bottom of the pop-up window, the new value and its name are displayed in the pop­
up menu associated with that Calculator key. To use the constant or function value, 

. choose the desired item from the pop-up menu. 

The following example describes how to create and save a function which, when 
chosen, adds together two numbers taken from memory registers, and stores the 
result in another memory register. 

Note that when you enter a value for a new function, you must type the keyboard 
equivalents in the Value field. To display the keyboard equivalents for each 
Calculator key, click SELECT on the Keys button. 

1. Move the pointer onto the Fun key and press the MENU mouse button. 

2. Highlight Enter Function and release MENU to display the Enter 
Function pop-up window. 

3. Type in the number of the function you wish to add or replace in the 
Function No: field. 

4. Type a function name in the Name field, for example, addition. 

S. Type a function into the Value field. To add the numbers in Memory 
Registers 1 and 2, and store the sum in Register S, type 1l1+R2=SS • 

6. Click SELECT on the Enter Function button to store the new function in 
your • calctoolrc file and add it to the Functions menu. 

To use the new function, choose it from the Functions menu. 
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The Calculator has the financial functions shown in Figure 10-11. This pop-up 
window is displayed when you choose Financial from the Mode key pop-up menu. 

Figure 10-11 Financial functions 

Financial Mode. 

The financial functions reUieve needed information from the memory registers. 
For example, in order to determine the amount of an installment payment, the 
Calculator needs to know the amoWlt of the loan, 1be interest rate, and the tenn of 
the loan. You must store this information in the appropriate registers before you 
click SELECT on the financial function button. See "Memory Registers" earlier 
in this chapter for infonnation about how to store numbers in. the registers. 

The function descriptions below includeinfonnation about what the Calculator is 
expected to find in each register for each function. To get a more detailed example 
of how to use each of these fmancial functions, press the Fl or Help key with the 
pointer over the Calculator button you want help for. 

o Use Ctnn to compute the number of compounding periods it will take an 
investment of present value to grow to a future value, earning a fIXed interest 
rate per compounding period. The Calculator expects to find the following 
numbers in the memory registers: 

• Register 0: Periodic interest rate 

• Register 1: Future value of the investment 

• Register 2: Present value of the investment 

o Use Ddb to compute the depreciation allowance on an asset for a specified 
period of time, using the double-declining balance methOd. Store the 
following infonnation in the memory registers: 

• Register 0: Amount paid for asset 

• Register 1: Salvage value of asset at end of life 

• Register 2: Useful life of an asset 

• Register 3: Time period for depreciation allowance 

a Use Fv to detennine the future value of an investment The Calculator 
computes the future value based on a series of equal payments, earning a 
periodic interest rate over the number of payment periods in a term. The 
memory registers need to contain the following numbers: 

• Register 0: Amount of each payment 

• Register·l: Interest rate 

• Register 2: Number of payments 
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a Use Pmt to compute the amount of the periodic payment of a loan. Most 
installment loans are computed like ordinary annuities, in that payments are 
made at the end of each payment period. Store the following information in 
the memory registers: 

• Register 0: Principal or amount of the loan 

• Register 1: Periodic interest rate of the loan 

• Register 2: Term, or number of payments 

a Use Pv to determine the present value of an investment The Calculator 
computes the present value based on a series of equal payments discounted at 
a periodic interest rate over the number of periods in term. The following 
information is retrieved from the memory registers: 

• Register 0: Amount of each payment 

• Register 1: Periodic interest rate 

• Register 2: Term, or number of payments 

a Use Rate to compute the periodic interest rate. It returns the periodic interest 
necessary for a present value to grow to a future value over the specified 
number of compounding periods in term. Store the follOwing information in 
the memory registers: 

• Register 0: Future value 

• Register 1: Present value 

• Register 2: Tenn, or number of compounding periods 

a Use SIn to compute the straight-line depreciation of an asset for one period. 
The straight-line method of depreciation divides the depreciable cost 
(actual cost minus salvage value) evenly over the usefullife of an asset The 
useful life is the number of periods, typically years, over which an asset is 
depreciated. Use the memory registers to store the following infonnation: 

• Register 0: Cost of the asset 

• Register 1: Salvage value of the asset 

• Register 2: Useful life of the asset 

a Use Syd to compute the sum-of-the-years' -digits depreciation. This method of 
depreciation accelerates the rate of depreciation so that more depreciation 
expense occurs in earlier periods than in later ones. The depreciable cost is the 
actual cost minus salvage value. The useful life is the number of periods, 
typically years, over which an asset is depreciated. Store the following 
information in the memory registers: 

• Register 0: Cost of the asset 

• Register 1: Salvage value of the asset 

• Register 2: Useful life of the asset 

• Register 3: Period for which depreciation is computed 
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o Use Term to compute the number of payment periods in the term of an ordinaty 
annuity necessary to accumulate a future value earning a specified periodic 
interest rate. Store the following information in the memory registers: 

• Register 0: Amount of each periodic payment 

• Register 1: Future value 

• Register 2: Periodic interest rate 

The Calculator has the logical functions shown in Figure 10-12. This pop-up 
window is displayed when you choose Logical from the Mode key pop-up menu. 

Figure 10-12 Logica~functions 
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o Use < to shift the displayed value, treated as a 32 bit integer, to the left. This 

key has a pop-up menu. The number of places to shift can be selected from this 
menu, and ranges from 1 through 15. 

o Use> to shift the displayed value, treated as a 32 bit integer, to the right. This 
key has a pop-up menu. The number of places to shift can be selected from this 
menu, and r,mges from 1 through 15. 

o Use &16 to truncate the current display to a 16-bit integer. 

o Use &32 to truncate the current display to a 32-bit integer. 

o Use Or to perform a logical OR operation on the last number and the next 
number entered, treating both numbers as 32-bit integers. 

o Use And to perform a logical AND operation on the last number and the next 
number entered, treating both numbers as 32-bit integers. 

o Use Not to perform a logical NOT operation on the currently displayed value. 

o Use Xor to perform a logical XOR operation on the last number and the next 
number entered, treating both numbers as 32-bit integers. 

o Use Xnor to perform a logical XNOR operation on the last number and the next 
number entered, treating both numbers as 32-bit integers. 

The Calculator has the scientific functions shown in Figure 10-13. This pop-up 
window is displayed when you choose Scientific from the Mode key pop-up menu. 
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Figure 10-13 Scientificfunctions 

10.10 Troubleshooting 

a Use the Trig key pop-up menu to set the trigonometric base to Degrees, 
Radians, or Gradients. The current trigonometric base is indicated by the 
second item on the mode line. 

a Use Hyp as a toggle for setting or unsetting the hyperbolic function flag. This 
flag affects SIN, COS, and TAN trigonometric functions. When this flag is set, 
the word "HYP" appears on the mode line beneath the numeric display. 

a Use Inv as a toggle for setting or unsetting the inverse function flag. This flag 
affects SIN, COS, and TAN trigonometric functions. When this flag is set, the 
word uINV" appears on the mode line beneath the numeric display. 

a Use eAx to return e raised to the power of the currently displayed value. 

a Use l()1\x to return 10 raised to the power of the currently displayed value. 

IJ Use yAx to raise the last number entered to the power of the next number 
entered. 

[] Use x! to return the factorial of the currently displayed value. 

IJ Use Cos to return the trigonometric cosine, arc cosine, hyperbolic cosine, or 
inverse hyperbolic cosine of the current value, depending on the settings of the 
hyperbolic and inverse function toggles. (See Hyp and Inv above). The result 
is displayed in the current trigonometric base (degrees, radians, or gradients). 

IJ Use Sin to return the trigonometric sine, arc sine, hyperbolic sine, or inverse 
hyperbolic sine of the current value, depending on the settings of the . . 
hyperbolic and inverse function toggles. (See Hyp and Inv above). The result 
is displayed in the current trigonometric base (degrees, radians, or gradients). 

IJ Use Tan to return the trigonometric tangent, arc tangent, hyperbolic tangent, or 
inverse hyperbolic tangent of the current value, depending on the settings of 
the hyperbolic and inverse function toggles. (See Hyp and Inv). The result is 
displayed in the current trigonometric base (degrees, radians, or gradients). 

[] Use Ln to return the natural logarithm of the currently displayed value. 

a Use Log to return the base 10 logarithm of the currently displayed value. 

IJ Use Rand to return a random number between 0.0 and 1.0. 

If the Calculator detects an error, such as division by zero, the word "Error" is 
displayed. The Calculator must then be cleared with the Clr key before any further 
calculations can take place. 

Context-sensitive help is available for every Calculator function. Position the 
pointer over the item you want help with, and press the Fl or Help key. A pop-up 
window will be displayed giving detailed infonnation. 
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and Base Window 

11 
Icon Editor 

The Icon Editor allows you to create your own icon images. You can display your 
own icon images in the File Manager by binding them to applications and data files 
using the Binder. See Chapter 12 for infonnation about how to use the Binder. 

This chapter describes how to use the Icon Editor application. 

The Icon Editor icon displays an artist's easel, as shown in Figure 11-1. 

"Figure 11-1 The Icon Editor icon 
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Icon Editor 

When you start the Icon Editor, the base window and a Draw pop-up window are 
displayed, as shown in Figure 11-2. 

Figure 11-2 The Icon Editor base window and the Draw pop-up window 
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11.2 Filing Options 

Loading a File 

The Icon Editor base window has a control area with File, View, and Edit menu 
buttons; a preview area in the upper right comer that shows you the final image size 
of the icon you are creating in the pane; and a canvas that you use to create your 
image. When the canvas is blank, the preview area is also blank and is therefore 
not visible. 

The Draw pop-up window contains the controls you use to draw an image in the 
canvas. To draw an image, choose a mode (point, line, square, circle, ellipse, or 
text). Information messages are displayed in the footer of the Icon Editor window. 
Click SELECT to draw a point Press-drag-release SELEcr to draw a line, square, 
circle, or ellipse. You can adjust your drawing by using ADJUST with any of the 
modes to draw in white, turning off pixels in the design. (Clicking ADJUST on an 
off pixel does not tum it on). Using the Move buttons, you can move the image or 
a region to the left, right, up, or down, or you can reverse or rotate it The controls 
in the Draw pop-up window are explained in detail later in this chapter. 

The File menu opens a File pop-up window, shown in Figure 11-3, that you use to 
load, save, and browse icon files. 

Figure 11-3 The File pop-up window 
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File: ____________ _ 

Load Operation: @) Source (Ol,lerwrlte Canvas) 

( Load) ( Save) ( Browse ... ) 

To load a file, type the directory in the Directory field and the fue name in the Flle 
field. 

You can choose how to load the file from the Load Operations menu shown in 
Figure 11-4. 

Figure 11-4 The Load Operations pop-up menu 

.-(l;O kon Editor: File 

Dlrectorv: /home/deskset 

File: 

LD --- rite Canvas) 
Source (OverwrlN Canvas) 

Or (Union) S 
- Xor (Exclusive Or) 

- And (Intersection) 
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CJ Use Source (Overwrite Canvas) to load a file, overwriting any existing 
infonnation on the canvas. 

CJ Use Or (Union) to load a file transparently over another image, allowing any 
existing infonnation on the canvas to show through the new file. 

CJ Use Xor (Exclusive Or) to load a file transparently over another image, turning 
bits that are on in both images off and leaving the other bits unchanged. 

CJ Use And (Intersection) to load a file transparently over another image, 
retaining only the bits that are on in both images and turning all other bits off. 

When you have chosen the load operation you want to use, click SELBeI' on the 
Load button to load the file into the canvas. 

You can also load an icon ftle by dragging it from the File Manager and dropping 
it onto the Icon Editor. 

To save a file, type the directory in the Directory field, the file name in the File 
field, and click SELECf on the Save button. 

If a file of the same name already exists, a Notice is displayed, as shown in 
Figure 11-5, asking you whether you want to overwrite the existing ftle or cancel 
the operation. 

Figure 11-5 The Save confirmation Notice 

Browsing for Icon Files 

r-=!!!------~--~ ..... ~·~~:.::ll Confirm Overwriting over existing file 

(Confirm ) (Cancel) 
t' 

You can browse a specific directory for icon files using the Browse button. To 
browse a directory, type the name of the directory in the Directory field and click 
SELEeI' on the Browse button. 

The Icon Editor browses the specified directory and displays a message in the 
footer showing how many icon . files are found. In addition, a pop-up window is 
displayed showing the icon ftles available in that directory. Figure 11-6 shows an 
example of the images and their rtle names found after browsing the entire 
directory specified. 

Revision A of 11 JlUle 1990 



192 DeskSet Environment Reference Guide 

Figure 11-6 Results of a Browse 
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load Operation: (!) Source (Overwrite Canvas) 
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To load one of the browse fIles, follow these steps: 

1. Press SELECT on one of the icon images or file names in the Browse 
window. 

The fIle name of the image is selected, as shown in Figure 11-7. 

Figure 11-7 A selected browse item 
Q II»" Edit: Brows. klDns 
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2. Press SELECT on Load at the top of the Browse menu. 

When you release SELECf, the image is loaded. If there is an existing image 
on the canvas, a Notice is displayed asking you to confirm the overwrite. 
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H you have directories with a large number of files, you can reduce browsing time 
by using wildcard charclCters in the File field to narrow the search. For example, 
typing * . icon searches only for all files with a • icon suffix. 

11.3 The View Menu The View menu, shown in Figure 11-8, provides the following display options: 

Grid Display 

Icon Size 

Cl Grid (on or off) 

Cl Size of the canvas area (64,48,32, 16 square) 

Cl Preview background window 

Figure 11-8 The View menu 

Use the Grid item to choose whether or not to display a 4-pixel grid for the canvas. 
Figure 11-9 shows an example of the canvas with the grid turned on. 

Figure 11-9 The grid 
~----------~----------~ 

" Cat 

The Size item provides four standard icon image sizes: 

Cl 64 by 64 pixels (the default icon size) 

Cl 48 by 48 pixels 
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Preview Window 

Cl 32 by 32 pixels (the default size for icons that can be used as Flle Manager data 
file icons) 

Cl 16 by 16 pixels (typical cursor size) 

The canvas is always centered in the Icon Editor window. If you change the size 
of the canvas when an icon file is loaded, or load an icon into a different canvas 
size, the file is read from the upper left comer. In the example shown in Figure 
11-10, the canvas with the cat. icon file has been loaded into a canvas sized to 
32 by 32 pixels. 

Figure 11-10 Changing the size of an existing icon 

.."."Ioeded. 

Larger images are cropped to fit the existing size of the canvas, but the full image 
is still available. . . 

The Preview Window item displays a pop-up window, as shown in the example in 
Figure 11-11, that lets you preview how your icon file will look on different 
background patterns. To choose a different pattern, move the pointer onto the 
pattern and click SELECf. 

Figure 11-11 Background Preview Window pop-up with Source (Overwrite) 
Icon edit: Preview Window 

I 1~(m.I~I*~i1.I.I.I.I.1 
SOurce (OYerwrlte) 

The Fill menu has the same four fill options that are also provided from the Load 
and Draw pop-up windows: 
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o Use Source (Overwrite Canvas) to display the icon file on top of the specified 
background, as shown in Figure 11-11, above. 

o Use Or (Union) to display a backgroWld transparently over the preview image, 
allowing the background to show through the preview image, as shown in 
Figure 11-12. 

Figure 11-12 Background Preview Window pop-up with Or (Union) 

cP Icon Edit Preview Window 

I· 1~1~1.I~i~I.I.I.I.I.1 
Fill f2) Or (Union) 

a Use Xor (Exclusive Or) to view the background transparently over the preview 
image, turning off bits that are on in both images and leaving the· other bits 
unchanged, as shown in Figure 11-13. 

Figure 11-13 Background Preview Window pop-up with Xor (Exclusive Or) 

~ Icon Edit: Preview Window 

I It~Wt~H~ll~ml.I.I.I.I.1 
Fill (2) Xor (Exclusive Or) 

a Use And (Intersection) to view the background transparently over the preview 
image, retaining only the bits that are on in both images and turning off all 
other bits, as shown in Figure 11-14. 

Figure 11-14 Background Preview Window pop-up with And (Intersection) 

11.4 The Edit Menu 

& Icon Edit: Preview Window 

I 1~~H~)~Ii~iH.'.I.'.I.1 
Fill (2) And (Intersection) 

The Edit menu, shown in Figure II-IS, provides the following editing options: 

a Undo 

a Draw 
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Undo 

a Invert 

a Oear 

Figure 11-15 The Edit menu 

~ 
Draw ... " C&t 

The items on the Edit menu are also available on the pop-up menu in the Icon 
Editor pane, as shown in Figure 11-16. To use the pop-up menu without moving 
the pointer out of the pane, press MENU, choose an item from the menu, and 
release MENU. 

Figure 11-16 The pop-up menu 

~ (View v) (Edit V) 

You can undo your last action by choosing Undo from the Edit menu. Choosing 
Undo a second time undoes the undo, restoring the canvas to its condition before 
you chose Undo the first time. 

You· can also use the Undo key from the keyboard. 

Draw Pop-up Window The Draw pop-up window, shown in Figure 11-17, is automatically displayed 
when you start the Icon Editor. IT you dismiss the Draw pop-up window, you can 
display it again by choosing Draw from the Edit menu. 
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Figure 11-17 The Draw pop-up window 
c9 Icon Editor: Draw 

Node: (!) • 

Move: (!J C±) (!J (!) 

@JC!D~~ 

The Mode Menu. To draw an icon, choose the mode you want from the Mode 
menu, shown in Figure 11-18. 

Figure 11-18 The Mode menu 
-~ Icon Editor: Draw 

Mode: • • . 
Point. 

Line 

Move: ( 

~ U (!J (!) 
D~~ , 

0 Square 

CJrcle 0 
Blllpse 0 

9 
Ten abc 

The Mode menu items function as follows: 

D Choosing Point allows you to click SELECI'to insert one black pixel at the hot 
spot of the pointer on the canvas. You can point to a black pixel and click 
ADJUST to tum the pixel from black to white. 

D Choosing Line allows you to draw a black line I-pixel wide. To draw a line, 
position the pointer at one end of the line, press SELEeI', drag the pointer to 
the other end of the line, and release SELECI'.· You can draw a white line in 
the same way using the ADJUST mouse button. 

D Choosing Square allows you to draw open or filled squares or rectangles using 
any of the fill patterns from the Fill menu, which is discussed later in this 
chapter. (The Fill menu is displayed only when the Draw option is a fillable 
shape, such as square, circle, or ellipse). Position the pointer at one comer of 
the square, press SELECI', drag the pointer to the opposite comer of the square 
or rectangle, and release SELECf. You can draw a white rectangle in the same 
way using the ADJUST mouse button. 
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o Choosing arele allows you to draw open or filled circles using any of the fill 
patterns from the Fill menu. Position the pointer at the center of the circle and 
press SELECT, drag the pointer to the enclosing rectangle, and release 
SELECf. You can draw a white circle in the same way using the ADJUST 
mouse button. 

o Choosing Ellipse allows you to draw open or filled ellipses using any of the fill 
pattems from the Fill menu. Position the pointer at the center of the ellipse and 
press SELECT, drag the pointer to the outside radius of the ellipse, and release 
SELECf. If you define a horizontal or vertical line, the ellipse is interpreted 
as a straight line. You can draw a white ellipse in the same way using the 
ADJUST mouse button. 

o Choosing Region (the rectangle within a rectangle) allows you to define a 
rectangular region on the canvas and move, flip, or rotate it by clicking 
SELECf on any of the Move buttons. 

o Choosing Text (abc) displays a pop-up window, shown in Figure 11-19, that 
allows you to type text in a text field. 

Figure 11-19 The Text pop-up window 

cP Icon Editor: Text 

Text: ... ___ _ 

Font: (2) Lucida 

Size: (2) 10 

To add text to the canvas, follow these steps: 

1. Choose Text from the Mode menu. 

The Text pop-up window is displayed. 

2. Choose the font you want to use from the Font menu. 

Note that you can change the set of available fonts. See the section 
"Customizing Your Icon Editor" later in this chapter for infonnation about 
how to change the set of available fonts. 

3. Choose the size you want to use from the Size menu. 

4. Type the text you want in the Text field. 

S. When you have typed the text in the text field, insert it in the icon by 
moving the pointer onto the canvas and pressing SELECT. 

A rectangle is displayed that shows you the size of the text to be inserted, as 
shown in the example in Figure 11-20. You can move the rectangle anywhere 
within the canvas to position it as long as you press SELECT. 
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Figure 11-20 Adding text to your icon 

6. Drag the pointer to position the rectangle, and when it is positioned 
correctly, release SELECT. 

The text is added to the canvas, as shown in the example in Figure 11-21. You 
can add white text to a dark background in the same way using the ADJUST 
mouse button. 

Figure 11-21 Text added to an icon 

~ konEditor 
.-t1 Ie .. [direr: Text 

Text: ~ 

reat: ml lucid a 

1r----------tJ Sbe: ml10 

.- - t 1.- _:1. _ 

Once you have added text to the canvas, you can edit it as you would any other 
part of the image. 
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Fill Menu 

Operation Menu 

The Fill menu, shown in Figure 11-22. allows you to choose an outline or one of 
ten fill patterns for drawing squares, circles. or ellipses. TIlis menu is only visible 
when the current mode is a fillable shape (square, circle, or ellipse). 

Figure 11-22 The Fill menu 

~ Icon Editor: Draw 

Mode: (!) D Fi • 

peratlo n : @) Source 0 
Move: ~ 

(~) 

(File V) (View V) 

Icon Editor 

The first item on the menu, an open square, draws an outline of the chosen shape, 
using a I-pixel wide black pattern when you use SELECf, and a I-pixel white 
pattern when you use ADJUST. 

The other items represent patterns, from white to black, that you can use to fill the 
square, circle, or ellipse modes. 

The Operation menu, shown in Figure 11-23, allows you to choose how you 
perfonn each filled draw operation. This menu is only visible when the current 
mode is a fillable shape. 

Figure 11-23 The Operation menu 

CP Icon Editor: Oraw 

Node: @) D FlII: @) D 
~ ite Canvas) 

Source (Over~e Canvas) 

Or (Union) 

)(or (Exclusive Or) 

And (Intersection) 

o Use Source (Overwrite Canvas) to draw, overwriting any existing infonnation 
on the canvas. 

o Use Or (Union) to draw transparently over another image, allowing any 
existing information on the canvas to show through. 

o Use Xor (Exclusive Or) to draw transparently over another image, turning off 
pixels that are on in both images and leaving the other pixels unchanged. 

o Use And (Intersection) to draw transparently over another image, retaining 
only the pixels that are on in both images and turning off all other pixels. 
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Invert 

NOTE 
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Use the move buttons (left, right, up, and down arrows) to adjust the position of the 
drawing in the canvas, or to move a region within the canvas. To move a selected 
region, click SELECf on one of the arrow buttons to move the region one pixel in 
the desigrlated direction. If no region is selected, the entire drawing is moved. 

Jfyou move part of the image off the canvas, the pixels are croppedjrom the image 
and are not restored if you move the image in the opposite direction. 

To move a region, follow these steps: 

1. Choose Regions (the next to the last item) from the Mode menu. 

2. Move the pointer to the corner of the region you want to move and press 
SELECT. 

3. Drag the pointer to define the region and release SELECT. 

4. Click SELECT on one of the arrow buttons to move the region one pixel 
in the designated direction. You can repeat this ope~ation as often as you 
like. 

The left two buttons in the bottom row flip the selected region from left to right or 
top to bottom. If no region is selected, the entire image on the canvas is flipped. 
The right two buttons rotate the region or the image 90 degrees in the direction of 
the arrow. 

You can reverse video on the icon image by choosing Invert from the Edit menu. 
All pixels that are on are turned off, and all pixels ·that are off are turned on. 
Figure 11-24 shows the cat icon after choosing Invert. 

Figure 11-24 An inverted image 
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$ 

Clear 

11.5 Customizing Your 
Icon Editor 

You can clear the canvas by choosing Oear from the Edit menu. No warning 
notice is displayed. If you change your mind, choose Undo from the Edit menu. 

If you would like to change the set of fonts available in the Icon Editor application, 
you can do so by editing the fue • iconedi t in your home directory. Follow 
these steps: 

1. Start up a Command Tool or Shell Tool. 

2. At the -system prompt, type cd and press Return to move to your home 
directory. 

3. To make sure you do not already have the. iconedit file, type 
1s • iconedit and press Return. If the system responds by listing the 
file. iconedit, skip step 4. 

4. Type cp $OPENWINHOME/bin/xview/ .iconedit . icon-edit 
and press Return. 

This copies the default system .iconedit file to your home directory so that you 
can customize your own version of this file. 

5. Using any text editor, edit the • iconedi t tile to add or delete the fonts 
available in the Icon Editor application. 

The format required by this file is described at the top of the fIle. 
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12.1 The Binder Icon and 
Window 

12 
Binder 

The DeskSet Environment provides an application called Binder that allows you to 
bind applications, icons, colol'S. and scripts to files. 1be Binder is a tool designed 
for use by a system administrator or a user with a working knowledge of SunOS 
operating system commands. Because the Ftle Manager and Print Tool 
applications come with a default set of bindings, most DeskSet Environment users 
will not need to use the Binder application to set up theDeskSet Environment. 

A binding is a logical connection between elements such as a type of file, an 
application, a print script, or other characteristics such as color and filters that the 
File Manager and Print Tool applications use to display and operate on files. This 
chapter explains how to use the Binder application. 

The Binder icon and base window are shown in Figure 12-1. 

Figure 12-1 The Binder icon and base window 
~(!) Iinde, 

, 
Bind I Pattern I Magic N~mber: I • 

(32x32 size) Icon Imale File: 

binder Icon Color: 

Application: 

Print Script 

Doc .. ",ent ID: 

Fllter(s): 

@!) (Delete) (Change) (Saye 9) 

binder =Q,+ ~ caktool =111+ 
clock =(9+ ... , 

The Binder window has a control area and a scrolling list. The control area 
contains controls that you use to add a new binding or to modify or delete an 
existing binding. The scrolling list displays a list of existing bindings. 

DeskSet Environment installation creates an / etc/ filetype file that contains 
the default bindings for the DeskSet Environment You can customize bindings 
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Types of Bindings 

and store them in a • filet ype rue in your home directory using the Binder. The 
scrolling pane displays your current bindings from / et c / filet ype if you have 
not created a • filetype file. If you have. filetype in your home directory, 
the bindings from that file are displayed in the Binder pane. 

You cannot overwrite your /etc/filetype unless you are root, and start 
Binder by typing binder & in a Shell Tool or Command TooL If you start Binder 
from the Workspace menu, you can only save changes to the • filetype file in 
your home directory. 

You can specify fIles and/or applications in the Binder by using either a specific 
file name, a generic pattern, or a magic number. Magic numbers are identifying 
numbers that files and applications use to identify specific types of files. Magic 
numbers are stored in the / etc/magic rue on your system. When you click 
SELECf on the Magic Number setting, an abbreviated menu button is displayed at 
the beginning of the text field. The menu shows the names for the items listed in 
the / etc/magic fIle on your system. Figure 12-2 shows an example of the 
Magic Number menu. Your system may display a slightly different list of entries. 

Figure 12-2 An example of a Magic Number menu 
r ~ Iinder 

I Rind I D~ttc>rrl I M~nl,. N, Imh<e>r I Eit I 
(cpi¢ archive ) archive ~ 

byte-swapped cpio archive MMOF mailbox 

ASCII cpio archive Interleaf ASCII document 
yery old archiye SunGt<S 

old archive Gt<S Metafile 

APl workspace (Ken's original?) PostScript document 

PDP-l1 single precision APl workspace Inter press document 
PDP-l1 double precision APL workspace ASCII font metrks 
VAX single precision APL workspace ASCII font bits 

VAX double precision APL workspace HeWS bitmap font 

old packed data HeWS font family 

packed data Frame Maker document 
compacted data Frame Maker MIF file 
compressed data Frame Maker MMl file 
Compiled Term info Entry mall folder 
Curses screen Image yfont definition 
Curses screen Image raster file 

System V Release 1 archiYe SunWrlte document 

archive random library SunDraw document 

The items on the menu are displayed in the same order they appear in the 
/ etc/magic file. 

When should you use a magic number instead of a pattern? The decision depends 
on the type of file and whether a standard convention for file name patterns is used. 
When a magic number exists for a common type of file, it is probably advantageous 
to use it. For example, many applications that create raster files use the raster file 
magic number to create the files. If you bind raster files using a suffix such as • r s, 
the binding may not apply to all of the raster files you create if you forget to use the 
suffix as part of the rue name. However, when standard suffix conventions exist, 
using a pattern is faster. 
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12.2 Creating a New 
Binding 
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The Binder base window fields currently in use function as follows: 

Cl Use the Bind setting to enter the name of the application, the pattern for 
filenames, or the magic number. 

Cl Use the Icon Image File field to type the path and ftIe name of the icon image 
file to be used by the Flle Manager when displaying files. 

Cl Use the Icon Color field to specify the color that the File Manager uses to 
distinguish different file types on color monitors. When an icon color is 
specified, and a black and white monitor is used, the Icon Color is ignored. 

Cl Use the Application field to enter the name of an application or to type a script 
which can be used to start or execute a file. 

Cl Use the Print Script field to enter a customized print script The default islpr. 

You can bind the following combinations: 

o Application to icon fue 

Cl Data file to application 

o Data file to application with an icon file 

o Application to print script 

o Data file to application with a print script 

o Icon color to any combination 

You can create a binding by typing infonnation in the text field, clicking SELECT 
on the Add button, and choosing either /etc/filetype or /home/user/.filetype from 
the Save menu. 

To delete a binding, click SELECT on an entry in the scrolling list, click SELECT 
on the Delete button, and choose either letclfiletype or /home~ser/.filetype from 
the Save menu. 

To change a binding, click SELECT on a binding to display the infonnation in the 
text fields. Make your editing changes in the text fields, then click SELECT on the 
Change button, and choose either /etclfiletype or /home/User/.filetype from the 
Save menu. 

The following sections show some examples of binding combinations. 

You create a new binding by typing infonnation in the text fields, clicking 
SELECT on the Add button, and saving the changes to • filet ype (or to 
/etc/filetype if you start Binder as root). 1beexample below shows how to 
bind an icon image to an application. 

To bind the cat icon created in Chapter 11 to the cat file in your Ibin directory, 
follow these steps: 

1. If the icon does not exist, use Icon Editor to create a 32 by 32 pixel icon. 
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2. Click SELECT on Pattern (if necessary) and type the application name, 
cat in this example, in the Bind text field. 

3. Press Return or click SELECT in the Icon Image File text field to change 
the insert point. 

4. Type the path and rile name of the icon image, 
thome/winsor /Desk.et/ amallcat .l.con in this example. 

S. Click SELECT on the Add button. 

6. Click SELECT on the Save button to save the current bindings in your 
. fi.letype file. 

The binding is saved and is displayed in the scrolling list, as shown in the 
example in Figure 12-3. 

Figure i2-3 Binding a new image to an application 
(v) Binder 

Bind I Pattern I Magic Number: I cat 

(32x32 size) Icon Image File: (!)/Deskset/smallcat.kon. 

Icon Color: 

Application: 

Print Script: 

Document 10: 

Filter(s): 

@ (Delete) (Change ) ~ 

binder =~+ 
':' --

calctool =iI+ '" 

cat - ~ + -
Restart the File Manager to get new definitions 

Both the Binder and the File Manager read the filetype file when you start them. 
An infonnation message in the footer of the Binder reminds you that you must quit 
File Manager and start it again before the changes you made are displayed. 

Figure 12-4 shows the bound image after quitting File Manager and starting it 
again. 
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Figure 12-4 The new image in the File Manager 

12.3 Specifying Color 

12.4 Binding an 
Application to Data 
Files 

(2) file Manater: lusr/bln 
., 

(File V)(Vlew V)~ (PrOPS V)(Home V)(Cioto: V). 

~ 

El El El El I 
bouncedemo cal calendar canvas_demo , El l El El 

capitali2e cat cb cc - - ---
You can specify colors for icons displayed by File Manager using the Icon Color 
text field. This field accepts red/green/blue (ROB) saturation values from 0 
through 255. If you want to display a red icon, for example, type 255 00 in the 
Icon Color text field. Color values are ignored on a monochrome display. 

You bind file types to applications using the Bind and Application text fields. You 
can bind data file types by their magic number or pattern matching without using 
an icon. If you want to include an icon, type the path and file name of the icon in 
the Icon Image File text field. 

Figure 12-5 shows an example of a binding for data files with the following 
characteristics: 

o A * . icon suffix 

o An icon image 

o An icon color 

o An application name with an argument specifying the color of the application 
window when it is open. The same color is specified for the application win­
dow and for the icon. You can specify different colors for the icon and the 
open window if you like. 
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Figure 12-5 An application bound to a data file pattern 

12.5 Binding a Print 
Script 

(2) linder 
-.., 

Bind I Pattern I Magic Number: I -Jcon. 

U2x32 size) Icon Image File: £!)/fUemgr/lcondodcon 

Icon Color: 255 225 255 

Application: Iconedlt -Wb 255 225 225 

Print Script: 

Document 10: 

Fllter(s): 

@ (Delete) (Change) (saye v) 

* .icon - ~ ~+ iconed1t -~b 255 

~ -
*owk? - ~+ dos -c 123 -
core* - ~+ - 6 

h.. ..I 

You bind print scripts to a data rtIe or an application, using the Print Script text 
field. In the example shown in Figure 12-6, raster files are bound by magic number 
to the SunPaint icon and the SunPaint application, and they use the print script 
Ipr -P$PRINTER -v $FILE. Whennoscriptisspecified,thedefaultbinding 
is to lpr. 

Figure 12-6 A print binding 
(2) Binder 

Bind I Pattern I MagiC Number: 1@l.:..::ra::::.,st:::,e:...rf:.:,:I1:,:&.:..-__ _ 

(32x32 size) Icon Image File: GJt/filemgr /paintdoc.icon. 

Icon Color: 255 255 160 
;;;;.;;;..;;...;;;,;;;..;;;...;.;::..:-----

Application: sunpalnt -Wb 255 255 160 

Print Script: Ipr -PSPRINTER -y SFILE 

Document 10: _______ _ 

Filter(s): _______ _ 

@ (Delete) (Change) (Save v) 

o )( - -

~ 
-

mail folder --
raster file - + sunpaint ~b 255 -

c::3 
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FUter(s) 

12.7 Troubleshooting 
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These fields are included for future use, but are not currently used. TIle intended 
function of these fields is to specify file format conversion filters. When a file is 
dropped onto an application, the Flle Manager will use these filters to conven the 
file to the fonnat expected by the application. 

If you change bindings and store the changes in the • f il et ype file in your home 
directory, and then find that the bindings do not work correctly, check to be sure 
that you have quit the application that does not register the change and statted it 
again. The Binder, Print Tool, and Flle Manager applications only read the 
• filetype when they are started. 

If you have quit and restarted the applications and the bindings still do not work, 
you can return to the system default bindings by removing your. filetype :file. 

If you enter Binder as root, make changes in the /etc/filetype file, and find 
that the bindings do not work correctly, you can reinstall the / etcl filetype 
file by running install_filemgr following these steps: 

1. Quit the current File Manager application if you have one running. 

2. From a Shell Tool or Command Tool, become root. 

3. Type cd $OPENWINHOME/bin/ xview and press Return. 

4. Type install_filerngr and press Return. 

The /etc/filetype file is reinstalled using the default bindings, and any new 
items are appended to your /etc/magic file. See the OpenWindows 
Installation and Stan-up Guide for more information about install_filemgr. 
Table 12-1 shows a list of the default DeskSet Environment bindings from 
/etc/filetype. The path name for all icons in Table 12-1 is: 
$OPENWINHOME/include/images/<iconfilename> 
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Table 12-1 The default DeskSet Environment bindings from letcljiletype 

Pattern Application Icon File Color Print Binding 

binder bind. icon 

calctool caIctool.icon 

clock fm_clock.icon 

cmdtool fm_cmdtool.icon 

dbxtool fm_dbxtool.icon 

filemgr filemgr.icon 

fontedit fm_fontedit.icon 

iconedit fm_iconedit.icon 

mailtool fm_mailtool.icon 

maze maze.icon 

perfmeter perfmeter.icon 

printtool printer.icon 

rolo rolo.icon 

sched sched.icon 

shelltool fm_cmdtool.icon 

snapshot snapshot.icon 

sundraw sundraw.icon 

sunpaint sunpaint.icon 

sunwrite sunwrite.icon 

tapetool tapetool.icon 

textedit fm_textedit.icon 

traffic fm_traffic.icon 

vitool vitool.icon 

xcalc calctool.icon 

xpuzzle puzzle.icon 

xsol xsol.icon 
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Pattern Application Icon File Color Print Binding 

*.wk? dos -c 123 spreadsheeticon 255225255 

*.icon iconedit 
-Wb 255 225 225 icondoc.icon 255225255 

*.wk? dos -c 123 spreadsheeticon 255225255 

core* coredoc.icon 25500 

*.exe dos-c dos.icon 206192255 

*.z uncompress compress.icon 25500 

Frame Maker document framedoc.icon 255255194 

mail folder maildoc.icon 0255204 

raster file sunpaint 
-Wb 255255 160 paintdoc.icon 

Sun Write document sunwrite 
-Wb 255 198 192 writedoc.icon 

vfont definition /usr/bin/fontedit fontdoc.icon 206192255 

SunDraw document sundraw 
-Wb 192255255 drawdoc.icon 

Revision A of 11 JWle 1990 



212 DeskSet Environment Reference Guide 

Revision A of 11 June 1990 



A.I Select then Operate 

A.2 Drag and Drop 

A.3 Mouse Buttons 

A 
Differences Between Sun View and 

the Open Windows DeskSet 
Environment 

This appendix lists some of the differences between the Sun View user interface 
and the DeskSet Environment See the OpenWindows User's Guide for a 
description of the DeskSet Environment. 

The DeskSet Environment is based on the select-then-operate paradigm. First you 
select an object by pointing at it with the pointers, then pressing and releasing a 
button on the mouse. Then, using either the pointer or the keyboard, you choose 
the operation to be applied to the selected object. One advantage to this paradigm 
is that you can operate on windows and icons directly, opening, closing, resizing, 
and moving them without having to first choose an operation from a menu. 

One of the primary differences between the Sun View user interface and the 
DeskSet Environment is the integrated workspace provided with the drag and drop 
paradigm. The DeskSet applications allow you to freely move data fues between 
windows by selecting them and then dragging and dropping them onto a 
destination application. 

The DeskSet Environment assigns three specific functions to the mouse buttons. 
and the location of these functions is different from the Sun View environment 

(] SELECf (usually the left mouse button) is used for highlighting objects such 
as windows, icons, text, and graphics that are to be used for a subsequent action 
and for activating buttons and choosing settings. 

(] ADJUST (usually the middle mouse button) is used to increase or reduce the 
group of items in the selection. 

(] MENU (usually the right mouse button) is used to display and choose from 
menus. 
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A.4 Pushpin Another innovation in the DeskSet Environment is that some menus and all pop­
up windows except Notices have a pushpin, shown in Figure A-t. 

Figure A-J An unpinned and pinned pushpin 

A.5 Double-Click to 
Open Icon 

A.6 Mail Tool Changes 

When the pushpin is unpinned (on its side), the menu or pop-up window is 
displayed and dismissed in a way similar to SunView menus and subwindows. 
You can click SELECf on the pushpin to pop it into its hole, pinning the menu or 
window to the workspace. As long as the pushpin is pinned, the menu or window 
remains displayed and available to you for repeated actions. Oicking SELECf on 
a pinned pushpin pops the pin out of the hole and dismisses the menu or window. 

To open an icon in the DeskSet Environment, you double-click SELECf, or 
choose Open from the Window menu. 

Users familiar with the SunView Mail Tool will find a number of enhancements 
and changes in the DeskSet Mail Tool application. See Chapter 3 for an in-depth 
discussion of Mail Tool features. Here is a summary of some of the changes: 

o View multiple messages at one time using multiple message windows. 

o Drag-and-drop messages from the In Tray into mail files that are represented 
graphically in the File Manager application. 

o Open and view the contents of mail files by dragging and dropping the fIles 
from File Manager onto the Mail Tool View pane. 

o Open one or several composition windows that operate independently of the 
Mail Tool base window, so that you can compose and send messages whenever 
you want without needing to open the Mail TQOI icon. 

o Maintain a history of mail files you have opened in your current session so that 
you can locate messages with ease. 

o Recover deleted messages in any order. 

o Perfonn operations on multiple messages: print, delete, move, and select 
several messages to reply to at one time. When you choose multiple messages 
for reply, a Compose window is opened for each reply. 
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B.l Erase Functions 

B.2 Move Caret 
Functions 

B.3 Function Keys 

B 
Keyboard Accelerators 

The following key combinations are keyboard equivalents formouseless operation. 
You do not need to use capital letters with the Shift and Control keys. For example, 
Control-b works the same as Control-B. 

Backspace: erases character to the left of the insert point. 

Shift -Backspace: erases character to the right of the insert point 

Control-W: erases word to the left of the insert point. 

Shift-Control-W: erases word to the right of the insert point. 

Control-U: erases to the beginning of the line. 

Shift-Control-U: erases to the end of the line. 

Control-B: moves the caret one character to the left. 

Shift-Control-F: moves the caret one character to the left. 

Control-F: moves the caret one character to the right. 

Shift-Control-B: moves the caret one character to the right 

Control-,: moves the caret one ,word to the left. 

Control-.: moves the caret to the end of the word. 

Control-A: moves the caret to the start of line. 

Control-E: moves the caret to the end of the line. 

Control-P: moves the caret up one line, maintaining column position. 

Control-N: moves the caret down one line, maintaining column position. 

Control-Return: moves the caret to the end of text 

Shift-Control-Return: moves the caret to beginning of text. 

Stop (L1): stops the current operation. 

Again (L2): repeats the previous operation. 
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B.4 Calculator Function 
Keys 

Props (L3): displays the property window for the application at the pointer 
location. 

Undo (lA): undoes previous operation. 

Front (LS): brings the window at the pointer location to the front of the screen. 
When the window is already at the front, moves it to the back of the screen. 

Copy (L6) copies selection to the clipboard. 

Open (L 7): opens the icon at the pointer location or closes the window at the 
pointer location. 

Paste (L8): copies clipboard selection to the insert point 

Fmd (L9): finds selection to the right of the caret 

Shift-Find: finds selection to the left of the caret 

Cut (LIO) cuts selection and puts it on the clipboard. 

Help (Fl): displays a help window with context-sensitive help for the object at the 
pointer location. 

Every function in the Calculator application has a keyboard accelerator associated 
with it. See the Calculator man page, included in Appendix C, for a listing of each 
Calculator function and its keyboard equivalent. 
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DeskSet Environment Application 

Man Pages 

This appendix provides the system man page summaries for DeskSet applications. 
These are quick reference documents that you can view in a Command Tool or 
Shell Tool by typing man <entry name>. The man page entries included in 
this appendix are listed below, with each entry name in bold type: 

o binder, an application used to modify the DeskSet bindings database 

o calctooI, a desktop calculator 

o clock, an application that displays the time in an icon or window 

o em, the Calendar Manager, an appointment. and resource scheduling tool 

o cmdtooI, an application to run a shell or other program in a text-based 
command window 

o filemgr, a mouse-based graphical file management program 

o iconedit, a tool to create and edit small images for use in icons, cursors and 
panel items 

o maiitool, an application used for reading, storing, composing and sending 
electronic mail messages 

o perfmeter, a tool to display system perfonnance values in a meter or strip chan 

o printtool, an application used to print files 

(] rpc.cmsd, the Calendar Manager selVice daemon 

Cl sheUtool, an application to run a shell or other program in an interactive 
tenninal emulator window 

(] snapshot, a tool to captUre and save some or all of a screen 

(] tapetool, a tool for reading files from tape and archiving files to tape 

(] textedit, an Xview window- and mouse-based text editor 

(] xview, a user-interface toolkit that supports interactive, graphics-based 
applications running under the X window system. This man page includes 
infonnation about the • Xdefaults file used to store and retrieve 
Open Windows resource settings. 
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NAME 
binder - modify deskset bindings data base 

SYNOPSIS 
binder 

AVAILABILITY 
This command is available with the Open Windows environment For information about installing 
OpenWindows, refer to the Open Windows Installation and Start-Up Guide . 

DESCRIPTION 

FILES 

BUGS 

binder is an Open Windows XView tool that allows the user to modify a data base. This data base 
desaibes bindings between types of files, and how they will be displayed and manipulated by the icon that 
the file will be displayed with, the color of the icon, the method to use for printing that file, and the pro­
gram to be used for viewing that kind of file . 

. Files may be described in one of 2 ways; by a name pattern or by their magic number (as defined in the 
letclfiletype file). 

The user has 2 data bases available to them. When install_filemgr is run on their system, a data base is 
installed in letclfiletype. With the binder, the user may also set up another data base in $HOMEI.filetype 
that will override the entries in the letclfiJetype data base. By doing this, the user may customize their 
working environment without affecting others. . 

Applications that use the bindings data base in Open Windows Version 2 are: 

fiJemgr(1) 
binder(1) 
printtool(l) 
maUtool(l) 

letclmagic 
letclfiletype 
$HOMEl.filetype 

Changing your bindings wiII not automatically update all those tools that read the bindings data base. Each 
tool will have to be quit and restarted to make the new bindings effective. 
instaU _ filemgr must be run as root, and requires that SOPENWINHOME be set for the root user. Most root 
users do not have that variable set. 
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NAME 
calctool - a desktop calculator. 

SYNOPSIS 
calctool [ -8 accuracy] [ -m ] [ -r ] [ -v] 

AV AlLABITLIY 
This command is available with the Open Windows environmenL For infonnation about installing 
OpenWindows, refez to the Open Windows Installation and Start-Up Guide . 

DESCRIPTION 

220 

Calctool is a desktop calculator. It has been designed to be used with either the mouse or the keyboard. It is 
visually simi1ar to a lot of hand-held calculators. There are financial, logical and scientific modes. Similar 
operations are color coded on color wcrkstations. Each key is discussed in more detail below. 

Caution: One of the most important things to remember about calctool is that calcu1ations are performed 
from left to right, with no arithmetic precedence. If you need arithmetic precedence, then you should use 
parentheses. 

Internal arithmetic is done with double precision floating point numbers. Accuracy can be adjusted from 
zero to nine numeric places in fixed notation. but numbers can be displayed in enginecnng and scientific 
notation as well. The calculator reverts to scientific notation when the number is largez than the display 
would allow in fixed notation. The base of operation can be changed between binary, octal, decimal and 
hexadecimal. Numbers are initially displayed in fixed notation to two numezic places, in the decimal base. 

You can use the CopyQ..fJ) and the Paste (L8) function keys in conjooction with the numeric display to 
store or rettieve characters from the text shelf. You can also remove the last digit entered. and the whole 
display can be cleared. 

There are ten memory registers. Numbers can be stored or retrieved in these locations, and arithmetic can 
be perfonned upon register contents. 

The display window contains the current numerical value plus the current base and ttigonometric type. 
There are also indicators that show if the hyperbolic and inverse function switches are set and which 
numerical mode is currently in operation. If an operation needing more than one numezical input is par­
tia11y complete. the operation is also displayed in this window as a rernindez. 

Context sensitive help is also available. Position the cursor over the item you need help with, and press the 
Fl or Help key. A pop-up will be displayed giving deWled information on this facility .. 

On startup, calctool will look for a .calctoolrc file in the usez's home directory. This file allows the user to 
define their own constant and function definitions, plus set up the initial values for the ten memory regis­
ters. It then looks for a .calctoolrc file in the current directory, and if present, uses the contents of this file 
in place of any previously defined values. 

With the .calctoolrc file, there are currently four valid record types. These are comments. constant and 
function definitions, and initial memory register values. 

Lines starting with a 'II' are treated as comments and ignored. 

lines starting with 'c' or 'C' in the first column are definitions for constants. The character is followed by a 
digit from 0 through 9 then a space. This is followed by a numbez in fixed or scientific notation. Following 
this is an optional comment, which, if found, will be used in the pop-up menu for the constants. If the com­
ment is present, then there must be at least one space between this and the preceding number. 

lines starting with 'r (X' 'F in the first column are definitions for functions. The charactel' is followed by a 
digit from 0 through 9 and then a space. This is followed by a function definition. Following this is an 
optional comment, which, if found, will be used in the pop-up menu for the functions. If the comment is 
present, then there must be at least one space between this and the preceding function definition. 

Lines starting with 'r' or 'R' in the first column are definitions for the initial contents of the memory regis­
ters. The character is followed by a digit from 0 through 9 and then a space. This is followed by a number 
in fixed or scientific notation. The rest of the line is ignored. 
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All other lines are ignored. There should be no embedded spaces in the fwlction definitions. Whenever a 
backslash is found, this and the following character signify a control character, for example" would be 
ASCn7. 

OPTIONS 
-a accuracy 

Initial number of digits displayed after the numeric poinL This value must be from 0 through 9. 
The default is two numeric places. 

-m Always display in monochrome, even 00 a color screen. 

-r Start up a "right-handed" version of the caIdooI program. 

-v Print the version number of this release of the calctool program. 

CALCULATOR BU1TONS 
This section describes the calculator keys present in the main calctool window. Apart from this basic 
mode, calctool has three otbel' modes, and the keys associated with each of these modes are descnOOd in 
separate sections below. 

Keyboard equivalents appear in the square brackets. Note that ,A, followed by a letter indicates that the 
Conttol key and this key should be pressed together. 

Numerical Keys [ 0-9 a-f. = <Return> J. 
Enter a digit (decimal digits 0-9 or hexadecimal digits A-F) into the display. The '.' character acts as the 
numeric po~ and '=' (or Return) is used to complete numerical entry. 

Up to forty digits may be en~ but internal accuracy will be lost for large numbers. 

Arithmetical Operations [ + - x • I]. 

Perfonn an arithmetical operation using the previous entry and the next entry as operands .. Addition, sub­
uaction, multiplication and division are denoted by the characters '+', '-', 'x' and 'f respectively ('.' is 
also synonymous with multiplication). 

Number Manipulation Operators. 
Int ( Ai ] Return the integer portion of the current entry. 

Frae [ AI] Return the fractional portion of the current entry. 

Abs ("u] 

Cbs [C) 

llx [r] 

xAl [@] 

~ (~ ] 

Sqrt [5] 

Asc (Aa] 

Menu Operatioal. 

Return the absolute value of the current entry. 

Change the arithmetic sign of the current entry. 

Return the value of 1 divided by the current entry. 

Return the square of the current entry. 

Perfonn a percentage calculation using the last entry and the next entry. 

Perfonn a square root operation on the current entry. 

A separate window is displayed that allows you to enter any character. The ASCll 
value of this character is then displayed in the current base. 

Each of these operations has a pop-up menu associated with iL This menu can be displayed using MENU 
and then you can make a selection. You can select the default item from the menu using SELECT. 

It is also possible to use just the keyboard to achieve the same results. The first keyboard value selects the 
menu operation; the second keyboard character selects the new value for this operation. Unlike the menu 
facility available with the mouse, there is no visual feedback on what choices are available to you, so the 
user has to know what item they wish to selecL 

Base [ B ] Change the base that calculations are displayed in. The available choices are binary 
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[ b ], octal [ 0 ], decimal [ d ] and hexadecimal [ h ]. Digits that are inappropriate for 
a particular base selection are greyed out in the main caldool window. 
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¥ 
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Disp [D] 

Mode [M] 

Acc [A] 

Con [# 1 

Fun [F] 

Rei [R] 

Sto [S] 

Exch [X] 

Other Operations. 

Change the numerical display mode. The choices are engineering [ e ], fixed point 
[fl, and scientific [s] notation. 

Change the calculator mode. By default. eaktool is in basic mode, and just the keys 
on the main eaktool window are visible. There are also three other modes; financial 
[ f l, logical [ 1] and scientific [ s ]. Selection of one of these modes will display an 
extra window with more keys. These special opezations are descnOed in more detail 
in the sections below. 

Set the display accuracy. Between 0 and 9 [ 0-9 ] significant digits can be displayed. 

Retrieve and display a constant value. 'I'bere are ten conslant values [ 0-9 1, and each 
one has a default value which can be ovenidden by enuies in the users .eaktoolrc 
file. The ten default values are: 

o 0.621 Ians per hour I miles per hour. 
1 1.41421 square root of 2. 
2 2.71828 e. 
3 3.14159 pi. 
4 2.54 cms I inch. 
5 57.29578 degrees in a radian. 
6 1048576.0 2 to the power of 20. 
7 0.0353 gms I oz. 
8 0.948 kilojoules I British thennals. 
9 0.0610 cubic cms I cubic inches. 

Retrieve and execute a function expression. There are ten function definitions [ 0-9 ]. 
These are set up with enuies in the user's .caktoolrc file. 

Retrieve memory register value. There are ten memory registers [ 0-9 ]. 

Store value in memory register. There are ten memory registers [ 0-9 l. The register 
number may be preceded by an arithmetic operation (addition, subtraction, multipli­
cation or division), in which case the specified operation is carried out between- the 
displayed entry and the value currently in the selected memory register t and the 
result is placed in the memory register. 

Exchange the current display with the contents of a memory register. There are ten 
memory registers [ 0-9 ]. 

Cir [ Delete] Clear the calculator display. 

Dsp [ Back Space] 
Remove the rightmost character of the current entry, and recalculate the displayed 
value. Note that internal accuracy is lost with this operation. 

( and) ( and ) ] Parentheses. Allow precedenCe with arithmetic calculations. Note that pareritheses 
can be nested 10 any level. and calctool provides a visual feedback of what is being 
typed in, in the calculator display. The calculation doesn't take place until the last 
parenthesis is matched, then the display is updated with the new resulL _ 

Exp [E) 

Keys [k] 

This is used 10 allow numbers to be entered in scientific notation. The mantissa 
should be initially entered, then the Exp key selected. The exponent is then entered. 
If no nwnerical input had occurred when the Exp key was selected, then a mantissa 
of 1.0 is assumed. 

Toggle the labels on the calctool buttons between the mouse and keyboard 
equivalents. 
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Mem [m ] Display the window with the ten memory register values. These values are displayed 
in the current base to the current degree of accuracy using the current numerical 
display notation. 

Quit [ q or Q ] Exit without user verification. 

FINANCIAL MODE 
An example of how to use each of these financial calculations is available via the context sensitive help 
facility. 

Ctrm [ At ] Compounding term. Computes the Dumber of compounding periods it will take an 
investment of present value pv to grow to a future value of lv, earning a fixed 
interest rate int per compounding period. 

Ddb [Ad] 

Fv [v] 

Pmt [P] 

Pv [p] 

Sun Release 4.1 

Memory register usage: 

Register 0 int (periodic interest rate). 
Register 1 fv (future value). 
Register 2 pv (present value). 

Double-declining depreciation. Computes the depreciation allowance on an asset for 
a specified penod of time, using the double-declining balance method. 

Memory register usage: 

Register 0 cost (amount paid for asset). 
Register 1 salvage (value of asset at end of life). 
Register 2 life (useful life of the asset). 
Register 3 period (time period for depreciation. allowance). 

Future value. This calculation determines the future value of an investment It com­
putes the future value based on a senes of equal payments, each of amount pmt, 
earning penodic interest rate int, over the number of payment periods in term. 

Memory register usage: 

Register 0 pmt 
Register 1 int 
Register 2 n 

(periodic payment). 
(periodic interest rate). 
(number of periods). 

Periodic payment Computes the amount of the periodic payment of a loan. Most 
installment loans are computed like ordinary annuities, in that payments are made at 
the end of each payment period. 

Memory register usage: 

Register 0 prin 
Register 1 int 
Register 2 n 

(principal). 
(periodic interest rate). 
(tenn). 

Present value. Detennines the present value of an investment It computes the 
present value based on a series of equal payments, each of amount pmt, discounted 
at periodic interest rate int, over the number of periods in term • 

Memory register usage: 

Register 0 
Register 1 
Register 2 

pmt 
int 
n 

(periodic payment). 
(periodic interest rate). 
(tenn). 
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Rate ["r] 

Sin [AS] 

Syd ["y] 

Term [T] 

LOGICAL MODE 
< [<] 

> [>] . 

&16 [ ] ] 

&32 [ [ ] 

Or [I] 

And [& ] 

Not [-] 

Xor [" ] 
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Periodic interest rate. Returns the periodic interest necessary for a present value of 
pv to grow to a future value of tv ov« the number of compounding periods in term • 

Memory registez usage: 

Register 0 fv (future value). 
Register 1 pv (preamt value). 
Register 2 n (tenn). 

Sttaight-Iine depreciation. Computes the straight-line depreciation of an asset foc one 
period. The straight-line method of deprecialion divides the depreciable cost (cost­
salvage) evenly over the useful life of an asset The useful life is the number of 
periods typically years) over which an asset is depreciated. 

Memory registez usage: 

Register 0 cost (cost of the asset). 
Register 1 salvage (salvage value of the asset). 
Register 2 life (useful life of the asset). 

Sum-of-the YeMS-digits depreciation. The sum-of-the-years' -digits method of depre­
ciation accelerates the rate of depreciation, so that more depreciation expense occurs 
in earlier periods than in later ones. The depreciable cost is the actual cost minus sal­
vage value. The useful life is the number of periods (typically years) over which an 
asset is depreciated. 

Memory register usage: 

Register 0 cost (cost of the asset). 
Register 1 salvage (salvage value of the asset). 
Register 2 life (useful life of the asset). 
Register 3 period (period for which depreciation is computed). 

Payment period. Returns the number of payment periods in the tenn of an ordinary 
annuity necessary to accumulate a future value of lv, emning a periodic interest rate 
of int. Each payment is equal to amount pmt. 

Memory register usage: 

Register 0 pmt 
Register 1 fv 
Register 2 int 

(periodic payment). 
(future value). 
(periodic interest rate). 

Shift the current entty to the left. The shift can be between 1 and 15 places 
[ 1-9, a-f]. This calculator key has a pop-up menu associated with iL 

Shift the current entry to the right. The shift can be between 1 and 15 places 
[ 1-9, a-fl. This calculator key has a pop-up menu associated with it 

Tnmcate the current entry to a 16 bit unsigned integer. 

Truncate the current entry to a 32 bit unsigned integer. 

Perform a logical OR operation on the current entty and the next entry, treating both 
numbers as unsigned long integers. 

Perfonn a logical AND operation on the current entry and the next entry, treating 
both numbers as unsigned long integers. 

Perform a logical NOT opezation on the current entty. 

Perfonn a logical XOR operation on the current entry and the next entry, treating 
both numbers as unsigned long integers. 
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Xnor [n] 

SCIENTIFIC MODE 
Trig [T] 

Hyp [h) 

Inv [i) 

eAx [ {] 

lOAx [}] 
yAx [y] 

x! [ ! ] 

Cos [AC] 

Sin [AS] 

Tan [At] 

Ln [N] 

Log [G] 

Rand [?] 

FILES 
-I.calctoolrc 
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Perfonn a logical XNOR operation on the current entry and the next entry, treating 
both numbers as unsigned long integers. 

Set the current trigonometrical base. This can be in degrees [ d ], gradients [ g ] or 
radians [ r J. This key also has a pop-up menu associated with it 

Toggle the hypezbolic function indicator. 1bis switch affects the type of sine, cosine 
and tangent trigonomettic functions performed. 

Toggle the inverse function indicator. This switch affects the type of sine, cosine and 
tangent trigonometric functions perfooned. 

Returns e raised to the power of the current entry. 

Returns 10 raised to the power of the current entry. 

Take the last entry and raise it to the power of the next entry. 

Return the factorial of the current entty. 

Return the trigonometric cosine, arc cosine, hypezbolic cosine or inverse hypezbolic 
cosine of the current display, depending upon the current settings of the hyperbolic 
and inverse function switches. The result is displayed in the current trigonometric 
units (degrees, radians or gradients). 

Return the trigonometric sine, arc sine, hypezbolic sine or inverse hyperbolic sine of 
the current display, depending upon the current settings of the hypezbolic and 
inverse function switches. The result is displayed in the current trigonometric units 
(degrees, radians or gradients). 

Return the trigonometric tangent, arc tangent, hyperbolic tangent or inverse hyper­
bolic tangent of the current display, depending upon the current settings of the 
hyperbolic and inverse function switches. The result is displayed in.the current tri­
gonometric units (degrees, radians or gradients). 

Return the natura1logaritbm of the current entry. 

Return the base 10 logarithm of the current entry. 

Return a random number between 0.0 and 1.0. 

User's personal calctool startup file. 

SEE ALSO 
DeskSet Environment Reference Guide. 
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NAME 
clock - display the time in an icon or window 

SYNOPSIS 
clock 

AVAILABILITY 
This command is available with the Open Windows environment For infonnation about installing 
OpenWindows, refez to the OpenWindows Installation and Start-Up Guide. 

DESCRIPTION 

USAGE 

BUGS 
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clock is an OpenWindows XView utility that displays the current time in a window or icon. When the win­
dow is open, clock can display the time in either analog or digital format The clock window is scalable in 
ci~rfoom~ . 

When the dock window is open, it has a floating menu from which you can bring up a property window. 
From this property sheet, you can modify the display of the tool by selecting either the Analog or Digital 
choice box. 

Seconds: 
On the analog version, this selection starts a second hand on the face of the clock. On the 
digital version, it adds two digits to ~ digital readout 

Date: 
Turns on a date display for both analog and digital versions of dock. 

If you reset the system time, clock will not reflect the new time until you change its window state from 
open to icon, or vice versa. To reset the system time, see date (1 V). 

The date display does not go well with the round clock face. 

Occasionally, when dock is uncovered, the face will be visually corrupted. Use the Refresh button from 
~ frame menu to repair. 
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NAME 
em - calendar manager, appointment and resource scheduling tool 

SYNOPSIS 
em [ generic-tool-arguments 1 

AVAILABILITY 
The man page you are currently viewing refers to the em that is available with Open Windows. All 
Open Windows standard tools use the OPEN LOOK Graphical User Interlace (GUI). For more infonnation 
about the OPEN LOOK UI. refer to the OpenWindows User's Guide. For information about installing 
OpenWindows, refer to the OpenWindows Installation and Start-Up Guide. 

DESCRIPI10N 
em is an appointment and resource scheduling tool that allows you to do the following: 

- Display day, week, month, year views 
- Schedule single or repeating events 
- Browse and edit calendars of other users 
- Set beeping, flashing, or pop-up reminders 
- Integrate with mail 
- Restrict access to your own calendar 
- Print high-quality hardcopy 

A full appointment editor is available for inserting and editing appointments. Most settings on the appoint­
ment editor can be preloaded through a Properties window available from the main panel. 

OPTIONS 
generic-tool-arguments 

USAGE 

em accepts the generic tool arguments described in xview(I). 

em operates via a set of pulldown menus from button stacks in a control panel. The menu commands are 
described below. 

The Control Area 

View Menu 

Day 

Week 

Edit 

Month 

Year 

Displays the appointments for a day. The default is today. 

Displays the appointments for a week. A graphed display is also displayed with the 
times for the appointments shaded. The default is the current week. 

Displays the appointments for an entire month. The default is the current month. 

Displays a full year. 

Appointment 
Schedule appointments by either selecting the day and choosing Appointment from 
the Edit menu or by double-clicking on day (m the month or week view) or on an­
hour (in the day view). Inserts and deletes appointments. 

Date: Automatically set by this tool, but may be changed. 

What: FIlled in with information about the appointment This information will be 
displayed on the various views. 

Scrolling List 
Automatically set with the current appointments for that day. It will be 
updated as appointments are added and deleted. 
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Start: and End: 

Repeat: 

Sets the time of the appoinbnent A choice of times is fOWld on the pull­
down menus. The choices are determined by the Day Bounds settings from 
the Properties window. 

Indicates whetbel' the appointment is a repeating event of a daily, weekly, 
biweekly, monthly or yearly interval. The number of times the appoinbnent 
re~ is controlled by the Repeat Abbreviated Choice below the toggles. 

Reminder: 
Detennines what action will be taken in advance of the appoinbnent 

Beep Produces an audible sound. 

Flash Inverts the frame of the tool or the icon if the tool is closed. 

Open Pops up a reminder window with the text of the appoinunent show­
ing. 

Mail Composes a message with the text of the appointment and sends it 
to recipien~ in the Mail To field. 

Advance 
Specifies the amount of time preceding the event the Reminder will be 
activated. 

Add Adds the appoinunent to the calendar. 

Delete Deletes the appointment selected in the scrolling list from the calendar. 

Change Changes the appoinunent selected in the scrolling list to the edited values 
from the appointment editor. 

Defaults: 
Clears the appointment edita' of context and sets default values from. the 
Properties window. 

Properties Sets default values for this tool. These values are used for setting default values in 
the Appointment Editor, setting display characteristics of the views, and granting 
access to the calendar. 

Editor Defaults 
Sets default reminder values and advance times for appointments. 

Day Boundaries 
Sets default begin and end times for the day that are used in drawing the 
chart on the week view and the grid on the day view. 

Browser Calendars 
Sets a default list of remote calendars to be automatically loaded at 
startup time. The entries have the format name@host. These entries will 
be available using the Browse menu. 

Access List and Permissions 
Sets default access to the calendar. Access can be Browse (Read), Insert 
(Add), Delete (Remove). The keyword world, opens up the calendar to 
everyone. The entries have the format name@hosl At this time, tradi­
tional UNIX groups are not supported. 

Apply Adds any changes made. 

Reset Reestablishes the values before you started editing. 

Defaults Reestablished the tool default values. 
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Browse Sets the toors context to a named calendar. You can display and edit appointments 
for othez users. Entries have the format aame@bost and are entered by typing into 
the Name text field and pressing Add. The entry will be added to the scrolling list 
and can then be selected for browsing. 

Print Displays the choices for printing hardcopy output. 

Previous 

Day, Week, Month, or Year 

CM Printer Options 

Postscript output can be sent to a file or to a printer named in the 'Printer 
text field. The default pinter is tw. Output width, height, positions from 
the left and bottom, and Dwubez o( copies can be set in their respective 
text fields. 

Changes the display to the previous logical unit or calendar data. 

Today Changes the display to today's logical unit o( calendar data. 

Next Changes the display to the (ollowing logical unit o( calendar data. 

lusrlspoollcalendar/callog.username 
$HOME/.cm.rc 
lusr/etclrpc.cmsd or $OPENWINHOMElrpc.cmsd 

SEE ALSO 
rpc.cmsd(l) 
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NAME 
cmdtool- run a shell (or other program) in an OpenWindows enhanced terminal window 

SYNOPSIS 
cmdtool [ -C ] [ -M bytes 1 [ -p count 1 [ -B boldstyle 1 [ -I command 1 [ generic-rool-argumt!nts 1 [pro­
gram [program-arguments 11 

AVAILABILITY 
This command is available with the Open Windows user environment For information about installing 
OpenWindows, refer to the OpenWindows Installation and Start-Up Guide. 

DESCRIPTION 
cmdtool is the standard OpenWindows support facility for shells and other programs. When invoked, 
cmdtool runs a program (usualIy a shell) in a text-based command window. Characters typed on the key­
board are insened at the caret. If the program is a shell, that shell accepts and runs commands in the usual 
manner. cmdtool also supports programs that perform CUfS<r motions directly, such as vi(l). 

The text of the current command line can be edited using normal texteciit(1) functions. The command 
window displays a log of the session, which can be scrolled through using the scrollbar (unless the escape 
command mode is in effect). This log can be edited, and saved by choosing the 'Store as New File' item 
in the text facility's pop-up menu. 

OPTIONS 
-C 

-M bytes 

-p count 

-B boldstyle 

-I command 

Console cmdtool. Redirect system console output to this shell tool. Display console 
messages in this cmdtool, which might otherwise appear in unexpected places on the 
wockstation screen. Since a cmdtool window can be scrolled, console error messages 
can be recorded for later examination. 

Set the log to wrap-around after the indicated number of bytes. 

Checkpoint the log after every set of count editing operations. 

Set the style for displaying bold text to boldstyle. boldstyle can be a string specifying 
one of the choices for the term.boldstyle default, see Defaults Options, below, or it 
may be a numerical value for one of those choices, from 0 to 8, corresponding to the 
placement of the choice in the list 

Pass command to the shell. SPACE characters within the command must be escaped. 

generic-tool-arguments 
cmdtool accepts the generic tool arguments listed in xview(1). 

program [program-arguments ] 
If a program argument is present, cmdtool runs it and passes any remaining arguments 
to that program. If no program is given, cmdtool runs the program indicated by the 
SHELL environment variable, or Ibio/sb by default 

USAGE 
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.xderaults File Options 
You can specify a number of defaults using the options in the .Xdefaults file that effect the behavior of 
cmdtool. The ones of interest are those that begin with text,term, or keyboard. See xview(l) for more 
detailed information. 

cmdtool Windows 
The window created by cmdtool is based on the text facility that is described in the textedit man page. 
The user is given a prompt at which to type commands and pop-up menus from which to select command 
options. 

cmdtool windows support cursor motions, using an letcltermcap entry called sun-cmd. Command win­
dows automatically set the TERM environment variable to sun-cmd. So, if you rlogin(lC) to a machine 
that does not have an entry for sun-cmd in its letcltermcap file, the error message 'Type sun-cmd 
unknown' results. To rectify this, type the command 'set TERM=sun'. Programs written using the 
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curses(3X) <X' curses(3V) library packages will W<R in a command window, but programs hard-coded for 
sun-type terminals may nOL When supporting a program that pezfonns cursor motions. the command win­
dow automatically takes on the characteristics of a tty window (as with sbeUtool(I». When that program 
terminates or sleeps. the full command window functionality is restored. 

andtool supports programs that use CBREAK and NO ECHO tenninal modes. This support is nonnally 
invisible to the user. However. programs that use RAW mode. such as rlogin(lC) and script{l). inhibit 
command-line editing with the mouse. In this case. however, tty-style ERASE, word-kill and line-kill char­
acters can still be used to edit the current command line. 

The cmdtool Menu 
The cmdtool window menu is called the Term Pane menu and contains the following options and their 
submenus: 

History Creates a a list of commands used during the cmdtool session. 
Mode 

Editable You can edit the contents of tile window. 
Read Only You can only read from the window. 

Store Log as new file 
Create a new file that contains the contents of the log. 

Clear log Oears all entries from the log. 
Edit Provides a set of editing functions for this window. 

Again Repeats the last action. 
Undo 

Undo Last Edit 
Undoes the last edit made in cmdtool • 

Undo All Edits 
Undoes all edits made during this session of andtool • 

Copy Makes a copy of the selected text and places it on the clipboard. 
Paste Pastes a copy of the text stored on the clipboard at the cursor location. 
Cut Deletes the selected text and places it on the clipboard 

Find Provides a set of find and replace functions. 
Find and Replace 

Brings up a pop-up menu containing text fields and command buttons that allow 
you to search forward and backward through the file being edited for specific text 
strings. Allows you to specify options for the replacement of text . 

Find Selection 
Forward Searches forward to find a selected text string. 
Backward Searches backward to find a selected text string. 

Find Marked Text 
Brings up a pop-up menu that allows you to find text that is included between 
specified bracket pairs. Also allows you to insert <X' remove bracket pairs around 
selected text. 

Replace l>fitld<1 > 
Allows you to replace selected text forward and backward throughout the file. 

Extras A user-definable pull-right menu controlled by the lusrllibl.text_extras_menu file. This can 
be overridden in two ways: 

FOe Editor 

Sun Release 4.1 

1) Change the value of the .XdefauIts parameter text.extrasMenuFilename to the correct file 
path. 
2) Set the environment variable EXTRASMENU to the file desired. 
Note that option I overrides option 2 if both are used. For more infonnation see the DeskSet 
Environment Reference Guide . 

Enable Allows you to edit files from within cmdtooL 
Disable Turns off the ability to edit files from within andtooL 
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Scrolling 
Enables Scrolling 

Enables scrolling within cmdtool. 
Disable ScroDing 

Turns off the ability to scron within cmdtooL Once scrolling in cmdtool is dis­
abled, it's functionality is identical to sheDtooi and a more restricted menu 
appears. Selecting the Enable Scrolling option from the restricted menu restores 
the full menu and functionality of cmdtool. 

User Defined Keyboard Remapping 
The file -I.textswrc specifies filter programs that are assigned to (available) function keys. These filters are 
applied to the contents of the primary selection. Their output is entezed at the caret. 

Accelerators 

FILES 

Text facility accelerators that are especially useful in command windows are described here. See 
textedit(l) for more infonnation. 
Cl'RL-RETURN Position the caret at the bottom, and scroll it into view as detennined by 

Text.LowerContext. 
CAPS-lock 
Toggle between all-uppez-case keyboard input, and mixed-case. 

Itmp/tty.txt.pid log file 
-I.textswrc 
-I.ttyswrc 
usrllib/.text _extras_menu 
$HOME/.TextExtraMenu 
letc/termcap 
lusrlbinlsh 

SEE ALSO 
rlogin(lC), script{l), shelltool(l), textedit(I), vi(l), xview{l), curses(3V), curses(3X) 

Open Windows User's Guide 

BUGS 
Typing ahead while cmdtool changes between its scrollable and cursor motion modes ~ sometimes 
freeze cmdtool. . 

Full tenninal emulation is not complete. Some manifestations of this deficiency are: 

• File completion in the C shell does not wod. 

• Enhanced display of text is not supponed. 
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NAME 
filemgr - OpenWindows mouse-based file manager 

SYNOPSIS 
filemgr [-d directory] [-i secs] [-8] [-?] 

AVAILABILITY 
Available with the Open Windows environment For information about installing Open Windows, refer to 
the Open Windows Installation and Start-Up Guide. 

DESCRIPTION 
filemgr is a graphical file management program. It allows you to navigate through and manipulate files. 
You can find. copy, move, link, open, and print existing or new files. You can find files, change file proper­
ties and view multiple directories at the same time. 

INSTALLATION 
filemgr should not be used until the program instaU_filemgr has been run (as root). 

OPTIONS 

USAGE 

filemgr accepts all the generic tool arguments described in xview(I}. In addition, it can accept these 
options: 

-d directory 
This will start the filemgr in the given directory . 

-i secs This will set the timer to check on folder and/or file modification times every secs seconds. 

-8 This will force the filemgr to check both folder and file modification times. By default, filemgr 
only checks the folder modification times. Be careful, as this option will severely affect perfor­
mance. 

-1 This will display a partial list of command line options that can be passed to filemgr. For addi­
tional generic options that can be passed to filemgr, type man shell tool ·1. 

filemgr operates via a set of pulldown menus from button stacks in a control panel. Most menu commands 
operate on the currently selected files. To select a file, click SELECf on its icon. To select additional files, 
click ADJUST on additional files. The menu commands are described below. 

File> 

Open> 

File Opening a document puts the document into the document window. 
Opening a folder puts that folder into the folder window. Opening an 
application starts the application. 

With 'Goto' Arguments 
Treats the text typed in the Ooto line as a command line argument 
(for applications only). 

In Document Editor 
Opens documents and applications in the default document editor. 
See Tool Properties (below). 

Print File Prints files using the default print script See Tool Properties below. 

Create Folder 
Creates an empty subfolder in the current folder. 

Create Document 
Creates an empty document in the current folder. 
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View> 

Edit> 

Props> 
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Remote Transfer_ 
Displays a command window which allows you to copy files to and from remote 
machines. You can make a reference to files on a remote machine by using the 
foonat machine_natne:file_name. See rcp(l). 

(your Commands) 
You can add your own entries to this menu by adding items to the file .fvcmd in 
your home directory. Each line in this file corresponds to a menu item you can 
execute. Use the "abbreviation % OLE to stand for the name of the selected file. 

Tree (or Path) 
Toggles between a hierarchical display of folders and a more compact view show­
ing only the path of the cwrent folder being viewed. 

ShowlHide Sublolders 
Shows or hides the subfolders of the selected folder (tree view only). 

Show AU Subfolders 
Shows the entire subfolder tree that branches from the selected folder. Note that 
this can be quite time consuming (tree view only). 

Begin Tree Here 
Makes the selected folder the root of the tree view (tree view only). 

Add Tree's Parent 
Adds the root's parent to the display. This moves the view up one level (tree view 
only). 

Folder Display> 

Icon Displays files with 32x32 icons. 

List Displays files with 16x16 generic icons. Also display any list options 
chosen (see Tool Properties, below). 

Sort By Determines the category by which the files are to be sorted in the display: name, 
modification date (youngest first), size (largest first), and type (folders, documents, 
applications). 

Select AU Selects all files in the current folder. 

Link Places selected files on the clipboard for a pending link operation. 

Copy Places selected files on the clipboard for a pending copy operation. 

Paste Pastes files from clipboard into the current folder. Pasted files are linked, ~ied, 
or moved, depending on how they were first stored in the clipboard. 

Cut> 

Cut to Wastebasket 
Places selected files in the wastebasket for a pending deiete operation. 

Move to Clipboard 
Places selected files in the clipboard for a pending move operation. 

Really Delete 
Removes files from folder (see Tool Properties, below). 

Show Clipboard 
Displays contents of system clipboard. 
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File Properties... 
This property sheet allows you to see and change file attributes. When several 
files are chosen at once, you must replace the indetenninate setting from owner, 
group, and permissions to apply them to the selected files. 

Tool Properties_ 
This property sheet allows you to customize filemgr. 

Home> A menu that always contains your home folder in the first position, Thereafter, it su.-es the last 
nine folders you have visited. Selecting a folder causes that folder to be opened. 

Goto> 

Entry This is grayed out unless there is an entry on the Goto line (located at the right of 
the Goto button). To change directories, type the directory name on the Goto line 
and then press Goto. 

Find Selecting this option brings up a command window that allows you to search for 
files within the specified directories. 

SEE ALSO 

FILES 

egrep(I), find(1) 

letC/filetype 
This file contains a database of file types and actions to be perfonned when files of each type 
are opened. 

$HOMEI.fvcmd 
This file contains your own commands, which can be referenced by the "Your Commands" 
menu. 

$HOME/.filetype 
User's personal copy of the file types database. It follow the same fonnat as /etc/filetype. 
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NAME 
iconedit - create and edit images for Open Windows icons, cursors and panel items 

SYNOPSIS 
iconedit [filename] [XView command-line arguments] 

AV AlLABll..1TY 
This command is available with the Open Windows user environment Foi- information about installing 
OpenWindows, refer to the OpenWindows Installation and Start-Up Guide • For infonnation about the 
XView command-line arguments see the XView Programming Manual. 

OPTIONS 
filename Contains the image. 

XView command-line argwnents 
iconedit axepts the XView command-line arguments listed in xview(l). 

DESCRIPTION 
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iconedit is pm:t of the Open Windows DeskSet prolt requires the pixreet library for its operation. With 
iconedit you can create and edit small images for use in icons, cursors, panel items, etc. iconedit has 
sevtnl submenus. Two of the submenus are visible at startup, the Main window and the Draw pop-up 
menu. 

Main Window 

Contains the drawing area (or canvas) together with the command panel and the message area underneath 
the canvas. From the control panel, you have the following pull-down menus. 

File 

Directory Specify the directory where the image is located. 

File Specify the name of the file with the image. IT you are not sure of the file name, 
use a regular expression for the File field or leave it blank, and it switches to 
Browse when you press Load. IT you already have an image in the canvas, it asks 
for confinnation before loading. You can also load a file by dragging the file icon 
from File Manager and dropping it into iconedit. 

Load Operation: 
Choose one of the operations using the abbreviated menu button. 

Source (Overwrite Canvas) 

Or (Union) 

Loads a file overwriting any existing infonnation on the canvas. 

Loads a file transparendy over another image, allowing any existing 
infonnation on the canvas to show through the new file. 

Xor (Exclusive Or) 
Loads a file ttansparendy over another image, turning bits that are on 
in both images off and leaving the other bits unchanged. 

And (Intersection) 
Loads a file transparendy over another image, retaining only the bits 
that are on in both images and turning all other bits off. 

Load This button loads in the file named in the Directory and File fields. Choose the 
raster operation to load it with. 

Save Saves your current image in the file specified in the Directory and File fields. IT 
the file exists, iconedit asks for confinnation before overwriting the file. 

Browse SeMches the directory specified in the Directory: field for image files with names 
matching the regular expression in the File field. If the File field is empty, it 
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View 
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assumes the reguIar expression. (search all files). IT images are found, they are 
displayed in a pop-up, scrollable window for browsing. IT no images are found, 
iconedit will report this in the menu area. From the browse window you can load 
an image by selecting it with the left mouse button. The Load operation will take 
into account the current load opt'2'8tion specified in the pop-up. 

Grid Turns a grid on or off in the display area. One grid square is a 4x4 area of pixels. 

Size Olanges the size of the canvas. There are four sizes: 64x64 (icon size); 48x48; 
32x32; and 16x16 (cursor size). When you switch to a smaller size, the rest of the 
canvas is hidden but not lost. Editing operations, however, will only affect the 
visible portion of the canvas. Saving will save only the visible portion of the 
image. 

Preview Opens the preview window for previewing a life-size version of the image being 
edited. 

Gray Shades 
Ten varying gray shades are available for filling the background. 
Click the left mouse button on the desired shade to load it 

Fill Select one of the four raster operations available from the abbreviated 
menu button. The source for the raster operation is the preview image 
and the destination is the preview background. 

Source (Overwrite Canvas) 
Overwrites any existing information on the canvas. 

Or (Union) 
Any existing information on the canvas shows through. 

Xor (Exclusive Or) 
Bits in both images are turned off and any other bits are 
unchanged. 

And (Intersection) 
Only the bits that are on in both images are left OD. All 
other bits are twned off. 

Edit This menu is attached to the canvas. 

Sun Release 4.1 

Undo Undoes the last operation. Restores the canvas to the state it was in before the last 
Edit operation. A second Undo undoes the previous Undo. 

Draw Window 
Displays the options available for drawing. To draw in black, use the left mouse 
button; to draw in white (erase), use the middle mouse button. As you draw, an 
enlarged version of the image appears in the canvas while a life size version of the 
image appears in the control panel as well as in the preview window. 

Mode Choose one of the following modes. The gray shade selected in the 
Fill pop-up and the operation selected from the Operation pop-up 
will be used. 

Dot Paints a single dot at a time. 
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Line Draws a line. Point to the first endpoint and press and 
hold the left (oc middle) button. Drag to another end­
point and release the button to draw the line. 

Rectangle Draws a rectangle. Press the mouse button Oeft or mid­
dle) at one comer of the desired rectangle. Drag to the 
opposite comer and release. For different rectangle 
shades. select the desired shade from the Fm menu. 

Circle Draws a circle. Press the mouse button at the center and 
drag to the edge and release the button. For different 
shades. select the desired shade from the Fill menu. 

Oval Draws an oval. Press the mouse button at the center of 
the oval and drag to the edge of the enclosing rectangle. 
For diffezent shades, select the desired shade from the 
Fill menu. 

Region Select the desiredrectangu1ar region by pressing the left 
(or middle) mouse button at one comer, drag it to the 
opposite comer, and release. A boundary box shows you 
the selection. After specifying the region, choose the 
move operation desired from the Draw window. 

Text Writes text on the image. Pops up the Text window that 
has a field for typing the string to be added to the icon. 
Once you press either the left or middle mouse button, a 
box appears. Position the box where the text is desired 
and release the mouse button. It also has a menu of avail­
able fonts and their sizes. To switch fonts, select from 
the menus provided. To change the set of available fonts, 
edit the file Jconedit A default Jconedit file can be 
found in $OPENWINHOMFlbinlxview. Yau may copy 
this default file into your home directory and edit it The 
format is explained in the default file. 

Operation: 

Source (Overwrite Canvas) 

Or (Union) 

Overwrites any existing information on the 
canvas. 

Any existing information on the canvas 
shows through. 

Xor (Exclusive Or) 
Bits in both images are turned off and any 
other bits are unchanged. 

And (Intersection) 
Only the bits that are on in both images are 
left on. All other bits are turned off. 

Move Shows eight arrows that indicate the ways of moving 
your image. If you have selected region from the draw 
menu, only the specified region is affected by the move 
operation. If region is not selected, the entire image is 
moved. 
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SEE ALSO 

Invert 

Clear 

Open Windows User's Guide. 
The XView Reference Manual. 

Sun Release 4.1 
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Invert all pixels on the canvas. Toggles from orr to On or vice versa. 

Clears the canvas. 
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¥ 

NAME 
mailtool - Open Windows interface for the mail program 

SYNOPSIS 
mailtool [ -Mx ] [ -Mi interval] [genenc-tool-arguments ] 

AV AlLABn.1TY 
This command is available with the Open Windows environment. For infonnation about installing 
OpenWindows, refer to the Open Windows Installation and Start-Up Guide. 

DESCRIPTION 
mailtool is the standard OpenWindows interface to maD(I). It provides a menu-driven facility for reading, 
storing, composing, and sending mail messages. Scrol1able windows allow easy access to mailbox and 
mail folders. 

The full editing capabilities of textedit(1) are available for modifying and composing mail messages as 
well as text fields within command panels. 

OPTIONS 

USAGE 
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-Mx Expen mode. Do not ask for confirmation after potentially damaging mail commands. This 
has the same effect as setting the expert variable. 

-Mi interval 
Check for new mail every interval seconds. This has the same effect as specifying a value for 
the interval variable. 

generic tool arguments 
mailtool accepts the generic tool arguments described in xview(1). 

mailtool operates through the use of a set of command panel buttons, message windows, menus, and other 
components that conform to the OPEN LOOK Graphical User Interface Functional Specification. Mail 
messages are edited using the menus and commands of the textedit program. For more information about 
the general usage of OPEN LOOK software applications, see the Open Windows User's Guide. For more 
infonnation about textedit conventions, see the textedit(1) man page. 

Command Panel Buttons 

The mailtool command panel is located near the top of the main window, under the window header. Select 
a command panel button to reveal the menu for that button. 

File 

Open 

InTray Used to mld mail from the user's system mail file into mailtooI. 

Mail File Opens the mail file specified in the Mail File text field in the com­
mandpaneL . 

Move into Mail File 
Moves all selected messages from the current mail file to the file named in the 
Mail FUe text field in the command panel. If the file exists, the messages are 
appended. 
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Copy into Mail File 

Print 

Copies all selected messages from the current mail file to the file named in the 
Mail File text field in the command panel If the file exists, the messages are 
appended. Unlike Move into Mail Filet the messages are not deleted from the 
InTray. 

Sends copies of all the selected mail items to your default printer. If there are no 
selected items, mailtool sends copies of those items you are currently viewing. 

Save Changes 
Causes all the deletions and changes you have made to the mail file to 
become pennanent and opens your InTray for any new mail. 

Messages Displays messages you have selec(ed. 

Abbreciated Header 
Strips unnecessary header fields from the messages you view. 
Specify these fields by setting the ignore variable in your .mailrc file. 

Full Header 
Displays the currently selected messages with alI of the message 
header fields. 

Previous Displays previous messages in your mailbox. 

Next Detennines the message following the last one displayed and displays it The 
message is chosen from all the messages in the current ~ail file. 

Sort By 

Cut 

Copy 

Delete 

Undelete 

Find 

Time and Date 
Sorts the messages in the mail folder by chronological order. 

Sender Sorts the messages in the mail folder alphabetically by sender. 

Subject Sorts the messages in the mail folder alphabetically by subject 

Deletes the selected mail messages, placing copies in the Clipboard. 

Copies the selected mail messages, placing copies in the Clipboard. 

Deletes the selected mail messages~ without placing copies in the CUpboard. If no 
mail messages are selected, the messages currently being viewed are deleted. 

Last Restores the last message deleted to your mail header display. This 
may be done until all messages deleted since the last commit are 
restored. This option also restores messages deleted through cut and 
move commands. 

From .. t Causes a command frame to appear that contains a list box with all 
the mail items that have been deleted since the last commit operation. 
You can select any numbez oftheset and press the button on the com­
mand frame. All the selected items will be returned to the mail header 
window. 

Sender: Enter text that is in the Subject field of the message you want Capi­
talization is ignored. 
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Subject: Enter text that is in the From field (mail address) of the message you 
want. Capitalization is igno-ed. 

Find Forward 
After entering text for Seader: or Subject: or both, click SELECT on 
Find Forward to locate the next message that matches the text. 

Find Backward 
Afta' entering text for Sender: or Subject: or both, click SELECT on 
Find Backward to locate the previous message that matches the text. 

Select AD After entering text for Seader: or Subject: or both, click SELECT on 
Select All to select all messages that match the text. 

Properties Displays the MaD Tool: Properties window. The various categories of properties 
you can modify are displayed in a pop-up menu from the Display abbreviated 
menu button. 

MaD Arrival Properties 

Check ror Mail Every: 
Specifies in seconds how often MaD Tool checks for new 
mail. 

Signal New MaD With: 
Specifies how many beeps or flashes or both that are used 
to notify you of the arrival of new mail. 

Automatically Display Headers: 
Specifies whether headers are displayed automatically or 
not. 

Apply When this button is selected, any changes you have 
specified are made. 

Reset When this button is selected. any changes you have made 
in the window are deleted. 

Composition Header Properties 

Compose with Subject Line: 
Specifies whethez a Subject: line appears in the Compo­
sition window. 

Cc Line: Specifies whethez a Cc: line appears in the Composition 
window. 

Bcc Line: Specifies whethez a Bec: line appears in the Composi­
tion window. 

Custom Fields 
Allows you to specify a list of header fields in addition to 
To:, Subject:, Cc:, and Bee. 

Add Arter 
Field is insetted into list afta' the selection point. 

Add Berore 
Field is insetted into list before the selection 
point. 

Delete Deletes the selected field from the list. 

Field Specifies the name of a custom field. The scrolling box 
displays all custom field names. 
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Apply When this button is selected, any changes you have 
specified are made. 

Reset When this button is selected, any chang~ you have made 
in the window are deleted. 

Template Properties 
Allows you to specify template files that you have created. These 
files can be included in mail messages. 

Templates Use the fonowing to specify when the template is to be 
used. One must be selected. 

Add After 
FIle is inserted into list after the selection point 

Add Before 
File is inserted into list before the selection 
point 

Delete Deletes the file from the list 

Name: Specifies the template name. 

File: Specifies the location of the template. 

Apply When this button is selected, any changes you have 
specified are made. 

Reset When this button is selected, any changes you have made 
in the window are deleted. 

General Properties 

Default Header Pane Height: 
Specifies the number of lines for the header pane. 

Default Header Pane Width: 
Specified the width of the header pane in columns. 

Default Message Pane Height: 
Specifies the number of lines for the message pane. 

Print Script: 
Script executed when File -> Print is selected. 

Mail File Directory: 
Specifies the name of the mail directory. 

Ask For Confirmations: 
Specifies whether Man Tool asks for confirmations. 

Apply When this button is selected, any changes you have 
specified are made. 

Reset When this button is selected, any changes you have made 
in the window are deleted. 

This panel button allows users to create new mail to be sent, reply to existing mes­
sages with or without including the current message, and to forward messages as 
needed. 

New Opens a composition window without the message headers being 
filled in. If an unused mail message window cUJTelltly exists on the 
screen, it will be brought forward -to be used and no new window is 
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created. H an unused mail message window current exists and is fully 
displayed on the screen, there will be DO change in the display. 

Reply> Opens a composition window with the message headers filled in 
appropriately and allows you to write and deliver your response. Han 
unused mail message window current exists on the screen, it will be 
brought forward to be used and DO new window is created. If an 
unused mail message window cmrent exists and is fully displayed on 
the screen, there will be no change in the display. Options to this sub­
menu are desaibed below: 

To Sender: 

To All: 

Opens a composition window. In the window, the address 
field contains the originator's address for the selected 
message. 

Opens a composition window. In the window, the address 
field contains addresses for the person who sent the 
selected message as well as all the people that the 
selected message was sent to. 

To sender, include: 
Opens a composition window. In the window, the address 
field contains the originator's address for the selected 
message. The window also contains the selected mes­
sage in the body of the new message. 

To All, Include: 
Opens a composition window. In the window, the address 
field contains addresses for the person who sent the 
selected message as well as all the people that the 
selected message was sent to. The window also contains 
the selected message in the body of the new message. 

Forward> Forwards the currently selected message. Opens a composition win­
dow with the cmrently selected message included in the new message 
body. . . 

Vacation Lets you compose a message that is automatically delivered in 
response to incoming messages. Use this when you can't read your 
mail for a period of time and want Mail Tool to respond to messages 
for you. 

The Composition Window 

This window has its own conttol panel with the following buttons. 

Include 

Bracketed Pastes the currently selected messages into the body of the message 
you are composing. The included messages are bracketed with special 
lines. 

Indented Pastes the currently selected messages into the body of the message 
you are composing. Each line of the included message is indented, 
using the standard indentation string. 

Templates Displays file names of templates. 
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Quit Window 
Mails the message you have composed and then dismisses the COID­

pose window. 

Close Window 
Mails the message you have composed and then closes the compose 
window to an icon. 

Clear Window 
Mails the message and then cIW'S the compose window to prepare it 
forre-use. 

Leave~~geIn~t 

Mails the message and leaves the message in the compose window. 

Headers> Selecting an option affects the header of the mail message. 

AddIDelete Ce: 
Adds or deletes the Cc: line from the message you are composing. 

AddlDelete Bee: 
Adds or deletes the Bee: line from the message you are composmg. 

Delete Subject 
Adds or deletes the Subject: line from the message you are compos­
ing. 

Add Custom > 
Add a custom header field already created in the Properties window. 

Delete Custom> 
Delete a custom h~r field already created .. 

Name Finder 
Displays a pop-up window that lets you ask for the mailing addresses of individu­
als in the NIS database. 

Name: Type the requested name. 

Sounds Like 
Looks for names that sound like the one you entered. The first letter 
must match exactly. 

Find Click SELECT to start the search. 

Clear Oears the contents of the compose window. 

Mailtool Variables 

In addition to the variables recognized by maD(l), maUtooi recognizes those listed below. They can be set . 
by editing your .mailre file. Unless otherwise noted, the default for the following variables is off. Some of 
these variables can be set using the Properties menu. 

aDowreversescan 
When set, allows you to step through messages in latest-first. oldest-first order if you choose. 
The next message depends on the order of travel. 

askbee Prompt for the Bee: field when composing or replying. 

beD The number of times to ring the bell when new mail anives. The default is O. 

editmessagewindow 
Request confirmation before the first editing operation to a message in the message window (as 
opposed to composing a reply). The default is not to request confirmation of the first edit 
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FILES 

expert Set expert mode iIi which no contirmation are requested. 

filemenu A list of files from which to initialize the Mail File: menu. These can be absolute path names, 
path names relative to the working directory for mailtool (typically your home directory), or 
filenames prefixed with a + t which are taken as relative to the directory specified in the folder 
variable (see mail (1». 

filemenusize 
Specifies the maximum size of the .Yale: menu. 

8ash The number of times to flash the window or icon when new mail arrives. The default is O. 

header lines 
The number of lines in header window. The default is 10. 

retrieveinterval 
The interval in seconds to check for new mail. The default is 300. 

moveinputtocus 
Move the input focus into the composition window for Compose and Reply. This only wo!ks 
for click-to-type. 

popuplines The number of lines in pop-up message composition window. The default is 30. 

printmail The command to use to print a message. The default is Ipr -p. 

trash The name of trash bin, which may be accessed just Ike any other folder. If set, all deleted mes­
sages are moved to the trash bin. The trash bin is emptied when you commit changes. 

suppressautoretrieve 
Does not automatically retrieve new mail messages. Default is to automatically retrieve new 
mail. 

additional fields: 
A list of header fields to access via the Add Custom field in the Header menu. 

templates A list of name :path pairs to access via the Include> Templates menu. name appears in the 
menu; path is the file included when name is selected. 

toolcols Default width of windows in columns. Default is 80. 

lvarlspoollmaill. System mailboxes 

-'.mailre Start-up file for maD and maUtooi. 

-I.mailtool-init Contains manu default and layout information. Generated by selecting Save 
Workspace in the root menu. 

SEE ALSO 
binmail(l), mail(l), textedit(l), aliases(S), newaUases(8), seadmail(8) 

Open Windows Use'-s Guide 
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NAME 
perfmeter - display system performance values in a meter or strip chart 

SYNOPSIS 
perfmeter [ -s sample-time] [ -b h-hand-int] [ -m m-hand-int] [ -M smax minmax maxmax ] 

[ -v value ] [ hostname ] 

AVAILABILITY 
This command is available with the Open Windows environment. For infonnation about installing 
OpenWindows, refer to the OpenWindows Installation and Start-Up Guide. 

DESCRIPTION 
perrmeter is an OpenWindows XView utility that displays performance values (statistics) for a given host­
name. IT no host is specified, statistics on the current host are metered. The rstatd(SC) daemon must be 
running on the machine being metered. 

When open, perfineter displays a perfonnance value in the form of a strip chart. When closed, it displays 
a meter dial. By default, the display is updated with a sample-time of 2 seconds. The hour hand of the 
meter represents the average over a 2O-second interval; the minute hand, the average over 2 seconds. The 
default value displayed is the percent of CPU being utilized. 

The maximum scale value for the strip chart will automatically double or halve to accommodate increasing 
or decreasing values for the host machine. This scale can be restricted to a certain range with the -M 
option. 

OPTIONS 
-s sample-time 

Set the sample time to sample-time seconds. 

-b h-hand-int 
Set the hour-hand interval to h-hand-int seconds. 

-m m-hand-int 
Set the minute hand interval to m-hand-int seconds. 

-M smax minmax ma.xmax 

-v value 

Sun Release 4.1 

Set a range of maximum values for the strip chart. Values for each of the arguments should be 
powers of 2. smax sets the starting maximum-value. minmax sets the lowest allowed maximum­
value for the scale. maxmax sets the highest allowed maximum-value. 

Set the performance value to be monitored by pressing MENU and sliding the pointer to one of the 
following options: 

cpu Percent of CPU being utilized. 

pkts Ethernet packets per second 

page Paging activity in pages per second. 

swap Jobs swapped per second. 

intr Number of device interrupts per second. 

disk Disk traffic in transfers per second. 

cntxt Number of context switches per second. 

load Average number of nmnable processes over the last minute. 

colis Collisions per second detected on the ethemet. 

errs Errors per second on receiving packets. 
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USAGE 
Commands 

Fn..ES 

You can change the statistic being displayed by clicking MENU ,and bringing up the property sheet for the 
tool. The property sheet will allow you to modify what the perfmeter is monitoring and how often it 
checks. Other meter parameters can be modified through the use of keyboard accelerators. Move the 
pointer into the window and type one of the following keyboard keys: 

m Deaease minutehandintv by one 

M Increase minutehandintv by one 

h Deaease howhandintv by one 

H Increase howhandintv by one 

1-9 Set sampietime to a range from 1 to 9 seconds. 

letclinetd.conf starts statistics server 

SEE ALSO 
xview(l), netstat(SC), rstatd(8C), VDlstat(8) 
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NAME 
printtool - Open Windows tool for printing files 

SYNOPSIS 
printtool [generic-tool-arguments ] 

A V AlLABILITY 
This command is available with the Open Windows environmenL For infonnation about installing 
OpenWindows, refer to the Open Windows Installation and Start-Up Guide . 

DESCRIPTION 
printtool is a user interface to the Ipr(I), Iprm(I), and Ipq(l) operating system printing functions. 

printtool is an OpenWindows based XView application that uses the Ipr(l) command to print files. By 
specifying a filename, printer name, number of copies to be printed and any optional filters, the user can 
print files, get status on files printed, and remove files from a printer queue. 

You can drag and drop a file from filemgr(l) onto an open printtool or icon, instead of typing a name in 
the File: text field. 

The printer names are derived from the letdprintcap file. By convention, the fonnat of the first line for 
each printer entry in the letdprintcap file is: 

printer number Ilogical name ldescription: 

For example: 

31Iaserbeamlprinter near Fred's office: 

The printer name used by printtooI is the longest of the first two fields. This field should not contain 
blanks. 

OPTIONS 
generic-tool-arguments 

USAGE 

printtool accepts the generic tool arguments described in xview(1). 

printtool is pan of the OpenWindows user environmenL For a description of the basic concepts of 
OpenWindows, see the OpenWindows User's Guide. 

File: Must specify a filename in the text field 

Printer: 
Must select a printer. It can be from the Printer: options or the default can be left 

Copies: Must specify the number of copies to print or leave the default of one. 

Filter: Optional. 

None Default and provides no filter. 

Raster File contains a raster image, see r.terfiIe(5). The printer must support an appropri­
ate imaging model such as PostScript in order to print the image. 

TeX The files contain data from tex (DVI fonnat from Stanford). 

Plot The files contain standard plot data as produced by the plot(3X) routines (see also 
plot{IG) for the filters used by the printer spooler). 

CifPlot The files contain data produced by cifplot. 

trofl' The files contain trofl'{l) data. 

pr Prints pages headed with the date, filename and page number. 

control Interprets the first character of each line as a standard FORTRAN carriage control 
character. 
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FILES 

other Used for printing a file with another command line print method, including pipes. 
Will accept the following variables: 

SFILE filename from drag and drop operation or name specified in File: 
text field. 

SPRINTER 

$COPIES 

printer specified in Printer: text field. 

nwnber of copies specified in Copies: text field 

Print The named file is printed. 

Status Displays the status of the printer specified in the Prin·ter: text field. 

Stop Printing 
Removes a printing job. 

Selected Print Job 
Stops the printing of the job or jobs you have selected in the scroll window. 

All Print Jobs 
Stops all of your print jobs that are currently queued. See printcap(5) for more infor­
mation. 

These filter options offer a standard user interface, and all options may not be available for, nor applicable 
to, all printers. The trofT filter is provided as part of the standard SunOS installation. 

Jetc/printcap Printer capabilities data base 

SEE ALSO 
filemgr (I), .pg (I), Ipr (I), Iprm (I), trofl'(I), pr (IV), plot (3X), printcap (5), rasterfile (5) 

DIAGNOSTICS 
See Ipr(1) diagnostics. 

prioter: unknown printer: 
Probably an incorrect entry in the Jetc/priotap file. 

The Jetclprintcap file must exist with valid printer enules for priottool to work. 

BUGS 
See Ipr(1) bugs. 
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NAME 
rpc.cmsd - calendar manager service daemon 

SYNOPSIS 
lusr/eklrpc.cmsd 
or 
SOPENWINHOMFJbinlrpc.cmscl 

DESCRIPTION 

RPC.CMSD(I) 

rpc.cmsd is a small data base manager for appoinunent and resource-scheduling data. It's primary client is 
Calendar Manager, a window-based tool. 

FILES 
lusrlspoollcalendar/callog.username 
letdinetd.conf 
$OPENWINHOMFJbinlinstall_ cmgr . 
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* 

NAME 
shelltool- nul a shell (or other program) in an OpenWindows terminal window 

SYNOPSIS 
shelltool [ -C 1 [ -B boldstyle 1 [ -I command 1 [ genenc-tool-arguments 1 [program [arguments 11 

AVAILABILITY 
This command is available with the Open Windows user environment. For information about installing 
OpenWindows, refer to the OpenWindows Installation and Start-Up Guide. 

DESCRIPTION 
shelltool is a standard OpenWindows facility for shells or other programs that use a standard tty-based 
interface. . 

When invoked, shelltool runs a program, (usually a shell) in an interactive terminal emulator based on a tty 
subwindow. Keyboard input is passed to that program. In the Open Windows vezsion of shelltool, a res­
tticted pop-up menu is available from the main display ami that allows you to enable scrolling. Selecting 
the Enable Scrolling option from the restricted menu gives shelltool the full functionality of the cmdtool 
window, included a larger pop-up menu from which to select options. Selecting Disable Scrolling from 
the pop-up submenu will return Shelltool to its original state. 

OPTIONS 

-c 
-B boldstyle 

-I command 

Redirect system console output to this shelltool. 

Set the style for displaying bold text to boldstyle. boldstyle can be a string specifying 
one of the choices for the term.boldstyle default. see Deraults Options, below, or it 
may be a numerical value for one of those choices, from 0 to 8, corresponding to the 
placement of the choice in the list. 

Pass command to the shell. SPACE characters within the command must be escaped 

generic-tool-arguments 
shell tool accepts the generic tool arguments listed in xview(1). 

USAGE 

252 

.xdefaults File Options 
You can specify a number of defaults using the options in the .Xderaults file that effect the behavior of 
shell tool. The ones of interest are those that begin with text,term, or keyboard. See .xview(l) for more 
detailed information. 

The Terminal Emulator 
The tty subwindow is a tenninal emulator. Whenever a tty subwindow is created, the startup file -I.ttyswrc 
is read for initialization parameters that are specific to the tty subwindow. 

The .ttyswrc FUe 
The command format for this file is: 

# 
set variable 
mapi key text 
mapo key texl 

Comment 
Tum on the specified variable. 
When key is typed pretend text was input. 
When key is typed pretend text was output. 

The only currently defined variable is pagemode. Icey is one of LI-LI5, FI-F15, TI-T15, R"t-RI5, LEFf , 
or RIGIIT (see note below). text may contain escapes such as 'E, \n, AX, etc. (ESC, RETURN , and CTRL-X , 
respectively). See termcap(5) for the format of the string escapes that are recognized. Note: mapi and 
mapo may be replaced by another keymapping mechanism in the future. 

When using the default kernel keyboard tables. the keys LI, LEFT • RIGIIT , BREAK , R8, RIO, R12, and 
R14 cannot be mapped in this way; they send special values to the tty subwindow. Also, when using the 
default kernel keyboard tables, LI-LIO are now used by XView. See input_rrom_deraults(l) and 
kbd( 4S) for more information on how to change the behavior of the keyboard 
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It is possible to have tenninal-based programs drive the tool in which its tty subwindow resides by sending 
special escape sequences. These escape sequences may also be sent by typing a key appropriately mapped 
using the mapo function described above. The following functions pertain to the tool in which the tty 
subwindow resides, not the tty subwindow itself. 

\E[lt -open 
\E[lt - close (become iconic) 
\E[3t - move, with interactive feedback 
\E[3;TOP;LEFrt - move, to TOP LEFI' (pixel coordinates) 
\E[ 4t - stretch, with interactive feedback 
\E[4;HT;WlDTHt - stretch, to HT WIDTH size (in pixels) 
\E[St - front 
\E[6t - back 
\E[7t - refresh 
\E[8;ROWS;COLSt - stretch, to ROWS COLS size (in characters) 
\E[1lt - report if open or iconic by sending \E[lt or \E[2t 
\E[13t - report position by sending \E[3;TOP;LEFI't 
\E[14t - report size in pixels by sending \E[4;HT;WIDTHt 
\E[18t - report size in characters by sending \E[8;ROWS;COLSt 
\E[20t - report icon label by sending \E)Llabel\E\ 
\E[2lt - report tool header by sending \E]llabel\E\ 
\E]ltext\E\ - set tool header to text 
\EJlfile\E\ - set icon to the icon contained in file; file must be in iconedit output for-

\E]Llabel\E\ 
\E[>OPT; ••• h 
\E[>OPT; ••• k 
\E[>OPT; ••• 1 

mat 
- set icon label to label 
- ttun SB OPT on (OPT = 1 => pagemode), for. example, \E[>1;3;4h 
- report OPT; sends \E[>OPTI or \E[>OPTh for each OPT 
- twn OPT off (OPT = 1 => pagemode), for example, \E[>1;3;41 

See EXAMPL;ES for an example of using this facility. 

sbeUtoolVViDdo~ 

The window created by sheUtooi is based on the text facility that is described in the textedit man page. 
The user is given a prompt at which to type commands and pop-up menus from which to select command 
options. 

sheUtool windows support cursor motions, using an letcltermcap entry called sun-cmd. Command win­
dows automatically set the TERM environment variable to sun-cmd. So, if you rlogio(l C) to a machine 
that does not have an entry for sun-cmd in its letcltermcap file, the error mesSage 'Type sun-cmd 
unknown' results. To rectify this, type the command 'set TERM=sun'. Programs' written using the 
curses(3X) (X' curses(3V) library packages will wen in a command window, but programs hard-coded for 
sun-type tennina1s may not. When supporting a program that ptrl'onns cursor motions, the command win­
dow automatically takes on the characteristics of a tty window (as with sbeUtool(l». When that program 
tenniDates or sleeps, the full command window functionality is restored. 

cmdtool supports programs that use CBREAK and NO ECHO terminal modes. This support is nonnally 
invisible to the user. However, programs that use RAW mode, such as rlogin(lC) and script(l), inhibit 
command-line editing with the mouse. In this case, however, tty-style ERASE, word-kill and line-ldll char­
aclm can still be used to edit the current command line. 

The shelltool Menu 
The sbelltool window menu is called the Term Pane menu and contains the following options and their 
submenus: 

Enable Page Mode 
Enables page mode within shelltool • 

Copy Places the highlighted text on the clipboard. 
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Paste 

ScrolHng 

EXAMPLES 

Puts the contents of the clipboard at the location pointed to by the cusor. 

Enables scrolling within sheUtool. 

FILES 

The following aliases can be put into your -/.ahrc file: 

1# dynamicaDy set the Dame stripe of the tool: 
alias header 'echo -D "\E]I\!*\E\"' 
1# dynamicaDy set the label on the icon: 
alias iheader 'echo -D "\E]L\!*\E\"' 
1# dynamicaDy set the image OIl the icon: 
aHas icoD 'echo -0 "\E]I\!*\E\"' 

-I.ttyswrc 
lusrllib/ttyswrc 
lusrlbinlxview/sheUtool 
lusr/demol* -

SEE ALSO 
cmdtool(l), more(l), xview(l), rlogin(1C), kbd(4S), termcap(5) 

Open Windows User's Guide 

BUGS 

SHELLTOOL ( 1 ) 

If more than 256 characters are input to a terminal emulator subwindow without an intervening NEWLINE t 

the tenninal emuIator may bang. If this occurs, an alert will come up with a message saying &Too many 
keystrokes in input buffer'. Choosing the Flush Input Buffer menu item may correct the problem. This 
is a bug for a tenninal emulator subwindow running on top of or rlogin(1C) to a m~hine with pre-4.0 
release kernel. 

254 ~tcbange: 11 June 1990 Sun Release 4.1 



TAPETOOL ( I ) USER COMMANDS T APETOOL ( I ) 

NAME 
tapetOol - Open Windows tool for reading files from tape or archiving files to tape 

SYNOPSIS 
tapetool [ generic-tool-arguments ] 

AVAILABILITY 
Although this command is available with the Open Windows Application Environment software installation 
options. For infonnation about installing OpenWindows, refer to the OpenWindows Installation and 
Start-Up Guide . 

DESCRIPTION 
tapetool is an OpenWindows based XView application that uses the tar(I) command to write files to tape, 
extract files from tape, or list the contents of a tape. 

OPTIONS 
generic-tool-arguments 

USAGE 

tapetool accepts the generic tool arguments described in xview(1). 

tapetool is part of the Open Windows user environment For a description of the basic concepts of 
OpenWindows, see theOpenWindows User's Guide. 

There are two windows associated with tapetool, the main window and the read window. The main win­
dow that appears when the tool is initially brought up is for writing files to tape. The read window appears 
when you List the contents of a tape or choose either Read Selected or Read Entire List. 

List._ Brings up a Tape Contents window that lists the files on tape. It may take some time listing the 
entire contents of a tape if it contains many files. If you want to extract just a few files and you 
know the exact names of the files, you may use Read Selected that will bring up an empty Tape 
Contents window. Use File To Read to put in the file names and then do a Read Entire List. 
File names can be added using File To Read • File names can be deleted using the scrolling list 
pop-up menu Read Functions. 
Select AU Selects all the files listed in the window. 
Deselect AU 

Removes the highlight (deselects) all the files you have selected. 
Delete Selected 

Removes all the files you have selected. 
Read The Tape Contents window does not have to be showing to do this. The files are put into the 

directory specified by the Destination field if they do not contain fully qualified path names. 
Selected Reads the files selected in the Tape Contents window. 
Entire List Reads all the files listed in the Tape Contents window. 
Entire Tape 

Reads the entire tape. 
Write Writes the file names listed in the main window to tape. 
FUeToWrite 

Adds file names to the main window scrolling list. This list has a pop-up menu for deleting files. 
Write Functions 

Deselect Selected 
Deletes the files you have selected. 

Deselect AU 
Deletes all the files displayed in the window. 

Destination: 
Specifies the directory for the location of files read from tape. This field is only used when the 
files on the tape do not have absolute path names. 

SunRel~4.1 Last change: II June 1990 255 



TAPETOOL ( 1 ) USER COMMANDS T APETOOL ( 1 ) 

Props Property sheet for specifying tar{l) options. 
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Device: 
Idev/rmtn Half inch magnetic tapes drives 
ldev/rarn Quarter inch tape drives 
Idev/rstn SCSI tape drives 

Tar Options 
Write: 

Read: 

Delete Dir: 

Other: 

No secs F option to tar(1). Excludes all directaies named sees 
from tarfile. 

No secs+ FF option to tar(l). Excludes all directories named sees, all 
files with .0 as their suffix, and all files named errs, core, 
anda.out. 

BlockIIO b option to tar(l). This is the blocking factor for tape 
records. The default blocking factor is 20 blocks. The block 
size is determined automatically when reading tapes. The 
detennination of the blocking facttt may be fooled when 
reading from a pipe or a socket. The maximum blocking 
factor is determined only by the amount of memory available 
to tar when it is run. Larger blocking factors result in better 
throughput, longer blocks on nine-track tapes, and better 
media utilization. 

Sym Links h option to tar{l). Follows symbolic links as if they were 
normal files or directories. Normally, tar does not follow 
symbolic links. 

Show Errs I option to tar(l). Displays error messages if all links to 
archived files cannot be resolved. If not used, no error mes­
sages are printed. 

Suppress 0 option to tar(1). Suppresses information specifying owner 
and modes and modes of directories that tar(l) nonnally 
places in the archive. 

No Check i option to tar(1). Ignores directory checksum errors. 
Mod Time m option to tar(l). Do not extract modification times of 

extracted files. The modification time will be the time of 
extraction. 

OrigMode 
p option to tar(1). Restores the named files to their original 
modes, ignoring the present umask(2). SetUID and sticky 
information are also extracted if you are the super-user. 

For writing files to tape 
None Retains filename path exactly as specified. 
AD Extracts the entire path from filename and writes just the 

filename. 
Pattern Extracts the pattern specified and writes the filentJme left 

over. 

Err Exit e option to tar(l). If any unexpected errors occur, tar aborts 
immediately with a positive exit status. 

Exclude X option to tar(l). Specifies a file containing a list of named 
files or directories to be excluded when reading from tape. 
Only one file can be specified. 

Apply Applies the options that have been set. 
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Reset Resets the options to the defaults. 
You may drag and drop files from filemgr(l) onto the tapetool write window for writing files to rape. You 
can also drop files onto the tapetool icon for writing. 

FILES 

BUGS 

Idev/nnt Half-inch magnetic tape interface 
Idev/rarn Quarter-inch magnetic tape interface 
Idev/rstn SCSI tape interface 

See bugs for tar(l). 

SEE ALSO 
filemgr (1), tar (1), tar (5) 
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'* 

NAME 
textedit - XView window- and mouse-based text editor 

SYNOPSIS 
textedit [generic-tool-arguments] [ -Ea on I oft'] [ -adjustJsJ)endinl_delete] [ -Ei on I oft'] 

[-auto_indent] [-Eoon I off] [-okay_to_overwrite] [-Er on I off] [-read_only] 
[ -Ec N] [ -checkpoint count ] [ -EL lines] [ -lower_context lines] [ -Em pixels] 
[ -margin pixels] [ -En N] [ -number_of _lines lines] [ -ES N ] 
[ -multt click _space radius] [ -Et N] [ -tab _width tabstop] [ -ET N] 
(-multi_click_timeout intrvl] [-EuN] [-history_limit max] [-EUN] 
[ -upper_context lines] filename 

AV AILABll..rrv 
This command is available with the Open Windows environment For information about installing 
OpenWindows. refer to the Open Windows Installation and Start-Up Guide. 

DESCRIPTION 
textedit is a window-based XView application that provides both mouse and pointer operations and key­
board accelerators for the editing of text In general. text editing throughout the Open Windows user 
environment uses textedit conventions, both in text display areas such as mail message windows and com­
mand panel text fields. 

textedit operates via a set of command panel buttons and text fields and a set of menus and submenus 
accessible from the main editing window. 

OPTIONS 
generic-tool-arguments 

258 

textedit accepts the XView generic tool arguments described in the XView Reference Manual. 

-Eaonlorr 
-adjustJs Jending_ delete . 

Choose whether or not an adjustment to a selection makes the selection "pending-delete." .The 
default is off. This option corresponds to, and overrides, the adjust_isJendinLdelete Text 
defaults entry. 

-Eionlorr 
-auto Jndent 

Choose whether or not to automatically indent newly-opened lines. The default is off. 
Corresponds to the auto Jndent Text default 

-Eo on I orr 
-okay_to _overwrite 

Set behavior to the Store as New File menu item. If on a Store as New FOe to the current file is 
treated as a Save Current File. If orr (the standard default), Store as New File operations using 
the current filename results in an error m~ge. Corresponds to Store_self_is _save. 

-Eronloff 
-read_only 

Tum read-only mode OIl or off. When OIl, text cannot be modified. 

-EcN 
-checkpoint count 

Checkpoint after every count editing operation. If count is 0 (the standard default), no check­
pointing takes place. Each character typed, each Paste, and each Cut counts as an editing opera­
tion. Corresponds to checkpoint_frequency. 

-ELlines 
-lower contextlines 

- Specify the minimum number of lines to keep between the caret and the bottom of the text 
subwindow. The default is 2. Corresponds to lower_context. 
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USAGE 

-Em pixels 
-margin pixels 

Set the scrollbar margin width in pixels. The default is 4. Cooesponds to left_margin. 

-EnN 
-number_o'_bes lines 

Set the number of lines in the bottom subwindow. The default is 45. 

-ESN 
-multi_dick _space radius 

-EtN 

Set the radius in pixels, within which clicks must occur to be treated as a multi-click selection. 
The default is 3 pixels. Corresponds to multi_click _space. 

-tab_width tabstop 

-ETN 

Set the number of SPACE characters displayed per TAB stop. The default is 8. This option has no 
effect on the characters in the file. Conesponds to tab_width. 

-multCdick_timeout intrvl 

-EuN 

Set the interval, in milliseconds, within which any two clicks must occur to be treated as a multi­
click selection. The default is 390 milliseconds. Corresponds to multi_dick_timeout. 

-history_limit max 

-EU N 

Set the maximum number of editing operations that can be undone or replayed. The default is 50. 
Corresponds to history_limit. 

-upper_context lines 
Set the minimum number of lines to keep between the caret and the top of the text subwindow. 
The default is 2. Corresponds to upper_context. 

textedit is part of the Open Windows user environment For a descriptions of the basic concepts of 
Open Windows, see the Open Windows User's Guide. 

Signal Processing . 
Iftextedit hangs, for whatever reason, you can send a SIGHUP sO signal to its process ID. which forces it to 
write any changes (if possible): 

kiU-HUPpid 

The edits are written to the file textedit.pid in its working directory. If that fails, textedit successively tries 
to write to a file by that name in /var/tmp, and then /tmp. In addition, whenever textedit catches a fatal 
signal, such as SIGILL, it tries to write out the edits bef<R aborting. 

Defaults OpdoDs 
You can specify a number of defaults using the .xderaults file that affect the behavior of the text-based 
facilities. See xview(l) for mere detailed inf<X1llation. 

Selections 
Selections in textedit are defined as selected portions of text to which editing operations can be applied. 
For example, a selection can be deleted, moved, copied, etc. 

textedit provides two types of selections: primary and secondary. Primary selections allow you to select a 
set of text on which to perform an editing function. Secondary selections allow you to define a second 
block of text without undefining your primary text selection or repositioning your cursor. Being able to 
define two sets of text at once allows you to take advantage of the advanced editing functions described 
below in the section called Function Keys. 
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Using a Mouse and Pointer: 
Single characters can be selected using the SELECT. 

Blocks of text can be selected by selecting a starting point with the SELECT and selecting an 
ending point with ADJUST. 

Or blocks of text can be selected using OPEN LOOK's wipe through feature by pointing at a 
beginning character and depressing the select button while moving the pointer to the end of a 
block of text 

Selections can also be made by sing clicldng (rapidly pressing) the select button. Oick once· to 
select a single letter; click twice to select a word; click three times to select a complete line of 
text; click four times to select the entire document being edited. 

Visual Feedback 
All primary selections are indicated visually by invene video of the text selected and are pend­
ing delete. Pending delete selections are replaced if you type or paste while the text is selected. 

Secondary selections that are not pending delete are indicated by lUlderlining of the text 

Secondary selections pending delete are indicated by underlining of the text and strike through 
of the individual characters. 

Secondary SeIecUons 
Secondary selections are made using any· of the selection methods described above in addition to 
holding down one of the four function keys corresponding to the commands Cut, Find, Paste, or 
Copy. 

Secondary selections are made pending delete by holding the Cl'RL keywben making the secondary 
IT a secondary selection is pending-delete, it is deleted when the function key is released, except in 
the case of the Find, which deselects the secondary selection. . 

You can make adjusted selections switch to pending-delete using the adjustJsJ>ending_delete 
defaults entry, or the -Ea option. In this case, crRL-Middle makes the selection not pending­
delete. 

Commands that operate on the primary selection do so even if the primary selection is not in the 
window that issued the command. 

Inserting Text and Command Characters 
For the most part, typing any of the standard keys either inserts the corresponding character at the insertion 
point, or erases characters. However, certain key combinations are treated as commands. Some of the 
most useful are: 

Command 

Cut-Primary 
Find-Primary 

Copy-to-Clipboard 
Paste-CUpboard 
Copy-then-Paste 

Go-to-EOF 

Character 

META-X 
META-F 

META-C 
META-V 
META-P 

crRL-RETURN 

Description 

Erases, and moves to the Clipboard, the primary selection. 
Searches the text for the pattern specified by the primary 
selection or by the Clipboard, if there is no primary selection. 
Copies the primary selection to the Clipboard. 
Inserts the Oipboard contents at the insertion point 
Copies the primary selection to the insertion point (through 
the Clipboard). 
Moves the insertion point to Ihe end of the text, positioning 
the text so that the insertion point is visible. 
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Function Keys 
The commands indicated by use of the function keys are: 

Command Sun-213 Key Description 

Stop 
Again 

Undo 
Front 

Copy 

Open 

Paste 

Find 

Cut 

LI 
L2 

IA 
L5 

L6 

L7 

L8 

L9 

LIO 

Aborts the current command. 
Repeats the pevious editing sequence since a 
primary selection was made. 
Undoes a prior editing sequence. 
Makes the window completely visible (or 
hides. it, if it is already exposed). 
Copies the primary selection, either to the 
Clipboard or at the closest end of the secondary 
selection. 
Makes the window iconic (or normal, if it is already 
iconic). 
Copies either the secondary selection or the Clipboard at 
the insertion point 
Searches for the pattern specified by, in ~, the 
secondary selection, the primary selection, or the Clipboard. 
Erases, and moves to the Clipboard, either the primary or 
the secondary selection. 

Help FI Produces help text. 

Find usually searches the text forwards, towards the end. Holding down the SHIFT key while invoking 
Find searches backward through the text. towards the beginning. If the pattern is not found before the 
search encounters either extreme, it ·'wraps around" and continues from the other extreme. Find starts the 
search at the appropriate end of the primary selection, if the primary selection is in the subwindow that the 
search is made in; otherwise it starts at the insertion point. unless the subwindow cannot be edited. in which 
case it starts at the beginning of the text 

CTRL-Find invokes the Find and Replace pop-up frame. 

Menu Items 
File 

Edit 

Display 

Find 

Extras 

A pull-right menu item for file operations. 

A pull-right menu item equivalent of the editing function keys. The Edit submenu provides 
Again, Undo, Copy, Paste, and Cut (same as function keys L2, lA. L6. LB, and LIO). 

A pull-right menu item for controlling the way text is displayed and line display fonnaL 

A pull-right menu item for find and delimiter matching operations. 

A user definable pull-right menu item. The Extras standard submenu is controlled by 
/usr/libl.ttxt_extras_menu, which has the same fonnat as .rootmenu file. This can be over-
ridden in two ways: 

1) Change the value of the .Xdefaults parameter text.extrasMenuFUename to the 
correct file path. 
2) Set the environment variable EXTRASMENU to the file desired. 
Note that option 1 ovmides option 2 if both are used. 
For more information see the DeslcSet Environment Reference Guide . See also 
xview(l). 

Only those items that are active appear as normal text in the menu; inactive items (which are inappropriate 
at the time) are ·'grayed out". 

Sun Release 4.1 Last change: 11 June 1990 261 



TEXTEDIT ( 1 ) USER COMMANDS TEXTEDIT ( 1 ) 

User Defined Commands 

FILES 

The file lusrllib/text_extras_menu specifies filter programs that are included in the text subwindow 
Extras pull-right menu item. The file -I.textswrc specifies filter programs that are assigned to (available) 
function keys. These filters are applied to the contents of the primary selection. Their output is entered at 
the caret 

The file lusrllib/textswrc is a sample containing a set of useful filters. It is not read automatically. 

-I.textswrc 
lusrllib/text extras menu 
lusr/bin 
filename % 

textedit.pid 
Itmpffext* 

- -
Specifies bindings of filters to function keys 
Specifies bindings of filters for the extras menu pull-right items 
Contains useful filters, including shift_lines and capitalize. 
Prior version of filename is available here after a Save Current File menu 
operation ' 
Edited version of filename; generated in response to fatal internal errors 
Editing sess~on logs 

SEE ALSO 
kill(l) 

Introduction to the Open Windows User Environment 

DIAGNOSTICS 

BUGS 
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Cannot open file 'filename', aborting! filename does not exist or cannot be read. 

textedit produces the following exit status codes: 

o nonnal tennination 
1 standard Open Windows help message was printed 
2 help message was requested and printed 
3 abnonnal termination in response to a signal, usually due to an internal error 
4 abnonnal termination during initialization, usually due to a missing file or running out of 

swap space 

Multi-click to change the current selection does not work for Adjust Selection. 

Handling of long lines is incorrect in certain scrolling situations. 

There is no way to replay any editing sequence except the most recent. 
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NAME 
XView - XView toolkit information 

SYNOPSIS 
There is no XView command per se, but this manual page will describe XView features and functions. 

AVAILABILITY 
This command is available with the XView software distribution. 

DESCRIPTION 

USAGE 

XView (X Window-System-based VisuaJ/lntegrated Environment for Workstations) is an Open Look 
user-interface toolkit which supports interactive, graphics-based applications running under the X Window 
System. For detailed infonnation see the XView Programming Manual. 

CompUIng XVJew Programs 
XView programs are compiled with the following command line: 

cc sourcefile.c -0 outputfile -Ixview -lolgx -IXII 

Generk XVJew Functions 
xv JnitO Establishes the connection to the server, initializes the Notifier and the 

DefaultslResource-Manager database, loads the Server Resource-Manager database, 
reads the -/.xdefaults database and any passed attributes, and installs a default XIO 
Errorllandler .. 

Sun Release 4.1 

void 
xv_init(attra) 

<attribute-value list> attrs; 

Creates an object 

Xv_object 
xv_create(owner, package, attrs) 

Xv_object owner; 
Xv-pkg package; 
<attribute-value list> attra; 

Destroys an object 

int 
xv_destroy (object) 

Xv_opaque object; 

Finds an object that meets certain criteria; or if the object doesn't exist, creates it _ 
(defauh bdlavior wbich can be defeated using XV _AUTO_CREATE, FALSE). 

Xv_opaque 
xv_find(owner, package, attra) 

Xv_object owner; 
Xv -pkg package; 
<attribute-value Ust> attra; 
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xv.JetO Gets the value of a single attribute. 

Xv_opaque 
xV_get(object, attra) 

Xv object object; 
<ai"iribute-value list> attra; 

Sets the value of one or mme attributes. 

Xv_opaque 
xv_set(object, attra) 

Xv_object object; 
<attribute-value list> attra; 

Command Line Resource Arguments 
In XView, display characteristics can be specified by adding command line arguments to the starting 
application's start-up command The usage is as follows: 

% program -argument} value} -argument2 value2 ... 

In the tables below, Argument(s) shows the short argument followed by the long argument--either can be 
used. Type describes the type of value the arguments can receive. Resource Name describes the X 
resource name modified by the arguments. Derault is the default value. Description describes what the 
arguments do. Example shows an example of a command using the argument 

Argument(s): -Wx, or -scale 
Type: string ("small", "medium", "large", "extra_large") 
Resource Name: Window.ScaIe 
Default: medium 
Description: Sets the initial scale of the application (larger or smaller). small is 10 pixels, medium is 

12 pixels, large is 14 pixels and extra_Large is 19 pixels. The fontname resource 'will 
override the scale. 

Example: cmdtool -scale eXU'a_large 

Argument(s): -Wt, -fn, or -font 
Type: . string 
Resource Name: FontName 
Default: lucida-sans 
Description: Sets the name of the font used for the application (not control areas). To find out what 

fonts are available, use the xlsfonts command (see reference manual page for more 
infonnation). It is also possible to see the available fonts for the Open Windows server 
with one of the NeWS demo prOgrams in the demo Navigator. Start this by choosing 
"demos .•. " from the default root menu. If the font you specify cannot be found, you see 
will an error message such as: 

Example: 

XView warning: Cannot load/om 'galant-24' (Font paclcage) 
XView warning: Attempting to load/om 

cmdtool -fn fixed 

Argument(s): -Ws, or -size 
Type: integer integer 
Resource Name: Window.Width and Window.Height 
Default: depends 
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Description: 
Example: 

Sets the width and height of the application's base frame. The values are in pixels. 
cmdtool-Ws 400 500 

Argument(s): -Wp, or -position 
Type: integez integer 
Resource Name: Window.x and Window.Y 
Default: depends on window managez 
Description: Sets the initial position of the application's base frame in pixels. The upper left comer 

of the screen is at position (0,0), with the x-axis increasing to the left, and the y-axis 
increasing downward. To detennine framebuffer size, one can use the <eeprom> com­
mand on the local machine. To determine screen size for a remote display, one can use 
Xlib functions (see the Xlib Programmers Manual). These values will also be generated 
by the "Save Workspace" option on the root menu into the SHOME/.openwin-init file 
when using the Open Look Window Manager .. 

Example: cmdtool-Wp 100 200 

Argument(s): -wa, or -geometry 
Type: suing of the format (WxH) ([+I-JX[+I-JY) 
Resource Name: Window.Geometry 
Default: depends 
Description: This sets both the size and the placement of the application's base frame. This option has 

priority ovez the -size and -position arguments. The size and placement parts of the 
value are optional. You can set just the size, just the position, or both. The size values 
are measured in pixels, and the position values use the same semantics as -position. 
Howevez, if you use the '-' in front of an X value, it will be taken as relative to the right 
hand side of the screen, instead of the left Likewise, if you uSe the '-' with the Y value, 
it will be taken relative to the bottom of the screen instead of the top. 

Examples: 
cmdtool -geometry SOOx600 
(will make the base frame SOOx600 pixels, with the position set by the window manager) 

cmdtool -WG +10+20 
(will make the base frame of default size with the left hand side of the ~e 10 pixels 
from the left hand side of the screen, and the top of the frame 20 pixels from the top of 
the screen) 

cmdtool-WG -10+20 
(will make the base frame of default size with the right hand side of the frame 10 pixels 
from the right hand side of the screen, and the top of the frame 20 pixels from the top of 
the screen) 

cmdtool -geometry 4OOx300'()'() 
(will make the base frame 400x300 pixels with the right hand side of the frame flush 
against the right hand side of the screen, and the bottom of the frame flush with the bot­
tom of the screen) 

Argument(s): -WP, -icon..,position 
Type: integez integer 
Resource Name: Icon.x Icon.Y 
Default: depends on window managez 
Description: Sets the position of the application's icon in pixels. Uses the same semantics as 

-position for base frames. 
Example: cmdtool-WP 400 20 
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Argument(s): -WI. -label. ex' ,.title 
Type: SIring 
Resource Name: Window.Header 
Default: depends on the application 
Description: Sets a default label for the base frame's header. However, the application can overwrite 

this setting and display its own header. 
Example: andtool-WI "Header Text" 

Argument(s): -Wi. and +Wi 
Type: boolean 
Resource Name: Window lconic 
Default: +Wi 
Description: These options conttol how an application will come up, open or closed (iconified). 
Examples: andtool + Wi (will make the COldfOOt come up open) 

cmdtooI -Wi (will make the cmdtoot come up closed) 

Argument(s): -Wf, or -foreground_color 
Type: integer integer integer 
Resource Name: Window.Color.Foreground 
Default: 0 0 0 
Description See Description in -Wb below. 

Argument(s): -Wb, or -background 
Type: integer integer integer 
Resource Name: Window.Colex'.Background 
Default: 255 255 255 
Description: These options allow the user to specify the foreground color (e.g., the color of the text in 

a textsw), or the background color (e.g .• the color that the text is painted on) of an appli­
cation. The three values should be integers between 0 and 255. They specify the 
amount of red, green and blue that is in the color. See .fg and -bg below for infonna­
tion on similar functions. 

Example: cmdtool-WfO 0255 -Wb 100 100 100 
(would come up with a blue foreground, with a gray background) 

Argument(s): -fg, or -foreground 
Type: string (color name, or hexidecimal color specification) 
Resource Name: Window.Color.Foregrowld 
Default: black 
Description: See Description in -bg below. 

Argument(s): -bg, or -background 
Type: string (color name, ex' hexidecimal color specification) 
Resource Name: Window.Col(X.Background 
Default: white 
Description: These options are similar to the -Wf and -Wb options,-except that they take a color argu­

ment in the fonn of a predefined color name (lavender, grey, goldenrod. ,etc.) from 
$OPENWINHOMFJIib/rbg.txt, ex' a hexidecimal representation. The hexidecimal 
representation is of the form pound sign (#) followed by the hexidecimal representation 
of tile red, green and blue aspects of the color. 

Examples: andtool-fg blue -bg gray 
(comes up with a blue fcreground, with a gray background) 
andtool -fg #d8OOff -bg white 
(comes up with a purple foreground, with a white background) 
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. Argument(s): -WI, or -icon_image 
Type: string 
Resource Name: Icon.Pixmap 
Default: depends on application 
Description: Sets the default tilename for the icon's image. However, the application can overwrite 

Ibis setting and display its own icon image. The tile must be in XView icon format The 
P-OgraJD <iconedit> will allow one to cmlte an image in the icon fonnat Several icons 
have been provided in the directory SOPENWINHOMF/include/images. By conven­
tion, icon format tiles end with the suffix • Jeon". 

Example: cmdtool -WI lusr(mclude/lDlages/stopJeon 

Argument(s): -WL, or -icon_label 
Type: string 
Resource Name: Icon.Footer 
Default: depends on application 
Description: Sets a default label for the base frame's icon. However, the application can overwrite 

this setting and display its own icon label. 
Example: cmdtool-WL "Icon Label" 

Argument(s): -WT, or -icon_font 
Type: string 
Resource Name: Icon.FontName 
Default: depends 
Description: Sets the name of the font used for the application's icon. To find out what fonts are 

available, use xlsfonts (see reference manual page for more information). 
Example: cmdtool-WT '.century schoolbook.' 

Argument(s): -Wd, or -default 
Type: string string 
Resource Name: given by the first string 
Default: none 
Description: This option allows the user to set resources that don't have command line equivalents. 

The format is -c:Iefault resource-name value • The XView resources without specific 
command line argwnents are discussed in the following section. 

Example: cmdtool -default Open Windows.ScrollbarPlacement left 

Argument(s): -xrm 
Type: string 
Resource Name: given in the string 
Default: none 
Description: lbisoption allows the user to set resources that don't have command line equivalents. 

This is similar to the -default option, but it takes only one argument, a string in the form 
of resource-name:value. 

Example: cmdtool-xrm OpenWindows.ScrollbarPJacement"right 

Argument(s): -WH, or -help 
Type: none 
Resource Name: none 
Default: none 
Description: Prints a description of the valid command line arguments for the application. 

Argument(s): -sync or -synchronous, and +sync or +synchronous 
Type: boolean 

Sun Release 4.1 Last change: 11 June 1990 '1fl7 



XVIEW(I) USER COMMANDS XVIEW(I) 

268 

Resource Name: Window.Synchronous 
Default: +synchronous 
Description: These options allow you to make the connection that the application has with the XII 

serv(2' either synchronous (-sync) or asynchronous (+sync). 

Argument(s): -Wr, or -display 
Type: string (host:display (.screen)) 
Resou~eName: S~(2'Nmne 

Default: laken from the DISPLAY environment variable 
Description: Sets the name of the XII server on which to connect. bost is the name or address of the 

~hine on whose saver you have pennission to display. display is a number 
corresponding to the server on which to display for that machine, and screen 
corresponds to which screen for the saver. See reference manual page on <Xhost> for 
more details on adding to pennissions list 

Examples: cmdtool -display foobar:O 
(will bring up a cmdtool on the default screen of the display #0 of host foobar) 
cmdtool -display foobar:O.I 
(will bring up a cmdtool on screen #1 of display #0 of host foobar) 

Argument(s): -Wdr, or -disable_retained 
Type: boolean 
Resource Name: Window.MonoDisableRetained 
Default: Not Retained on' color systems, and Retained on monochrome systems 
Description: This option is useful for applications running on a monochrome display, where server 

memory is at a minimum. For performance reasons, monochrome windows are by 
default retained by the server. Using retained windows will use more memory in the 
XII server; however, it also speeds up repainting when the window is covered and 
Wlcovered by other windows. When true, monochrome windows are not retained, thus 
saving server memory. 

Argument(s): -W dxio, or -disable_xio_error_handler 
Type: boolean 
Resource Name: none 
Default: enable xio handler-this option disables it 
Description: This option is useful for debugging an application. Whenever there is a fatal XIO error, 

the server will print an error message before exiting. XView installs a error handler to 
keep those messages from appearing. IT you would like to see these messages, use this 
option. 

Argument(s): -Wfsdb, or -fullscreendebug 
Type: boolean 
Resource Name: Fullscreen.Debug 
Default: FALSE 
Description: Enables/disables fullscreen debugging I1l()de during which XGrabs (XGrabServerQ, 

XGrabKeyboardQ, XGrabPointerQ) are not done. When using FULLSCREEN, the XII 
server will be grabbed which prevents other windoWs on the S(2'Ver from responding 
ootil the grab has been released by the one window which initiated the grab. Refer to 
the Appendix F in the XView Reference Manual: Converting Sun View Applications for 
further details. 

Argument(s): -Wfsdbs, or -fullscreendebugserver 
Type: booleal 
Resource Name: FuUscreen.Debugserver 
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FALSE 
Enables/disables server grabbing (XGrabServerO) that is done via the fullscreen pkg. 
Refer to the Appendix F in the XView Reference Manual: Converting SunView Appli­
cations for fwther details. 

Argument(s): -Wfsdbk, or -fu11screendebugkbd 
Type: boolean 
Resource Name: Fullsaeen.Debugkbd 
Default: FALSE 
Description: Enables/disables keyboard grabbing (XGrabKeyboardO) that is done via the fullscreen 

pkg. Refer to the Appendix F in the XView Reference Manual: Converting SunView 
Applications for further details. 

Argument(s): -Wfsdbp, or -fullscreendebugpar 
Type: boolean 
Resource Name: Fu1lscreen.Debugptr 
Default: FALSE 
Description: Enables/disables pointer grabbing (XGrabPointerQ) that is done via the fullscreen pkg. 

.xderaults FOe 

Refer to the Appendix F in the XView Reference Manual: Converting Sun View Appli­
cations for fwther details . 

The .XdefallIts file is used to store and relrieve resource settings. We recommend, however, that you use 
the command line arguments descnbed above in order to change display characteristics. Changing the 
resources in the .xdefaults file will modify the behaviour of the user's session. Novice users should not 
casually hand modify these settings. Before attempting edits to this file please read the appropriate sections 
of the Xlib Programming Manual on the file fonnat and the specific properties you intend to change. 

Note that resoW'Ces docmnented below do not have command line arguments. It is still possible, however, 
to change them without altering the .xdefaults file. Refer to the command line arguments -xrm and -
defaults for instructions on how to to this. Additional resources that have command line arguments are 
documented the previous section. 

The resources are documented in the following formac 

Resource: 

Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 
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Resource Name ( Props if resource can be modified by the OpenWindows Property 
Sheet) 
Possible Values. and/or Format of Values 10 be Assigned to Resource (Default Value)" 
Description of Resource. 

window.synchronous, +sync -sync 
True, False (False) 
Useful when debugging or tracking down a problem since the e2TOI' codes emitted from . 
Xlib will correspond to the immediate request made. Running in a synchronous mode 
will cause the application to run significantly slower. 

mouse.modifier.button2 
Shift, Carl, any valid modifier keysym (Shift) 
When using a mouse with less than three buttons, this resource gets an equivalent map­
ping for the second button which is the ADJUST button on a three button mouse. For 
more infonnation on keysyms, see the <xmodmap> reference manual page, Xlib docu­
mentation. and the include file SOPENWINHOME/include/XII/Xkeymap.h. 
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Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Default 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 
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mouse.modifier.button3 
Shift, Ctrl, any valid modifier keysym (Ctrl) 
When using a mouse with less than three buttons, this resource gets an equivalent map­
ping for the third button which is the MENU button on a three ' button mouse. For more 
information on keysyms, see the <xmodmap> reference manual page, Xlib documenta­
tion, and the include file SOPENWINHOME/include/XII/Xkeymap.h. 

OpenWindows.beep (Props) 
never, notices, always (always) 
When the value is notices, the audible bell will ring only when a notice pops up. When 
the value is never, the audible bell will never ring. When the value is always, the audi­
ble bell will always ring when the bell function is called by a program. 

alann. visible 
True, False (True) " 
When ringing the bell in an XView program, flash the window as well to warn the user. 

Open Windows. windowColor (Props) 
any valid XII color specification (#cccccc--80% grey) 
Specify the base color for control areas for 3-D look. Takes hexadecimal representation. 
Three other colors used for shading and highlighting are calculated based upon the value 
of the specified control color. The actual calculated values are done by the OLGX 
library to provide a consistent color calculation between XView and OL WM. The desk­
top properties program allows a full range of customization and previews what the 
chosen 3-D look will look like. Does not apply to monochrome displays. 

Open Windows. workspaceColor (Props) 
any valid XII color specification (#cccccc--80% grey) 
Specifies the color for the root window and the background color for icons that blend 
into the desktop. 

xview.icccmcompliant 
True, False (True) 
When False, tell XView to set window manager hints in a way that was used before the 
ICCCM was adopted. Useful for window managers that are released before XIIR4. 
Not needed with the Open Look Window Manager provided with Open Windows. 

Open Windows.3DLook.Color 
True, False (True on all but monochrome screens) 
When False, do not use the 3-D look on a color or greyscale screen. 

Open Windows.dragRightDistance (Props) 
N (100) 
Used by menus to determine when a pullright submenu would display when dragging 
over the menu item near a submenu. N is an integer greater than O. A re3$Onable value 
might start at 20 and go to 200 or so. May need to try different values to see what feels 
right to each person. 

Open Windows.selectDisplaysMenu (Props) 
True, False (False) 
When True. the SELECT button (usually left mouse) will display the menu as well as 
the MENU button (usually right mouse). 
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Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 

Resource: 
Values: 
Description 
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Open Windows.popupJumpCursor (Props) 
True, False (False) 
When False, do not warp the mouse to the notice when it appears. 

notice.beepCount 
N(l) 

XVIEW(l) 

Where N is an integer to specify how many times to ring the bell when a notice appears. 
Ringing the bell can consist of either an audible beep and/or a visual flash. 

Open Windows.scroIlbarPlacement (Props) 
Left, Right (Right) 
When set to Left, put all scroll bars on the lefthand side of the window or object 

Open Windows.multiClickTimeout (Props) 
N (4) • 
Where N is an integer greater than 2. Set the number of tenths of a second between 
clicks for a multi-click. A click is button-down, button-up pair. 

text.delimiterChars 
string (' 'JJl1!\"#$%&\'O*+,-J:;<=>?@[\\]"_'{lr') 
This resource allows the user to select the delimiter characters that are used when doing 
word level selections in the XView package. It was added because of the needs of the 
international marketplace, and it allows the user to define the local delimiters for the 
character set that is being used with the current keyboard and Sun workstation. 

The selection of delimiters will be automatically available to the user once the SunOS 
4. I becomes the default operating system environment, however this resource is used as 
a bridge during that period. 

Note that the octal characters can be scrambled by Xnn during a rewrite of the value of 
text.delimiter.Chars. Xnn interprets the text.delimiterChar string when it is loaded. 
Specifically it will decode the backslashed portions of the string and convert them to 
octal representations. When this is passed to the client application, the logic will func­
tion correctly. However, this misbehavior of Xrm causes the string to· be stored 
incorrectly if the user saves the .Xdefaults file using the Xnn content of the string. The 
specific problem(s) that occur are the stripping of the backslash characters and the 
expansion of the tab character ( 11). 

To correct this problem, one can put the textdelimiterChar entry into an.xdefaults file 
that will not be overwritten when saving the workspace properties (for example, a sys­
tem wide defaults file). Or a copy of the textdelimiterChar entry can be inserted after 
.Xdefaults file saves. 

scrollbar.jumpCursor (Props) 
True, FaIse (frue) 
When False, the scroll bar will not move the mouse pointer when scrolling. 

scrollbar.repeatDelay 
N (100) . 
Where N is some integer greater than 2. Specifies the time in milliseconds when a click 
becomes a repeated action. 
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N (100) 
Where N is some integer greatez than 2. Specifies the time in milliseconds between 
repeats of a single page scroll. 

scrollbar.lineInterval 
N(1) 
Where N is some integer greatez than O. Specifies the time in milliseconds between 
repeats of a single line scroll. How long to pause scrolling when bolding down the 
SELECr button on the scrollbar elevator. Saollbar sets up a timez routine for repeats. 

keyboarddeleteChar 
C (177 = octal for Delete) 
Where C is some character eithez typed into an editor or specified with an octal 
equivalent. Specifies the delete character. This resource applies to text windows only 
and not to panel text items. This would work in eithez cmdtool or textedit or the com­
pose window of mailtool. 

keyboarddelete W ord 
C ( 27 = octal for loW) 
Where C is some character either typed into an editor or specified with an octal 
equivalent Specifies the delete word character. This resource applies to text windows 
only and not to panel text items. This would work in either cmdtool or textedit or the 
compose window of mailtool. 

keyboard.deleteLine 
C 
Where C is some character either typed into an editor or specified with an octal 
equivalent Specifies the delete line character. This resource applies to text windows 
only and not to panel text items. This would work in either cmdtool or textedit or the 
compose window of mailtool. 

t.extmaxDocumentSize 
N(2000) 
Where N specifies the bytes used in mem<X)' before a text file is saved to a file on disk. 
Once this limit is exceeded, the text package will send a notice to the user to tell them 
that no more insertions are possible. H the file being edited is saved to a file, or it is a 
disk file being edited, then the limit does not apply. 

t.ext.retained 
True, False (False) 
If True, retain text windows with server backing store. 

textexttasMenuFilename 
filename (fusr/lib/.t.excextras_menu) 
Where filename is an absolute location to a file. Can also be set via environment vari­
able EX1RASMENU. This file is used for the text package's Extras menu. 1be com­
mands specified in the extras menu are applied to the contents of the current selection in 
the textsw window and then it inserts the results at the current insertion point 

t.extenableScrollbar 
True, False (True) 
When False, do not put a scrollbar on the text window. 
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textagainLimit 
N(1) 
Where N is an integer between 0 and 500. Number of operations the "again history" 
remembers for a textsw. 

textautoIndent 
True. False (False) 
When True. begin the next line at the same indentation as the previous line as typing in 
text 

textautoScrollBy 
N(l) 
Where N is an integer between 0 and 100. Specifies the nwnber of lines to scroll when 
type-in moves insertion point below the view. 

textconfirmOverwrite 
True. False (True) 
When False. do not give user confirmation if a save will overwrite an existing file. 

textdisplayControlChars 
True. False (True) 
When False. use an up arrow plus a letter to display the control character instead of the 
character that is available for the current font 

texLundoLimit 
N (SO maximum of 5(0) 
Where N is an integer between 0 and 500. How many operations to save in the undo 
history log. These operations will be undone when you press the "Undo" key in the text 
window. 

text.insertMakesCaretVisible 
If_auto_scroll (Always) 
Controls whether insertion causes repositioning to make inserted text visible. 

textlineBreak 
Clip. Wrap_char, Wrap_word (Wrap_word) 
Determines how the textsw treats file lines when they are too big to fit on one display 
line. 

text.margin.bottom 
N(O) 
Where N is an integer between -1 and 50. Specifies the minimum nwnber of lines to 
maintain between insertion point and bottom of view. A value of -1 turns auto scrolling 
off. 

mouse.multiclick.space 
N(4) 
Where N is an integer between 2 and 500. Specifies the maximwn nwnber of pixels 
between successive mouse clicks to still have the clicks considered as a multi-Glick 
event 

textstoreChangesFile 
True, False (True) 
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When False. do oot change the name of the current file being edited to the name of the 
file that is stored. The name of the current file is reflected in the titlebar of the textedit 
frame. 

text.margin.top 
N(2) 
Where N is an integer between -1 and SO. Specifies the minimum nwnber of lines to 
maintain between the start of the selection and the top of the view. A value of -1 mtmlS 
defeat normal actions. 

textmargin.left 
N(8) 
Where N is an integer between 0 and 2000. Specifies the margin in pixels that the text 
should maintain between the left hand bordez of the window and the first character on 
~line. 

texunargin.right 
N(O) 
Where N is an integer between 0 and 2000. Specifies the margin in pixels that the text 
should maintain between the right hand border of the window and the last character on 
each line. 

texttab Width 
N(8) 
Where N is an integer between 0 and SO. Specifies the width in characters of the tab 
charaCtel' • 

tenn.boldStyle 
None, OffseCX. OffseC Y. Offset_X_and_ Y. Offset_XY. OffsecX_and_XY. 
Offsec Y _and_XY. Offset_X_and_ Y _and_XY. Invert (Invert) 
Specify the text bolding style for a tenninal based window. 

tenn.inverseStyle 
Enable. Disable. Same_as_bold (Enable) 
Specify the text inverting style for a tenninal based window. 

tenn.unda'lineStyle 
Enable. Disable. Same_as_bold (Enable) 
Specify the text underlining style for a tenninaI based window. 

tenn.useAltemateTtyswrc 
True. False (True) 
When True. and a SHOME/.ttyswrc is not found. look f<X' an alternate ttyswrc file. 
When False. do not look for an alternate file is one is not fOWld in the home directory. 
SHOMF/.ttyswrc. 

tenn.altemateTtyswrc 
filename ($XVIEWHOME/lib/.ttyswrc) 
Where filename specifies a complete filename and absolute path of an alternate ttyswrc 
file. This is only used if a .ttyswrc file is not found in $HOME/.ttyswrc and 
tenn.useAltemateTtyswrc is True. 

tenn.enableEdit 
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Values: True, False (True) 
Description When False, do not keep an editlog of what hu been typed into the term window. This 

is set to false automatically when switching from a scrollable tenn to one that is not 
sc:rollable. 

ENVIRONMENT 

FILES 

SOPENWINHOME is recognized as where Open Wmdows is installed. 
$DISPLAY is the name of the sezver and screen to which applications should display. 
$LD _UBRARY _PATH is the SunOS shared library search path. 
$HELPPATH is the path that applications will search for Open Look Help files. 

$OPENWINHOME/include/images 
$OPENWINHOME/lib 
$OPENWINHO:ME/include 
$OPENWINHOME/bin/xview 
$OPENWINHOWiE/sbarelsrc/sun/xview/demos 
$OPENWINHOMFJsharelsrc/sun/xview/examples 

(XView images) 
(XView Library) 
(include files) 
(binaries) 
(XView demo programs) 
(XView example programs) 

SEE ALSO 
open win , xllnews 
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